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Getting Started
Once Leapfrog Works is installed, there are some first steps to carry out before you begin working with
projects. This topic describes those first steps and then provides an overview of Leapfrog Works project
files. This topic is divided into:
l
l
l
l
l

Signing In to Leapfrog Works With Seequent ID
Graphics and Drivers
The Leapfrog Works Projects Tab
Recording Reference Codes
Managing Leapfrog Works Projects

Once you have carried out these first steps, see An Overview of Leapfrog Works for a description of the
different parts of the Leapfrog Works main window and Concepts for information that is important to
helping you get the most out of Leapfrog Works.

Signing In to Leapfrog Works With Seequent ID
To use Leapfrog Works, you need a Seequent ID and the correct permissions.
If you do not have a Seequent ID, you can sign up for one by launching Leapfrog Works and clicking
the Register button.
To find out more about different permissions, visit the Flexible Leapfrog Software Subscription
Options page.
Once you have a Seequent ID and the correct permissions, launch Leapfrog Works, enter your details
and click the button to sign in.
In the next window, you can:
l
l

l

Select your group, if your organisation has a number of different groups.
Select what extensions you wish to use. Some Leapfrog Works features are only available with an
extension.
Select how long you wish to check out a seat, if your organisation is set up to check out seats on a
day-by-day basis.

Select your options, then click the Get Started button.
Signing in to Leapfrog Works also signs you in to View, so you can upload scenes to View.
The Seequent ID menu in the upper right-hand corner of the main window is used to manage your
MySeequent identity.

If your organisation shares Leapfrog seats between users, signing out when you are finished working
with Leapfrog Works releases your seat for other Leapfrog users in your organisation.
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The menu is displayed in grey rather than green when you are working offline. You will not be able to
sign out of MySeequent when you are offline.

Graphics and Drivers
Many laptop computers come with two graphics options: low-powered graphics integrated into the
CPU and a high-performance dedicated graphics option (a GPU). To save power, often the laptop’s
default setting is to run programs using the slower integrated graphics option. However, selecting highperformance graphics options is very important to Leapfrog’s performance. If you have a dedicated
graphics option, you should be using it. It’s also important to have the most up-to-date drivers to make
the most of your computer’s capabilities.
To determine what graphics capabilities your computer has:
1. From the Leapfrog Works menu, select About.
2. Click on the System Info tab.
Under the Summary, you will see the following details:
l

l

l

Graphics in use by shows the graphics option being used. Note that Leapfrog Works uses only the
option indicated; if there are two options available, Leapfrog Works does not use both
simultaneously.
All available graphics hardware lists the options available. If there are two options listed, you will
want Leapfrog Works to use the dedicated graphics option rather than the slower integrated
graphics.
Driver date shows the date at which the driver was last updated for each graphics option.

If your graphics drivers are out of date, it is recommended that they be updated prior to switching the
graphics in use by Leapfrog Works. You can find detailed information on setting up your graphics
correctly for Leapfrog Works on MySeequent.
You may need to know your installation path. The default installation path for Leapfrog Works
version 4.0 is: C:\Program Files\Seequent\Leapfrog Works4.0\bin\Works.exe.

Running the Graphics Test
Leapfrog Works can run in one of three acceleration modes. These modes are selected by clicking on the
button at the bottom of the main window:

See 3D Acceleration Mode in Settings for more information on these settings.
A newer computer will run in Full Acceleration mode without issues. However, if you are running
Leapfrog Works on a computer that is more than five years old, it is a good idea to run the graphics test
to test your computer’s graphics capabilities.
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To start the test, open Leapfrog Works and select Test Graphics from the Leapfrog Works >
Diagnostics menu:

The graphics test displays a series of image pairs that test your computer’s capabilities for the currently
selected acceleration mode. For each pair, compare the images:

Even if the differences are slight, click the Images Differ button. If the images match, click the Images
Match button. The next test will be displayed.
At the conclusion of the test, the result is displayed. If one or more tests have failed, information about
solving problems will be displayed.
If you click on Save Report, you will be prompted to save the file on your computer.
If the test has failed, try switching to a different acceleration mode and running the test again. If
possible, avoid using Software Rendering as it can be very slow.
If you cannot resolve the problem, save a copy of the graphics test report and contact technical support
as described in Getting Support. Be sure to include information about your system copied from the
About > System Info tab.
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The Leapfrog Works Projects Tab
After you have signed in to My Leapfrog, the Leapfrog Works main window will appear with the
Projects tab displayed:

Thumbnails for the most recent projects are displayed in the Recent projects list. The second set of
thumbnails is for projects contained in the Search folder:
l

l

Click on the folder button ( ) or press the F5 key to change the Search folder. The Search folder
is useful if you have one folder in which you keep most of your Leapfrog Works projects.
Click on the Refresh button ( ) or press the F4 key to update the list of projects in the Search
folder.

Projects from other Leapfrog modelling products are indicated in the Projects tab. Leapfrog Geo and
Leapfrog Geothermal projects can be converted to Leapfrog Works projects. See Converting Leapfrog
Geo and Leapfrog Geothermal Projects for more information. Leapfrog Hydro projects can be opened
without converting them, and you will still be able to open them in Leapfrog Hydro.
Click on a thumbnail to open a project. You can also navigate directly to the required project file by
clicking on Open Project File.
Once a project file has been opened, Leapfrog Works switches to displaying the Scene View tab.
See Managing Leapfrog Works Projects below for more information on saving, compacting and
upgrading projects.
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Recording Reference Codes
You can enter a reference code to track work on specific projects. The time associated with each
reference code is included in your monthly usage report.
To enter a code, click the button in the status bar on the bottom edge of the Leapfrog Works main
window:

Select from the codes defined and click OK. The code entered will be displayed in the status bar:

To define new reference codes or delete old ones, click on the Manage Codes button. See Usage
Policy Settings.
To work without a code, click on the button, select <No Code>, then click OK. Note that whether it’s
possible to use Leapfrog Works without first entering a reference code depends on a setting in the
Settings > Usage Policy window.

Managing Leapfrog Works Projects
To create a new project, click New Project at the top of the Projects tab. The new project will be
saved in the Search folder.
Leapfrog Works project files use the extension .aproj. A folder is also created that contains information
used by the project.
Do not change the name of your project folder or alter its contents. Doing so could render your
project file unusable.
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A .lock file is created when a project is opened. The .lock file protects the project from being moved
while the project is open and from being opened by another instance of Leapfrog Works, which can
happen when projects are saved on shared network drives.
Leapfrog is optimised for working off your local hard drive, and you will experience increased
processing times and object load times if you access your project from a different storage system. It is
strongly recommended that you do not work from network drives, synced drives (e.g. OneDrive,
DropBox) or USB drives as working in this way can result in corrupted projects.

Saving Projects
Leapfrog Works automatically saves an open project each time a processing task has been completed or
settings have changed. Projects are also saved when they are closed so that scene settings can be
restored when the project is next opened.

Saving Zipped Copies of Projects
You can save a zipped copy of a project by selecting Save A Zipped Copy from the Leapfrog Works
menu. You will be prompted to choose a name and location for the zipped project. Click Save to create
the zip file.

Saving Backup Copies of Projects
You can save a backup copy of a project by selecting Save A Copy from the Leapfrog Works menu.
You will be prompted to choose a new name and location for the saved project. Click OK to create the
new project file. Leapfrog Works will save a copy of the project in the location selected.
Once the backup copy is saved, you can open and use it from the Projects tab. Otherwise, you can
keep working in the original copy of the project.

Compacting Projects
When you delete objects from a project file, Leapfrog Works retains those objects but notes that they are
no longer used. Over time, the project file will grow in size and data stored in the database may become
fragmented.
Compacting a project removes these unused objects and any unused space from the database. When
you compact a project, Leapfrog Works will close the project and back it up before compacting it.
Depending on the size of the project, compacting it may take several minutes. Leapfrog Works will then
reopen the project.
To compact a project, select Compact This Project from the Leapfrog Works menu. You will be
asked to confirm your choice.

Upgrading Projects
When you open a project that was last saved in an earlier version of Leapfrog Works, you may be
prompted to upgrade the project. A list of affected objects will be displayed. For large projects with
many objects that need to be reprocessed, the upgrade process may take some time. However, it is a
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good idea to back up projects before opening them in a new version of Leapfrog Works and backing up
the project is strongly recommended.
Tick the Back up the project before upgrading button, then click Upgrade and Open. Navigate to
the folder in which to save the backup and click Save.
For large projects with many objects, upgrading without backing up the project is not recommended.

Converting Leapfrog Geo and Leapfrog Geothermal Projects
Leapfrog Geo and Leapfrog Geothermal projects can be converted to Leapfrog Works projects.
However, the process is one-way, and projects opened in Leapfrog Works can no longer be opened in
Leapfrog Geo/Leapfrog Geothermal.
When you open a Leapfrog Geo/Leapfrog Geothermal project, you will be prompted to save a backup
before converting the project.
It is strongly recommended that you back up the project before converting it.
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An Overview of Leapfrog Works
This topic provides an overview of the different parts of the Leapfrog Works main window. For more
detailed information on using the controls in the different parts of the main window, see the following
topics, which describe different aspects of using Leapfrog Works:
l
l
l
l
l
l
l
l
l

The Project Tree
The 3D Scene
Visualising Data
Working With Data Tables
Correcting Data Errors in Leapfrog Works
Evaluations
Query Filters
Drawing in the Scene
Organising Your Workspace

For more information on basic concepts that are important to getting the most out of Leapfrog Works,
see the Concepts section.
The Leapfrog Works main window is divided into three main parts:

The Project Tree contains all the data in the project and tools for working with that data. When you
want to change how this data is used in the project, work with the objects in the project tree. See The
Project Tree. The Scene View tab displays a 3D representation of selected objects from the project
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tree. Changing how you view objects in the scene window does not change those objects in the project
tree. See The 3D Scene. Tools for changing the appearance of data in the scene window are available in
the shape list and the shape properties panel . Changing the appearance of these objects does not
change those objects in the project tree.
You can add objects to the scene window by dragging them from the project tree. You can temporarily
hide them in the scene or remove them altogether using the controls in the shape list.
Leapfrog Works is unit-less and adopts the units used in the data you import. For example, if your
imported data is in metres, the units displayed will be metres, and figures such as resolution,
measured distances and slicer thickness will be in metres. It is important, therefore, to be consistent
in the units used in the data you import. If you are importing data that uses different coordinate
systems, you will need to pre-process the data so that it is using the same coordinate system.
When you open a Leapfrog Works project, the project is displayed in the state it was in when it was
closed.

Keyboard Shortcuts in the Main Window
Use the Tab and Shift+Tab keys to move between the different parts of the main window in the
following order:
l
l
l
l
l

Project tree
Scene toolbar
Scene window
Shape list
Shape properties panel

Key(s)

Action

F8

Maximise scene, minimise project tree and shape list. Press F8 again to restore.

Ctrl+1

Activate the Select tool (

Ctrl+2

Activate the Draw slicer line tool (

)

Ctrl+3

Activate the Draw plane line tool (

)

Ctrl+4

Activate the Ruler tool (

Ctrl+\

Split the scene view

F10 or Alt L

Open the Leapfrog Works menu

F11

Open the Seequent ID menu

F1

Open Leapfrog Works help

Ctrl+Q

Quit Leapfrog Works

)

)
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The Project Tree
The series of folders in the project tree are used to organise objects such as datasets, maps and images
into categories. These folders also provide tools that let you import information into the project and
generate models. Right-click on each folder to view the actions you can perform using that folder.
This topic provides an introduction to working with the project tree. It is divided into:
l
l
l
l
l
l
l

Importing Data
Data Object Options
Organising Objects in the Project Tree
Object Properties
Comments
Object Processing
Project Tree Keyboard Shortcuts

Importing Data
Leapfrog Works has tools for importing, creating and working with many different types of data, and
these tools are available by right-clicking on the different folders in the project tree. For example, rightclicking on the GIS Data, Maps and Photos folder gives you options for importing vector data and
maps, along with options for batch importing GIS data:

Leapfrog Works is unit-less and adopts the units used in the data you import. For example, if your
imported data is in metres, the units displayed will be metres, and figures such as resolution,
measured distances and slicer thickness will be in metres. It is important, therefore, to be consistent
in the units used in the data you import. If you are importing data that uses different coordinate
systems, you will need to pre-process the data so that it is using the same coordinate system.
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Data Object Options
You can right-click on data objects within the top-level folders to view more information on that object
or carry out actions specific to that object. For example, right-clicking on a table of imported borehole
data reveals a menu showing possible actions:

When a bold option appears in the right-click menu, as Open does in the menu above, that option can
also be selected by double-clicking on the object.
You can select more than one object in the project tree by holding down the Shift key or the Ctrl key
while clicking. This is useful for viewing or deleting multiple objects at once.
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The way folders and objects are organised in the project tree lets you reveal or hide information about an
object to focus on objects you are currently working with. This is also useful when you are exploring a
project and want to determine how something was put together. The arrows next to objects in the
project tree let you reveal or hide an object’s details to focus on objects you are currently working with.
Here, the Topographies folder is expanded to show a Topography object that is made up of a mesh:

Also note that:
l

l

l

The mesh itself is stored in the Meshes folder, but is hyperlinked to from wherever it is used in the
project.
The Borehole Data folder and the Boreholes object have been expanded to show the borehole
data tables.
Folders that have no arrow have no detail stored.
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Expanding a data table ( ) shows the columns in that table contains, including category data columns (
), numeric data columns ( ) and query filters ( ):

Some tables are marked as having errors ( ), which are discussed in Identifying Errors in Data Tables.
Expanding a geological model reveals information about how it was built. Here, a geological model has
been expanded to show the basic objects that make up a model:

The five objects underneath the geological model “GM” represent the five basic parts of a geological
model:
l
l
l
l

The Boundary object defines the outer limits of the geological model.
The Fault System object defines faults and their interactions in the geological model.
The Lithologies object defines the lithologies in the model.
The Surface Chronology object defines the structure of the model’s contact surfaces.
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l

The Output Volumes folder contains the generated units (outputs) that make up the geological
model.

Here, boundary objects for a geological model have been expanded to show how they were created:

The Topography object is included as the model’s upper boundary. The “East_boundary” object was
created using a polyline from the Polylines folder and the “North_boundary” object was created using a
GIS data object in the GIS Data, Maps and Photos folder. Clicking on the hyperlinks will locate the
object from which the extent was created.

Organising Objects in the Project Tree
Leapfrog Works has a number of tools to help you organise the large numbers of objects in a project.
One of these tools is the use of display lines in the project tree to better show relationships:

If you wish to display line in the project tree, open the Settings window from the Leapfrog Works
menu. Click on User Interface and enable Show Tree Lines.
When you have a large number of folders open in the project tree, you can close all folders by rightclicking on the top of the project tree and selecting Collapse All:
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Hotkeys for opening and closing folders include:
l
l
l
l
l

Ctrl + shift + left arrow collapses all folders.
Right arrow expands a collapsed folder or object but keeps child objects collapsed.
Shift + right arrow expands a collapsed folder or object and child objects.
Left arrow collapses an expanded folder or object but keeps child objects expanded.
Shift + left arrow collapses an expanded folder or object and child objects.

Hotkeys work with more than one object selected.
Subfolders
In many project tree folders, you can create subfolders that help in organising large numbers of data
objects. For example, here colour gradients have been organised into subfolders:

To add a subfolder, right-click on a folder in the project tree and select New Subfolder. Add objects to
subfolders by dragging and dropping them. You can also use Cut (Ctrl-X) and Paste (Ctrl-V) shortcuts
to move objects and subfolders.
Subfolders can be renamed, moved and deleted, but cannot be moved to other top-level folders.
Subfolders have the same right-click commands as their parent folder, which means you can import or
create new data objects inside the subfolder rather than in the parent folder. You can also add comments
to folders to aid in keeping data organised:

You can view all objects in the subfolder by dragging the folder into the scene or by right-clicking on the
subfolder and selecting View All.
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When lists of objects are displayed, the subfolder organisation will be reflected in the list. For example,
when creating an interpolant, the list of data objects that can be interpolated is displayed organised by
subfolder:

Subfolders cannot be created in the Borehole Data folder, although they can be created in the
Composites and Planned Boreholes folders.
Copying Objects
Many objects in the project tree can be copied. Right-click on an object and select Copy. You will be
prompted to enter a name for the object’s copy.
The copied object is not linked to the original object. However, if the original object is linked to other
objects in the project, the copy will also be linked to those objects.
Renaming Objects
When an object is created in Leapfrog Works, it is given a default name. It is a good idea to give objects in
Leapfrog Works names that will help you distinguish them from other objects, as large projects with
complicated models will contain many objects.
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To rename an object in the project tree, right-click on the object and select Rename. The Rename
Object window will be displayed:

Enter a new name for the object. Click Rename to change the object’s name.
Finding Objects
To find objects in the project tree, click the search button at the top of the project tree:

You can also click anywhere in the project tree and type “Ctrl-F”.
In the Find window, enter the information you are searching for, then click Backwards or Forwards to
locate the object in the project tree.
Deleting Objects
When you delete an object from the project tree, a window will be displayed listing all other objects in the
project that will also be deleted and those that will be reprocessed. Some objects will be put into an error
state; you will need to correct those errors before the affected object can be used elsewhere in the
project.
Consider carefully the effects on other objects in the project, as once an object is deleted, it cannot
be recovered.
Deleting data from the project may cause other objects to be reprocessed, which can take some time.
To delete more than one object from the tree, hold down the Shift key or the Ctrl key while selecting
objects.
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Sharing Objects
Some objects are created as part of working with other objects and are not available elsewhere in the
project. An example of this is a polyline drawn as part of creating a model boundary. To share such
objects within the project, right-click on the object in the project tree and click Share. The shared
object will be copied to the relevant location in the project tree and a hyperlink added to the object it was
shared from.
For example, here a polyline created as part of a lateral extent is shared:

The polyline is saved to the Polylines folder and a hyperlink to it appears as part of the model’s
boundary. Whenever the polyline is updated, changes will be made wherever it is shared in the project.
Polylines that have been shared can be unshared. See Sharing and Unsharing Polylines for more
information.

Object Properties
You can view the properties of most objects imported into or created in Leapfrog Works. To do this,
right-click on the object in the project tree and select Properties.
The information available in the Properties window depends on the type of object. Tabs may include:
l

A Processing tab that shows the current status of the processing (queued to process, processing,
finished).
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l

l

l

An Errors tab that displays errors that have occurred while processing the object. See Object
Processing.
A General tab that summarises information about the object. The amount of information in the
General tab will vary according to the type of object. For example, for table objects, the General
tab shows the table’s data structure.
A Statistics tab that shows statistics for some types of interpolants.
l
l

l

For RBF interpolants, see RBF Interpolant Statistics.
For multi-domained RBF interpolants, see Sub-Interpolant Statistics.

A History tab that records information about who created and modified an object and when.

The History tab was introduced in Leapfrog Works 2.1. For objects created in earlier versions of
Leapfrog Works, the History tab will display changes made to the object in version 2.1 and later.

Comments
Another aid to documenting work in a project is comments.
You can record comments on many objects in the project tree, including subfolders. This can be helpful
when the project contains many objects and when several different people are working on a model.
Objects that have comments are indicated in the project tree by a comment balloon ( ). The comment
will be displayed when you right-click on the object:

Tab or click to add a new comment or edit an existing one. You can also add standard information to a
comment, such as date and time. If you add a URL to a comment, it will be converted to a clickable link.
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You can add information about the project as a whole using the Notes object ( ), which is the last
object in the project tree. Double-click on the Notes object to open it and add information. When
viewing projects in the Projects tab, information in a project’s Notes will be displayed when you hold
the mouse cursor over the project’s thumbnail:

Object Processing
Objects that are up-to-date are displayed in the project tree using black text. When an object is being
processed, its processing state is indicated in the project tree in either green or grey text. For example,
here the Maia Geological Model is being updated:

The four surfaces displayed in green are currently being processed, and the objects displayed in grey are
awaiting processing. The Surface Chronology and the geological model itself are displayed in grey
because one or more of their child objects are being processed or are awaiting processing.
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The processing queue shows how many tasks are currently being processed:

The button will turn grey when all processing is complete.
Click the button or press Alt + P to view the processing queue:

Objects will be added to the processing queue when you make changes to them via the project tree.
l
l

To pause processing, press Ctrl + P.
To resume processing, press Ctrl + P again.

You can close a project while it is still running tasks. When you next open the project, the remainder of
the tasks in the processing queue will be processed.
Controlling Processing
When a project contains only a small amount of data, all changes can be processed when they are made
without interrupting your work. As a project grows larger and more complex, you may wish to use the
different processing controls to determine when changes you make to objects are processed. There are
two ways to control when objects are processed:
l
l

Prioritising Objects
Freezing Objects
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These tools are described below. Experiment with both of them separately to get an idea of how they
work; this will help in determining the approach that best suits your projects as you add more data and
models to them.
The project tree may also contain restricted objects:

Restricted objects were created using features only available in extensions. You can display restricted
objects in the scene and change how they are displayed, but you cannot make changes to the objects
themselves or export them. When changes are made to objects that are inputs to restricted objects,
the restricted objects will not be processed. Instead, they will remain in the processing queue marked
as “frozen”.
Contact Customer Support as described in Getting Support for more information about extensions.
Prioritising Objects
Objects can be prioritised so that they and their inputs are processed before other objects. To prioritise
an object, right-click on it the project tree and click the Prioritise button ( ). Prioritised objects are
marked in the project tree with an arrow:

Prioritising an object is useful when you are editing it and wish to view the effect of changes without
reprocessing all objects in the project. For example, you may be modifying a surface that is used for a
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model boundary. You can prioritise the surface, then run it each time you make changes; the surface and
objects it is dependent on will be processed before any other objects are processed.
To limit processing of other objects further, you can set the processing queue so that only prioritised
objects are processed. If your project has a lot of objects that are dependent on the object you are
working on, this is useful for limiting the amount of time Leapfrog Works dedicates to processing. To
restrict processing in this way, click the processing queue button, then click Priority Only:

The processing queue button will change to show that only priority tasks will be run:

When changes are made to the prioritised object, the only objects processed will be those needed to
make the prioritised object valid. For example, here the Intermineral diorite surface has been prioritised.
The geological model itself, its surface chronology and its output volumes will not be updated when the
prioritised surface is updated:
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Objects not needed to validate the prioritised object will remain in the processing queue in Waiting and
Queued states:

The number of objects that have been prioritised is indicated by the button at the top of the project
tree ( ):

To view prioritised objects, click the button. All prioritised objects will be selected and displayed in the
project tree.
To reset a priority object, right-click on it and click the Clear Priority button ( ).
Click the processing queue button, then click Run All to resume normal processing.
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Freezing Objects
Objects can also be frozen so that they will not be processed, which is a useful way of working on one
object without having all linked objects reprocess upon each change. For example, you may wish to
modify a surface in a geological model, in which case you can freeze all objects other than the surface.
You can display frozen objects in the scene, change how they are displayed and export them, but you
cannot make changes to the objects themselves.
Some objects become frozen because they are restricted objects created using features only available
in extensions. Frozen restricted objects can only be unfrozen if you switch to using the relevant
extension.
To freeze an object, right-click on it the project tree and click the Freeze button ( ). You can also
quickly freeze multiple objects by selecting them and then right-clicking on the selection:

Frozen objects are marked in the project tree with a pause button ( ). Here, some of the contact
surfaces and all of the output volumes have been frozen so that work can be done on the Intermineral
diorite surface without processing all other changes to the model:
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When a frozen object has unprocessed changes, it will be displayed in the project tree greyed out, which
is the case here for the model’s output volumes:

The frozen contact surfaces are still displayed in black because changing the Intermineral diorite surface
does not change those other surfaces. However, all of the output volumes are displayed using blue text
because they have unprocessed changes as a result of the changes made to the Intermineral diorite
surface.
The number of objects in a project that have been frozen is indicated by the button at the top of the
project tree . To quickly select all frozen objects, click the button. All frozen objects will be selected in the
project tree.
The number of objects that have been frozen is indicated by the button at the top of the project tree (
):

To view frozen objects, click the button. All frozen objects will be selected and displayed in the
project tree.
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Correcting Errors
If processing of an object fails, all other objects dependent on that object will also fail. Open the
processing queue to view the errors. To inspect the source of error, right-click on the object in the queue
and select Show Error:

The object’s Properties window will be opened with the Errors tab displayed. The information in this
tab may be helpful in fixing the error.

Project Tree Keyboard Shortcuts
Keyboard shortcuts for navigating in the project tree are as follows:
Key(s)

Action

Up and down arrows

Navigate up and down the tree

Right arrow

Expand folder/object or go down one level

Left arrow

Close folder/object or go up one level

Ctrl+shift+left arrow

Close all folders/objects

Shift+right arrow

Expand the selected folder/object and any objects in it

Shift+left arrow

Close the selected folder/object and any objects in it

Ctrl+A and Ctrl+/

Selects all folders and objects

Ctrl+F

Search for objects

Enter

The equivalent of double-clicking on an object

Ctrl-X

Cut an object or subfolder. Use with Ctrl-V to move objects and subfolders.

Ctrl-V

Paste an object or subfolder

Some actions are not available until data has been imported into the project.
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The 3D Scene
This topic describes how to interact with the 3D scene. It is divided into:
l
l
l
l

Locating an Object from the Scene
Slicing Through the Data
Measuring in the Scene
Working With Split Views

How to change the way objects are displayed in the scene is described in a separate topic, Visualising
Data.
The best way to navigate the 3D scene in Leapfrog Works is using the mouse. If you are running
Leapfrog Works on a laptop, it is recommended that you plug in a mouse rather than using the laptop’s
touchpad for navigation. However, you can also navigate in the scene using the keyboard.
Action

Mouse

Changing the viewing
angle

Click and drag to rotate the scene

Zooming in and out of
the scene

Panning the scene

Keyboard
Press the arrow keys to rotate the scene
For smaller steps, hold down the Shift key while pressing the
arrow keys

Use the scroll wheel

Press the Page Up or Page Down keys

Hold the right mouse button while
moving the mouse

For smaller steps, hold down the Shift key while pressing the
Page Up or Page Down keys

Click and hold both mouse buttons,
then drag

Hold down the Alt key while pressing the arrow keys

Hold the scroll wheel and drag
Centre an object in
the scene

Click the scroll wheel
Click both mouse buttons together

© 2020 Seequent Limited

The 3D Scene | 29

Use the Look menu above the scene window to switch to different viewing angles:

If you prefer to navigate using the keyboard, use the following keyboard shortcuts:
Key(s)

Action

Arrow keys

Rotate the scene in 10 degree steps

Shift+Arrow keys

Rotate the scene in 2 degree steps

Home

Reset the view, showing all visible objects in scene

U, D, E, W, N, S

Look Up, Down, East, West, North and South

L

Look at the slicing plane

Shift+L

Look at the back of the slicing plane

M

Look at the moving plane

Shift+M

Look at the back of the moving plane

Ctrl+M

Look down the moving plane pitch

Shift+Ctrl+M

Look up the moving plane pitch

P

Select Perspective view

O

Select Orthographic view

Ctrl+Delete

Clear the scene

Ctrl+B

Bookmark the viewing angle and zoom

B

Display the bookmarked viewing angle and zoom
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Key(s)

Action

Ctrl+’

Save the scene

Ctrl+C

Copies the scene to the clipboard. The image can then be pasted into another
application, such as an image editor.

Ctrl+/

Add the slicer to the scene. Press Ctrl+/ to remove the slicer from the scene.

Ctrl+;

Add the moving plane to the scene. Press Ctrl+; to remove the moving plane from the
scene.

The current viewing angle and scale are displayed in the lower right-hand corner of the scene window:

You can change how the viewing angle and scale are displayed in the Overlays tab of the Settings
window.
You can save the current viewing angle as a bookmark by selecting Bookmark Viewing Angle from
the Look menu or by pressing Ctrl+B. Restore the bookmark by selecting Look > Restore Bookmark
or by pressing B.
Only one viewing angle bookmark can be saved. The bookmark is not saved when Leapfrog Works is
shut down.
The scene window displays a 3D representation of selected data from the project tree. You can add
objects from the project tree to the scene in two ways:
l

l

Click on the object and drag it into the scene. Hold down the Shift key or the Ctrl key while clicking
to select multiple items, then add them to the scene.
Right-click on the object and tick the View Object box.

Dragging objects into the scene window may be blocked by other applications on your computer. For
example, if you are sharing a screen using Skype, you will not be able to drag objects into the scene.
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Once you have added objects to the scene window, you can change the appearance of those objects
using the controls in the shape list and the shape properties panel.

This is described further in Visualising Data.
Changing how you view objects in the scene window does not change those objects in the project
tree.
All objects in the shape list have a button ( ) that will remove the object from the scene. Most objects
also have a visibility button ( ) that can temporarily hide that object in the scene. It is often easier to
make an object temporarily invisible than to remove it from the list. Some objects have an edit button (
) that you can click to begin editing the object.

Locating an Object from the Scene
When you have a number of objects displayed in the scene, it may not be readily apparent where you can
find more information about those objects. Leapfrog Works helps you find the object in the project tree
and the shape list in two ways, by Clicking in the Scene and by Clicking in the Shape List.
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Clicking in the Scene
Clicking on an object in the scene displays a window that contains a summary of the data and, for many
objects, a link to the corresponding data in the project tree. For example, here borehole data is displayed
in the scene and clicking on a segment displays the corresponding data:

Note that clicking on an object in the scene also selects it in the shape list.
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Clicking in the Shape List
When you have objects displayed in the shape list and want to locate them in the project tree, simply
right-click on the object in the shape list and select Go to Project Tree:

The object’s location in the project tree will be expanded and the object will be selected.
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Slicing Through the Data
The slicer is a powerful tool for revealing data that is concealed behind other objects and for
emphasising data. Slicing can be considered a form of dynamic sectioning.
Two buttons in the toolbar can be used to add the slicer to the scene:

You can add the slicer to the scene by clicking the Show slicer button ( ). The slicer will appear in the
scene and you can adjust its position using the controls in the shape list:
You can also click the Draw slicer line button ( ), then click and drag in the scene to cut a slice
through the scene.
The scene may appear empty because the slicer has removed all visible data. Reposition the slicer or
turn it off.
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Slicer Properties
You can change the way the slice appears in the scene using the controls in the shape list, and finer
controls are available in the shape properties panel:

Right-click on the slicer in the shape list to view more information about each option:

The Lock to Camera ( ) option locks the slice to the current view so that moving the scene changes
the direction of the slice.
These options can also be controlled from the Look menu:
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The Set location to list in the shape properties panel contains standard views, together with any
sections displayed in the scene:

To move the slicing plane in a direction orthogonal to the slicing plane, hold down the Ctrl key and the
right mouse button while dragging the mouse.
To change the thickness of a thick slice, hold down the Ctrl key and the middle mouse button while
dragging the mouse. If you have a two-button mouse, hold both buttons.
Object Slice Mode
When you draw a slice in the scene, how objects in the scene are displayed in relation to the slicer is
controlled in the properties panel for that object. For example, here the M_Geology table is selected in
order to change how the boreholes are displayed in relation to the slicer:

The From Scene setting is the default; the object is sliced according to the properties set for the slicer.
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By changing the Slice mode for objects in the scene, you can illustrate how a model has been
constructed:

Slicer Shortcuts
Use the following keyboard shortcuts to control the slicer:
Key(s)

Action

Ctrl+/

Add the slicer to the scene. Press Ctrl+/ to remove the slicer from the scene.

L

Look at the slicing plane

Shift+L

Look at the back of the slicing plane

T

Thick slice (

F

Remove front (

)

K

Remove back (

)

Ctrl+V

Orient the slicer to the current view

Ctrl+E

Slice the east (X) axis (

Ctrl+N

Slice the north (Y) axis (

Ctrl+D

Slice the elevation (Z) axis (

)

)
)
)
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Key(s)

Action

Ctrl+L

Lock the slicer to the camera (

)

C

Centre the slicer in the scene (

)

Ctrl+right mouse button

Move the slicer forward and backward in the scene

Ctrl+middle (or left+right) mouse
button

Change the slice width

, (comma)

Step the slicer forward

. (full stop)

Step the slicer backward

Measuring in the Scene
Leapfrog Works has a number of tools for making quantitative measurements in the scene. These
include:
l

l

l
l
l

Clicking on an object in the scene. This will open a window containing more information about the
object.
Viewing an object’s properties to determine its size. Right-click on the object in the project tree and
select Properties. Information on the size of the object will be displayed in the General tab.
Using the cursor to determine an approximate location in the scene. See Determining a Location.
Using the moving plane to measure trends. See The Moving Plane.
Using the ruler to measure in the scene. See The Ruler.
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Determining a Location
The simplest way of measuring an approximate location in the scene is to first display an object in the
scene window, then position the cursor over the location. The position of the cursor is displayed at the
bottom of the Leapfrog Works window:

The position of the cursor in the scene is calculated using the depth buffer on the graphics card and so is
not an exact method of measuring in the scene.
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If you require an exact position, click on the object. Leapfrog Works will compute the exact position of
the point highlighted in the scene and display it in a pop-up window:
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The Moving Plane
In Leapfrog Works, the moving plane is used for measuring planar structures and defining coordinate
system orientations. There are two tools in the toolbar that relate to the moving plane:

To use the moving plane, click the Show plane button ( ) and position the plane in the scene. The
main axis of the moving plane is defined by the green line. The second axis is defined to be in the plane at
right angles (orthogonal) to the main axis. Third axis is perpendicular to the plane.
There are three ways to position the plane. You can:
l

l

l

Use the handles in the scene window to move the plane. If you cannot see the handles, click on the
moving plane.
Use the Plane controls in the shape properties panel to change the Dip, Dip Azimuth, Pitch and
Centre Point.
Orient the scene to look parallel to the required plane position, then click on the Draw plane line
button ( ). Draw the required line in the scene.

Plane movement can be aligned to the Axes or to the Camera:
l
l

With the Axes option, the handles move in cartesian coordinates. .
With the Camera option, the handles move relative to the camera angle.

Drawing the plane line is usually the most convenient method of defining a planar structure.
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To remove the moving plane from the scene:
l

Click the Show plane button ( ).

l

In the shape list, click the delete button ( ) for the moving plane.

Use the following keyboard shortcuts to control the moving plane:
Key(s)

Action

Ctrl+;

Add the moving plane to the scene. Press Ctrl+; to remove the moving plane from the
scene.

M

Look at the moving plane

Shift+M

Look at the back of the moving plane

Ctrl+M

Look down the moving plane pitch

Shift+Ctrl+M

Look up the moving plane pitch

The Ruler
You can use the ruler to measure distances in three dimensional space and between boreholes and
planned boreholes.
The easiest way to use the ruler is to click on the Ruler button ( ) and click and drag between points in
the scene to start making measurements. A ruler line will appear in the scene to indicate the
measurement. Information about the distance measured will appear in the scene and in the shape
properties panel:

The ruler tool stays active in the scene so you can make as many measurements as required.
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You can also measure the distance between boreholes or between boreholes and a point. To do this,
click on the Calculate Distance button in the shape properties panel. The Distance Calculator
window will appear:

You can select both boreholes and planned boreholes. Click Calculate to calculate the distance and
update the ruler in the scene. The distance value will appear in the Distance Calculator window.
You can also select a point in the scene by clicking the Select button ( ) in the Distance Calculator
window, then clicking in the scene. The location of the point in the scene will appear in the Distance
Calculator window.
After measuring a distance, it is a good idea to change the viewing angle to confirm that the
measurement has been made between the correct points in three dimensions.
There are two ways to remove the ruler from the scene:
l

Click the Select button ( ).

l

Click the delete button ( ) for the ruler object in the shape list.

© 2020 Seequent Limited

44 | User Manual

Working With Split Views
The Split View button ( ) in the toolbar allows you to view up to two alternative views of the objects
displayed in the scene:

The alternative views available are a Plan View or a Zoomed Out view:

You can also open an alternative view in a new tab by choosing the New Split View Tab option:

You can resize the scene and the alternative views and Leapfrog Works will remember the position of
each view when you switch to that split view again.
To return to displaying only the scene view, click the Split View button ( ).
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Each alternative view has a toolbar that gives you different options for displaying the view. Use the
Enclose Object list to zoom into or out of the alternative view:

The list displayed includes all objects available in the project, plus the clipping boundary and the current
scene view.
Click the Visibility button to change what objects from the scene view are visible in the alternative view:

An object must be visible in the scene view’s shape list for its visibility to be controllable from the
alternative view’s Edit Visibility list. What this means is that objects hidden in the scene view cannot be
made visible in an alternative view.
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When the slicer is in the main scene view, you can display the contents of the alternative view sliced or
unsliced. Click the View Unsliced button ( ). The slicer, shown in blue in this image, remains
displayed in the alternative views, but the view’s contents are displayed unsliced:

In alternative views, you can display a view window that shows what part of the alternative view is
displayed in the scene view. Click the Enable View Window button ( ):
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Each alternative view has a Settings button ( ) that lets you change what overlays are displayed for
that view. The alternative view can use the scene view settings, or you can customise the display of the
screen grid, axis lines and scale bar:
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Visualising Data
Visualising data is an important part of interpreting and refining data and making modelling decisions.
This topic describes the tools available for changing how data objects are displayed in the scene. It is
divided into:
l
l
l
l
l
l
l

Colour Options
Opacity
Property Buttons
Legends
Slice Mode
Filtering Data Using Queries
Filtering Data Using Values and Categories

Tools for visualising data are accessed via the shape list and the shape properties panel:

The tools available depend on the type of object being displayed.
Changing how you view objects in the scene window does not change those objects in the project
tree.
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The view list is available for objects that can be displayed in different ways. For example, a lithology data
table may contain several columns and the column displayed can be selected from the view list:

Geological and numeric model evaluations are also selected from the view list. See Evaluations.
The shape properties panel adjacent to the shape list provides more detailed control of the appearance
of the selected object:

You can select multiple objects in the shape list and change their display properties using the shape
properties panel. To do this, hold down the Shift or Ctrl key while clicking each object you wish to
change:

Only controls common to the selected objects are available.
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Colour Options
The colour options for an object are changed in the shape list, and the options available depend on the
type of object. Three different colour display options are shown below:

l

l

l

The collar table is displayed using a single colour. Click the colour chip to change the colour. See
Single Colour Display.
The Geology table is displayed according to a colourmap of the categories in the table. These colours
can be changed by clicking on the Edit Colours button, then clicking on each colour chip in the
Legend window. See Category Colourmaps.
The Contaminant table uses a colourmap to display the numeric data. Numeric data coloumaps are
automatically generated based on the data, and manually changing a colourmap can often help in
understanding the data. See Numeric Colourmaps.

If your organisation uses standard colour coding for category and numeric data, you can import
colourmaps for these data types. See Importing and Exporting Colourmaps.

Single Colour Display
Many objects viewed in the scene are displayed using a single colour. To change the colour, add the
object to the scene window, then click on the colour chip in the shape list. A window will appear in which
you can change the colour:
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You can:
l

l

l
l
l

Click and drag the crosshair to pick a colour, then select the darkness or lightness of the colour from
the triangle ( and ).
Click on the Pick Colour button, then click on something elsewhere on the screen to select the
colour of that part of the screen.
Select a colour chip from the palette.
Click on the Random button to set a random colour.
Enter specific values for the colour to use.

Changes made are automatically applied to the scene. The Revert button changes back to the colour
assigned when the window was first opened.
Category Colourmaps
Category data colourmaps can be edited by adding the data column to the scene, then clicking on the
Edit Colours button in the shape list:

To change the colour used for a category, click on its colour chip in the Legend window.
Category colourmaps can also be imported and exported, as described in Importing and Exporting
Colourmaps above.
Numeric Colourmaps
There are two types of colourmap used for displaying numeric data:
l
l

Continuous Colourmaps
Discrete Colourmaps

© 2020 Seequent Limited

52 | User Manual

To edit the colourmap for an object, add the object to the scene. Click on the colourmap in the shape list
and click the pencil ( ).

An Edit Colourmap window will display the colourmap that is currently being used to display the data;
this window will be different for continuous and discrete colourmaps. Any changes you make in the Edit
Colourmap window will be reflected in the scene. To save the currently displayed colourmap, click
Close.
To create a new colourmap, click on a colourmap in the shape list and select New Colourmap. In the
window that appears, select whether you wish to create a continuous colourmap or a discrete
colourmap:

Leapfrog Works contains a number of preset colour gradients that are used in displaying both
continuous and discrete numeric colourmaps. These are:
l
l

l
l
l
l

l

l

l

Rainbow (bgyr). This is a perceptually uniform rainbow.
Rainbow (bgyrm). This is similar to Rainbow (bgyr), but follows red with magenta, which is
common in geophysics software and RQD (geotech).
Viridis. This is a good linear gradient.
Plasma. This is the default colourmap for face dip.
Linear (gow). This gradient is useful for elevation data.
Diverging (bwr). This colourmap can be used when you are interested in data at either end of the
spectrum.
Spectral. With this colourmap, the middle is not white, and white is reserved for bins that have no
data.
Cyclic (mygbm). This is a good colourmap for azimuth data. Northern directions are displayed in
blue and southern in yellow.
Grey (10-95). This grey colourmap works well on white and black backgrounds as it doesn’t start or
end in white or black.

Additional colour gradients can be imported into a project. See Importing Colour Gradients.
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Continuous Colourmaps
A continuous colourmap uses a gradient whose colours are stretched across a range of values. In the Edit
Colourmap window, the Gradient list includes all inbuilt gradients and any that have been imported
into the Colour Gradients folder.

Click the Generate Curve button to change the Curve mode used and the Number of lines on the
histogram:

You can limit the range of values used back in the Edit Colourmap window by disabling Dynamic and
then setting the minimum and maximum values.
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The curve modes all stretch the colourmap so that each line groups the histogram bars by colour. The
available curve modes are:
l
l

l

l

Quantile. The sum of the histogram bars between each pair of lines is equal.
Progressive. The sum of the histogram bars between each pair of lines is progressively smaller,
covering a smaller percentage of values towards the end of the curve.
Progressive Double. This is similar to Progressive, but the effect is emphasised by increasing the
percentage difference between lines.
Logarithmic Intervals. This stretches the colours using a logarithmic transform, which may be
preferred for data with a wide range of values.

Experiment with the different settings and click Apply to see the effects of changes. To edit the curve
points on the histogram, close the Generate Curve window:
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Note that if you use more than 10 lines in generating the curve, you will not be able to edit the curve
points on the histogram:

You can change the Bin Width in the Options menu:

Enable Histogram of the Log to see the value distribution with a log scale X-axis. You can also view a
Cumulative distribution function for the values, with or without a log scale X-axis.
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If the numeric data column for which the colourmap is defined has been produced from other data
sources in the project, you will be able to select whether to display the Local Values or the values from
the Parent Data. For example, for a numeric data column that is part of a merged table, you can display
the values from only the merged table or from the parent table:

If the Dynamic option is enabled, the gradient will be updated when the data is updated, such as when
borehole data is appended. If the option is disabled, the values manually set for the Minimum and
Maximum limits will control the lower and upper bounds of the colourmap. Reducing the range of the
upper and lower bounds is useful if the bulk of the data points have values in a range much smaller than
the overall range of the data. This is common in skewed data.
The Set limits from data button automatically adjusts the Minimum and Maximum Limit values so
that the colourmap would follow the actual data distribution of the input data. The values that lie outside
the Limits are coloured with the last colour at the relevant end of the colourmap.
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Both continuous and discrete colourmaps can be used to display date information. If a date is displayed
using a continuous colourmap, the curve points represent the start and end dates:

When you click Revert, all changes you have made in the window are discarded.
Discrete Colourmaps
With a discrete colourmap, you can define intervals and select which colours are used to display each
interval:
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Click the Generate Intervals button to generate intervals based on various statistical methods:

Select an Interval Mode. The options are:
l

l

l

l
l

l

Quantile. This attempts to create the specified number of intervals so that each interval contains the
same number of values.
Progressive. This attempts to create intervals that enclose progressively smaller percentages of
values. For example, 1000 unique values organised into 5 intervals would have the following
percentiles: ~33%, ~27%, ~20%, ~13%, ~6%.
Progressive Double. This is similar to Progressive, but is “steeper”. For example, 1000 values
organised into 5 intervals would have the following percentiles: ~50%, ~25%, ~12.5%, ~6.25%,
~3%.
Equal Intervals. This creates intervals at equal spacing across the range of the values.
Logarithmic Intervals. This creates intervals at equal spacing, in log-space, across the range of
values.
K Means Clustering. This is an iterative algorithm that sorts values into clusters in which each value
belongs to the cluster with the nearest mean. This option can take some time, especially with large
datasets and a large number of intervals.

Set the Number of Intervals and the Colour Gradient to be used as the basis for the interval
colourings. The first interval is assigned the first colour of the selected Colour Gradient and the last
interval is assigned the gradient’s last colour; selecting Invert Gradient swaps this around.
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You can change the Bin Width in the Options menu:

Enable Histogram of the Log to see the value distribution with a log scale X-axis. You can also view a
Cumulative distribution function for the values, with or without a log scale X-axis.
If the numeric data column for which the colourmap is defined has been produced from other data
sources in the project, you will be able to select whether to display the Local Values or the values from
the Parent Data. For example, for a numeric data column that is part of a merged table, you can display
the values from only the merged table or from the parent table:

The Set limits from data button automatically adjusts the X-Axis Limits so that the colourmap would
follow the actual data distribution of the input data.
Experiment with the different settings and click Apply to see the effects of changes.
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You can also add intervals manually by clicking the Add button. For example, if you create a discrete
colourmap to show the different stages of a drilling campaign, the initial colourmap contains only two
intervals:

Click the Add button to add new intervals and use the Min and Max entries in the table to set the start
and end points of each interval:

When you click Revert, all changes you have made in the window are discarded.
Importing Colour Gradients
Additional colour gradients can be imported into a project in the following formats:
l
l
l
l

Geosoft Colour Files (*.tbl)
ERMapper Lookup Tables (*.lut)
MapInfo Colour Files (*.clr)
Leapfrog Colour Files (*.lfc)

Perceptually uniform colourmaps are available at http://peterkovesi.com/projects/colourmaps/,
where they can be downloaded in ERMapper (*.lut), Geosoft (*.tbl) and Golden Software Surfer
(*.clr) format.
Colourmaps used in earlier versions of Leapfrog Works can be downloaded from
http://downloads.leapfrog3d.com/Colourmaps/older_leapfrog_gradients.zip.
Matplotlib colour gradients can be downloaded from
http://downloads.leapfrog3d.com/Colourmaps/matplotlib_colour_gradients.zip.
Imported colour gradients are stored in the project tree in the Colour Gradients folder. To import a
colour gradient right-click on the Colour Gradients folder and select Import Gradient. In the window
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that appears, navigate to the folder containing the gradient file and click Open. The gradient will be
added to the Colour Gradients folder and you can then select it from the Gradients list when editing a
colourmap:

If you delete a colour gradient from the Colour Gradients folder and it is in use in the project, you
will need to select a replacement gradient for all colourmaps that use that gradient. Select the
replacement colour gradient from those available in the project:
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Importing and Exporting Colourmaps
Colourmaps can easily be shared between projects on a column-by-column basis, which is useful if your
organisation uses standard colourmaps. To import or export a colourmap, expand the data object in the
project tree and right-click on a column. The Import and Export options are available from the Colours
menu:

To export a colourmap, right-click on the data object and select Colours > Export. If more than one
colourmap is associated with the selected object, you will be prompted to choose from those available.
Click Export.
In the window that appears, navigate to the folder where you wish to save the colourmap. Enter a
filename and click Save. The colourmap will be saved in *.lfc format.
When you import a colourmap:
l
l

For category colourmaps, the existing colourmap will be overwritten.
For numeric colourmaps, the imported colourmap will be added to those already defined.

To import a colourmap, right-click on the data object and select Colours > Import. Navigate to the
folder containing the colourmap file and click Open.
If the object has more than one colourmap associated with it, you will be prompted to choose which one
to overwrite.
If the column you expected is not listed, check to see if you have selected the correct file. The
columns displayed are those that correspond to the type of data in the selected file (category or
numeric).
Click Import.
Leapfrog Works will map the information in the file to the information in the selected data column.

Opacity
The opacity slider in the shape list controls the transparency of objects in the scene:
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Property Buttons
The property buttons available in the shape list vary according to the type of object selected. For
example, property buttons can show or hide the triangles on a mesh, render points as spheres or display
a surface clipped to a model boundary. You can always find out what a button does by holding the cursor
over the button:

Legends
You can display a legend for many objects, including lithologies. To do this, click the legend button in the
shape list:

To remove the legend from the scene, either click the legend button again or click the red X in the scene
window:
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To reorder the legend, click the Edit Colours button in the shape list to open the Legend window. Click
on an item in the list, then use the arrows to move it up or down. The legend shown in the scene will be
updated when you close the Legend window.

Slice Mode
When an object is selected in the shape list, a Slice mode property is available in the properties panel.
See Object Slice Mode for more information.

Filtering Data Using Queries
When a data table is selected in the shape list, you can use the controls in the shape properties panel to
apply filters to the data in the scene. If query filters are available for the selected object, they will be listed
in the Query filter list:
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Filtering Data Using Values and Categories
In the shape properties panel, you can also filter the range of values displayed. Tick the Value filter box,
then set the upper and lower limits of the range of data displayed:

If the data includes date information, you can use the Value filter option to restrict the display to a
range of dates.

Working With Data Tables
This topic describes how to work with data tables in Leapfrog Works. It is divided into:
l
l
l
l

Importing Data Tables and Mapping Data Columns
Data Tables in the Project Tree
Viewing Table Data
Adding and Updating Data for Existing Tables

Importing Data Tables and Mapping Data Columns
Importing data tables into Leapfrog Works involves selecting the files to import and then mapping the
data columns in the files to the format Leapfrog Works expects. The data columns Leapfrog Works
expects differs for different data types, and you can find more information about the expected format in
the help for each data type. See:
l
l
l
l
l

Importing Borehole Data
Importing Points Data
Geophysical Data
Importing Planar Structural Data
Importing Lineations
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Once you have selected the file or files to be imported, Leapfrog Works prompts you to map the columns
in the file to the expected format. For example, here we are importing a set of points. File Data shows a
snapshot of the data in the file. The Column Summary shows what columns are in the file and how
Leapfrog Works will map these columns, unless you make changes in this window.

The fields below the Column Summary allow you to change settings such as the character encoding
and date and time formats.
The dark header row shows how each column will be mapped in Leapfrog Works and the row labelled
one is the first row in the file.

For this file, columns X, Y and Z in the file have been mapped in Leapfrog Works to columns East (X),
North (Y) and Elev (Z). These are shown in green.
The AG_gpt and Cu_pct columns are currently marked as Not Imported.
Each type of table being imported will have different column assignments available, but all table types
will display:
l
l
l
l
l

The categories columns can be assigned to (top of the list)
The option to not import the column
The required columns, which in this example are East (X), North (Y) and Elev (Z)
Any optional columns, which in this example is the Hole ID column
The option to select a custom name
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You can see the options available for importing columns by clicking on the column header. Here the AG_
gpt column will be set to be a numeric data column:

Note that both the File Data table and the Column Summary have been updated, with the new
column assignment indicated in yellow:

If you choose not to import a column, you can do so later using the Import Column option, which is
described in Importing Additional Columns to a Data Table below.
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When setting import options for a column you can also work with the Column Summary. Here the Cu_
pct column will be set to be a numeric data column:

If you wish to import all columns, click on the Import All Columns button, then check that all columns
have been correctly mapped.
You can select a column for import, then use it as a Unique Row ID. This can specify the column being
used in other data systems to uniquely identify rows in a table. The column must not contain duplicate
values. If a Unique Row ID is specified, Leapfrog Works will use this column to match rows when
appending columns or reloading tables.
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If the data contains date and time information and the date and time format is not detected, click on
Date and Time Formats to reveal more information:

If the date and time format you wish to use is not among the options, you can create a custom format.
For *.csv files that use characters other than the comma as the separator, you can specify the delimiter,
comment leader, quote and decimal characters in the Import window. Click on CSV characters to
enter the characters used in the data files:
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Data Tables in the Project Tree
Expand a data table in the project to see the columns in the table. Here the WP_points table contains
three numeric data columns ( ) and two category data columns ( ):

To delete a column, right-click on it and select Delete. You will be asked to confirm your choice, as any
objects in that project that have been created from that data column will also be deleted.
To rename a column, right-click on it and select Rename. If you later export the table and wish to use
your new column name in the exported table, make sure you untick the Use original column names
option:

You can evaluate models onto data tables, as described in Evaluations. Evaluated models will appear
under the table as a separate set of objects:
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Viewing Table Data
To view the contents of a data table, double-click on it in the project tree. The Table window will
appear:

To view the contents of the attribute table for a GIS object, right-click on the object and select
Attribute Table.
If the Ignored column is ticked, then Leapfrog Works completely ignores that row, as though it has been
deleted. This is useful for suppressing erroneous data from being processed.
If a row in a collar table is ignored, then all other data associated with that hole (e.g. surveys and
interval measurements in other tables) are also ignored.
Collar tables have a trench column that indicates whether or not the borehole is from a trench. When
the trench column is ticked for a borehole, the trench will be desurveyed in a different manner from
other boreholes. See The Raw Tangent Algorithm for more information.
Cells in a table are editable, apart from the id column, which Leapfrog Works uses as unique identifier.
Double-click in a cell to edit it. If the cell you wish to edit is already selected, press the space bar to start
editing.
When you edit a cell, the change will be indicated in bold text:
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When you save the table, the edited text will no longer be displayed in bold.
The controls in the table toolbar provide quick access to table operations:

Click on Fix Errors to begin correcting errors in the table. See Correcting Data Errors in Leapfrog
Works and Handling Special Values for more information.
Click on Query to open up the query editor:

See the Query Filters topic for more information on how to build and use queries.

Adding and Updating Data for Existing Tables
If you wish to add or update data for an existing data table, you have several options. Which you choose
depends on what new data is available:
l

l

l

If new columns of data are available or if when you imported a table, you did not import all the
columns, use the Import Column option. See Importing Additional Columns to a Data Table below.
If new rows of data are available, use the Append Data option. See Adding New Rows to Existing
Data Tables below.
When the data in the table has been updated outside of Leapfrog Works and you wish to refresh the
data, use the Reload option. Note that the Reload option overwrites existing data. See Reloading
Data Tables below.

Importing Additional Columns to a Data Table
If new columns of data are available or if when you imported a table into Leapfrog Works you did not
import all the available columns, you can add more columns by right-clicking on the existing table and
selecting Import Column. You can choose the file to use as part of this process, so the new columns can
be in the original file or in separate files.
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Importing a column is similar to importing tables themselves. Leapfrog Works will display the data in the
file in the Add Table Column window and you can select how you wish to import any additional
columns. Here, we will import the AG_gpt column as numeric data:

It is not necessary to re-import any columns that are already part of the project.
Click Finish to import the new column.
Adding New Rows to Existing Data Tables
If new data rows are available for a table you have already imported into Leapfrog Works, you can add
the new data by appending it to the existing table.
Append data when you wish to add extra data to existing columns.
l

l

If you wish to add new data columns to the table, use the Import Column option, which is
described in Importing Additional Columns to a Data Table above.
If you wish to refresh the entire table, overwriting all existing data, use the Reload Data option,
which is described in Reloading Data Tables below.

To append new data rows to an existing table, right-click on the table in the project tree and select
Append Data. The Import Data For Appending window will be displayed. Check that the columns
that will be appended have been correctly mapped, then click Finish.
Reloading Data Tables
When data in a table has been updated outside of Leapfrog Works and you wish to refresh the data, use
the Reload Data option.
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Reloading a data table overwrites all existing data. If you have data you wish to add to the project
without overwriting existing data, use the Append Data or Import Column options.
To reload a data table, right-click on it in the project tree and select Reload Data. The Reload Table
window will be displayed. Check that the data has been correctly mapped, then click Finish.

Correcting Data Errors in Leapfrog Works
This topic describes how to correct errors in data tables in Leapfrog Works. It is divided into:
l
l
l
l
l

Identifying Errors in Data Tables
Exporting Data Errors
Viewing and Correcting Errors in Leapfrog Works
Common Errors and How to Fix Them
Handling Special Values

Identifying Errors in Data Tables
Leapfrog Works automatically identifies and flags common data errors when data tables are imported. In
the project tree, there are three ways Leapfrog Works marks tables that contain conflicts or errors:
l

l

l

Tables marked with a red exclamation mark ( ) contain errors that mean data cannot be used for
processing. These errors can be corrected by opening the Errors window, which is described in
Viewing and Correcting Errors in Leapfrog Works below.
Numeric data columns marked with a red exclamation mark ( ) contain non-numeric values, which
means that the rules that are used to handle non-numeric and negative values need to be reviewed. If
a table has data that contain non-numeric and negative values, the affected rows cannot be used for
further processing until the rules are verified, which is described in Handling Special Values below.
Tables marked with a yellow exclamation mark ( ) contain warnings. Affected rows can be used for
further processing, but the information in the warning can indicate that the data requires further
attention. For example, if a warning indicates there is data missing for a borehole defined in the collar
table, it may be that a borehole has been duplicated or that not all required data files have been
loaded. Warnings are listed along with table errors in the Errors window.

Until errors are corrected, the rows that contain those errors are excluded for all processing that uses the
table, including viewing in the scene. For example, if the ID for a collar position contains an invalid
coordinate, that collar will not be displayed in the scene as its location is not known. Likewise, any
processing will ignore data associated with this borehole.
It is worth correcting errors as soon as possible, as correcting them later can result in significant
recomputation time.
When a table contains errors and warnings, only the errors will be apparent in the project tree view.
However, all errors and warnings relevant to a particular table will be displayed in the Database
Errors window.
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There are two approaches to correcting errors in data:
l

l

Correct the data in the primary source. Export the errors as described in Exporting Data Errors
below. Then, when the errors have been corrected, reload the borehole data as described in
Reloading Data Tables.
Correct the data in Leapfrog Works. If you need a record of corrected errors, first export the errors as
described in Exporting Data Errors below. Then correct errors as described in Viewing and
Correcting Errors in Leapfrog Works below.

Exporting Data Errors
If you need a record of corrected errors, first export the errors. This must be done first, as once errors
have been corrected in Leapfrog Works, they cannot be exported, as they no longer exist.
For individual borehole tables, points tables and structural data tables, export the errors by right-clicking
on the table and selecting Export Errors. Choose a location where the file will be saved and click Save.
To export all errors in the borehole data set, right-click on the Boreholes object and select Export >
Export Errors. The Export Borehole Errors window will appear:

The list shows the files that will be created, one for each table that contains errors. Choose a folder
where the files will be saved, then enter a Base file name, which will be added to the front of each file
name.
Click Export to export the error files.

Viewing and Correcting Errors in Leapfrog Works
If you require a record of the errors in data, export the errors as described in Exporting Data Errors
above before starting to correct the errors in Leapfrog Works.
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To correct errors in a data table, right-click on the table and select Fix Errors. The Errors window will
appear. For drilling data, you can display collated errors for the data set as a whole or on a table-by-table
basis. To display collated errors for the whole data set, right-click on the Borehole Data object in the
project tree and select Fix Errors.
Leapfrog Works identifies a range of common errors, and all errors identified are grouped by type. Click
on an error type to expand it and see more information. Here the errors are shown for a survey table.
The Hole ID not in collar table error has been expanded and the error in row 9 is displayed, showing
the value that is causing the error:

You can change the size of the Errors window and the columns in the table to view more information
easily. When you have finished fixing errors, click the Save button ( ). Leapfrog Works will then update
the database.
Errors are automatically grouped by Type, but if there are many errors, you may find it useful to view
them grouped by Table or by the Hole:
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When a row that contains an error is selected, a red box indicates the source of the error. When two
rows of data conflict, both rows will be displayed, which may be useful in determining how to fix the
error:

The Edit button gives you a number of options for correcting data errors:

l
l

l
l

Use Edit Error Cell to edit the incorrect value.
The Write to Selected Rows option opens the Replace All option, which is described below, in
Replacing Values in a Column.
Use Ignore Error Row to mark selected rows to be ignored.
When two rows of data conflict, use Ignore Conflict Row to mark the conflicting row as ignored.
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Replacing Values in a Column
The Replace All button ( ) in the toolbar may be useful in correcting any errors without closing the
Errors window. With the Replace All button, you can replace an incorrect value that occurs multiple
times in a column. To do this, click the Replace All button. Select the Column to search and enter the
new value:

Click Replace All Occurrences to make the changes.
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You can also select a number of rows and replace values in a selected column with a single value. To do
this, use the Shift and Ctrl keys to select the rows you wish to edit, then click the Edit button and select
Write to Selected Rows:

The Replace All Occurrences button will change to a Write to Selected Rows button. In the fields
that appear, enter the New value, then click the Write to Selected Rows button:

Common Errors and How to Fix Them
There are many possible sources of error in the data itself and you may be able to correct the errors
directly in the Errors window. With borehole data, however, the message given in the Errors may
actually point to an error elsewhere in the dataset, in which case you will need to open the other table
from the project tree and edit it directly.
The errors and warnings described are:
l
l
l
l

Duplicate Points Error (Points Tables)
Duplicate Hole ID Error
Hole ID Not in Collar Table Error
Collar Max Depth Error
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l
l
l
l
l
l

Invalid Max Depth Error
From Depth Exceeds To Depth Error
Overlapping Segments Error
No Samples for Collars Warning
No Surveys for Collar Warning
Wedges Found Warning

Duplicate Points Error (Points Tables)
Points tables will have Duplicate Points errors when rows have identical x, y and z values:

Tick Ignored for the rows you wish to ignore. If there are many duplicate points in the table, click the
Ignore Duplicates button ( ). When you save the table, all duplicate rows will be marked as Ignored.
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Duplicate Hole ID Error
Collar tables will have Duplicate Hole ID errors when collars have been assigned the same ID. Here,
rows 4 and 5 have the same ID but are clearly different holes:

Changing the hole ID for one of the boreholes will correct the error. If the collar has been recorded twice
by accident, tick the Ignored box for the duplicate collar.
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Hole ID Not in Collar Table Error
Interval tables will have Hole ID not in collar table errors when the hole ID specified in the interval
table is not found in the collar table.

Affected intervals cannot be displayed. There are two possibilities for fixing this error:
l
l

The collar table uses the wrong hole ID. Edit the collar table to correct the hole ID.
The interval table uses the wrong hole ID. Use the Replace All tool to the incorrect values with the
correct one. See Replacing Values in a Column above.
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Collar Max Depth Error
Interval tables will have Collar max-depth exceeded errors when the depth values in the interval table
exceeds the maxdepth value defined in the collar table. The maxdepth defined in the collar table is
often a theoretical value established before drilling. If the depth value flagged as an error is not
unrealistic, click on the Fix Max Depths button ( ):

This results in the collar table being updated with a maximum depth value that reflects the data in the
interval tables.
Invalid Max Depth Error
Collar tables will have Invalid Max Depth errors when the maxdepth value is negative or non-numeric:

These errors are often the result of data entry mistakes and can be corrected by editing the table in the
Errors window.
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From Depth Exceeds To Depth Error
Interval tables will have From depth > = to depth errors when the from and to values in a row do not
make sense:

These errors are often the result of data entry mistakes and can be corrected by editing the table in the
Errors window.
Until the error is corrected, the affected interval cannot be displayed, although all non-conflicting
intervals will still be displayed for that borehole.
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Overlapping Segments Error
Interval tables will have Overlapping Segments errors when intervals are in the same place for the
same hole or when two holes are in the same place. Here, row 12 overlaps row 13 and the error can be
corrected in the Errors window by entering the correct to value for row 12:

If an interval has been defined twice, click Ignored for one of the rows. Until the error is corrected, the
affected intervals cannot be displayed, although all non-conflicting intervals will still be displayed for that
borehole.
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No Samples for Collars Warning
Interval tables will have No values for Hole ID warnings when there are no values in the interval table
that correspond to a collar defined in the collar table. In this example, a hole called M090 has been
defined in the collar table, but there is no data for it in the M_Assays table.

There are three possibilities:
l

l

l

There are no values in this interval table for that collar. There is no need to do anything to remedy the
warning as it will not affect further processing of the data.
The collar table uses the wrong hole ID. This may be the case if there is also a Hole ID not in collar
table warning listed. Edit the collar table to correct the hole ID.
There are values for that collar in the interval table but they use the wrong collar ID. Again, there may
also be a Hole ID not in collar table warning listed. Edit the interval table and correct the hole ID
for the affected intervals.

No Surveys for Collar Warning
This survey table error is similar to No Samples for Collars Warning above: there are no values in the
survey table that correspond to a collar defined in the collar table. Check that the collar table and the
survey table are using the right hole ID. You will need to edit the survey table or collar table directly before
this warning can be cleared.
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Wedges Found Warning
Wedges found warnings occur in the collar table or in the survey table when boreholes appear to be
duplicates because they are very close together in space.

Leapfrog Works flags boreholes that are less than 1° apart as possible duplicates; if you have two
boreholes that are that close together, you may need to adjust the collar location of one of the boreholes
to clear the warning. You can do this by editing the collar table.

Handling Special Values
Assay data often contains special values to represent different situations, such as grade values that are
below a detection limit, cores that have been lost or segments that were not sampled. In addition, it is
not uncommon for a borehole to contain some intervals that have no values.
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When borehole data tables and points data are imported, Leapfrog Works will mark columns containing
non-numeric special values and missing intervals so that you can review these missing and non-numeric
values and determine how Leapfrog Works will handle them. For example, here numeric data columns
that contain errors are marked with a red X:

To review these errors, double-click on the column. The Errors window will appear with the error
displayed for the selected column:

Leapfrog Works will automatically set missing and non-numeric intervals to be omitted from further
processing. Negative values are automatically set to keep. To change the Action, select another action
from the list:
l
l

Select replace to enter a numeric value to be used for further processing.
Select keep to use a negative value in further processing.

For non-numeric and negative values, all values are initially treated as a single rule. However, if values
have different meanings, you can define specific rules to determine how each value is handled. To do
this, click on the Add Rule button. The window that appears will show the values present in the data. To
define a new rule for a specific value:
l
l

Select that value in the list.
Tick the box for The value I want is not in the list.
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l
l

Enter the Value.
Click OK.

In the Invalid Value Handling window, the value will be listed separately and you can choose the
Action to apply.
Once you have reviewed the rules that will be applied to the column, tick the These rules have been
reviewed box and click OK. The rules will be applied and used in further processing.
When you open a data table, the original values will be displayed. In all further processing of that data,
the assigned special values will be used.

Evaluations
In Leapfrog Works, models can be evaluated onto other objects in the project. To do this, right-click on
an object and select Evaluations:

See Back-Flagging Borehole Data for information on evaluating boreholes on geological models.
See Evaluating on Sections for information on evaluating surfaces on cross sections and fence
sections.
See Evaluating Points Data for information on evaluating surfaces on points.
A window will appear listing all objects in the project that can be used for an evaluation. Once you have
selected one or more objects, click OK.
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The evaluations will be added to the object in the project tree:

When you display objects in the scene, you can select the evaluations from the view list:
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Query Filters
Query filters can be used to select or view a subset of rows in a table. A query filter can be created for any
type of table in a Leapfrog Works project, including borehole data, GIS data, points data and structural
data.
Two different query builders are used in Leapfrog Works, the standard query builder that is used for
most data tables and the points query builder that is used for imported points data tables.
The rest of this topic describes how to build and use query filters in Leapfrog Works. It is divided into:
l
l
l
l

Using a Query Filter in Displaying Data
Using a Query Filter in a Model
The Standard Query Builder
The Points Query Builder

Using a Query Filter in Displaying Data
To apply a query filter to the scene, select the object in the shape list, then select the filter from the
Query filter list in the shape properties panel:
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For a borehole data table, this displays only the data selected by the filter. The trace lines remain
displayed in the scene. To filter out the trace lines so they are not displayed in the scene, tick the
Filter trace lines box:

Using a Query Filter in a Model
When creating or editing a model, you can use a query filter to filter the data used. For example, here you
can use one of the query filters defined for the borehole data to create a new geological model from the
borehole data for a specific drilling campaign:
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Here a structural data table is used to create a form interpolant. The query filters on the structural data
table can be used to filter the data used in the interpolant:
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It is also possible to change the filter used for a model after the model has been created. In a geological
model, for example, you cannot change the data column used for the model, but you can edit the model
and apply a new query filter to the data:

The Standard Query Builder
The standard query builder is used for creating queries for all data tables in Leapfrog Works except for
imported points data tables. For information on building queries for points data tables, see The Points
Query Builder below.
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There are three windows that make up the standard query builder:

In the first window, the New Query Filter window, you can type in a query using the query syntax
described in Leapfrog Works Query Syntax. Press Ctrl-Enter for a new line in longer queries.
The second window, the Build Query window helps you build some common queries by selecting from
the data columns in the table and defining different tests. Open the Build Query window by clicking the
... button in the New Query Filter window. See The Build Query Window for more information on
building queries in this way.
The third window, the Advanced Query window, shows all the data columns and possible operations.
See The Advanced Query Builder for more information.
To create a query filter for a data table, right-click on the table in the project tree and select New Query
Filter. The New Query Filter window will appear and you can choose which way you prefer to build
your query. Assign the filter a name and click OK to save it. It will appear in the project tree under the
table to which it applies:

Query filters defined for collar tables are available to all other borehole data tables.
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Leapfrog Works Query Syntax
The Leapfrog Works query syntax is based on the WHERE clause of the Structured Query Language
(SQL) with some restrictions:
l
l
l
l

Unary operators are not allowed
SQL functions cannot be used
The SELECT statement should not be used (as in 'holeid in (SELECT holeid FROM ...)')
Following statements are also prohibited: CASE, WHEN or MATCH

There is also one main SQL extension:
l

IN and NOT IN will accept a partition group for the value list. E.g. 'zone IN layers.weathered' where
"layers" is a partition of the "zone" column that has a group called 'weathered'.

These are some examples of valid Leapfrog Works query statements:
l
l
l

holeid in ('m-001', 'm-002')
holeid not in ('m-001', 'm-002')
holeid not like 'MAR%'

To enter a query that contains an apostrophe, enter two apostrophes. Adding the second apostrophe
lets the query builder treat this as a mid-phrase apostrophe instead of an end-of-phrase marker, and
results in a valid query.
The Query box allows the following shortcut queries:
l

l

Typing a single word will match all hole-ids starting with that string. For example, typing "MAR" is a
shortcut for "holeid like 'MAR%'"
Typing a comma-separated list of words will match all hole-ids that exactly match the given words.
For example typing "M001, M002" is a shortcut for "holeid in ('M001', 'M002')".

The Build Query Window
Many common queries can be built using the Build Query window:

This window aims to be easy to use rather than comprehensive in its support for the full Leapfrog Works
query syntax.
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To add a criteria, click Column to view a list of columns available in the table. Select a Test and enter a
Value. What can be entered for the Value depends on the type of column and test selected.
Quotes are not required around text values entered in the value column as they are in SQL. Leapfrog
Works will add quotes and brackets to the value "MX, PM" to make a valid SQL list of strings "('MX',
'PM')" when the query is saved.
Click on the Apply button to apply to query to the context in which the dialog was opened.
Use the Delete button to delete the criteria in the selected row and the Add button to add a blank row.
The Advanced Query Builder
The Advanced Query window provides a powerful and flexible query building using the Leapfrog
Works query language.

Enter the query in the Criteria to Match area on the left. The query is displayed as a tree structure with
AND and OR terms as the branch nodes and conditions as the leaves. Use the Delete button to delete a
row from the query and the Add button to add a blank row. The Check button can be used at any time
to check if the current query statement is valid. Below the buttons is a box showing the raw SQL form of
the query.
Except for the arrow buttons, the buttons down the middle of the dialog are used for entering values
into the query. The arrow buttons are used for moving the currently selected criteria to a different
position in the query. The Date, List and Value buttons will open a builder dialog for the column
selected in the current row. If there is no column found or the column is of the wrong type, an error
message is displayed.
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The tree on the right contains all the columns available to the query. Double-click on a column name to
insert it into the query.

The Points Query Builder
Imported points data tables use a different query builder from that used for other data tables.
To create a query filter for a points data table, right-click on the table in the project tree and select New
Query Filter.

You can define filters by three methods:
l
l
l

Construct the query using the Insert options to add columns, operators and other elements
Write the query using query syntax directly in the query editor
Use the query builder
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Insert Query Elements Using Ready Reference
Click the Insert button to expand the window to see an adjacent ready reference. This provides quick
access to all the numeric columns, metadata variables, operators and functions that can be used in
constructing a query.

The Insert list will assist you in constructing a valid query in the same syntax as used for Calculations and
Filters. For full details on each of the Existing items and Syntax and Functions, see Catalogue of
Metadata, Syntax and Functions.
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Select an item from the Insert list and the item will be added to the query at the cursor location.

While the query is being built, it is normal to see errors appear under the partly-constructed query. This is
because the query is incomplete. Once you have completed building your query, if you still see an error
message, the description of the error can help you identify what you need to change in the query to
make it valid.
The if(::) if block option is special in that it allows for multiple rows of conditions to be defined. Once
added, putting the cursor inside the if block will result in the Add Row button ( ) becoming available. If
condition rows have been added, the Delete Row button ( ) will be available whenever the cursor is
inside a condition row.

The Undo and Redo buttons make it easy to revert a change you made to a query, or repeat a change
you have just reverted.
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Assign the filter a name and click OK to save the filter and close the query filter window. It will appear in
the project tree under the table to which it applies. Apply will change the filter in use so the effect may
be seen in the scene without closing the query filter window.
Write a Query in Query Editor
It is not necessary to use the Insert list to add elements to the query under construction. Once you
become familiar with the query syntax you may find it quicker to simply type the query directly into the
query editor window.

For full details on the syntax for this query filter editor, please see Catalogue of Metadata, Syntax and
Functions.
Write a Query Using the Query Builder
Many common queries can be built using the Build Query window:

This window aims to be easy to use rather than comprehensive in its support for the full Leapfrog Works
query syntax.
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To add a criteria, click Column to view a list of columns available in the table. Select a Test and enter a
Value. What can be entered for the Value depends on the type of column and test selected.
Click on the Apply button to apply to query to the context in which the dialog was opened.
Use the Delete button to delete the criteria in the selected row and the Add button to add a blank row.
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Drawing in the Scene
In Leapfrog Works, you can draw polylines to define many surfaces, including lateral extents and contact
surfaces. You can also use polylines to make adjustments to surfaces and create new GIS lines.
This topic describes drawing polylines in Leapfrog Works. It is divided into:
l
l
l
l
l
l
l

The Drawing Toolbar
Drawing Hotkeys
Drawing 3D Lines
Drawing 2D Lines
Polyline Properties
Tangents and Ribbons
Drawing Points

For information on importing and exporting polylines, see Polylines.
When drawing in Leapfrog Works, you can draw on surfaces or on the slicer.
l
l

If you are drawing on surfaces ( ), the line will be in 3D.
If you are drawing on the slicer ( ), the line will be in 2D and locked to the plane it was drawn in. It
can be converted to a 3D line.

When you start drawing a polyline, drawing tools are added to the scene window. If you are drawing a
GIS line or if the slicer was already in the scene, the drawing mode will be set to be on the slicer. Toggle
between the two options using the toolbar buttons:
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When drawing and otherwise working with the polyline, tooltips are displayed in the scene that show
what actions are currently possible:

For example, if the drawing mode is set to on slicer ( ), you will be warned if the slicer is not in the
scene:

You can disable these tooltips once you are more familiar with how the polyline tool works. Open the
Settings window by clicking on the Leapfrog Works menu and selecting Settings. Click on
Overlays and disable the Polyline help text option:

The Drawing Toolbar
The Draw lines ( ) and Draw points ( ) tools are used to create new lines and points. The tools in
the second row are for controlling whether the polyline is drawn (on the slicer ( ) or on surfaces ( )).
The Select list lets you select different parts of the polyline.
The other tools are for working with selected parts of the polyline:
l

Making line segments straight ( ) or curved ( )

l

Adding nodes ( ) to lines
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l

Adding tangents to lines or reorienting selected tangents ( )

l

Flipping selected tangents and disks ( )

l

Add disks to points ( )

l

Converting a 2D polyline to 3D ( )

l

Setting the slicer to a 2D polyline ( )

l

Simplifying the line by reducing the number of nodes ( )

There are also buttons for undoing ( ) and redoing actions ( ), as well as saving the polyline ( ) or
deleting selected parts of it ( ).

Drawing Hotkeys
Use the following keyboard shortcuts while drawing:
Key(s)

Action

Ctrl+5

Draw lines (

Ctrl+6

Draw points/disks (

Ctrl+S

Save (

Ctrl+W

Close editor (

Ctrl+Z

Undo (

)

Ctrl+Y

Redo (

)

Delete

Delete the selected segment, node, tangent or disk (

X

Draw/move on slicer (

Shift+X

Draw/move on objects (

)

Q

Make segments curved (

)

Shift+Q

Make segments straight (

)

Shift-A

Add node (

A

Add/reorient tangent (

V

Flip tangent/disks (

Shift+D

Add/remove disk (

Shift+E

Make selected line 3D (

Shift+W

Set slicer to selected 2D line (

Shift+S

Simplify the line by reducing the number of nodes (

Ctrl+A

Select all

)
)

)
)

)

)

)
)

)
)
)
)
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Key(s)

Action

Shift+Ctrl+Alt+L

Select all lines

Shift+Ctrl+Alt+T

Select all tangents

Shift+Ctrl+Alt+P

Select all points without disks

Shift+Ctrl+Alt+D

Select all points with disks

Drawing 3D Lines
Polylines are made up of nodes, which are added where you click in the scene using the Draw lines ( )
tool. This is a 3D polyline, which is indicated in the scene by the dashed line:

Click to select a node and drag to move it in the scene parallel to the screen. If you hold down the Ctrl
key while moving the node, it will snap onto surfaces in the scene.
When borehole segments are in the scene, the polyline tool will snap to the end of nearby intervals.
When you click to add a node, dragging the mouse before releasing the button lets you control the
curvature:
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When you start drawing a polyline, a tangent is automatically added to the first node. This is oriented in
the direction of the camera, and you will need to rotate the scene to see that it is a cone.

You can hide the tangent cones in the scene, if it makes drawing difficult. To do this, click on the
polyline in the shape list and disable the Show tangent cones option:

There are also bezier control points on curved segments. These are used to control the curvature of the
segment, and you can click on a control point and drag it to change the curve of the segment:

If you can’t see the bezier control points, click on the polyline in the shape list and enable the Show
bezier control points option:
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When you have finished drawing, right-click to end the polyline. Switch to the Select tool ( ) to make
changes to the polyline.

l

Click on a node to move it.
Click on a segment away from a node and drag it to change its curvature.

l

Click on one or more segments, then make them straight ( ) or curved ( ).

l

Select a point on the polyline, then click ( ) to add a node.

l

l

Select a point on the polyline. The point selected is indicated in the scene by a red cone. You can then
click ( ) to add a tangent oriented in the direction of the camera.

l

Select a tangent and click ( ) to change the orientation of the segment to that of the camera.

l

Select a tangent and click ( ) to flip it.

Begin drawing again by selecting the Draw lines button ( ). To continue from an existing node at the
start or end of a polyline, click on the node.
Use as many nodes as necessary to draw the polyline. You can later reduce the number of nodes using
the Simplify polyline tool ( ). Each time this tool is used, Leapfrog Works attempts to halve the
number of nodes on the select segments:

Although you can make the line curved while adding nodes, an easy way to draw a curved polyline is to
simply click to add a series of points. Set the curvature of the whole line by selecting all segments and
then clicking the Make selected segments curved button ( ):
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You can then make any adjustments to the curves required by dragging the segments or using the bezier
control points.

Drawing 2D Lines
Working with a 2D polyline is similar to working with a 3D polyline, except that drawing is restricted to
the 2D plane set by the slicer. A 2D polyline is indicated in the scene by an unbroken line:

To convert a 2D polyline into a 3D polyline, click the 3D polyline button ( ).

Polyline Properties
In the shape list, you can control the colour of the positive (red) and negative (blue) surfaces of the line
and of the line itself (green):

For contact surfaces, the colour of the positive and negative sides of a ribbon will be determined by
the lithologies or categories assigned to either side of the surface.
With the controls in the properties panel, you can change the size of different parts of the polyline to
make working with the polyline easier.

For Ribbon width and Point size, the setting is, by default, in pixels, but both can be displayed in realworld size, which may make editing the polyline easier in some circumstances.
You can also choose whether or not to show tangent cones and bezier control points.
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Tangents and Ribbons
The Surface ribbon ( ) and Normal ribbon ( ) help you to determine the orientation of the
polyline in the scene. The surface ribbon reflects the orientation of the polyline and the normal ribbon is
perpendicular to the surface ribbon.
For example, click on the Surface ribbon button ( ) to determine which side of the polyline is positive
(red) and which side is negative (blue):

If you are having trouble seeing the ribbons, you can change their size using the Ribbon width control
in the properties panel.
When you first draw a polyline, it has only one tangent, located at the first node and oriented in the
direction of the camera. You can add more nodes by clicking at a point along the polyline and then
clicking the Tangent button ( ). A tangent is added to the polyline, which is updated to reflect the new
information. The tangent’s orientation is taken from the camera angle. To reorient a tangent, click on it
in the scene, change the camera angle to reflect the orientation you wish to set, then click the Tangent
button ( ).
You can also flip selected tangents by clicking on the Flip tangents and disks button ( ).
You can add as many tangents as required, although it is best to keep them to a minimum.
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Drawing Points
Polylines can also include points, which are drawn using the Draw points tool ( ). Clicking adds a
point, and clicking and dragging adds a point with a normal:

Normals are shown in the scene as disks intersecting the points.
The scene below shows one point with a normal and one without:

To move a point without a normal, switch to the Select tool ( ). Click on the point and drag it. To add
a normal to the point, click on it in the scene and click the Add disk button ( ).
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To edit the orientation of a point with a normal, click on it in the scene. There are two rotation modes. In
the first, the handles adjust the dip and azimuth of the disk:

Click on the disk to change the rotation mode.
In the second rotation mode, dragging the disk rotates it in the plane indicated by the handles:

Change the angle of the plane by moving the mouse cursor over the disk.
You can also change the orientation of a disk by drawing over it. To do this, make sure the Draw points
tool ( ) is selected. Hold the cursor over the point you want to edit. The cursor will turn green to
indicate that you can adjust the disk’s angle:
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Drag to adjust the angle and release the mouse button when finished:

You can also flip selected disks by clicking on the Flip tangents and disks button ( ).

© 2020 Seequent Limited

114 | User Manual

Organising Your Workspace
You can split the Leapfrog Works main window into separate parts to make better use of your screen
space. In addition, some Leapfrog Works windows open in separate tabs that can be used either docked
or detached. This topic describes how to change the main window to make the best use of your screen
space. It is divided into:
l
l
l

Detaching Tabs
Detaching and Minimising the Project Tree
Organising the Scene View Tab

Detaching Tabs
To detach a tab, either:
l
l

Click on it and drag it away from the main window.
Right-click on it and select Move to New Window.

You can then move and resize the detached tab.
To dock a detached tab, click on it and drag it to where you want to dock it:

When the move handle ( ) appears, release the mouse and the tab will dock.
Tabs can be docked to the main window or to other tabs. Drag tabs to reorder them.
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You can view a list of all open tabs by clicking the List open tabs button, which is the down arrow to
the right of the processing queue button:

When you close a project, the position of open tabs will be saved and restored when the project is next
opened.
For Leapfrog Works windows that open in separate tabs, the position in which tabs open is
determined by the New tab position setting in the Settings window:
l
l
l

Open all tabs in the main window.
Open all tabs in separate windows.
Tabs can open where the last tab was moved to. This setting can be used for creating a window in
which all tables and dockable windows open, with the scene window, project tree and shape list in
another window.

To change this setting, click on the Leapfrog Works menu, select Settings and then click on the
User Interface tab.

Detaching and Minimising the Project Tree
The project tree can also be detached from the main window. To do this, either:
l

Right-click at the top of the project tree and select Detach:

l

Click on the List open tabs button and select Detach project tree:
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To reattach the project tree, click the X to close the tab. It will reappear docked to the main window. You
can also click on the List open tabs button and select Attach project tree.
You can also hide the project tree. To do this, right-click on it and choose Hide project tree or press
the F8 key. Restore the project tree by:
l
l

Clicking on the List open tabs button and selecting Show project tree.
Pressing the F8 key once again.

Organising the Scene View Tab
The Scene View tab is made up of the scene window, the shape list and the shape properties panel.
The shape list and shape properties panel can be displayed on the right-hand side of the scene rather
than below the scene. To do this, right-click in the shape list and select Move List to Right:

You can also detach the shape list and display it as a tab, which can then be detached from the main
window. To do this, right-click in the shape list and select Put List in Separate Tab:
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You can then detach the tab from the main window:

To dock the shape list to the Scene View tab, right-click in the Shape List tab and choose where you
wish to dock the list:

Concepts
This section of the help describes important concepts you can refer to as you start working with
Leapfrog Works. You don’t need a complete understanding of these topics in order to start working with
Leapfrog Works, but you can come back to these topics as you start working with different features.
The topics in this section complement the topics in An Overview of Leapfrog Works.
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What is Implicit Modelling?
Implicit modelling is a game-changing innovation in geological modelling.
Traditionally, geological models are produced using a manual drawing process. Sections are defined, and
lithologies, faults and veins are drawn on the sections. Lines are then drawn to connect surfaces across
multiple sections. Modelling geology in this manner is time-consuming and inflexible as it is difficult to
update the model when more data becomes available. Early assumptions that later are proved incorrect
could shape a model in a way that is never corrected because of the effort involved in starting over.
Instead of using their knowledge to reveal important information about the study site, geologists spend
significant proportions of their time engaged in mechanical drawing.
Implicit modelling, on the other hand, allows geologists to spend more time thinking about the geology.
Implicit modelling eliminates the laborious legwork by using mathematical tools to derive the model from
the data. A mathematical construct is built that can be used to visualise different aspects of the data in
3D. Leapfrog Works uses FastRBF™, a mathematical algorithm developed from radial basis functions.
FastRBF uses the data and parameters supplied by the geologist to derive any one of a number of
variables to be modelled. Discrete variables such as lithologies can be used to construct surfaces, as well
as continuous variables such as ore grades.
Instead of presenting a model constructed from rigid geometric constructs, the visualisations echo the
natural forms found in reality.

What are the Advantages of Implicit Modelling?
Implicit models are easy to keep up-to-date with the latest data. New borehole data can quickly be
integrated, instead of taking weeks or longer manually modifying the model.
Implicit modelling allows several alternative hypothetical models to be produced from the data, quickly
and easily. New data that affects the model, even in very significant or fundamental ways, can be
assimilated and integrated with little effort. Models can be built rapidly, which means that a range of
geological interpretations can be continually tested.
Because less effort is involved in creating a model, more time is available to spend on understanding the
geology and studying more complex details such as faulting, stratigraphic sequences, trends and veins.
The model can be developed to reflect reality to a greater degree of precision than was previously
possible.
Geological risk is reduced when modelling is done implicitly. With traditional modelling, the effort
involved means that the first model developed may be held to as the ground truth, despite mounting
evidence that may discredit it. Instead, implicit modelling supports an approach that follows the proven
scientific method, developing hypothetical models, experimenting to find new data to corroborate or
discredit models and, ultimately, allowing the best model to be revealed. A geologist can experiment
with alternative parameters at the limits of what is geologically reasonable to determine if there is any
significant variation in the resulting models, which can then bracket the model with conceptual error
bars. Geostatistical analysis can be conducted to identify what models are the most valid.
It is easy to change your mind when modelling implicitly. Perhaps models have been produced
demonstrating isometric shells enclosing specific grades of ore. Commodity price changes then make it
desirable to recreate the model using alternative ore grade values. If the model had been produced
manually, doing so would not be practical. But with implicit modelling, the ease of generating a new
model with new interpolation parameters means this valuable business information can be readily
produced.
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New questions can be answered more easily. A model tends to answer one question or class of questions
well, and new questions require new models. If a model takes months to produce, those new questions
may remain forever unanswered. If it can be produced with only days or hours worth of effort, valuable
insights can be gained that could provide critical business value.

Implicit Modelling Makes Assumptions Explicit
Often, there is insufficient information in the data alone. For instance, borehole data may well need to be
supplemented with known details about the geology. When a geologist is constructing a model using
traditional techniques, they use their knowledge of the geology to make decisions about the model as it
is constructed. This is something the geologist will do automatically, which irretrievably conflates
measured data with hypothesised data, hiding away subjective assumptions that have influenced the
development of the model.
Implicit modelling, however, keeps the measured data separate from interpretations. The geologist can
use polylines and structural disks to interpret the data without equating them to measured data. Implicit
modelling makes assumptions explicit; there is a clear separation between hard data and user-introduced
interpretations.
Implicit modelling and the presentation of a selection of models communicating different aspects of the
geology provide new tools a geologist can use to communicate with professionals in other parts of the
business.
On a purely business level, specialist staff can be putting their skills to use in productive, valuable
geological modelling, rather than drawing lines on sections ad infinitum.
Implicit models are more repeatable and, therefore, more auditable, because they are derived from actual
data and explicitly communicated geological interpretations, with selected parametric variables as inputs
and processed using a mathematical algorithm.
The only thing implied in implicit modelling is the unknown value between two known values. Everything
else is explicit. For this reason, it is best to refer to traditional modelling techniques as ‘traditional
modelling’ rather than ‘explicit modelling’, assuming that it should be labelled with a name that is the
inverse of ‘implicit modelling’. Implicit modelling is much more explicit than traditional modelling.

Best Practices
l

l

l

l

l
l

Analyse data. Analyse your data using borehole interpretation and data visualisation tools. Use 3D
visualisation to look for errors in the data set.
Stay focussed. Produce a model that answers a specific question or addresses a specific problem.
Don’t unnecessarily model all the data available just because it is there. When a new question is asked,
produce a model that answers that question using the necessary data.
Experiment and explore. Produce variations of the same model, or even models, using quite different
fundamental assumptions. Plan boreholes that will help reveal what model fits best and then discard
models that are inconsistent with new data.
Understand risk. Model using a range of input parameters and assumptions to understand the level of
geologic risk.
Share. Discuss and explore alternatives.
Adapt. Previously, the effort of production and review of traditional models meant that there is
reluctance to rebuild a model when new data becomes available soon after model completion.
However, with implicit modelling, you should integrate new data and refine the model as soon as the
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l

new data is available. The revised model could indicate that planned activities should be redirected as
expensive resources would be wasted persisting with the original plan, for little return.
Evaluate and review. Don’t assume that because it’s easy to generate a model that you have quickly
produced the right model. Understanding the geology is vital for validating the model and producing
something that is geologically reasonable.
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Interpolant Functions
Leapfrog Works’s powerful 3D interpolation engine can interpolate any numeric data (e.g. ore grade or
piezometric head measurements) to describe how a real, numerical quantity varies in three dimensional
space. Interpolation produces an estimate or “interpolated value” of a quantity that is not known at a
point of interest but is known at other points.

The simplest way to estimate values is to take the average of known values. Using this method,
estimated values are the same everywhere, regardless of the distance from known data. However, this is
not ideal as it is reasonable to assume that an estimated value will be more heavily influenced by nearby
known values than by those that are further away. The estimates for unknown points when varying the
distance from known point values is controlled by the interpolant function. Any interpolation function
and the various parameters that can be set for each will produce a model that fits all the known values,
but they will produce different estimates for the unknown points. It is important to select interpolation
functions and parameters that make geologic sense. It may be necessary to identify a location that
models predict differently, and plan boreholes to identify the best fit option.
Leapfrog Works uses two main interpolant functions:
l
l

The Spheroidal Interpolant Function
The Linear Interpolant Function

The Spheroidal Interpolant Function
In common cases, including when modelling most metallic ores, there is a finite range beyond which the
influence of the data should fall to zero. The spheriodal interpolant function can be used when modelling
in these cases.
The spheroidal interpolant function closely resembles a spherical variogram, which has a fixed range
beyond which the value is the constant sill. Similarly, the spheroidal interpolant function flattens out
when the distance from X is greater than a defined distance, the range. At the range, the function value
is 96% of the sill with no nugget, and beyond the range the function asymptotically approaches the sill.
The chart below labels the y-axis interpolant. A high value on this axis represents a greater uncertainty
relating to the known value, given its distance from X. Another way to think of this is that higher values
on this axis represent a decreasing weight given to the known value.
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Known values within the range are weighted proportionally to the distance from X. Known values further
from X than the range will all be given approximately the same weight, and have about the same
influence on the unknown value. Here, points A and B are near X and so have the greatest influence on
the estimated value of point X. Points C and D, however, are outside the range, which puts them on the
flat part of the spheroidal interpolant curve; they have roughly the same influence on the value of X, and
both have significantly less influence than A or B:

The parameters used to define a spheroidal interpolant are Total Sill, Nugget, Nugget to Total Sill Ratio,
Base Range, Alpha, Drift and Accuracy.
To edit the parameters for an interpolant, double-click on the interpolant in the project tree and click on
the Interpolant tab. The graph on the tab shows how the interpolant function values vary with distance
and is updated as you change interpolant parameters:

The yellow line indicates the Base Range. For this interpolant, the value of the interpolant is offset by
the value of Nugget.
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Total Sill
The Total Sill defines the upper limit of the spheroidal interpolant function, where there ceases to be
any correlation between values. A spherical variogram reaches the sill at the range and stays there for
increasing distances beyond the range. A spheroidal interpolant approaches the sill near the range, and
approaches it asymptotically for increasing distances beyond the range. The distinction is insignificant.
Nugget
The Nugget represents a local anomaly in sampled values, one that is substantially different from what
would be predicted at that point, based on the surrounding data. Increasing the value of Nugget
effectively places more emphasis on the average values of surrounding samples and less on the actual
data point, and can be used to reduce noise caused by inaccurately measured samples.
Nugget to Total Sill Ratio
It is the Nugget to Total Sill ratio that determines the shape of the interpolant function. Multiplying
both these parameters by the same constant will result in an identical interpolant. Here, the interpolant
on the left has a nugget of 3 and a sill of 25; the one on the right has a nugget of 6 and a sill of 50. Note
that because the nugget and sill have been increased by the same factor, the function has the same
shape.
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Base Range
The Base Range is the distance at which the interpolant value is 96% of the Total Sill, with no
Nugget. The Base Range should be set to a distance that is not significantly less or greater than the
distance between boreholes, so it can reach between them. As a rule of thumb, it may be set to
approximately twice the average distance between boreholes.
Here the effect of different range settings on the value of X is demonstrated using our trivial example of
four boreholes:
Range = 1

Range = 4

Range = 8
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Range = 30

When the range is set to 1, it is too small to describe any real effect between boreholes. When the range
is set to 30, distant boreholes have more influence, increasing the spatial continuity. Also illustrated is the
range set to approximately the average distance between boreholes (range = 4) and the range set to
about twice the average distance between boreholes (range = 8). Of these, the range set to 8 might be
the best choice.

© 2020 Seequent Limited

126 | User Manual

Alpha
The Alpha constant determines how steeply the interpolant rises toward the Total Sill. A low Alpha
value will produce an interpolant function that rises more steeply than a high Alpha value. A high Alpha
value gives points at intermediate distances more weighting, compared to lower Alpha values. This
figure charts an interpolant function for each alpha setting, using a nugget of 8, sill of 28, and range of
5000. A spherical variogram function is included for comparative purposes. The inset provides a detailed
view near the intersection of the sill and range.

An alpha of 9 provides the curve that is closest in shape to a spherical variogram. In ideal situations, it
would probably be the first choice; however, high alpha values require more computation and processing
time, as more complex approximation calculations are required. A smaller value for alpha will result in
shorter times to evaluate the interpolant.
The following demonstrates the difference between alpha = 3 and alpha = 9:
Alpha = 3

Alpha = 9
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There is a measurable difference between the estimates at the point being examined, but for many
purposes, using a lower alpha will result in satisfactory estimates and reduced processing time.
Drift
The Drift is a model of the value distribution away from data. It determines the behaviour a long way
from sampled data.
l
l
l

Constant: The interpolant goes to the approximated declustered mean of the data.
Linear: The interpolant behaves linearly away from data, which may result in negative values.
None: The interpolant pulls down to zero away from data.

Here, the three Drift options for the interpolant are shown evaluated on grids:
Drift = Constant

Drift = Linear
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Drift = None

In this example, the boundary is larger than the extent of the data to illustrate the effect of different
Drift settings.
Away from the data, the value of the interpolant when Drift is Constant and Linear is not reasonable in
this case, given the distance from the data. The low value when Drift is None is more realistic, given the
distance from the data.
If when using the spheroidal interpolant you get a grade shell that fills the model extents, it is likely that
the mean value of the data is higher than the threshold chosen for the grade shell in question. If this
occurs, try setting the Drift to None.
Accuracy
Leapfrog Works estimates the Accuracy from the data values by taking a fraction of the smallest
difference between measured data values. Although there is the temptation to set the Accuracy as low
as possible, there is little point to specifying an Accuracy significantly smaller than the errors in the
measured data. For example, if values are specified to two decimal places, setting the Accuracy to 0.001
is more than adequate. Smaller values will cause the interpolation to run more slowly and will degrade the
interpolation result. For example, when recording to two decimals, the range 0.035 to 0.044 will be
recorded as 0.04. There is little point in setting the accuracy to plus or minus 0.000001 when intrinsically
values are only accurate to plus or minus 0.005.

The Linear Interpolant Function
Generally, estimates produced using the linear interpolant will strongly reflect values at nearby points
and the linear interpolant is a useful general-purpose interpolant for sparsely and/or irregularly sampled
data. It works well for lithology data, but is not appropriate for values with a distinct finite range of
influence.
The linear interpolant function is multi-scale, and, therefore, is a good general purpose model. It works
well for lithology data, which often has localised pockets of high-resolution data. It can be used to
quickly visualise data trends and whether or not compositing or transforming values will be required. It is
not appropriate for values with a distinct finite range of influence as it aggressively extrapolates out from
the data. Most ore grade data is not well interpolated using a linear interpolant function.
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The linear interpolant function simply assumes that known values closer to the point you wish to
estimate have a proportionally greater influence than points that are further away:

In the above diagram, points A and B will have the most effect on point X as they are closer to X than
points C and D. Using the linear interpolant function in Leapfrog Works gives a value of 7.85, which is
between the nearby high grade values of A (10) and B (7). Because of their distance from X, the low
grade values at C and D have a much weaker effect on the estimate of point X, and they have not
dragged the estimate for X lower.
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The parameters used to define a linear interpolant are Total Sill and Base Range, Nugget, Drift and
Accuracy.
To edit the parameters for an interpolant, double-click on the interpolant in the project tree and click on
the Interpolant tab. The graph on the tab shows how the interpolant function values vary with distance
and is updated as you change interpolant parameters:

The yellow line indicates the Base Range. For this interpolant, the value of the interpolant is offset by
the value of Nugget.
Total Sill and Base Range
A linear interpolant has no sill or range in the traditional sense. Instead, the Total Sill and Base Range
set the slope of the interpolant. The Base Range is the distance at which the interpolant value is the
Total Sill. The two parameters sill and range are used instead of a single gradient parameter to permit
switching between linear and spheroidal interpolant functions without also manipulating these settings.
Nugget
The Nugget represents a local anomaly in values, one that is substantially different from what would be
predicted at that point based on the surrounding data. Increasing the value of Nugget effectively places
more emphasis on the average values of surrounding samples and less on the actual data point, and can
be used to reduce noise caused by inaccurately measured samples.
Drift
The Drift is a model of the value distribution away from data. It determines the behaviour a long way
from sampled data.
l
l

Constant: The interpolant goes to the approximated declustered mean of the data.
Linear: The interpolant behaves linearly away from data, which may result in negative values.
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Here, the two Drift options for the interpolant are shown evaluated on grids:
Drift = Constant

Drift = Linear

In this example, the boundary is larger than the extent of the data to illustrate the effect of different
Drift settings.
Accuracy
Leapfrog Works estimates the Accuracy from the data values by taking a fraction of the smallest
difference between measured data values. Although there is the temptation to set the Accuracy as low
as possible, there is little point to specifying an Accuracy significantly smaller than the errors in the
measured data. For example, if values are specified to two decimal places, setting the Accuracy to 0.001
is more than adequate. Smaller values will cause the interpolation to run more slowly and will degrade the
interpolation result. For example, when recording to two decimals, the range 0.035 to 0.044 will be
recorded as 0.04. There is little point in asking Leapfrog Works to match a value to plus or minus
0.000001 when intrinsically that value is only accurate to plus or minus 0.005.

Surface Resolution in Leapfrog Works
In Leapfrog Works, meshes are used to represent surfaces in the form of vertices and triangles that
define the 3D shape of the surface. The resolution of a surface is controlled by the size of the triangles
used to create a surface. A lower surface resolution value means smaller triangles and, therefore, a finer
resolution. A higher surface resolution value will take less time to process but the surface may not show
the level of detail required.
When a surface is imported, Leapfrog Works automatically sets a surface resolution based on the
information in the file. It is not possible to change the resolution of surfaces imported into Leapfrog
Works. The exception is elevation grids (see Importing an Elevation Grid).
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When surfaces are created, Leapfrog Works sets a default resolution based on the data available. You can
set a lower value, but calculations will take longer. In addition, the resolution for many surfaces can be
adaptive; that is, areas closer to data will have a finer resolution than areas further away from data.
To see the effect of different resolution settings, consider a simple geological model of three rock types.
Here, the surface resolution is set to 50 and the adaptive isosurfacer is disabled:

Here, the resolution has been reduced, which results in smaller triangles:
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For both resolution settings above, the triangles are the same size everywhere in each surface, even
where real data is available. Once the adaptive isosurfacer has been enabled, the triangles closer to the
boreholes are smaller than those further away:

Areas of the surface that have large triangles indicate that there is less data in those areas to guide the
interpolation of the surface.
In Leapfrog Works, the resolution for different types of surfaces can be controlled as follows:
l

l

l

l

For geological models, a resolution can be set for the model as a whole, but individual surfaces can
have different settings. See Surface Resolution for a Geological Model.
For interpolants, the resolution of the output isosurfaces is controlled by a single setting that can be
overridden for individual surfaces. See Output Settings for an RBF Interpolant.
The resolution can be changed for editable interpolated meshes ( ) and can be adaptive. See
Interpolated Meshes.
When the topography has been defined using multiple data sources, the resolution can be set and the
adaptive option is available. See Changing Topography Settings.

Modifying Surfaces
This topic describes aspects of modifying surfaces in Leapfrog Works. It is divided into:
l
l
l
l
l
l

Adding Data to Surfaces
Honouring Surface Contacts
Editing Surfaces With Polylines
Editing Surfaces With Structural Data
Modifying Surfaces With Anisotropic Trends
Applying a Structural Trend

Trends can also be applied to reshape surfaces. For more information on the concept of trends, see
Trends and Anisotropy.
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Adding Data to Surfaces
Many surfaces can be refined by adding points, structural data, GIS data and polylines. If a surface can be
modified in this way, an Add menu will appear for the object when you right-click on it in the project
tree. For example, the Add menu for this contact surface shows the data types that can be used to refine
the surface:

Select the type of data you wish to use to modify the surface. Leapfrog Works will display all the suitable
objects in the project. Select the required object and click OK. A hyperlink to the added data will appear
under the surface in the project tree. The added data can be removed from the surface by expanding the
surface in the project tree, then right-clicking on the hyperlinked data object and selecting Remove.

Honouring Surface Contacts
In Leapfrog Works, surfaces can be created from borehole data, points data, structural data, GIS data
and polylines. When surfaces are created from several different objects, it may be desirable to snap the
surface to some data objects but not to others.
There are several options for snapping surfaces to data:
l
l

l

l

Off. The surface does not snap to the data used to create it.
All data. The surface snaps to data within the Maximum snap distance, which includes borehole
data and any data added to the surface.
Drilling only. The surface snaps to borehole data and data objects derived from borehole data
within the Maximum snap distance but not to other data used to modify the surface. For example,
the surface will honour points data derived from borehole data, but not points data imported into the
Points folder.
Custom. The surface snaps to selected data objects within the Maximum snap distance.

© 2020 Seequent Limited

Honouring Surface Contacts | 135

Snapping forces surfaces to honour the specified contacts, moving triangles on the surface so that
the surface precisely intersects the contact. For example, snapping is disabled for the surface on the
left, but enabled for the surface on the right. The points used to generate the surface are shown in
red, and the triangles are displayed so you can see how snapping to data affects the surface:

When snapping is enabled, the Maximum snap distance is used to determine what data should
affect the surface. The Maximum snap distance is, by default, set to half of the Surface
resolution setting, but you can adjust that up or down, if required.
In this image, three surfaces are shown, along with the points used to generate the surface (red). The
grey surface is the surface that results when snapping is Off. For the yellow surface, snapping to the
points is enabled and the Maximum snap distance has been set to a high value, resulting in the
yellow surface snapping to the distant point indicated by the arrow. Snapping to points is also
enabled for the blue surface, but the Maximum snap distance has been set to a lower value, so that
the surface snaps to some close points, but does not snap to the distant point.

While the most suitable snapping option is always project- and purpose-specific, if you have sufficient
drilling data, snapping to Drilling only is recommended. This option gives the highest priority to the
input data itself while still allowing the surface to be influenced by manual interpretations. Contrary to
the All data snapping option, the Drilling only option also reduces the potential for complications
resulting from contradictory data (e.g. the drilling data indicates a surface contact is in one place, but
a polyline indicates it’s somewhere else).
Take care in enabling snapping and in selecting what data the surface will snap to, as the more data
you include, e.g. by setting a large Maximum snap distance or selecting All data for Snap to
data, the greater the possibility that errors in the data or assumptions inherent in interpretations
(e.g. polylines) will cause distortions in the meshes. If you do enable snapping, it is best to snap only
to drilling data.
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For example, here the Snap to data has been set to Drilling only for a mesh created from multiple
data objects:

Note that the only objects Snap is enabled for are the contacts derived from borehole data.
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Here, Snap to data has been set to Custom, which makes it possible to enable Snap for only the
selected data objects:

In Leapfrog Works, the snap settings for different types of surfaces can be controlled as follows:
l

For geological models, Snap to data can be set for the model as a whole, but individual surfaces can
have different settings. For more information, see:
o
o
o
o
o
o

l

Editing a Geological Model
Surfacing Options for Deposits and Erosions
Surfacing Options for Intrusions
Surfacing Options for Veins
Surfacing Options for Faults
Changing Fault Inputs

For editable interpolated meshes and offset meshes ( ), Snap to data can be set by doubleclicking on the mesh and changing the settings in the General tab. See Refining an Interpolated
Mesh and Offset Meshes for more information.

© 2020 Seequent Limited

138 | User Manual

Editing Surfaces With Polylines
In Leapfrog Works, many surfaces can be edited using polylines, including contact surfaces, geological
model extents and editable meshes.
To edit a surface with a polyline, it is a good idea to first add the object you wish to edit to the scene and
draw a slice across the scene where you plan to edit the surface. Next, right-click on the surface in the
project tree and select Edit > With Polyline.
The drawing toolbar will appear for the type of polyline selected and a new polyline will be added to the
scene. Draw the polyline and adjust it as described in Drawing in the Scene, then click the Save button (
) to view the effect of the polyline on the surface. To remove the polyline from the surface, expand the
surface in the project tree. Right-click on the polyline object and select Remove.
In cases where you have existing polyline edits (control points), you can import them and add them
to the surface. To do this, import the polylines to the Polylines folder, then add them to the surface
by right-clicking on the surface and selecting Add > Polyline.
How a polyline can be used to edit a surface can be illustrated by the following surface, where a small
volume is disconnected from the main surface:

First, a slice is drawn through the surface where it will be edited:
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Next, a polyline is created, using two lines to represent contacts that link up the surfaces:

When the polyline edits are saved, the surface is updated to reflect the edits:

It is best to keep polyline edits to a minimum, as small edits can have significant effects on the shapes of
surfaces.
If editing a surface with a polyline results in a distorted surface, use the surface and normal ribbons to
check the orientation of the polyline and its segments. See Tangents and Ribbons for more
information.
When you save the polyline, the object will be updated to reflect the additional points. The polyline will
be added to the project tree as part of the object that was edited. You can edit the polyline by doubleclicking on it or by right-clicking and selecting Edit Polyline.

Editing Surfaces With Structural Data
In Leapfrog Works, many surfaces can be edited using planar structural data points drawn in the scene.
Surfaces that can be edited in this way include contact surfaces, model extents and interpolated editable
meshes. There are two ways to do this:
l

l

If you have a structural data table created in or imported into Leapfrog Works that you want to use to
adjust the surface, right-click on the surface in the project tree and select Add > Structural Data.
You will be prompted to select from the structural data tables available in the project.
If you want to create structural data points to use to adjust the surface, right-click on the surface in
the project tree and select Edit > With Structural Data.

To edit a surface with structural data using the second option, it is a good idea to first add the object you
wish to edit to the scene. Next, right-click on the surface in the project tree and select the Edit > With
Structural Data option.
The structural data toolbar will appear and a new structural data object will be added to the scene. Draw
the structural data points and adjust them as described in Creating New Planar Structural Data Tables,
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then click the Save button ( ) to view the effect on the surface. Structural data tables created in this
way cannot be used by other objects in the project until the table has been shared. To do this, right-click
on the table in the project tree and select Share. The structural data table will be saved to the
Structural Modelling folder.
To remove the structural data from the surface, expand the surface in the project tree. Right-click on the
structural data object and select Remove.

Modifying Surfaces With Anisotropic Trends
More detailed information on Global Trends can be found in the Trends and Anisotropy topic.
How the moving plane can be used to adjust a surface in this manner is illustrated by the following
intrusive contact surface:

The intrusion surface has two bodies that are not connected, and we can apply a trend to connect the
two parts. Here, the intrusion surface has been hidden in the scene and the scene rotated to line up the
QzP segments. A plane line can then be drawn through the QzP segments:
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Using the plane settings to adjust the surface results in the two parts of the intrusion joining up:

Applying a Structural Trend
More detailed information on Structural Trends can be found in the Trends and Anisotropy topic.
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To apply a structural trend to an interpolated editable mesh or an interpolant, double-click on the object
in the project tree and click on the Trend tab:

To apply a structural trend to an intrusion contact surface, enable Show additional surfacing
options in the Surfacing tab, then click on the Trend tab:
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Click on Structural Trend, then select the required trend from the list. Click OK to apply the trend to
the surface.
When a structural trend is applied, surfaces may appear distorted further away from the data:

If this is the case, experiment with the Outside value setting. The Outside value is the long-range
mean value of the data. Setting a value of -1 for intrusions (where the positive values are on the inside)
and +1 for other surfaces will result in a smoother surface in most cases. For example, here, the Outside
value has been set to -1 for this intrusion, resulting in a much smoother surface:
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Trends and Anisotropy
A point source of light radiates in all directions equally, and the intensity of that radiated light decreases
at a rate equal to the inverse of the square of the distance from the source. This radiation is isotropic, and
in many fields isotropic behaviour can be assumed when making measurements. Geologists are well
aware that, in their field, this cannot be assumed. Because of the processes involved in rock and strata
formation involving sedimentation, compression and igneous flows, measurements can demonstrate
strong trends in one particular direction or plane, but weak trends in an orthogonal direction. Leapfrog
provides tools to account for this anisotropy when modelling, including:
l
l
l
l

Global Trends
Structural Trends
Variable Orientation
Variography

Global Trends
The most basic anisotropy tool is the global trend. As the name suggests, this applies the anisotropic
trend globally. It is suitable for use in situations where the underlying geology suggests that the
anisotropy is planar and continuous over a large area. The global trend sets a constant trend that will
favour grade continuity in one direction. When calculating interpolants and modelling, the application of
this global trend will reflect the favouring of the trend direction.
Where an object includes a Trend tab in its settings, you can directly specify the Dip, Dip Azimuth and
Pitch directions, as well as the Maximum, Intermed and Minimum ellipsoid ratios.
The global trend is expressed in the form of ratios in three orthogonal directions, described as the major
(“Maximum”), semi-major (“Intermed”) and minor (“Minimum”) axes of an ellipsoid. When the same
value is used for each axis, the ellipsoid is spherical and the global trend is isotropic. Reducing the ratio in
the minor axis direction relative to the major and semi-major axes produces an oblate discus-shaped
anisotropic trend that de-emphasises the minor axis direction. This sort of global trend is typical for
modelling structures that have undergone compression.
Increasing the ratio value in the major axis direction, while having a lower ratio for the semi-major axis
and smaller still for the minor axis, further emphasises the trend in the Maximum direction. This sort of
global trend is typical for modelling structures formed from flows. When the geology is modelled, the
Maximum direction of the trend is favoured over the other directions, and the Minimum direction is
de-emphasised.
When the semi-major and minor axes have the same value and the major axis is larger, this emphasises
the trend in only in the Maximum direction. This results in a prolate cigar-shaped anisotropic trend.
Leapfrog does not enforce that the ratios for the global trend axes are such that the values for
Maximum > Intermediate > Minimum. As such, it is possible to create an ellipsoid that has a trend
strongest in, say, the Minimum direction. This should be avoided as it will likely produce confusion,
especially for others endeavouring to understand the geology modelled in the project.
The global trend ellipsoid can be oriented in any direction other than the x, y and z axes of the model by
rotating it using Dip, Dip Azimuth and Pitch controls.
You can use the View Plane button to add a moving plane to the scene and use the handles on the
moving plane to adjust the Dip, Dip Azimuth and Pitch which will be updated when the Set From
Plane button is clicked. The moving plane indicates the orientation of the major-semimajor axis of the
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trend ellipsoid, with the Maximum trend direction in the direction of the green Pitch arrow. Ellipsoid
ratios cannot be set from the moving plane.
The Ellipsoid Ratios determine the relative shape and strength of the ellipsoids in the scene, where:
l
l

l

The Maximum value is the relative strength in the direction of the green line on the moving plane.
The Intermed. value is the relative strength in the direction perpendicular to the green line on the
moving plane.
The Minimum value is the relative strength in the direction orthogonal to the plane.

Often the easiest way to apply a trend is to click on the Draw plane line button ( ) and draw a plane
line in the scene in the direction in which you wish to adjust the surface. You may need to rotate the
scene to see the plane properly. Once you have adjusted the plane to represent the trend you wish to
use, click the Set From Plane button to copy the moving plane settings.
The Set to list contains a number of different options Leapfrog Works has generated based on the data
used in the project. Isotropic is the default option used when the surface was created. Settings made to
other surfaces in the project will also be listed, which makes it easy to apply the same settings to many
surfaces.
Anisotropic or Ellipsoidal Distance
When a trend is applied during modelling, distances between points are scaled proportionally to the
ellipsoidal trend, creating a concept called the anisotropic distance or ellipsoidal distance. When
interpolating to calculate a value at a specific point, measured data points closer to that point will have
more influence in the interpolation calculation. When a trend is applied, the anisotropic distance is used
instead of the actual distance. In the trend's Maximum direction we want the measured data points to
have more influence, so the anisotropic distance is smaller than the actual distance. We divide the actual
distance by the Maximum axis ratio, so if the ellipsoid Maximum ratio is 4, the anisotropic distance to a
point in the maximum direction is ¼ the actual distance, significantly increasing the influence of a
measured point in that direction. If the Intermediate ratio is 2, the anisotropic distance to a point in the
intermediate direction is ½ the actual distance, again increasing the influence of a measured point in that
direction, though not as significantly as in the Maximum direction. Consider this diagram
demonstrating how points equidistant from a central point are treated when an anisotropic trend is
applied, with the ratios Maximum = 4, Intermediate = 2 and Minimum = 1.
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It may be useful to think of the ellipsoidal trend as warping spacetime, making the apparent anisotropic
distance or ellipsoidal distance shorter in emphasised directions. Still, it is not normally necessary to
envisage things by anisotropic distances. More intuitively, interpolated surfaces modelled using trends
clearly demonstrate the emphasis indicated by the trend ellipsoid proportions and orientation.

When you have the Contaminants extension, the trend can also be visualised in the scene as an
ellipsoid. For more information, see The Ellipsoid Widget.
Where the underlying geology shows that it cannot be assumed that the anisotropy is planar and
continuous over a large area, Leapfrog provides additional tools.

Structural Trends
When there is a gradual shift in the direction of the grade continuity, perhaps due to flows, a global trend
will not suffice to model the geology. In this case, Leapfrog's structural trend tool is more appropriate. A
structural trend localises trend modelling to indicate changes in direction of continuity. A selected
surface or structural data is used as an indicator to locally align the trend direction. The result is that for
any given point of interest, the trend orientation is specific and appropriate to that location.

When displayed in the scene, the structural trend is rendered as a grid of oblate ellipsoids. The grid has
regular 10x10x10 spacing which enclose the extents of the structural trend's inputs. The orientation of
the disk gives the direction of the anisotropy. The size of a disk is proportional to the anisotropy
strength. Where there are no disks (or the size is very small) the trend is isotropic.
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Note that when a structural trend is used in an interpolation, the locations of the depicted ellipsoids are
not the only locations influenced by the structural trend. They are discrete points used to visualise the
continuous structural trend effect. If you would like to study a specific area in closer detail, make a copy
of the source mesh and select the mesh extents to clip the area of interest. Create another structural
trend using this smaller mesh, and you will get a higher-resolution visualisation of the structural trend in
that area.

The above scenes depict the result when the Trend Type is set to Non-decaying. In these illustrations,
a mesh has been selected and added to Trend Inputs and a trend Strength specified. Because the
strength of the trend does not decay, all the ellipsoid disks are the same size but may point in different
directions.
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Creating a Structural Trend
To create a new structural trend, right-click on the Structural Trends folder (in the Structural
Modelling folder) and select New Structural Trend. The Structural Trend window will appear:
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Structural trends can be created from surfaces and from structural data. Click Add to select from the
suitable inputs available in the project. The list of inputs will be displayed:

Tick the box for each input required, then click OK. The selected inputs will be added to the Structural
Trend window:
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The Non-decaying option can be used when it can be assumed that the strength of the trend does not
decay as you get further away from the mesh. This is useful when the geology has a fairly constant trend
across the model, but with some directional shift. The Strength parameter describes how many times
stronger the trend is in the maximum and intermediate plane than in the minimum direction. Note that
when using a structural trend, the maximum and intermediate directions use the same strength value, so
the depicted ellipsoids will always be oblate spheroids and cannot be prolate.
Where a trend is isolated to a region near a structure and the influence away from the structure
decreases, an effect Range can be specified in conjunction with the Trend Type option Strongest
along inputs. Where the trend approaches an isotopic trend, no ellipsoid is visualised.

Away from the structural trend, you can specify the overall global trend that the model should tend
towards. The Global Mean Trend tab lets you set this as for a global trend, with Maximum, Intermed
and Minimum ellipsoid ranges, and Dip, Dip Azimuth and Pitch directions. To set this, click on the
Global Mean Trend tab.
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You can enter the trend manually or add the moving plane to the scene and set the trend using the
moving plane, as described in Global Trends.
For instance, here a Strongest along inputs trend has been added to a global mean trend that goes in
a very different direction.

Complex trend interactions can be modelled using structural trends by describing the trend components
for each structure. Select Blending as the Trend Type, then add each input mesh to the Trend Inputs
list, specifying an appropriate Strength and Range for each. The Blending option requires multiple
meshes and blends them according to their individual strength settings. A trend with higher strength
makes a stronger impact on the blending. The blended trend is a decaying type, and its strength
weakens further away from the mesh. Leapfrog Geo will blend the trends at the places they interact.
Because of the strength blending, some of these ellipsoids may end up prolate, but each of the
component trend strengths can still only be configured using the same strength value for the maximum
and intermediate directions. The Global Mean Trend tab can also be used to add an overall trend
magnitude and orientation to the model.

Compatibility
Structural Trends includes an option to select the Compatibility as Version 1 or Version 2. Version
2 is the default and preferred option for all new models, as Version 1 is deprecated and retained for
compatibility with existing, older models. Version 2 employs an improved strategy to ensure small
changes such as the addition of a few new data points does not trigger a significant recalculation of the
whole model. Both strategies use clusters of data with similar locations and trend orientations. These
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clusters are interpolated separately using the average trends across each cluster and then the
interpolants are combined, smoothed with a weighed average. Version 1 recalculated the clusters
whenever new data was added, potentially causing significant model changes from a small data change.
Version 2 retains the clusters and only the clusters immediately surrounding the new data are updated,
limiting the effect of the change.

Variable Orientation
For Kriging and other estimations, structural trends do not provide the needed control over the
anisotropy ratios, among other considerations. For this purpose, Variable Orientation can be used.
This feature is only available when you have the Contaminants extension.
Variable orientation provides a similar control over the changing direction of anisotropy for the purposes
of improving local value estimates, orienting the search space and variogram according to local
characteristics. Variable orientation is visualised using lines or, as in this illustration, flat disks with a line
indicating the orientation of the maximum axis direction for each search space local to each centroid.
Here the disks have also been coloured reflecting the Dip direction.

For a full description of this feature, please see Variable Orientations.

Variography
This feature is only available when you have the Contaminants extension.
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Variography is the analysis of spatial variability of grade within a region. This is an intrinsic part of the
estimator functions available as part of the Contaminant extension.Understanding how sample grades
relate to each other in space is a vital step in informing grades in a block model. A variogram is used to
quantify this spatial variability between samples. A theoretical variogram is developed as a hypothesis
attempting to describe this spatial variability, and experimental variography tools are used to visualise
and test this hypothesised variogram

For more information on the variography capabilities in the Contaminant extension, see Experimental
Variography and Variogram Models.

Polarity in Leapfrog Works
Polarity refers to which side of an object is considered the “inside” or “outside”, or the “younger” or
“older” side. When used correctly, polarity is a useful tool for controlling structurally complex surfaces,
defining how custom boundaries are applied to models or controlling how meshes are clipped during
mesh operations. Object polarity can cause unexpected or confusing results if the polarity of an object is
different to what was intended or expected.
Polylines, surfaces and structural data all have polarity in Leapfrog Works.
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Polarity and Polylines
When a polyline is drawn on a two-dimensional plane such as the slicer, the orientation of the polyline
will be consistent. When a polyline is drawn on a three-dimensional object, however, each segment in
the polyline will have a different “in” and “out” orientation. To see the line polarity, and the polyline to
the scene and increase the Ribbon width so a clear ribbon extends away from the polyline. This will
help you to see not only how a line changes direction, but also how it twists. You can view the Surface
ribbon ( ) as shown here:

Or you can choose the Normal ribbon ( ), which depicts the ribbon at the normal (or, right angles to)
the Surface ribbon view:
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Invert Polyline Polarity
If the whole line has the wrong polarity, you can select the line then click the Flip selected objects
button ( ).
Adjust Polyline Polarity Using Tangents
To adjust a portion of a polyline, one tool you might choose is the Add or set tangents at the
selected points, from the current viewing angle button ( ). Click on the line where you would
like the tangent inserted, then click the ( ) button. This will add a tangent pointed directly away from
the current viewing perspective, and whole line will be twisted so the surface ribbon is aligned in the
direction of the viewing angle also, up to the point that some other part of the ribbon has an existing
tangent set (if any).

To achieve the desired result, you may need to reposition the viewing angle and set additional tangent
points.
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Imported polylines can often have inconsistent polarity across different parts of the polyline, which can
limit their usefulness until the polarity issues are addressed. Observe how a inverted polarity direction in
one part of a polyline can affect a mesh built from the polyline:

If you are editing a surface with a polyline and you get an unexpected result such as the one shown
above, check the polarity of your polyline disks.

Polarity and Surfaces
Almost every mesh added to the scene in Leapfrog Works, including meshes from the Meshes folder or
surfaces from a geological model, will have one colour on one side of the surface and a different colour
on the other side. This represents the polarity of the surface, identifying what is considered the ‘outside’
and the ‘inside’ of the surface. Note that numeric model isosurfaces and form interpolant surfaces do not
have polarity.
When a surface from the Meshes folder is added to the scene, by default the colouring is red for the
inside and blue for the outside of the mesh.
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When a surface from a geological model is added to the scene, the colours reflect the relevant unit
colours defined by the drillhole data, and the polarity represents the “younging” side. Here a couple of
surfaces separating some stratigraphic layers are revealed, and the colour of each side of the surface is
consistent with the stratigraphic layer it contacts.

Polarity and Structural Data
The polarity of structural data is also indicated by the colouring of the disk sides. The orientation of a
structural data disk is initially set when it is drawn, according to the direction the mouse was dragged
after clicking on the place to insert the disk:
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Then the tilt of the disk is set in the Planar Structural Data window. Note also the Flip Polarity
button to invert the orientation of the disk if the disk was accidentally drawn in the wrong way.

Consistency of polarity is important to get a consistently oriented surface created from the structural
data, a surface with a clear ‘inside’ and ‘outside’.
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Where structural data has been placed with inconsistent polarity, any resulting surface will have a
contorted and inappropriate shape due to unclear ‘inside’ and ‘outside’ directions. If you are editing a
surface with structural data and you get an unexpected result such as the one shown below, check the
polarity of your structural data disks.

Boundaries in Leapfrog Works Projects
This topic discusses boundaries in Leapfrog Works. It is divided into:
l
l
l

The Clipping Boundary
Object Extents
Extending a Surface

A newly-created project has only a basic set of X-Y-Z coordinates, and the coordinate system used by
the project is determined by the data imported to the project. It is not necessary to specify what
coordinate system is used; however, it is necessary to ensure that data you import into the project uses
the same coordinate system.
Often the best way to set the coordinates for the project as a whole is to import a map or aerial photo.
Adding georeference data to a map will set the location of the map in three-dimensional space and set
the coordinates for the project. See Importing a Map or Image for more information.
An important consideration in defining the project space is setting the clipping boundary. See The
Clipping Boundary.
It is not necessary to define a topography to model in Leapfrog Works, but a defined topography can be
used as an upper boundary for all models built in the project. See Defining a Topography.
Part of creating many objects in Leapfrog Works is defining the basic rectangular boundary that defines
the object’s extents. See Object Extents.
You can modify the extents of geological models and interpolants using surfaces created from different
types of data. See Modifying a Geological Model’s Boundary and Modifying an RBF Interpolant’s
Boundary With Lateral Extents.

The Clipping Boundary
An important consideration in defining the project space is setting the clipping boundary.
The default clipping boundary in a new project file encompasses everything in the project and grows as
more data is added to the project. It is not necessary to set the clipping boundary. However, the clipping
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boundary defines the limits of the X-Y coordinates for the region in which data will be imported and
models built and so defines the region in which calculations are made. Restricting the size of the clipping
boundary limits the area in which calculations are made and is especially important if you are working
with a large dataset.
The best way to set the clipping boundary is using an imported map or aerial photo, as this provides a
visual reference that is helpful in working with data added to the project in the future. GIS data or
borehole data can also be used to set the clipping boundary.
To set the clipping boundary, add to the scene the objects you wish to reference in setting the boundary.
Right-click on the Topographies folder or on the GIS Data, Maps and Photos folder and select Set
Clipping Boundary. The Set Clipping Boundary window will be displayed, together with controls in
the scene you can use to resize the clipping boundary:

There are three ways to define the rectangular clipping boundary:
l
l

l

Enter the coordinates.
Select Enclose Object and choose from the list of objects in the project. The clipping boundary will
be updated using the selected object.
Use the controls that appear in the scene. The orange handle adjusts the corner of the clipping
boundary and the red handles adjusts its size.

When you have finished adjusting the clipping boundary, click OK.
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If you are going to import elevation data and use it to create a topography, it is important to set the
clipping boundary before creating the topography. For example, here a map has been imported and a
topography (yellow) has been created from an elevation grid. The map is displayed draped on the
topography:

The red arrows and orange handle show the clipping boundary, which has been allowed to expand to
encompass all data imported to the project. Because the topography was created before the clipping
boundary was set, all the data in the imported elevation grid has been used and the resulting topography
is larger than might be practical. Clearly, if the intention is to model within the area on the map, the
clipping boundary should be limited to the region indicated by the map.
If the map is the only object in the project, it can easily be used to set the clipping boundary by selecting
<Everything> from the Enclose Object list:
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This results in a clipping boundary that is limited to the extents of the map:

Once the clipping boundary has been set, further data imported into the project will be clipped to it. For
example, importing an elevation grid and using it to create a topography only after the clipping boundary
has been set to the map extents will result in a topography (with the map draped) that looks like this,
with only a narrow yellow boundary:

Object Extents
Part of creating many objects in Leapfrog Works is defining the basic rectangular boundary that defines
the object’s extents. There are generally two options for defining an object’s extents:
l

l

The first option is to define extents that are independent of other objects in the project. You can do
this by entering coordinates or adjusting controls in the scene to set the size and shape of the
extents. The new object’s extents are fixed to the specified size. This is a good choice if, for example,
you are building a geological model from a map and wish to define the model extents based on
information on the map.
The second option is to define extents based on other objects in the project. This is done by selecting
the other object from the Enclose Object list that appears in many Leapfrog Works screens.

For both methods, the new object’s extents are fixed to the selected size. Using the Enclose Object
list does not link the two objects; it is simply using the X-Y-Z coordinates of the original object as the
basis for the new extents.
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For example, here, a geological model’s extents could be defined using the lithology segments used as
the base lithology:

When creating some objects, you have the option of sharing extents with another object. This is the case
with editable meshes ( ), where you can choose whether the mesh has its own extents or shares
extents with other objects in the project. Shared extents are updated when the original object’s extents
are updated.
If you are unsure about relationships between objects, expand them in the project tree to view more
information. Here, two meshes have been defined from the same set of points. The first mesh has its
own extents that are not updated by other objects in the project, whereas the second mesh shares its
extents with those of the RockType geological model.
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Geological models and interpolants are created with a basic set of rectangular extents that can then be
refined by adding extents created from other data in the project. Creating extents is a useful way of
restricting modelling to a particular area of interest. For example, modelling can be restricted to a known
distance from borehole data by applying a distance function as a lateral extent. See Modifying a
Geological Model’s Boundary for more information.

Extending a Surface
Geological models created in a Leapfrog Works project automatically use the defined topography as an
upper boundary. If a model is defined that extends outside the topography, an error will occur. A similar
error occurs when surfaces used in geological models do not extend outside the model’s extents. In all
cases, Leapfrog Works cannot process the surface and an error will be displayed.
In this example, an error has occurred during the process of creating a geological model because the
model extents (pink) do not fall completely inside of the topography:

In order for Leapfrog Works to be able to divide the model into separate volumes, the topography needs
to be extended to enclose the model’s boundary or the model’s boundary needs to be restricted so it falls
inside the topography.
The solutions proposed will depend upon the data used to create the surfaces that conflict, but fall into
three broad categories:
l

l

l

Reduce the size of the model’s or interpolant’s extents. Click the Edit Extents button. This will open
the object’s Boundary window and you can change the boundary.
Enlarge the topography by manually adjusting it. Click on the Edit Topography Extents button.
This option is only available when the topography has been created from more than one data source.
See Adding Height Data to the Topography and Changing Topography Settings.
Use the surface’s vertices to create the boundary or contact with extents large enough to be used in
the model or interpolant. Click the Use Vertices button to create a new vertices object and use it as
the source data for the boundary or contact.

If you have a solution to the problem that is not covered by the options presented, click Do Nothing.
For example:
l

If the topography is not large enough, there may be additional data available. If it is not already in the
project, import the data and add it to the topography as described in Adding Height Data to the
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l

Topography.
If a surface being used to define a contact surface or boundary in a geological model or interpolant is
not large enough, you can add additional data to the surface.

Using vertices to create the boundary or contact results in the creation of a new points object that will be
saved in the Points folder. For example, here the geological model uses vertices to create the
“Topography” used as an extent:

Using topography vertices can take some time to process.
An additional disadvantage to using vertices is that the vertices object created is not linked to the original
object, and when the object used to create the vertices changes, the vertices will not be updated.
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Central Integration
Central’s integration with Leapfrog Works lets you work in different project revisions, publish models to
the server, view documents and annotations and reply to annotations. Projects shared within Central
can be downloaded and worked on locally in Leapfrog Works. When you have finished working on a
project, select the objects you wish to publish to Central and add notes about the revision. New projects
can be added to Central by building them from scratch or by uploading an existing project.
The rest of this topic describes how to connect to Central from within Leapfrog Works. It is divided into:
l
l
l
l

Enabling Central Connectivity
Switching to Using Seequent ID
Connecting to Central
Troubleshooting Connectivity Issues

To learn more about Central, see the Central 4.0 help.

Enabling Central Connectivity
To enable Central, open the Settings window by clicking on the Leapfrog Works menu. Select
Central and tick the box to enable Central. A Central Projects tab will appear in the main window,
with a list of Central servers you have access to.
See Central Settings for more information on the other Central-related settings in the Settings
window.

Switching to Using Seequent ID
If your organisation is switching to using Seequent ID to connect to Central, you may be prompted to
change your Central settings when you attempt to connect to your Central server. To do this:
1. Click on the Leapfrog menu and open the Settings window.
2. Click on Central.
3. Enable the Use Seequent ID option.
4. Close the Settings window.
5. Restart Leapfrog.
The Central servers you have access to via your Seequent ID will be listed in the Central Projects tab.
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Connecting to Central
The Central Servers panel in the Central Projects tab shows all the Central servers you have access
to. The Central servers you connect to are set up via your Seequent ID.

If a server you expect to see does not appear in the list, click the refresh button ( ).
Click on a server description to connect to it.
Leapfrog Works version 4.0 is compatible with Central Server version 4.0. If you get a message
saying that the version of Leapfrog Works you are using is not compatible with the Central Server
you are trying to connect to, follow the instructions in the message, then try connecting again.

Troubleshooting Connectivity Issues
Seequent Start checks to see if your network will support the connection of Seequent web-based
services to your desktop applications. If you are having trouble with your connection to Central, see
Checking Connectivity With Seequent Start.

Central Projects
This topic describes how to work with Central projects in Leapfrog Works. It is divided into:
l
l
l
l

Viewing a Project’s History
Sharing Projects
Downloading a Local Copy of a Project
New Central Projects

The Central Servers panel in the Central Projects tab shows all the Central servers you have access
to. The Central servers you connect to are set up via your Seequent ID.
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If a server you expect to see does not appear in the list, click the refresh button ( ).
Click on a server description to connect to it.
Leapfrog Works version 4.0 is compatible with Central Server version 4.0. If you get a message
saying that the version of Leapfrog Works you are using is not compatible with the Central Server
you are trying to connect to, follow the instructions in the message, then try connecting again.
When you are connected to a Central server, there is an Open Portal button that will open the Central
user portal in a browser window:

Viewing a Project’s History
See Projects, Revisions, Branches and Nodes in the Central 4.0 help for an overview of how Central
projects are organised.
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Once you’re connected to a Central server, the Central Projects tab shows thumbnails of all the
projects you have access to. Use the search bar to narrow down the list of projects displayed.

Projects will be organised by location if there are multiple projects at a given location; otherwise projects
will simply appear in a list. If a project you expect to see is not listed, click the Refresh button ( ) in the
Central Servers part of the Central Projects tab. This will refresh the list of projects for the server
you are connected to.
A project’s location is set in the Central Portal. You cannot change its location from Leapfrog Works.
Click on a project to view its history, which will open in a new tab.
Central projects are organised into revisions and branches:
l
l

Different points in the modelling process are captured as revisions, which are specific points in time.
A revision can be the basis for a new branch, exploring an alternative hypothesis.

These are displayed visually in a project’s history tab, with local copies of projects shown in the panel at
the top of the tab:
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Each local copy is numbered so that it can easily be seen what versions have local copies in the Local
column. The number in the column corresponds to the project in the Local copies panel. You can also:
l
l

Click a thumbnail to open a local copy.
Click the branch/copy number button ( ) to identify the parent version of the local copy in the
project history.

l

Click the Publish button ( ) to publish the copy being edited to Central.

l

Click the Delete button ( ) to delete a local copy, if the project is not open.

In the Project history, revisions are displayed chronologically, from the most recent down to the
oldest. In the Graph, offshoots from a revision are branches where an alternative hypothesis has been
investigated. Changes made in a branch do not appear in other branches; branches effectively diverge
from the base revision. The dots on the graph line up with the revision information.
To view more information about a revision, click on it in the history.
Locking Branches
When working on a branch in Leapfrog Works, the branch can be locked so no other Central users can
make changes to it. This is useful for letting others users know that a model is being worked on.
The Locked column indicates whether or not the branch is available to be worked on. If a branch is
locked, hold the cursor over it to see who locked it and when it will be available once again.
To lock a branch, right-click on it in the project history and select Lock branch:

In the window that appears, set the Lock duration and add any comments. The lock can be set for as
little as one day; when the lock expires or when a new publish is completed, the branch will be unlocked
for other users. While the branch is locked, other users are still able to download projects, create new
branches and publish to branches that are not locked.
If you locked a branch, you can unlock it before the lock expires by right-clicking on it and selecting
Unlock branch:
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You can also ask your Central administrator to unlock a branch.

Project Included
The Project column indicates whether or not the Leapfrog Works project was included when the
revision was published. If there is no icon displayed, then no project was uploaded when the revision was
published. You can view the revision in the Central Browser, but you cannot work on it in Leapfrog
Works.
When Leapfrog Works projects are included in a revision, they can be published in a Complete state ( )
or in an Unprocessed state ( ). The difference between the two is whether or not stored modelling
calculations are included in the published project. Removing stored modelling calculations can make the
upload/download size of a revision considerably smaller and is useful when internet connectivity is poor.
The tradeoff is that when the project is downloaded by a Leapfrog Works user, the project will have to
be reprocessed before they can use it. This may take some time.
Project Stages
The Project Stage is useful for promoting projects through an organisation’s procedures. For example,
your organisation may have project stages defined that include “Experimental”, “Ready for Peer Review”
and “Ready for Production”. Different stages are displayed in different colours so it is easy to see at a
glance what revisions belong to each stage.
Comments and Attachments
With comments, Central Browser and Leapfrog Works users can carry out conversations about specific
aspects of the model. Comments include a scene. If you already have the project downloaded and open
in Leapfrog Works, you can load the current version of the object referred to by the comment. Click on
the scene; you will be prompted to load all the objects or only the unchanged objects:

If the selected scene has a geotag, it will be added to the shape list and displayed in the scene.
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If the project is not open, the scenes shown in comments will be greyed out:

Central Browser users can also attach files, which can be downloaded in Leapfrog Works.

Sharing Projects
If you are a project’s owner, you can share it with other Central users by clicking the Share Project
button in the project’s history tab:

© 2020 Seequent Limited

Downloading a Local Copy of a Project | 173

Clicking Share Project opens the Central Portal, displaying the list of users for that project:

You may need to sign in to the Portal.
You can select from the other users in the system or enter a user’s email address, then assign their
permissions.
There are four levels of project permissions in Central: Owner, Editor, Viewer+Export and Viewer.
An Owner can:
l
l

Assign other users as the owner. A project can have more than one owner.
Configure and add an integration to a project they own.

A user who uploads a new project to Central is automatically assigned as the project owner.
Editor access allows a user to work in a project in Leapfrog.
Viewer+Export access allows a user to open a project in the Central Browser and export data from the
project.
Viewer access allows a user to open a project in the Central Browser and make annotations. They
cannot export data from the project.

Downloading a Local Copy of a Project
Select a revision and then click Download to download a local copy of the project. The project will be
downloaded to the location on your local drive specified in the Settings > Central window. A new
revision of the project will be created in the history, as an unpublished project.
Click the Open button in the Local copies panel to open the project:
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Work in the project as you would any other Leapfrog Works project.

New Central Projects
There are two options for putting a project into Central:
l
l

Create a new Central project.
Put an existing project into Central.

Creating a New Central Project
Use this option to create a new Leapfrog Works project and put it into Central. In the Central Projects
tab, click Create blank project. Enter a name for the project and click OK. A new Leapfrog Works
project will be created and saved in the location on your local drive specified in the Settings > Central
window.
Work in the project as you would any other Leapfrog Works project. When you are ready to publish the
project to Central, click on the Central button in the lower left-hand corner of the screen and select
Publish:

Adding a Project to Central
Use this option to add an existing project to Central.
Open the project you wish to import, then in the Central Projects tab, click Import open project.
Enter a new name for the project, if you wish, then click OK. The project will be opened and copied to
the location on your local drive specified in the Settings > Central window.
Work in the project as you would any other Leapfrog Works project. When you are ready to publish the
project to Central, click on the Central button in the lower left-hand corner of the screen and select
Publish.

Publishing to Central
See Projects, Revisions, Branches and Nodes in the Central 4.0 help for an overview of how Leapfrog
Works projects are organised into revisions when they are published to Central.
When you publish a revision to Central, there are different choices you can make as to what objects are
included and whether or not a Leapfrog Works project is uploaded as part of the revision.
l

When you select objects to publish to Central, the objects will be available for visualisation in the
Central Browser and the Central Portal. You can choose to publish all objects in a project, but if your
team’s discussion is limited to, for example, a subset of data or one or two models, it might be best to
publish only those objects relevant to the discussion.
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l

When you choose to include a Leapfrog Works project, other Leapfrog Works users who have access
to the project via Central can download a copy of the project and work in it.

When you are ready to publish your project to Central, you can start the publishing process by clicking on
the Central button in the lower left-hand corner of the screen and selecting Publish:

You can also select the Publish button ( ) in the Local copies panel:

The rest of this topic describes the steps in publishing a project to Central. These are:
l
l
l
l
l
l
l

Unfinished Publish Events
Selecting Objects
Setting the Project Workflow Stage
Including the Project
Adding Revision Information and Branching
Preparing the Package
Uploading the Package
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Unfinished Publish Events
When you click Publish, you may receive a message saying there is an unfinished publish event:

This occurs when a previous publish event was interrupted. Choose from the options presented.
If the publish event was abandoned, it can be removed via the Central Portal.

Selecting Objects
Select the objects you wish to publish from those available in the project.
Most data types in Leapfrog Works projects can be published to Central. If a data object is not listed in
the Publish window, then the publishing of that data type is not yet supported.
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When you publish a project revision to Central from Leapfrog Works and wish to make a data object
available for use in other projects, make sure you select that object from those in the project:

For example, in the project above, the data objects that will be available for use in other projects on the
same Central server are:
l
l
l

The Topography mesh
The surfaces in the Lithology geological model
The surfaces in the AG_gpt and AS_ppm numeric models

Unticked objects such as the Distance to collar mesh, the topography inside Distance to collar mesh and
the AU_gpt numeric model will not be available.
Click Next to choose options for how the project will be uploaded.

Setting the Project Workflow Stage
Project stages are useful for advancing projects through an organisation’s processes. If the project is
ready to be moved on to a different stage, select a different Project Workflow Stage from the list.
Project stages can later be changed in the Central Browser.

Including the Project
Select whether or not to include the Leapfrog Works project. There are three options:
l

l

No. The Leapfrog Works project will not be published. Other Central users will not be able to
download the project and work on it in Leapfrog Works. They will, however, be able to review the
published objects and their history in the Central Browser.
Complete.This option publishes the complete Leapfrog Works project, including stored modelling
calculations. Other Central users will be able to download the project and work on it in Leapfrog
Works without reprocessing the project.
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l

Unprocessed. An unprocessed project has a smaller upload/download size because stored
modelling calculations are removed. When an unprocessed project is downloaded again, all of the
modelling calculations will need to be reprocessed from the underlying data. Other Central users will
be able to download the project and work on it in Leapfrog Works. Depending on the size of the
project, reprocessing may take some time.

Click Next.

Adding Revision Information and Branching
Enter information about the new revision. If you want to create a new branch, click the New Branch
button and enter a name for the branch.
Once you branch from a timeline, you cannot merge back into it. There’s no reason, however, that
you can’t keep working in a branch and start considering that the main branch, if that’s the
conclusion you and your team reach.

Preparing the Package
Click Next to begin the processes of packaging the project for publication.

Uploading the Package
Once the project has been packaged, there are two options for starting the upload:
l

l

If you want the upload to begin automatically once the package has been prepared, tick the Auto
upload box.
If you want the option to cancel the upload once it has been packaged, leave the Auto upload box
unticked. Once the project has been packaged, click Publish to upload the project to Central.

If for some reason you need to stop the upload, click on the Central button in the lower left-hand corner
of the screen and select Stop Upload:

You can resume the upload by clicking Publish in the project history. You will be prompted to resume
the unfinished publish event, as described in Unfinished Publish Events above.
If the upload is interrupted because the connection to the server is lost, you will be prompted to finish the
publish event the next time you log in to Central.
If you exit Leapfrog Works while a publish event is in progress, you will be warned that a publish event is
in progress. You can:
l
l

Cancel exiting Leapfrog Works, in which case the publish event will continue.
Confirm that you wish to exit Leapfrog Works. The next time you connect to this Central server or
publish from this project or from another project on the same server, you will be prompted to the
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resume the interrupted publish event. You can complete the interrupted publish event, if you wish, or
ignore it.
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Importing Data From Central
When you are working on a Central project, you can import some data types from other projects on the
same server. In this way, you can easily share data between projects and, if the data object is out-ofdate, you can reload it from Central.
Data types that can be imported from Central are:
l
l
l
l
l
l
l

Meshes
Borehole data
Points
Polylines
Planar structural data
2D grids
OMF files

Borehole data and data in OMF files can only be imported from a project’s data room. Although
borehole data can be published to Central, that is for the purpose of visualising the data in the Central
Browser and the Central Portal. Published borehole data cannot be imported into other Leapfrog
Works projects.
Geological models and refined geological models can also be imported from Central. Geological models
and refined models are imported as static geological models. See Creating a Static Copy of a Geological
Model for information on how to work with static geological models.
The rest of this topic describes how to import and reload data from Central. It is divided into:
l
l
l
l

Object Availability
Importing Central Data Objects
Updating Out-of-Date Objects
Appending Rows and Adding Columns to Data Tables

Object Availability
With the exception of borehole data and OMF files, data objects that can be imported from Central are
those that have been:
l

l

Published to Central as part of a revision via Leapfrog. These appear in the Import From Central
window in the Project History tab.
Uploaded to the project’s Data Room via the Central Portal. These appear in the Import From
Central window in the Files tab.
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For more information on publishing data to Central, see Publishing to Central in this help system.
When you publish a project revision to Central from Leapfrog Works and wish to make a data object
available for use in other projects, make sure you select that object from those in the project:

For example, in the project above, the data objects that will be available for use in other projects on
the same Central server are:
l
l
l

The Topography mesh
The surfaces in the Lithology geological model
The surfaces in the AG_gpt and AS_ppm numeric models
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Unticked objects such as the Distance to collar mesh, the topography inside Distance to collar mesh
and the AU_gpt numeric model will not be available.

Importing Central Data Objects
To import data objects from Central, first make sure you are already connected to Central. Then rightclick on the folder for the data type you wish to import and select the Import From Central option. In
the window that appears, select one of the projects in the repository.
In the next window, there are two options, the Project History tab and the Files list:
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In the Project History tab, select a revision to view its published objects, then click on a model to load
its list of objects. The list displayed will depend on the type of data object you are importing. Here, the
surfaces in the project are displayed:

The Files tab shows any files that have been uploaded to the Central project’s Data Room:
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Whether you wish to import files from a revision or from the Data Room, use the Shift and Ctrl keys to
select as many objects as required. Click Import to import the objects, which will be saved into the
project tree. Objects imported from Central are displayed using a different icon. For example, here the
meshes in the Central meshes (current) folder are marked with the Central logo ( ), whereas the
meshes in the Project meshes folder are not ( ):

Updating Out-of-Date Objects
Leapfrog Works also checks to see if the object imported from Central is the latest version of that object.
If a newer version of an object is available, the object’s icon will be marked as out-of-date ( ):

The options for reloading an out-of-date object depend on whether you imported the object from a
project’s Data Room or from a project’s history.
When you have imported an object from a project’s Data Room, you have two options for updating outof-date objects:
l

l

Reload Latest File Version imports the newest version of the object available in the Data Room
the object was originally imported from.
Reload From File History displays the file’s history so you can choose which version you want to
use.

Right-click on a data object and choose one of these options.
When you have imported an object from a project’s history, you have two options for updating out-ofdate objects:
l

l

Reload Latest on Branch imports the newest version available on the branch the out-of-date
object was imported from.
Reload From Project History displays the project’s history and you can choose any point in time
on any branch.
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If you have selected multiple out-of-date objects from the project’s history, you can reload them all at
once by right-clicking on them and selecting Reload Latest on Branch:

Appending Rows and Adding Columns to Data Tables
Data tables imported from the Central Data Room also have options for appending new data rows and
adding data columns.
See Adding and Updating Data for Existing Tables in the Working With Data Tables topic for a
discussion of the differences between reloading data, appending data and adding new data columns.
When you want to append new rows to a table, right-click on the table and select the Append from
Latest File Version option. You will be prompted to select the project and file. Once you have selected
the data source, the process is the same as described in Adding New Rows to Existing Data Tables.
When you want to add new columns to a table, right-click on the table and select either Import Column
from Latest File Version or Import Column from File History. The from Latest File Version
option will display the file and you can select additional columns to import, whereas the from File
History option lets you select from the file history. In each case, the file’s contents will be displayed and
you can select additional columns to import, as described in Importing Additional Columns to a Data
Table.
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Settings
Open the Settings window by clicking on the Leapfrog Works menu and selecting Settings:

The settings available in this window are described below:
l
l
l
l
l
l
l
l
l
l

Display and Navigation Settings
Overlay Settings
Colour Scheme
Lighting Settings
Processing Settings
User Interface Settings
Central Settings
Usage Policy Settings
Network Settings
Help Settings

To close the Settings window and leave settings unchanged, click the Revert button, then click Close.
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Display and Navigation Settings
In the Settings window, click on Scene to change scene display and navigation settings.

3D Acceleration Mode
Leapfrog Works can run in one of three acceleration modes. Click the Acceleration mode button in the
Settings > Scene window to use a different mode. The modes available are:
l

l

l

Software Rendering uses software only, for maximum compatibility with any hardware. This
option can be very slow displaying all but the simplest scenes, and is provided as a fall-back if display
issues cannot be resolved with either of the other two options.
Partial Acceleration uses hardware acceleration that has been provided on graphics cards for
many generations. In this mode, Leapfrog Works renders scenes using “fixed function pipeline”
hardware acceleration features that have been superseded in modern graphics cards by
programmable shaders, but this legacy capability is widely supported and offers performance
advantages over software rendering. Using Partial Acceleration can sometimes fix anomalies or
problems encountered in Full Acceleration mode that may be due to bugs in old drivers, and it
should work with even old or lower-featured hardware.
Full Acceleration is the best option, assuming you have good hardware and up-to-date drivers.
Because it makes use of programmable shaders provided by modern graphics cards, it is the fastest
of the three modes and uses your available graphics memory more efficiently. It is the mode you
should use, if your system supports it.

First, try using Full Acceleration and see how it renders scenes. If you seem to be having issues with
how data is displayed in the scene, see Running the Graphics Test for information on testing your
computer’s graphics capabilities. Note that especially when graphics cards are new on the market, there
may be a number of driver versions released to address anomalies, so the use of a recent driver version is
important. If using a laptop with dual graphics cards, use it with the power supply connected, and select
the Performance Graphics option over the Power Saving option.
If that doesn’t resolve the graphics problems, then try Partial Acceleration mode. If possible, avoid
using Software Rendering as it can be very slow.
If your current hardware is unable to support Full Acceleration mode, it may be worth considering
upgrading your graphics card. Medium- to high-end home PC and gaming graphics cards are sufficient.
High-end workstation grade cards also work very well, but you will also be paying for further capabilities
that are not utilised by Leapfrog Works.
The acceleration mode can also be changed by clicking the button at the bottom of the Leapfrog Works
main window:

Font Size
This setting is the size of text used to display information on the grid and axes.
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Z Axis Scale
The Z-axis scale setting lets you set a value greater than 1.0 for the z-axis relative to the x- and y-axes.
This is useful when the area under study is very planar and extends over a wide area. In such cases,
scaling the z-axis can accentuate the distribution of data along the z-axis. If you have a project open
when you change this setting, the change will be reflected in the scene so you can experiment with
different values before choosing the one that best accentuates the distribution of data.
The z-axis setting can also be changed by clicking the Z-Scale button at the bottom of the Leapfrog
Works main window. The Scale Z Axis window will appear:

Note that each project saves the z-axis scaling setting when the project is closed. In addition, when
saving scenes (see Saved Scenes), the z-axis scale is saved as part of the scene.

Rotation Settings
The Geographic rotation and Free rotation settings determine whether or not the model displayed
in the scene window can be “rolled”. With the Geographic rotation option, the azimuth and elevation
can be varied, but the z-axis is constrained to be vertical. With the Free rotation option, however, the
rotation of the model is not fixed to any axis and the model can be freely rolled around any axis. Select
the option you prefer. When Leapfrog Works is installed, Geographic rotation is set as the default
option as it is the most commonly used.
The Rotate with left button and Rotate with right button settings determine how the mouse is
used to rotate the scene:
l

l

When Rotate with left button is selected, you can rotate the scene by holding down the left
mouse button and dragging in the scene. Clicking and holding the right mouse button zooms in and
out of the scene.
When Rotate with right button is selected, holding down the right mouse button and dragging
rotates the scene. However, zooming and rotating functions are not swapped. Instead, the left
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mouse button can only be used for clicking on different objects in the scene. Select this option if you
tend to accidentally move the scene when you intend to click.

Camera Settings
The Orthographic projection and Perspective projection settings determine the view of the model
in the scene window.
If Perspective projection is selected, you can change the Perspective angle using the slider. This is
similar to adjusting the zoom setting on a camera. Higher angles make nearby objects larger and more
distant objects smaller. Lower angles will compress the scene. Experiment with the settings to see the
effect on objects in the scene.
Select the option you prefer.

Overlay Settings
In the Settings window, click on Scene > Overlays to change what objects are included in the scene.
Changes you make to these settings are automatically updated in the scene so you can easily
experiment to see what overlays you prefer.
Select Revert to return to the settings in place when the Settings window was first opened.

Screen Grid Settings
The Show screen grid setting determines whether or not the screen grid is displayed. Select the
option you prefer. The Loose Spacing, Normal Spacing and Fine Spacing options determine the
spacing of the grid.

Axis Lines Settings
The Axis Lines settings determine how X-Y-Z coordinates are displayed in the scene. When axis lines
are enabled, the axes indicate the extent of data currently displayed in the scene.
l
l

l

Enable Show axis lines to display the east (red), north (green) and elevation (blue) axis lines.
Enable Put numbers on axes to display scale ticks along the grid. These are automatically adjusted
to fit the extent of the data and the current zoom setting.
Enable Show whole box to display the axis lines as a box that encloses the current data set.

Other Overlay Settings
The scale bar, compass ball and viewing angle text are the navigation aids in the lower right-hand corner
of the scene window.
When the slicer is in the scene and the slice is aligned with the x-, y- or z-axis, text describing the slicer
position can be displayed in the lower left-hand corner if the scene. To do this, enabled the Slicer
position text option.
When drawing polylines, tooltips are displayed. If you do not wish to view these tooltips, untick the box
for Polyline help text.
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Colour Scheme
In the Settings window, click on Scene > Colour Scheme to change the colour scheme used in the
scene. The options that can be changed include:
l
l
l

l
l
l
l

The background colour used in the Scene View tab
The colour and width used to display borehole traces
The colour and width of mesh edges, together with the width of the line used when a mesh is sliced
and the highlight colour used when mesh parts are selected in the scene
The colours used for displaying the x, y and z axes
Grid line width, style and colour
Axes box line width, style and colour
Slicer edge width, style and colour

Leapfrog Works is installed with three colours schemes: Default, Black Background and White
Background. The scheme selected in the Schemes list will be used for all new Leapfrog Works projects
and for existing projects when they are next opened.
l

l
l

l

Experiment with the settings to see how they affect the scene window. The scene will be updated as
you make changes.
Select Revert to return to the settings in place when the Settings window was first opened.
To create a new scheme, click on an existing scheme. This is the scheme that will be used as a basis
for defining the new scheme. Next, click the New Scheme button and change its settings.
Click Factory Reset to revert to the colour schemes defined when Leapfrog Works was first
installed.

Clicking on Factory Reset to revert to the original colour schemes deletes any custom colour
schemes.

Lighting Settings
In the Settings window, click on Scene > Lighting to change how visual effects are displayed in the
scene window. You may be able to use these settings to emphasise significance in the data displayed in
the scene.
l
l

The Ambient level setting determines the overall brightness of the scene.
The Specular brightness and Specular shininess settings determine how light appears to fall on
the surfaces in the scene. The Specular brightness setting has a stronger effect when Specular
shininess is soft.

You can have up to four light sources defined for a project. By default, two light sources are defined.
Changes made to these settings are automatically applied to the scene.
l
l

Click Revert to return to the settings in place when the Settings window was first opened.
Click Factory Reset to revert to the lighting sources and settings defined when Leapfrog Works
was first installed.
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Processing Settings
In the Settings window, click on Processing to change how background processing is used to run
changes to data and models. The Automatic option creates one process for each physical CPU core on
your computer or one for every 2.5 GB of RAM, whichever is smaller. However, there is an upper limit of
8 processes.
You can manually set the number of Background processes you would like to commit resources to.
For example, you might want to use all but one process for Leapfrog Works and reserve one for other
application use.
Select Revert to return to the settings in place when the Settings window was first opened.

User Interface Settings
In the Settings window, click on User Interface to change project tree and scene toolbar options and
to enable uploading to View.

Show Tree Lines
Ticking the box for Show Tree Lines displays objects in the project tree with lines:

Enable this option if you find it useful for displaying relationships between objects in the project tree.
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Show Save Scene Button
Ticking the Show Save Scene box adds an extra button to the scene toolbar:

Click this button to save the current scene.
You can also change the scene toolbar by right-clicking on it and selecting Customise.

Upload to View
Ticking the box for Show View upload displays the View button ( ) in the Scene View toolbar:
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Tab Position
Some Leapfrog Works windows open in separate tabs that can be used either docked or detached. The
position in which tabs open is determined by the New tab position setting:
l
l
l

Open all tabs in the main window.
Open all tabs in separate windows.
Tabs can open where the last tab was moved to. This setting can be used for creating a window in
which all tables and dockable windows open, with the scene window, project tree and shape list in
another window.

Central Settings
To enable Central, open the Settings window by clicking on the Leapfrog Works menu. Select
Central and tick the box to enable Central. A Central Projects tab will appear in the main window.
If the Use Seequent ID option is enabled, Central integration is automatically enabled and cannot
be disabled.
When you connect to Central, you can download projects and work on them locally. To change the
location where projects are saved, click the Change button under Project Files and navigate to where
you want to save projects:
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The Publishing Cache settings determine where Central data is stored while publishing to Central. If
you have a small local drive and use network storage for most of your data, you can change where
temporary publishing data is stored. To do this, click on the Change button and navigate to the required
location.
The Empty Cache button clears the publishing cache folder for the connected Central Server. This
button is only active when you are connected to a Central server and should only be used if you are
having problems publishing to Central.
The Connection settings determine how you connect to the Central server.
Seequent is in the process of transitioning to using Seequent ID to connect to Central. The Use
Seequent ID setting determines whether your connections to Central are automatically configured via
your Seequent ID or whether you need to manually set up connections to Central servers.
l

l

If your organisation is using Central 3.0 or later, you will need to connecting using Seequent ID.
Enable this setting.
If your organisation has not yet upgraded to Central 3.0, you will need to connect manually using the
information provided by your administrator. Leave this setting disabled.

You will be prompted to restart when you change this setting.
The Large request timeout is used for publishing, uploading attachments and getting a revision. All
other communication with the Central server uses the Default request timeout. The Default request
timeout and Large request timeout should only be adjusted upward if you have problems with a poor
connection. The default values are 60 seconds and 600 seconds.
The Upload chunk size setting is useful if you have a poor connection. It determines the size of the
chunks used to upload large files. For example, if the Upload chunk size is 10MB and you are uploading
a 100MB file, the file will be uploaded in 10 chunks. If your connection is poor and you are experiencing
issues, you can decrease the value of the Upload chunk size.
There is an option for checking the integrity of a revision after it has been uploaded. If you wish to do
this, enable the Check file consistency after upload option.

Usage Policy Settings
When the Idle time-out setting is enabled, Leapfrog Works will prompt you after a period of inactivity.
Follow the instructions in the message displayed.
Leapfrog Works can use reference codes to track work on specific projects. The number of days
associated with each reference code is included in your organisation’s monthly usage report. In the
Settings > Usage Policy window, you can define reference codes on a per-project or per-computer
basis. Click the Add New Code button to add a code for either the computer or the currently open
project.
The other two settings can be used to ensure that you are regularly prompted to update the reference
code.
l

l

Prompt at project start up ensures that a prompt is displayed for selecting a reference code
whenever a project is opened or a new project is created.
Always required ensures that Leapfrog Works is not used without a reference code being selected.
<No Code> is not an option.
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Network Settings
If your organisation uses a proxy server to connect to the internet, you can set this up in the Settings >
Network window.
If you choose the Autodetect proxy server option, Leapfrog Works will detect the authentication
type, server address and port; there are no further settings for you to change.
If Autodetect proxy server does not work or if you need to switch between proxy servers in different
network environments, choose the Manually configure proxy server option and enter the
information provided by your IT department. The advanced settings are optional and you should only
change them from the default values if you have been instructed to do so by your IT department.
You can manually configure more than one proxy server. Click the New button to add a new profile and
enter the required settings. When you want to swap from one proxy server to another, simply select a
Profile from those already defined.
If you have multiple Seequent products running on your computer, you only need to configure network
proxy settings once. Once you have, for example, configured the proxy for Leapfrog Works, the same
settings will be used for the Central Browser.

Help Settings
If you are working on a slow connection, you can download a copy of the help that can be saved to your
hard drive. To do this:
l
l

l

Click here to download a copy of the help.
Once you have downloaded a copy of the help and installed it, select Settings from the Leapfrog
Works menu.
Click on the Help tab and then select Local folder.

Leapfrog Works help is updated at each release. If you are using a downloaded copy, you will need to
download a new copy each time you update Leapfrog Works.

Reporting a Problem
If Leapfrog Works encounters an error, the Leapfrog Works Problem window will be displayed. Enter
as much information as you can about the problem, then click Send.
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Getting Support
Technical support is available by visiting https://my.leapfrog3d.com/support/new-request.

Checking Connectivity With Seequent Start
Seequent Start checks to see if your network will support the connection of Leapfrog web-based
services to your desktop applications.
To run Seequent Start, either click the Test Web Services button in the Settings > Network
window or click on the Leapfrog Works menu and select Diagnostics > Test Web Services:

Supplying Your Licence Details
When contacting technical support, please include your licence number and a full description of the
problem or query, including any information provided in system error messages.
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You can access your licence information by selecting About from the Leapfrog Works menu:
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You may also be asked to provide a copy of the log files. To find out where these are stored, select
About from the Leapfrog Works menu, then click on the System Info. tab. Click on the link to open
the folder that contains the log files:
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Data Types
Leapfrog Works has tools for importing, creating and working with many different types of data,
including:
l
l
l
l
l
l
l
l

GIS Data, Maps and Images
Borehole Data
Design Models
Points Data
Geophysical Data
Structural Data
Meshes
Polylines

For an introduction to importing data into the project tree, working with data tables, correcting errors in
data tables and creating query filters, see the following topics in the Getting Started part of the help:
l
l
l
l

The Project Tree
Working With Data Tables
Correcting Data Errors in Leapfrog Works
Query Filters
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GIS Data, Maps and Images
Often the first data imported into a new project is information that sets the coordinates for the project
as a whole. This includes GIS data, maps and aerial photos.
You can view the attribute table for most GIS data objects by right-clicking and selecting Attribute
Table. You can also create query filters that can be used when displaying the GIS object. See the Query
Filters topic for more information.
If, during the course of a project, GIS data changes, it can be reloaded and models that are dependent on
that data will automatically be updated.

Displaying GIS Data
In Leapfrog Works, there are three ways of viewing GIS data:
l

l

l

In its “native” form, as it was imported to the project. Add the GIS data object to the scene as you
would any other object.
On the topography. GIS data objects added to a project are automatically projected onto the
topography and saved in the Topographies > Draped GIS Objects folder. Add the draped GIS
object to the scene.
Combined with other data draped on the topography. See Custom Topography Views below.

The reason for having different ways of displaying GIS data is the difficulty posed by inconsistent height
data. Not all height data is correct or wanted. In practice, it is important for all the data to be consistent.
For this reason, a single elevation field is defined as part of the topography and available data is assigned
heights from this object. The native height information is available and can be used to define the height
of layers in the models.

Custom Topography Views
In Leapfrog Works, topography can be displayed with any of the GIS data and images available in the
project. With a custom view, you can display multiple GIS data objects, maps and aerial photos.
To create a custom view, add the topography object to the scene. Select Views > Edit views from the
GIS data list:
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The Edit GIS Views window will appear. Click New to create a new view. Enter a name for the new
view and click Create:

The new view will be created in the Edit GIS Views window, together with a list of Available layers.
Use the arrows to move layers into the Current layers list and organise them:

Use the transparency and point and line size controls to emphasise data.
Click Close. The topography will be displayed in the scene with the new view applied:

Importing Vector Data
Vector data formats Leapfrog Works supports include:
l
l
l

Shape Files (*.shp)
MapInfo Files (*.tab, *.mif)
ESRI Personal GeoDatabase Files (*.mdb, *.accdb)

© 2020 Seequent Limited

202 | User Manual

You can also import data from MapInfo and ESRI databases. See Importing a MapInfo Batch File and
Importing Data from an ESRI Geodatabase for more information.
To import vector data, right-click on the GIS Data, Maps and Photos folder and select Import
Vector Data. Navigate to the folder that contains the GIS data and select the file. You can select
multiple files using the Shift and Ctrl keys.
Click Open to begin importing the data.
If you are importing a single file, the Import GIS Vector Data window will show a summary of the data
in the selected file:

You can choose what field in the data to use for the Elevation Field from the list.
If you are importing multiple files, all files being imported are listed in the Import GIS Vector Data
window and no summary of each file is displayed:

Data is automatically clipped to the clipping boundary, but you can change how the data is filtered to suit
any bounding box that exists in the project. If you do not wish to clip the data, untick the Filter data
box.
Click OK to add the data to the project. The object or objects will appear in the project tree under the
GIS Data, Maps and Photos folder. If a topography has been defined for the project, the imported
GIS data objects will automatically be projected onto the topography and saved in the Topographies >
Draped GIS Objects folder.
You can then view an object’s attributes by right-clicking on it and selecting Attribute Table.
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When importing files, you may be prompted to select whether or not to filter elevation data. If you
wish to use another data source for your elevation data, select Filter data. For example, if you
import a GIS line that has suspect elevation data, you can discard the elevation data and set the
elevation from the topography, as described in Setting Elevation for GIS Objects and Images.
If data changes outside the project, it can be reloaded as described in Reloading GIS Data.

Importing a MapInfo Batch File
You can import a collection of GIS data exported from MapInfo. The MapInfo file can include points,
lines, polygons, images and elevation grids.
To import GIS data in this way, right-click on the GIS Data, Maps and Photos folder and select
Batch Import > from MapInfo. In the window that appears, navigate to the folder that contains the
MapInfo batch file, which is an XML file. Click Open.
The data that can be imported will be displayed and you can select which files to import:

You can select multiple files using the Shift and Ctrl keys.
Data is automatically clipped to the clipping boundary, but you can change how the data is filtered to suit
any bounding box that exists in the project. If you do not wish to clip the data, untick the Filter data
box.
Click OK to import the selected files, which will be added to the GIS Data, Maps and Photos folder as
a group ( ), with the exception of elevation grids, which will be added to the Meshes folder.
Points, lines and polygons can be reloaded on an individual basis, which is described in Reloading GIS
Data.

Importing Data from an ESRI Geodatabase
You can import points, lines and polygons from an ESRI geodatabase. However, the import of raster
data is not supported.
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To import GIS points, lines and polygons in this way, right-click on the GIS Data, Maps and Photos
folder and select Batch Import > from ESRI Geodatabase. In the window that appears, navigate to
the folder that contains the database and click Open.
Leapfrog Works imports uncompressed ESRI geodatabases.
The data that can be imported will be displayed and you can select which files to import:

You can select multiple files using the Shift and Ctrl keys.
Data is automatically clipped to the clipping boundary, but you can change how the data is filtered to suit
any bounding box that exists in the project. If you do not wish to clip the data, untick the Filter data
box.
Click OK to import the selected files, which will be added to the GIS Data, Maps and Photos folder as
a group ( ). Data in the group can be reloaded individually or as a group, which is described in
Reloading GIS Data.

Reloading GIS Data
If during the course of a project GIS points, lines and polygons change, they can be reloaded and
dependent models will automatically be updated. Objects originally imported as part of an ESRI database (
) can be reloaded individually or as part of the group.
Although the GIS data will be overwritten, any elevation data set in Leapfrog Works will be retained.

Reloading Points, Lines and Polygons
To reload a GIS point, line or polygon, right-click on it in the project tree and select Reload Data.
Navigate to the folder containing the GIS file and select the file. Click Open.
The process is the same as importing GIS data. Click OK to reload the data. The original data will be
overwritten and dependent objects will be updated to reflect the new data.
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Reloading an ESRI Database
To reload an ESRI database, right-click on it in the project tree and select Reload Data. In the window
that appears, select the layers to reload, then click OK.
Points, lines and polygons imported as part of an ESRI database can also be reloaded on an individual
basis.

Importing a Map or Image
Image formats Leapfrog Works supports include:
l
l
l
l
l

PNG Files (*.png)
JPEG Files (*.jpg, *.jpeg)
TIFF and GeoTIFF Files (*.tiff, *.tif)
Windows Bitmap Files (*.bmp)
Graphics Interchange Format Files (*.gif)

If images being imported contain georeference data, that information is assumed to be correct. You can,
however, edit the information if you need to.
In Leapfrog Works, three markers ( , , ) are used to display the georeference data for imported
images. You can see these markers in the scene when you double-click on an imported image, which
opens a tab that has tools for cropping the image and editing its georeference data:
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When you switch back to the scene, you can see the georeferencing markers:

The rest of this topic describes how to work with imported images in Leapfrog Works. It is divided into:
l
l
l
l
l
l

Importing a Single Image
Importing Multiple Images
Cropping Images
Manually Georeferencing Images
Overriding Georeference Data
Exporting a Georeferenced Image

Importing a Single Image
To import a single image, right-click on the GIS Data, Maps and Photos folder and select Import
Map. Navigate to the folder that contains the image, select the file and click Open.
l

l

If the image contains georeference data, it will be imported into the GIS Data, Maps and Photos
folder.
If the image does not contain georeference data, the Import Map window will be opened so you can
add the georeference data. See Manually Georeferencing Images below. Once you have
georeferenced the image, click Import. The image will be imported into the GIS Data, Maps and
Photos folder.

Importing Multiple Images
There are two ways to import multiple images:
l

l

Right-click on the GIS Data, Maps and Photos folder and select Import Map. Navigate to the
folder that contains the files you wish to import. Select the images and click Open. The images will
be imported and added to the GIS Data, Maps and Photos folder.
In the File Explorer, select all the files you wish to import. Drag and drop them into the GIS Data,
Maps and Photos folder in Leapfrog Works.

© 2020 Seequent Limited

Cropping Images | 207

All images will be imported and added to the GIS Data, Maps and Photos folder. If an image does not
contain georeference data, you will need to open the image and add the information manually, as
described in Manually Georeferencing Images below.

Cropping Images
Images larger than 16384 by 16384 pixels will be scaled down. Reducing your images in size below
this limit will avoid scaling. You can scale down images in an external image editor, or you can crop
imported images in Leapfrog Works.
Cropping an image to only the area of interest will reduce video RAM usage and may improve graphics
performance. To crop an image, double-click on the image in the project tree. In the window that
appears, select the Crop Image button ( ) and then drag around the part of the image you wish to use.

Click on the Remove Crop button ( ) to clear the cropping.

Manually Georeferencing Images
If an image does not contain georeference data, you will need to add it manually by adding the three
reference markers ( , , ) to the image. To select a marker, click on its marker button (Marker 1,
Marker 2 or Marker 3), then move it to the required location on the image using the mouse or the
arrow keys.
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Once each marker is correctly positioned, enter the real-world X and Y coordinates for each marker:

There are two ways to do this:
l

l

Enter the coordinates for each marker in the East (X) and North (Y) fields. As you enter the
coordinates, the positions of the markers will be displayed in the scene.
Copy coordinates from the scene using the three scene markers ( ,
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The second method is useful when you already have other objects correctly georeferenced in the
project. For example, if you have a larger map in the project and wish to import a more detailed map, you
can copy the coordinates from the georeferenced map to the detailed one. To do this, move the image’s
tab so you can see enough of the scene to work in both windows:

Next:
l

In the Import Map tab, position the marker ( ,

,

) on the image being imported.

l

Click the corresponding copy coordinates marker ( ,

l

Zoom in to the point in the scene window where you wish to place the marker and click.

,

).

The coordinates in the scene will be copied to the Import Map tab.

Overriding Georeference Data
If an image being imported contains georeference data, the image will automatically be imported and
added to the GIS Data, Maps and Photos folder. To edit its georeference data, double-click on the
image to open it and tick the Override georeference data from image box. Edit the information as
described in Manually Georeferencing Images above.

Exporting a Georeferenced Image
Leapfrog Works exports georeferenced images as GeoTIFFs. To do this, right-click on it in the project
tree and select Export. You will be prompted for a filename and location. Click Save.

Setting Elevation for GIS Objects and Images
You can set the elevation for GIS objects and images by:
l
l

Using a fixed elevation
Using the elevation data from one of the object’s attributes
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l

Using the elevation data from a surface in the project

The options available depend upon the type of object.
Fixed Elevation

From Attribute

From Surface

GIS lines

X

X

X

GIS points

X

X

X

2D grids

X

-

X

GIS lines drawn in Leapfrog Works

X

-

-

GIS lines extracted from polylines

X

-

X

Images

X

-

-

To set the elevation for a GIS object or an image, right-click on it in the project tree and select Set
Elevation. The Set Elevation window will appear, displaying the available options. Select the option
required and click OK.

Creating a New GIS Line
There are three ways to create a new GIS lines object in Leapfrog Works:
l

l

l

If you do not have GIS data for a topographical feature you wish to use in model building, you can
draw a new GIS line. See Drawing a New GIS Line
If you have two surfaces that intersect, you can generate a new GIS line from their intersection. You
can use any surface in the project, including those that are generated in building models. See
Creating a New GIS Line from Intersecting Meshes.
If you have a polyline you wish to use as a GIS lines object, right-click on it in the project tree and
select Extract GIS Line. The new GIS line ( ) will appear in the GIS Data, Maps and Photos
folder. It is not linked to the original polyline.

To view new GIS line draped on the topography, select the object from the GIS data > GIS objects
list, as described in Topography Display Options.

© 2020 Seequent Limited

Drawing a New GIS Line | 211

Drawing a New GIS Line
GIS lines can be drawn on the slicer or on a surface.
Right-click on the GIS Data, Maps and Photos folder and select New GIS Line > From New
Drawing. In the window that appears, enter a name for the new object and click OK.
The object will be created in the project tree and added to the shape list. The scene view will change to
view the objects in the scene from above and tools for drawing polylines will appear. Click on the Draw
lines button ( ) and start drawing in the scene, as described in Drawing in the Scene.

When you have finished drawing, click the Save button ( ). The new line ( ) will be saved in the
project tree.
You can edit the GIS line by right-clicking on it in the project tree and selecting Edit. If it is in the shape
list, you can edit it by clicking on the Edit button ( ).

Creating a New GIS Line from Intersecting Meshes
You can create a new GIS line from two intersecting meshes. You can use any surface in the project,
including those that are generated in building models.
To create a new GIS line from two intersecting meshes, right-click on the GIS Data, Maps and
Photos folder and select New GIS Line > From Intersecting Meshes. In the window that appears,
select the meshes to use, enter a name for the new object and click OK.
The new line ( ) will be saved in the project tree. It is not linked to the meshes used to create it and will
not be updated when the meshes are updated.
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Exporting GIS Data
To export GIS data, right-click on the GIS data object in the GIS Data, Maps and Photos folder and
select Export. The Export GIS window will be displayed:

Select whether elevation information will come from the topography or from the GIS object itself, or
untick the Use 2.5D format with elevations from box to export the object without elevation
information.
Click Export. You be prompted for a filename and location.
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Borehole Data
Borehole data forms the basis for creating models in Leapfrog Works. Because borehole data often
contains errors that reduce the reliability of a model, Leapfrog Works has tools that help you to identify
and correct errors and work with the data.
Borehole data defines the physical 3D shape of boreholes. It is made up of:
l
l
l

A collar table, containing information on the location of the borehole.
A survey table, containing information that describes the deviation of each borehole.
At least one interval table, containing information on measurements such as lithology, date or any
numeric or textual values. An interval table must also include collar IDs that correspond to those in the
collar table and sample start and end depth.

You can also import downhole points.
When a project is first created, the only options available via the Borehole Data folder are for importing
data. See Importing Borehole Data for more information on these options.
Once data has been added to the project, a Boreholes object will be created that serves as a container
for the tables imported:

You can open each table by double-clicking on the table ( ). The table will be displayed and you can
make changes. See Working With Data Tables. When there are errors in the data, the relevant table will
be marked with a red exclamation mark ( ). See Correcting Data Errors in Leapfrog Works for more
information on fixing borehole data errors.
In addition to the imported borehole tables, the Boreholes object also has two objects that help in
visualising and analysing borehole data. These are:
l
l

The Borehole traces object. See Displaying Borehole Traces.
The Borehole Graphs object. See Displaying Borehole Graphs.

To delete a lithology or numeric data table, right-click on the table in the project tree and select
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Delete. You will be asked to confirm your choice.
When you right-click on the borehole or collar table object in the project tree and select Delete, the
resulting action will also remove all lithology and numeric data tables from the project. You will be
asked to confirm your choice.
The rest of this topic discusses options for displaying boreholes and viewing statistics on borehole data
tables. It is divided into:
l
l

Displaying Boreholes
Viewing Borehole Data Table Statistics

Displaying Boreholes
Viewing borehole data in the scene is an important part of refining borehole data and building a
geological model. Therefore, Leapfrog Works has a number of different tools for displaying borehole
data that can help in making borehole data processing and modelling decisions. Display borehole data in
the scene by dragging the Boreholes object into the scene. You can also drag individual tables into the
scene.
Once borehole data is visible in the scene, click on a borehole to view the data being displayed. You can
also display the data associated with each interval by clicking on the Show text button ( ) in the shape
list. Here, data display is enabled for two interval tables:
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The Show trace lines button ( ) in the shape list displays all trace lines, even if there is no data
defined for some intervals. The Filter trace lines option in the shape properties panel displays only
trace lines for boreholes selected by a query filter. See the Query Filters topic for more information.

Displaying Boreholes as Lines or Cylinders
You can display boreholes as lines or cylinders. You can also display the data associated with each
segment. Here, the boreholes are displayed as flat lines:

The width of the lines is set in the shape properties panel.
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When the Make lines solid button ( ) is enabled, the borehole data is displayed as cylinders and the
property that can be controlled is the Line radius:
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When numeric data is displayed, there is an additional option, to use a data column in the table for the
cylinder radius:

When the log button ( ) is enabled, the log of values is used for the radius.
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Hiding Lithologies
When lithology tables are displayed, you can hide some of the lithologies to help make better sense of
the information in the scene. Click on the Edit Colours button in the shape list. In the window that
appears, use the Show/Hide buttons ( ) to determine what segments are displayed:

To select multiple lithologies, use the Shift or Ctrl keys while clicking. You can then change the visibility
of all selected lithologies by clicking one of the visibility ( ) buttons.
Hiding lithologies in this way only changes how the data is displayed in the scene. Another way of
limiting the data displayed is to use a query filter (see the Query Filters topic), which can later be used
in selecting a subset of data for further processing.
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Displaying a Legend
To display a legend in the scene, click the Show legend button ( ) for the table:

The legend in the scene will be updated to reflect lithologies that are hidden in the scene when you click
Edit Colours and hide some lithologies.
To reorder the legend, click the Edit Colours button in the shape list to open the Legend window.
Click on an item in the list, then use the arrows to move it up or down. The legend shown in the scene
will be updated when you close the Legend window.

Changing Colourmaps
To change the colours used to display lithologies, click on the Edit Colours button in the shape list. In
the window that appears, click on the colour chip for each lithology and change it as described in Single
Colour Display.
Use the Shift or Ctrl keys to select multiple lithologies. This is useful for changing multiple colour
chips to a single colour or for moving multiple lithologies up and down in the list.
You can also import a colourmap, which is described in Importing and Exporting Colourmaps.
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Viewing Multiple Interval Tables
When viewing multiple interval tables, use the line and point size controls and the transparency settings
to see all the data at once. For example, here, the geology table has been made transparent to show the
contaminant intervals inside:

Selecting from Multiple Columns
When an interval table has more than one column of data, select the column to view from the view list:

Some columns are editable, in which case you can click on the Edit button ( ) to start editing the table:
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Displaying Interval Data in the Scene
Boreholes can be displayed with the data associated with each segment. For example, in the scene
below, contaminant values are displayed along the borehole:

To view data in this way, select the table in the shape list, then click on the Format Display Text
button. In the Text Format window, click Insert Column to choose from the columns available:

You can display multiple columns and add text:
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Click OK to update the formatting in the scene. You can conceal the formatting in the scene by clicking
on the Show text button ( ) in the shape list:

Clear text formatting by clicking on the Format Display Text button, then on the Delete button ( ).

Displaying Borehole Traces
Adding the Borehole traces object ( ) to the scene can be useful in visualising the extent of drilling.
You can change the colour used to display the traces, and they can be displayed as lines or cylinders. You
can also display depth markers in the scene. To do so, click on the traces in the shape list and enable the
Show depth marks option:
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Depth markers can be displayed with or without text. Enable the Show text option (( )) to display the
depth values. This option also displays the hole ID, which can be displayed at the start or the end of the
borehole.

Displaying Borehole Graphs
Downhole numeric data can be displayed in the scene as a bar graph and downhole points data can be
displayed as a line graph. To display downhole data in this way, add the Borehole Graphs object ( )
to the scene. The Borehole Graph Style Manager will be displayed, showing the data columns
available:

Data can be displayed to the right or the left of the borehole trace. Use the sliders to change the Scale
and the Offset from the trace.
Data can be clamped, e.g. all values above the set maximum value will be set to the maximum value.
If there are negative values in the data, they will be displayed on the graph with a value of zero.
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Downhole points can be displayed as a line, and you can change the Colouring, Scale and Offset of
the line:

All changes made in the Borehole Graph Style Manager are automatically updated in the scene so
you can experiment with the settings. Once you have closed the window, you can also change the Scale
and Offset by clicking on the Borehole Graphs object in the shape list:

To select a different column to display, open the style manager by double-clicking on the Borehole
Graphs object in the project tree or select a new column from the shape list.
If you are working in a new project into which you have just imported boreholes, the Borehole
Graph Style Manager will open when you add it to the scene. If the Borehole Graph Style
Manager does not open when you add the Borehole Graphs object to the scene, it is because the
styles have already been set, perhaps by another user. You can change them by double-clicking on
the Borehole Graphs object.
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Viewing Borehole Data Table Statistics
To view statistics on an interval table, right-click on the table in the project tree and select Statistics.
The following options are available:

See the Analysing Data topic for more information on each option:
l
l
l
l

Table of Statistics
Scatter Plots
Q-Q Plots
Box Plots

The Interval Length Statistics graph is a univariate graph, so for more information on the options
available, see Univariate Graphs in the Analysing Data topic.
Right-click on a numeric column and select Statistics to open a univariate graph for that column.

Importing Borehole Data
Leapfrog Works can import borehole data from the following sources:
l

l

Files stored on your computer or a network location. To start, right-click on the Borehole Data
folder and select Import Boreholes.
From a Central project’s Data Room. See Importing Drilling Data From the Central Data Room.
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l
l

From any database that runs an ODBC interface. See Selecting the ODBC Data Source.
From OpenGround Cloud. See Connecting to an OpenGround Cloud Database.

For each of these options, once the data source is selected, the process of importing borehole data is the
same. See Importing Data Tables and Mapping Data Columns for an overview of how to map data
columns in files to the format Leapfrog Works expects.
Once Leapfrog Works has imported the data, it will appear in the project tree under a new Boreholes
object.
The rest of this topic discusses the data format required for importing borehole data. It is divided into:
l
l

Expected Borehole Data Tables and Columns
AGS Format Borehole Data

Expected Borehole Data Tables and Columns
Required table types for importing borehole data are:
l
l

A collar table
At least one interval table

Downhole points tables can also be imported, but are optional.
A screens table can be imported, if you have the Hydrogeology extension.
The following formats are supported:
l
l
l
l
l
l

CSV Text File (*.csv)
AGS Files (*.ags)
ASCII Text File (*.asc)
Plain Text Files (*.txt)
Data Files (*.dat)
TSV Text Files (*.tsv)

For data imported in CSV, ASCII, TXT, DAT and TSV formats, separate files are required for each type
of table. For data imported in AGS format, a single file is imported that contains each type of table and a
summary of the relevant data is presented at each stage of the importation process so you can select
from the available groups of data.
The Collar Table
The collar table should contain five columns:
l
l
l

A borehole identifier
The location of the borehole in X, Y and Z coordinates
The maximum depth of the borehole

A collar table can also contain a trench column, and collars marked as trenches will be desurveyed in a
manner different from other boreholes. See Borehole Desurveying Options for more information.
Leapfrog Works expects a 0 for a normal hole and a 1 for a trench. If there is no trench column in the
collar table, Leapfrog Works will create one.
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The borehole ID is used to associate data in different tables with a single borehole. The ID for a borehole
must be identical in all tables in order for data to be associated with that borehole. Inconsistencies in the
way boreholes are identified are common sources of errors.
The maximum depth column is optional. If it is present, is used to validate the data imported for the
interval tables. The maximum depth specified is often a planned quantity, whereas the interval table
records actual measurements. For this reason, Leapfrog Works has an option for fixing the maximum
depth value in the collar table to match the data in an interval table.
If maximum depth information is not included in a collar file, Leapfrog Works will determine it from the
maximum depth sampled as indicated by data in the interval tables.
Boreholes in AGS format may also include a Project ID column that can be used to identify boreholes
that have the same hole ID but are actually from different projects.
The Survey Table
For the survey table, Leapfrog Works expects a minimum of four columns:
l
l

A borehole identifier
Depth, dip and azimuth values

By default, Leapfrog Works assumes that negative dip values point up. If this is not the case, tick the
Negative survey dip points down option.
Boreholes in AGS format may also include a Project ID column that can be used to identify boreholes
that have the same hole ID but are actually from different projects.
See Borehole Desurveying Options for more information on the borehole desurveying algorithms used in
Leapfrog Works.
The Screens Table
A screens table can only be imported if you have the Hydrogeology extension.
For the screens table, Leapfrog Works expects a minimum of four columns:
l
l
l

A borehole identifier
Start/from and end/to depths
A value column

Boreholes in AGS format may also include a Project ID column that can be used to identify boreholes
that have the same hole ID but are actually from different projects.
Interval Tables
For interval tables, Leapfrog Works expects, at minimum, four columns:
l
l
l

A borehole identifier
Start/from and end/to depths
A column of measurements

If a borehole ID in an interval table does not correspond to one in the collar table, the table can still be
imported but the interval table will contain errors.
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Supported column types are:
l
l
l

l

l
l

Lithology columns containing lithologic data, which can be used for geological modelling.
Numeric columns containing numeric values, which can be used for interpolating data.
Category columns, which is text representing categories such as company, geologist, or
mineralisation.
Text columns containing text data that is not categorical, such as comments. Text columns are not
validated when imported.
Date columns containing date data. Custom date and timestamps formats are supported.
URL columns. Use the prefix file:/// to link to local files.

When an interval table is displayed in the scene and an interval is selected, clicking on a link in the URL
column will open the link. This is a useful way of linking to, for example, data files or core photo images
from within Leapfrog Works:

Boreholes in AGS format may also include a Project ID column that can be used to identify boreholes
that have the same hole ID but are actually from different projects.
Points Tables
For downhole points tables, Leapfrog Works expects the following columns:
l
l

A borehole identifier
Depth

AGS Format Borehole Data
Leapfrog Works supports the importation of borehole data using the Association of Geotechnical and
Geoenvironmental Specialists (AGS) format. AGS versions 3.1 and 4 are supported. The process for
importing boreholes in AGS format is the same as that for importing data described in the rest of this
topic, except that a single file is selected for import.
For each type of table, a summary of the relevant data in the file is presented, allowing you to select
groups of data.
The Collar Table
For the collar data group, the HOLE group (v 3.1)/LOCA group (v 4.0) will automatically be selected.
Click OK to accept the selection. The selected data will be mapped and you can change how it is mapped
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as described in Importing Data Tables and Mapping Data Columns.
The Survey Table
For the survey table data group, the HOLE group (v 3.1)/HORN group (v 4.0) will automatically be
selected. Click OK to accept the selection.
If there is no survey information in the file, click OK, then click the Skip button in the Import Boreholes
window to move on to the interval table data.
Interval Tables
All remaining groups that contain suitable interval data are displayed, although you can display all groups
in the file by disabling the Only show groups suitable for interval data option.
Only one group can be selected, and typically the GEOL table contains the lithology data. However, if
you need to import more groups, there are two options:
l

l

Import the other groups as additional interval tables (see Importing Interval Tables). Select Import
From File and then select whether you wish to import intervals or points, then select the AGS file
again.
Append the dataset, as described in Adding New Rows to Existing Data Tables in the Working With
Data Tables topic.

Depth Points Tables
All remaining groups that contain points data are displayed, although you can display all groups in the file
by disabling the Only show groups suitable for depth points data option.

Importing Drilling Data From the Central Data Room
Borehole data can only be imported from a project’s data room. Although borehole data can be
published to Central, that is for the purpose of visualising the data in the Central Browser and the
Central Portal. Published borehole data cannot be imported into other Leapfrog Works projects.
See the The Project Data Room topic in the Central 4.0 help for information on how to work with a
Central project’s data room.
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To import borehole data from Central, first make sure you are connected to a Central server. Next, click
on the Borehole Data folder and select Import Boreholes via Central. In the window that appears,
select the project you wish to import data from. The Import Boreholes from Central window will be
displayed. Click the button for Collar to navigate the project’s data room to locate the collar file you
wish to use.

Select the file and click Import. Work through the files as described in Importing Borehole Data.

Selecting the ODBC Data Source
Leapfrog Works supports database files in Access Database (*.mdb, *.accdb) and gInt Project (*.gpj)
formats.
To import borehole data directly from any database that uses an ODBC interface, right-click on the
Borehole Data folder and select Import Borehole Data via ODBC. The Select ODBC Data Source
window will appear:

Enter the information supplied by your database administrator and click OK.
If you are importing from a local database file, click the Database file option and then browse to locate
the file.
Selecting Tables
In the Select Tables To Import window, select the tables you wish to import.
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To add an interval or points table, click the Add button ( ); the list of tables in the database will be
displayed. To remove a table from either list, click on it and click the Remove button ( ).
Click OK to begin the process of importing the data, which is similar to that described in Importing
Borehole Data.

Connecting to an OpenGround Cloud Database
To import drilling data via OpenGround, right-click on the Borehole Data folder and select Import
Boreholes via OpenGround Cloud. In the window that appears, enter your credentials for the
database you wish to connect to, then select the instance you will use.
In the next window, select from the projects available, then click Next.

Once the project has been opened, select the data columns to map to the Collar, Survey and Tables
lists.
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You can only select one collar table and one survey table, but you can select as many interval and point
tables as you need. Change how tables are mapped using the Import As dropdown list:

Select only as many columns as you need to work with. You can import additional data columns from
the project later.
Once you have selected the columns you wish to import, click Import to work through the data tables
and add the data to the project tree.

The import process is similar to that described in Working With Data Tables.
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The data will be added to the project tree in the Borehole Data folder:

To import additional tables, right-click on the Boreholes object and select Import from OpenGround
Cloud. Once you choose whether you will import intervals or points, the database will open and you can
choose from the tables available.
See Adding and Updating Data for Existing Tables in the Working With Data Tables topic for
information on appending and reloading borehole data.
You cannot append or reload data from a different OpenGround project.

Importing Interval Tables
Interval tables that have not been imported during the borehole data import process can be added to the
project at any time. To add an interval table, right-click on the Boreholes object in the project tree and
select from the options available:
l

l

If the interval table is stored in a file on your computer or a network location, select Import From
File > Interval Values. Leapfrog Works will ask you to specify the file location, and then will display
the data in the file in the Import Interval window.
If the interval table is stored in an ODBC database, select Import From ODBC > Interval Values.
You will be prompted to select the data source. See Selecting the ODBC Data Source.

Columns required are:
l
l
l

A borehole identifier
Start/from and end/to depths
A column of measurements
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See Expected Borehole Data Tables and Columns for more information on the supported column types.
Select the required columns and assign the data type for each column. Click Finish to import the file,
which will appear under the Boreholes object.

Importing Point Values Down Boreholes
To import a set of points on boreholes, right-click on the Boreholes object in the project tree and select
Import From File > Point Values or Import From ODBC > Point Values.
When importing from a file, Leapfrog Works will ask you to specify the file location and then will display
the data in the file in the Import Depth Points window.
When importing from ODBC, you will first be prompted to select the data source. See Selecting the
ODBC Data Source.
Columns required are:
l
l

A borehole identifier
Depth

Select the required columns and assign the data type for each column. Click Finish to import the file,
which will appear under the Boreholes object.

Importing LAS Points Down Boreholes
Leapfrog Works imports LAS points down boreholes in LAS 1.2 and LAS 2.0 formats. An imported set of
LAS files appears as one object with its associated data columns plus a LAS Boreholes folder that
contains a filter for each borehole. Importing the data preserves the metadata from the LAS files, which
can be viewed in the Properties window for the LAS points object and in the Properties window for
each borehole.
To import LAS points down boreholes, right-click on the Boreholes object and select Import From
File > LAS Data. Select the files you wish to import and click Open.
Next, the Import LAS Data window will appear. The data displayed in this window is combined from
the selected files, with blank and invalid values indicated by “nan”. For example, if a borehole file does
not contain columns that are included in other borehole files, those missing columns will be marked as
“nan”.
Leapfrog Works expects borehole ID and Depth columns and will attempt to match the data in the files
with the expected format. Select the columns to import, then click Finish. The files will be added to the
project tree as part of the Boreholes object, as described above.
To view LAS points, add the LAS points object to the scene. You can also display individual boreholes by
adding their filters to the scene.
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LAS File Mapping
The Properties window for LAS Boreholes includes a LAS Mapping tab that shows what data files
have been used for the selected borehole:

This is useful when data for a borehole originates in different files.
LAS File Inconsistencies
When importing LAS files, inconsistencies in the files are handled as follows:
l

l

l

If there are two files with the same curve values at the same depth, the duplicate values will be added
to the existing column and flagged as overlapping segments. See Correcting Data Errors in Leapfrog
Works for more information about correcting borehole data errors.
If there are more than two files with the same curve values at the same depth, Leapfrog Works will
not be able to import the files. Note the conflicting files shown in the error message and reimport the
files, leaving the conflicting files out.
If there are multiple logs of the same name in the files, Leapfrog Works will not be able to import the
data. Edit the LAS file header outside of Leapfrog Works to change the names.

Importing Downhole Structural Data
Leapfrog Works supports structural measurements in .csv or text formats. This topic describes importing
downhole structural data tables. Structural data tables that include location information can also be
imported to the Structural Modelling folder. See Importing Planar Structural Data.
To import a set of structural data on boreholes, right-click on the Boreholes object in the project tree
and select Import From File > Planar Structural Data or Import From ODBC > Planar
Structural Data.
When importing from a file, Leapfrog Works will ask you to specify the file location and then will display
the data in the file in the Import Planar Structural Data window.
When importing from ODBC, you will first be prompted to select the data source. See Selecting the
ODBC Data Source.
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Leapfrog Works expects columns describing the borehole identifier, the depth and the structural
orientation. Structural orientation can be specified using either dip and dip azimuth or alpha and beta.
Match the values in the file to the required column headers, then click Finish to import the file. The table
will appear under the Boreholes object.
If the structural orientation is specified using alpha and beta, the reference line from which the beta is
measured can be the bottom or top of the borehole. When the table is imported, the default setting is
Bottom of core. To change this, double-click on the structural data table in the project tree. Next, click
on Compatibility to change the Beta reference mark setting to Top of core:

Borehole Desurveying Options
Borehole desurveying computes the geometry of a borehole in three-dimensional space based on the
data contained in the survey table. Under ideal conditions, the borehole path follows the original dip and
azimuth established at the top of the borehole. Usually, though, the path deflects away from the original
direction as a result of layering in the rock, variation in the hardness of the layers and the angle of the drill
bit relative to those layers. The drill bit will be able to penetrate softer layers more easily than harder
layers, resulting in a preferential direction of drill bit deviation.
There are a number of paths a borehole could take through available survey measurements, but the
physical constraints imposed by drilling are more likely to produce smoother paths. Selecting the
desurveying method that gives the best likely approximation of the actual path of the borehole will
ensure that subsequent modelling is as accurate as possible.
Leapfrog Works implements three algorithms for desurveying boreholes:
l
l
l

The Spherical Arc Approximation Algorithm
The Raw Tangent Algorithm
The Balanced Tangent Algorithm

These options are described in more detail below.
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Another factor that affects how boreholes are desurveyed is how dip values are handled. When the
survey table is imported, Leapfrog Works sets the Negative survey dip points down value according
to the data in the imported table. When the majority of the dip data in the table is positive, Leapfrog
Works assumes all these boreholes will point down and leaves the field Negative survey dip points
down disabled. When most of the values are negative, the field is enabled. This field can be changed by
double-clicking on the survey table to open it and then clicking on Compatibility to show the table’s
desurveying settings:

If you are going to change the automatically set value of Negative survey dip points down, consider
carefully the implications if there is a mix of boreholes pointing down and up.
The other Compatibility setting relates to the algorithm used in desurveying the boreholes.

The Spherical Arc Approximation Algorithm
The default algorithm used in Leapfrog Works is spherical arc approximation, which is sometimes
referred to as the minimum curvature algorithm. Downhole distances are desurveyed exactly as
distances along a circular arc:

The algorithm matches the survey at the starting and end positions exactly and the curvature is constant
between these two measurements. At the survey points, the direction remains continuous and,
therefore, there are no unrealistic sharp changes in direction.
If you wish to use spherical arc approximation, there is no need to change any settings.
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The Balanced Tangent Algorithm
The balanced tangent algorithm uses straight lines but attempts to improve the accuracy of the raw
tangent algorithm by assigning equal weights to the starting and end survey measurements:

It is an improvement on the raw tangent algorithm but still suffers from an unrealistic discontinuity in the
borehole path. It is, however, a better approximation of the overall borehole path and is reasonably
accurate when the spacing between measurements is small.
To use the balanced tangent algorithm, double-click on the survey table in the project tree. Click on
Compatibility and change the Desurveying method.

The Raw Tangent Algorithm
The raw tangent algorithm assumes the borehole maintains the direction given by the last survey
measurement until the next new measurement is reached:

This implies that the borehole makes sharp jumps in direction whenever a measurement is taken, which
is unlikely, except when the borehole is being used to define a trench.
Collar tables have a trench column that indicates whether or not the borehole is from a trench. When
the trench column is ticked for a borehole, the trench will be desurveyed using the raw tangent
algorithm. Double-click on the collar table in the project tree, then tick the trench box for the boreholes
you wish to desurvey using the raw tangent algorithm.

Processing Borehole Data
Once imported and corrected, borehole data usually requires further processing before any models are
built. Use the techniques described in Displaying Boreholes to aid in making decisions on what further
processing is required.
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Often, selecting a small portion of intervals can be achieved using a query filter (see the Query Filters
topic). In some cases, however, you may wish to composite data to focus on a single unit. There may
also be issues with how borehole data has been recorded; for example, two units have been catalogued
as one, or a single unit may be divided into multiple units.
Leapfrog Works has a number of tools for processing borehole data, including:
l

l

l

l

l

l

l

l

l

Category Composites. Sometimes unit boundaries are poorly defined, with fragments of other
lithologies within the lithology of interest. This can result in very small segments near the edges of the
lithology of interest. Modelling the fine detail is not always necessary, and so compositing can be
used to smooth these boundaries.
Majority Composites. Category data can be composited into interval lengths from another table or
into fixed interval lengths. The compositing is based on a majority percentage where each interval is
assigned a category based on the category that makes up the highest percentage of the new interval.
Numeric Composites. Compositing numeric data takes unevenly-spaced borehole data and turns it
into regularly-spaced data, which is then interpolated. Numeric data can be composited along the
entire borehole or in selected regions. You can also set the compositing length from the base interval
table.
Grouping Lithologies. The group lithologies tool lets you define a new unit to which existing units are
added. For example, a sandstone deposit might appear in an interval table as poorly-sorted and wellsorted units. The group lithologies tool lets you group both units into a single sandstone unit.
Splitting Lithologies. Lithology units may be incorrectly grouped, which can become apparent when
you display boreholes in the scene. The split lithologies tool lets you create new units by selecting
from intervals displayed in the scene.
Interval Selection. If the lithologies in a column are poorly sorted, you can display the column in the
scene and use the interval selection tool to work with all the segments and sort them into new units.
Overlaid Lithology Column. You may have two versions of an interval column, one that contains draft
data and one that contains the final version. The final version may contain gaps, which can be filled in
using the draft version. The overlaid lithology tool lets you combine the two columns to create a new
column.
Category Column from Numeric Data. When you have numeric data you wish to use with the
lithology and category modelling tools, you can convert the numeric data to a category column.
Back-Flagging Borehole Data. Evaluating geological models on boreholes creates a new lithology
table containing the lithologies from the selected model.

Each of these tools creates a new interval table or creates a new column in an existing interval table,
preserving the original data. New tables and columns can be used as the basis for new models in the
project and can be incorporated into existing models using From Other Contacts options. When a
new table is created, you can view it in the scene along with the original table to see the differences
between the processed and the unprocessed data.
If you are working with columns in different interval tables, you can create a new merged table that
includes columns from these different tables. Columns created in Leapfrog Works can be included in a
merged table. See Merged Borehole Data Tables.

Category Composites
Sometimes unit boundaries are poorly defined, with fragments of other lithologies within the lithology of
interest. This can result in very small segments near the edges of the lithology of interest. Modelling the
fine detail is not always necessary, and so compositing can be used to smooth these boundaries.

© 2020 Seequent Limited

240 | User Manual

In Leapfrog Works, you can composite category data in two ways:
l

l

Composite the borehole data directly. This creates a new interval table that can be used to build
models, and changes made to the table will be reflected in all models based on that table. This
process is described below.
Composite the points used to create an object.

The rest of this topic describes compositing borehole data directly.
Right-click on the Composites folder, which is in the project tree as part of the Boreholes object, and
select New Category Composite. You will be prompted to select from the category columns available
in the borehole data. Next, the New Composited Table window will appear, showing the options for
sorting intervals in the selected column:

Compositing category data sorts segments into three categories:
l

l

l

Primary. This is the unit of interest. In the case of compositing on intrusion contact surfaces, this will
be the interior/intrusive lithology.
Ignored. These are units that are, generally, younger than the unit of interest and should, therefore,
be ignored in generating contact surfaces.
Exterior. These are units that occur outside of the unit of interest. For an intrusive lithology, other
lithologies the intrusion contacts should be classified as Exterior.
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Unspecified intervals can be handled as Ignored, Primary or Exterior.
The additional compositing parameters determine how ignored segments flanked by interior or exterior
segments are handled and the length of segments that will be filtered. Each of these settings is discussed
below.
Click OK to create the table. Once you have created a composited table, you can edit it by right-clicking
on it and selecting Edit Composited Table.
Converting Ignored Segments
The Convert enclosed ignored segments setting determines how ignored segments are handled
when they are flanked by either two interior segments or two exterior segments. If Convert enclosed
ignored segments is enabled, Leapfrog Works will convert enclosed ignored segments to match the
surrounding segments. In cases where an ignored segment does not lie between two interior or exterior
segments, it will remain ignored.
If you wish to set a maximum size for ignored enclosed segments, tick the Shorter than box and set the
maximum length.
If Convert enclosed ignored segments is disabled, this processing does not occur and ignored
segments are never converted. When an intrusive contact surface is created, this setting is disabled by
default.
For example, this scene shows two ignored segments that are flanked by the unit of interest. Because
Convert enclosed ignored segments is disabled, the segments remain ignored:
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Enabling Convert enclosed ignored segments results in the segments being converted to the
Primary unit:

Enabling Shorter than and setting it to 4 results in the shorter segment being converted to the
Primary unit and the longer segment remaining Ignored:
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Zooming out, we can see that the ignored segments at the top of the boreholes have not been
converted:

Filtering Short Segments
The Filter primary segments and Filter exterior segments parameters determine how short a
segment must be before it is composited:
l
l

Short Exterior segments flanked by Primary segments will be converted to Primary segments.
Short Primary segments flanked by Exterior segments will be converted to Exterior segments.

When the value is set the zero, no segments will be converted.
To see how these parameters can smooth the shape of a unit of interest, let’s look at a series of
boreholes where we wish to create an intrusion boundary based on the red segments. Short segments
are highlighted in the intervals that have not been composited:
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An intrusion generated from these intervals will have more detail than is necessary for modelling.
However, when compositing settings are applied and the short intervals are converted, we can see that
the intrusion boundary is more geologically reasonable:

Viewing Category Composite Statistics
Once you have created a composited table, you can view statistics on the table. To do this, right-click on
it and select Statistics. The following options are available:

See the Analysing Data topic for more information on each option:
l
l
l
l

Table of Statistics
Scatter Plots
Q-Q Plots
Box Plots

The Interval Length Statistics graph is a univariate graph, so for more information on the options
available, see Univariate Graphs in the Analysing Data topic.

Majority Composites
Category data can be composited into interval lengths from another table or into fixed interval lengths.
The compositing is based on a majority percentage where each interval is assigned a category based on
the category that makes up the highest percentage of the new interval. If two categories are equally
represented, the category that occurs further up the borehole (closest to the collar) is assigned.
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This is useful for comparing lithology and assay data; the intervals from an assay table can be applied to a
category column to produce a new lithology column with the shorter intervals typical of assay tables.
The majority composite column can then be used to create a merged table containing both lithology and
assay data.
Borehole data is composited from the Composites folder, which is in the project tree as part of the
Boreholes object. To create a majority composite, right-click on the Composites folder and select
New Majority Composite. The New Composited Table window will appear:

Select the interval table that will be used to specify the intervals for the new majority composite or
specify a fixed Compositing Length. Next, select the columns that will be composited. Click OK to
create the composite. The composite will be added to the Composites folder in the project tree. You
can edit it by right-clicking on it and selecting Edit Composited Table.
Here assay intervals are shown inside the much longer lithology intervals. The selected interval goes
from 14.0 to 23.7 metres:

Here a majority composite has been created based on the lithology table using the assay table intervals.
The category column displayed in the scene appears similar to the category column used to create it, but
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selecting an interval in the scene shows that the lithology has been composited into smaller intervals that
match the assay intervals:

Viewing Majority Composite Statistics
Once you have created a composited table, you can view statistics on the table. To do this, right-click on
it and select Statistics. The following options are available:

See the Analysing Data topic for more information on each option:
l
l
l
l

Table of Statistics
Scatter Plots
Q-Q Plots
Box Plots

The Interval Length Statistics graph is a univariate graph, so for more information on the options
available, see Univariate Graphs in the Analysing Data topic.
Right-click on the numeric columns and select Statistics to view information about the composited
values. See Univariate Graphs in the Analysing Data topic for more information.
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Numeric Composites
Compositing numeric data takes unevenly-spaced borehole data and turns it into regularly-spaced data,
which is then interpolated. Compositing parameters can be applied to entire boreholes or only within a
selected region of the borehole. For example, you may wish to composite Au values only within a specific
lithology.
There are two approaches to compositing numeric data in Leapfrog Works:
l

l

Composite the borehole data directly. Compositing parameters can be applied to entire boreholes or
only within a selected region of the borehole. This creates a new interval table that can be used to
build models, and changes made to the table will be reflected in all models based on that table. This
process is described below.
Composites the points used to create an interpolant. This is carried out by generating an interpolant
and then setting compositing parameters for the interpolant’s values object. This isolates the effects
of the compositing as the compositing settings are only applied to the interpolant.

Intervals that have no data can have a significant effect when compositing data as they are ignored
by the compositing algorithm. The effect of these missing intervals can be managed using the
Minimum coverage parameter, but it’s best to assign special values where intervals have no data.
For example, intervals that are missing data can be assigned a value of 0 or that of the background
mineralisation. See Handling Special Values for more information.
The rest of this topic describes compositing borehole data directly. It is divided into:
l
l
l
l
l

Creating a Numeric Composite
Compositing in the Entire Borehole
Compositing in a Subset of Codes
Using Intervals From Another Table
Viewing Numeric Composite Statistics

Creating a Numeric Composite
Creating a numeric composite involves the following steps:
l
l
l
l
l
l

Selecting the compositing region
Setting the composite length
Setting coverage
Setting residual length handling
Selecting an additional weighting column (optional)
Selecting the output columns

To start the process of creating a numeric composite, right-click on the Composites folder and select
New Numeric Composite. You will be prompted to select the compositing region. There are three
options:
l

l

Entire Borehole. The same compositing parameters are applied to all values down the length of
boreholes, regardless of unit breaks. See Compositing in the Entire Borehole.
Subset of Codes. Different compositing parameters can be set for each code down the length of
boreholes. See Compositing in a Subset of Codes.
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l

Intervals from other Table. Interval lengths from another table are used to determine composite
lengths. The value assigned to each interval is the length-weighted average value, and there are no
further compositing parameters to set. See Using Intervals From Another Table.

Each option requires a different set of compositing parameters, which are described below.
Once you have set up the composite, click OK to create the table, which will be saved to the
Composites folder. Double-clicking on the table displays the data in its columns. Edit the table by rightclicking on it and selecting Edit Composited Table. You can view statistics on the table or for each
individual column in the table. See Viewing Numeric Composite Statistics.
Compositing in the Entire Borehole
When compositing is carried out using the Entire Borehole option, the boreholes are divided into
intervals wherever numeric data occurs and the parameters set in the Compositing tab are applied to all
values down the length of boreholes.

Compositing Length
The Compositing length you set will depend on factors including the deposit style, the sampling
method and raw sample length. You can view statistics on the borehole data table to get an idea of the
distribution of interval lengths. Right-click on the borehole data table and select Statistics. In the
window that appears, select the Interval Length Statistics option:

Another consideration in selecting the composite length is choosing a length that will not split units. For
example, if most intervals are 2m long, choosing a length of 1m or 5m will split some intervals so that an
interval with a single value will be represented more than once in the composite intervals. If intervals are
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mostly 2.5m long, then a composite length that is 2.5m or a multiple of 2.5m would ensure that units are
not split.
Note that the actual length of intervals in the composited table may be longer than that set by the
Compositing length. This arises from residual segments at the ends of boreholes and where there
is data missing down a borehole; the length of these residual segments will, in certain conditions, be
added to the composite intervals further up the borehole. See Residual End Length Handling below
for more information.
Minimum Coverage
The Minimum coverage parameter determines whether or not a value will be calculated for a
composite interval, based on the data available in the input data table. The Minimum coverage is a
threshold the input intervals must meet in order for a composited value to be calculated. If, for example,
the Minimum coverage is 50%, a value will be calculated for a composite interval only when there is
data in at least 50% of the borehole that informs the composited interval.
l

l

Setting Minimum coverage to 100% will result in composite intervals being assigned values only
when there is data for all borehole intervals that inform the composite interval.
Setting Minimum coverage to 0% will results in all composite intervals being assigned values.

Intervals that have no data can have a significant effect when compositing data as they are ignored
by the compositing algorithm. The effect of these missing intervals can be managed using the
Minimum coverage parameter, but it’s best to assign special values where intervals have no data.
For example, intervals that are missing data can be assigned a value of 0 or that of the background
mineralisation. See Handling Special Values for more information.
Composite values are calculated for each composite interval. This is simply the length-weighted average
of all numeric borehole data that falls within the composite interval.
Composite points are generated at the centre of each composite interval from the composite values.
Residual End Length Handling
The full length of each borehole will seldom divide up exactly into a whole number of intervals of the
specified Compositing length. For this reason, “residual segments” will occur at the end of each
borehole and where there is data missing down the length of the borehole. In the Compositing tab, you
can set a residual end length value, then specify how residual segments that are shorter than that value
are handled. There are three options:
l

With the Discard option, both the length of the residual segment and the Minimum coverage
threshold determine whether the segment is discarded or retained:
l
l

l

l

Residual segments shorter than the specified length are discarded.
Residual segments longer than the specified length that meet the Minimum coverage threshold
are retained as separate segments at the end of the borehole.
Residual segments longer than the specified length that do not meet the Minimum coverage are
discarded.

With the Add to previous interval option, the Minimum coverage is automatically set to zero so
that the length of residual intervals is the sole factor in determining whether they are retained as
separate segments or added to the previous interval.
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l
l

l

Residual segments longer than the specified length are retained as separate segments.
Residual segments shorter than the specified length are added to the previous interval. Note that
when this occurs, the actual length of that last composited interval will be longer than the
Compositing length specified.

With the Distribute equally throughout borehole option, the Minimum coverage is
automatically set to zero so that the length of the residual segments is the sole factor in determining
whether they are retained as separate intervals or distributed equally throughout the other intervals.
l
l

Residual segments longer than the specified length are retained as separate segments.
Residual segments shorter than the specified length have their length distributed among the other
intervals. Note that when this occurs, the actual length of each composited interval will be longer
than the Compositing length specified.

Additional Weighting Column
If you use an Additional weighting column, the column selected must contain valid (positive) values
for all of the composite’s output intervals. If this is not the case, you will receive a message saying the
table cannot be created. If the column selected as the weighting column is also in the list of output
columns, that output column will be composited using length-weighted averaging only.
Compositing in a Subset of Codes
When compositing is carried out using the Subset of Codes option, some codes can be excluded from
the composited table or the raw data from the Base column can be used. When compositing is applied
to a code, the same parameters apply as for the Entire Borehole option, but different codes can use
different Compositing length and Minimum coverage parameters.

For the Action column, select from:
l

l

Composite. Numeric data that falls within the selected code will be composited according to the
parameters set.
No compositing. Numeric data is not composited within the selected code. The raw data will be
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l

used in creating the new data table.
Filter out. Numeric data within the selected code will excluded from the new data table.

See Compositing in the Entire Borehole above for an explanation of the Length, Minimum coverage,
If residual end length and Additional weighting column parameters.
Once you have set the compositing parameters, click on the Output Columns tab to select from the
available columns of numeric data. Click OK to create the table.
Using Intervals From Another Table
When compositing is carried out using the Intervals from other Table option, first select the Base
table. This is the table that will that will be used to determine the interval lengths in the composited
table.

The value assigned to each interval will be the length-weighted average value, and you can use an
Additional weighting column. This column must contain valid (positive) values for all of the
composite’s output intervals. If this is not the case, you will receive a message saying the table cannot be
created. If the column selected as the weighting column is also in the list of output columns, that output
column will be composited using length-weighted averaging only.
There are no further compositing parameters to set. Click OK to create the table.
Viewing Numeric Composite Statistics
Once you have created a composited table, you can view statistics on the table or for each individual
column in the table.
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To view statistics for the table, right-click on it and select Statistics.

See the Analysing Data topic for more information on each option:
l
l
l
l

Table of Statistics
Scatter Plots
Q-Q Plots
Box Plots

The Interval Length Statistics graph is a univariate graph, so for more information on the options
available, see Univariate Graphs in the Analysing Data topic.
Right-click on the table columns and select Statistics to view information about the composited values.
The first option displays statistics on the composited values; see Univariate Graphs in the Analysing Data
topic for more information. The other two options display statistics comparing data before and after
compositing.
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Compositing Comparison
The double histogram, one displaying the distribution of the raw data and one displaying the distribution
of the composited data, enables comparison of the two distributions of the same element before and
after the compositing transformation. Impacts on the symmetry of distributions will be evident.

In the Histogram settings, Bin width changes the size of the histogram bins used in the
plot.Percentage is used to change the Y-axis scale from a length-weighted scale to a percentage scale.
The Box Plot options control the appearance of the box plot drawn under the primary chart. The
whiskers extend out to lines that mark the extents you select, which can be the Min/max whiskers, the
Inner fence whiskers or the Outer fence whiskers. Inner and outer values are defined as being 1.5
times the interquartile range and 3 times the interquartile range respectively.
The Limits fields control the ranges for the X-axis and Y-axis. Select Automatic X axis limits and/or
Automatic Y axis limits to get the full range required for the chart display. Untick these and manually
adjust the X limits and/or Y limits to constrain the chart to a particular region of interest. This can
effectively be used to zoom the chart.
The bottom left corner of the chart displays a table with a comprehensive set of statistical measures for
the data set.
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Compositing Interval Lengths
This graph shows a double histogram of distributions of the interval lengths before and after
compositing.

In the Histogram settings, Bin width changes the size of the histogram bins used in the
plot.Percentage is used to change the Y-axis scale from a length-weighted scale to a percentage scale.
The Box Plot options control the appearance of the box plot drawn under the primary chart. The
whiskers extend out to lines that mark the extents you select, which can be the Min/max whiskers, the
Inner fence whiskers or the Outer fence whiskers. Inner and outer values are defined as being 1.5
times the interquartile range and 3 times the interquartile range respectively.
The Limits fields control the ranges for the X-axis and Y-axis. Select Automatic X axis limits and/or
Automatic Y axis limits to get the full range required for the chart display. Untick these and manually
adjust the X limits and/or Y limits to constrain the chart to a particular region of interest. This can
effectively be used to zoom the chart.
The bottom left corner of the chart displays a table with a comprehensive set of statistical measures for
the data set.

Grouping Lithologies
The group lithologies tool lets you define a new unit to which existing units are added. For example, a
sandstone deposit might appear in an interval table as poorly-sorted and well-sorted units. With the
group lithologies tool, you can group both units into a single sandstone unit.
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When you group lithologies, the original lithology column is preserved and a new lithology column is
added to the interval table. You can then select the original lithology column or the new one when
displaying data and creating models.
To start grouping two or more lithologies, right-click on the interval table in the project tree and select
New Column > Group Lithologies. The New Lithology Column window will appear:

Select the lithology column you wish to use from the Base Column list, then enter a Name for the new
lithology column. Click OK.
A window will appear displaying all lithologies in the base lithology column:

In this example, two spellings of Alluvium have been used and these lithologies should be combined into a
single lithology.
The most straightforward way to group lithologies is to select the first of the lithologies, then click New
Group. A group will be created for the selected lithology with only that lithology as a member:

© 2020 Seequent Limited

256 | User Manual

Next, click on a lithology in the Ungrouped Lithologies pane and drag it onto the group:

Grouping lithologies creates a new lithology column and any lithologies left in the Ungrouped
Lithologies pane will be excluded from the new column. For this reason, once you have grouped the
required lithologies, move all remaining lithologies to the Groups pane by clicking on each lithology,
then on the New Group button. This will make each remaining lithology a new group with a single
member:

When you are finished, click OK to create the new lithology column. It will appear in the project tree as an
additional lithology column in the interval table.
Select the new column from the shape list to display it:

Click on the Edit button ( ) to start editing the selected column.
The other way to group lithologies is to let Leapfrog Works create the lithology groups.
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Automatic Lithology Groups
Leapfrog Works can automatically create lithology groups. To do this, create a new lithology column, as
described above. Click the Auto Group button to reveal more options:

The First letter(s) and Last letter(s) options let you create groups according the names of the
existing lithologies. Click Group to create the new groups.
Here, the first two letters have been used to created a new set of lithologies:

The two alluvium lithologies have been added to a single group.
The One group per value option creates a group for each original lithology. You can then drag and
drop lithologies into different groups, move lithologies you do not wish to group back into the
Ungrouped Lithologies pane and use the Delete Groups options to remove any empty groups.
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Splitting Lithologies
With the split lithologies tool, you can create new units from a single unit by selecting from intervals
displayed in the scene. When you split lithologies, the original lithology column is preserved and a new
lithology column is added to the interval table. You can then select the original lithology column or the
new one when displaying data and creating models.
The difference between the interval selection tool and the split lithologies tool is that with splitting
lithologies, you are limited to selecting intervals from a single lithology. If you wish to select intervals
from multiple lithologies, see Interval Selection.
To start splitting a lithology, first add the borehole data to the scene. Then right-click on the interval
table in the project tree and select New Column > Split Lithologies. The New Lithology Column
window will appear:

Select the lithology column you wish to use from the Base Column list, then enter a Name for the new
lithology column. Click OK.
The Lithologies and Splits window will appear, together with a set of tools that will help you to select
intervals in the scene:

Alluvium (gold) appears both above and below Coarse Sand (blue) and so should be split into two
separate lithologies.
The first step is to select the lithology that will be split in the Lithologies and Splits window. In the
example above, Alluvium is already selected.
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Next, click on the Select Intervals tool ( ) and click the Add Intervals tool ( ). In the scene, draw a
line across each interval you wish to select.

To change the width of the line used to select intervals, click on the Change line width button ( )
and enter a new value. You can keep the Set Line Width window open while you select intervals so
you can change the line width as required:

Note that the current line width is indicated by the Change line width button.
Selected intervals are highlighted in the scene. If you accidentally select the wrong interval, either:
l

Click the Remove intervals button ( ) and draw across the interval once again.

l

Hold the Ctrl key while drawing across the interval.

You can also:
l
l

Select all visible intervals by clicking on the Select all button ( ) or by pressing Ctrl+A.
Clear all selected intervals by clicking on the Clear selection button ( ) or by pressing
Ctrl+Shift+A.
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l

Swap the selected intervals for the unselected intervals by clicking on the Invert selection button (
) or by pressing Ctrl+I.

Once you have selected some segments, click on the Assign to button in the Lithologies and Splits
window and select Create New Split:

The New Split window will appear:
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Enter a Name for the new lithology, then click OK. The new lithology will be created and the scene
updated to reflect the changes:

Once you have created a new lithology, you can add to it by selecting intervals, then selecting the
lithology from the Assign to list.
When you are finished, click the Save button ( ) and close the Lithologies and Splits window. The
new lithology column will appear in the project tree as an additional lithology column in the interval table.
Select the new column from the shape list to display it:

Click on the Edit button ( ) to start editing the selected column.

Interval Selection
When you wish to select a small portion of intervals or you don’t have suitable parameters to use a query
filter, you can select intervals from boreholes displayed in the scene to create a new lithology column.
The original lithology column is preserved and a new lithology column is added to the interval table. You
can then select the original lithology column or the new one when displaying data and creating models.
The difference between the interval selection tool and the split lithologies tool is that with splitting
lithologies, you are limited to selecting intervals from a single lithology. With interval selection, you
can choose intervals from any lithology displayed in the scene.
To start selecting intervals, first add the borehole data to the scene. Then right-click on the interval table
in the project tree and select New Column > Interval Selection. For a merged table, right-click on it
and select Interval Selection.
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The New Lithology Column window will appear:

Select the lithology column you wish to use from the Base Column list, then enter a Name for the new
lithology column. Click OK.
The Interval Selection window will appear, together with a set of tools that will help you to select
intervals in the scene. To select intervals, click on the Select Intervals button ( ) and click the Add
Intervals button ( ). In the scene, draw a line across each interval you wish to select:

Selected intervals are highlighted in the scene. If you accidentally select the wrong interval, either:
l

Click the Remove intervals button ( ) and draw across the interval once again.

l

Hold the Ctrl key while drawing across the interval.

You can also:
l
l

l

Select all visible intervals by clicking on the Select all button ( ) or by pressing Ctrl+A.
Clear all selected intervals by clicking on the Clear selection button ( ) or by pressing
Ctrl+Shift+A.
Swap the selected intervals for the unselected intervals by clicking on the Invert selection button (
) or by pressing Ctrl+I.

To change the width of the line used to select intervals, click on the Change line width button ( )
and enter a new value. You can keep the Set Line Width window open while you select intervals so
you can change the line width as required:
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Note that the current line width is indicated by the Change line width button.
When you have selected at least one interval, click on the Assign to button, then either select an
existing lithology or create a new lithology by selecting Create New Lithology:
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Enter a Name for the new lithology, then click OK:

The new lithology will be created and the scene updated to reflect the changes:

Once you have created a new lithology, you can add to it by selecting intervals, then selecting the
lithology from the Assign to list.
When you are finished, click the Save button ( ) and close the Interval Selection window. The new
lithology column will appear in the project tree as an additional lithology column in the interval table.
Select the new column from the shape list to display it:
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Overlaid Lithology Column
You may have two versions of an interval column, one that contains draft data and one that contains the
final version. The final version may contain gaps, which can be filled in using the draft version. The
overlaid lithology tool lets you combine the two columns to create a new column.
Both columns must be part of the same interval table. If they are not, use the merged table tool to create
a new table that contains both columns. See Merged Borehole Data Tables.
To create an overlaid lithology column, right-click on the interval table in the project tree and select New
Column > Overlaid Lithology Column. For a merged table, right-click on it and select Overlaid
Lithology Column.
The New Overlaid Lithology Column window will appear:

For the Primary column, select the column that you wish to have precedence. Data in the Fallback
column will be used when no data is available from the Primary column.
Click Create to create the new column. The new column will appear in the project tree.
You can display borehole data with the new column by selecting it from the shape list:

Category Column from Numeric Data
When you have numeric data you wish to use with the lithology and category modelling tools, you can
convert the numeric data to a category column. To do this, right-click on the numeric data column and
select New Column > Category From Numeric. In the window that appears, select the Base
Column, then enter a name for the new column. Click OK.
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The next step is to sort the numeric data into categories:

Leapfrog Works automatically assigns three categories calculated from the distribution of data. To add a
new category, click the Add button and enter the required value. Click the Open Statistics Tab button
to view the distribution of data, which will help in deciding what categories to define. See Univariate
Graphs in the Analysing Data topic for more information on using this tab.
Click OK to create the new column, which will appear in the project tree as part of the original interval
table.

Back-Flagging Borehole Data
Evaluating geological models on boreholes creates a new lithology table containing the lithologies from
the selected model. This is useful for validating models created from borehole data as you can generate
statistics for the correlation between modelled geology and drilling data.
To created a back-flagged borehole data table, right-click on the Boreholes object in the project tree
and select New Evaluation. The New Evaluation window will appear:

Select the model to use and enter names for the column and table.
When the selected model is a faulted model, the Evaluation Type setting determines whether the
model’s output volumes, faulted output volumes or fault blocks are evaluated.
Click OK to create the new table, which will appear in the project tree as part of the Boreholes object.
The new table contains From, To and Lithology columns defined using the intersection between the
model’s output volumes and the boreholes.
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For output volume evaluations, you can view the correlation between modelled geology and actual
logged borehole segments. To do this, right-click on the table and select Statistics. In the Correlation
Statistics window, you can compare model values to drilled lithologies or vice versa.
See:
l
l
l

Comparing Modelled Values to Drilling Lithologies
Comparing Drilling Lithologies to Modelled Values
Refining the Geological Model to Improve Correlation Statistics

You can export the information displayed in the Correlation Statistics window in CSV format for
use in other applications. To do this, click Export.

Comparing Modelled Values to Drilling Lithologies
Comparing model values to drilling lithologies shows how accurately drilling lithologies are
modelled in the selected geological model. High matching percentages for drilling lithologies in the lefthand side of the window mean the model closely matches the drilling data for that lithology:

The right-hand side of the window shows the composition of the modelled values for the selected
Drilling Lithology. Here, D1 in the geological model corresponds to D1 in the lithology data for 88.2%
of the length of the borehole:

D1 in the model is actually D2 for 2.37% of the length of the boreholes, and 9.44% of the drilled D1
values fall outside of the boundary of the geological model.
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In the images that follow, we will look at the correlation between the D5 drilling lithology and modelled
D5. Here, two borehole data tables are displayed with the D5-D4 contact surface from the geological
model:

The inner boreholes show the original borehole data. The outer boreholes show the geological model
back-flagged onto the borehole data table. In the highlighted borehole, we can see there is a
discrepancy between the actual lithology data and that modelled. When we view correlation statistics for
this model, we can see that this discrepancy is explained by the fact that 17.97% of the D5 drilling length
is modelled as D4:

You might consider this an acceptable match, but if it is too low, there are several ways to refine the
geological model so that the geological model more closely reflects the original boreholes, which are
discussed below. For this example, we will adjust the resolution of the geological model. The modelled
segment now corresponds more closely to the original borehole data:
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Viewing the correlation statistics shows that 99.62% of modelled boreholes now match the original
data:

Comparing Drilling Lithologies to Modelled Values
Comparing drilling lithologies to model values shows the lithological composition of modelled
values. Again, high matching percentages in the left-hand side of the window mean the model closely
matches the drilling data for that modelled lithology:

The non-matching percentage indicates how much of the modelled lithology is not the borehole
lithology. You can see in the right-hand side of the window the lithologies that make up the nonmatching portions of the modelled value.
In the images that follow, we will look at the correlation between the D5 drilling lithology and modelled
D5 once again. The non-matching percentage is 4.8, and on the right-hand side of the window, we can
see that this is exclusively drilling lithology I2:
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Adjusting the resolution of the geological model improves the matching percentage to the point where
only 0.09 percent of the D5 modelled value is drilling lithology I2:

Refining the Geological Model to Improve Correlation Statistics
If the matching percentages are too low for the lithologies of interest, there are several ways to refine
the geological model so that the geological model more closely matches the boreholes:
l

l
l

Reduce the resolution of the geological model or of its contact surfaces. See Surface Resolution for a
Geological Model and Surface Resolution in Leapfrog Works.
Add more data to the model’s surfaces. See Adding Data to Surfaces.
Snap surfaces to the data used to create them. See Honouring Surface Contacts.

Merged Borehole Data Tables
When you have more than one borehole interval table in a project, you can create a new table using
selected columns from existing interval tables. You can include columns created by, for example,
grouping or splitting lithologies or compositing.
To create a merged table, right-click on the Boreholes object in the project tree and select New
Merged Table. The New Merged Table window will appear showing all interval columns available in
the project:

You can change the columns included once you have created the table.
Select the columns you wish to include in the new table and click OK. The new table will appear in the
project tree as part of the Boreholes object.
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You can create query filters for a merged data table, as described in the Query Filters topic. You can also
select intervals (see Interval Selection) and create an overlaid lithology column (see Overlaid Lithology
Column). You cannot, however, use the group lithologies and split lithology tools on a merged table.
To edit the table, right-click on it and select Edit Merged Table.

Core Photo Links
Leapfrog Works can link borehole data to ALS Webtrieve, Coreshed and Imago core photo databases.
When you have added a core photo link to a project, a core photo link will be displayed when intervals
are clicked on in the scene:

You can click on the link to open the corresponding core photo in your browser.
Adding a core photo link also adds a button to the toolbar that allows for rapid viewing of core photos:

Once you are logged in to your core photo database, enable this mode, then click on intervals in the
scene to view core photos in the browser. To disable rapid viewing mode, click on another tool in the
toolbar.
When borehole data has been linked to a core photo database, a photo link object will appear in the
project tree:

You can only have one type of core photo link associated with the borehole data.
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To add a link, right-click on the Boreholes object and select Add Core Photo Link. In the window that
appears, select the core photo provider and click OK:

For information on setting up and using the different core photo links, see:
l
l
l

The ALS CoreViewer Interface
The Coreshed Core Photo Interface
The Imago Core Photo Interface

An alternative to linking to a core photo database is to link to files stored locally or on a network drive.
This can be achieved by having a URL column in an interval table. When the interval is selected in the
scene, you can click the link to view the file:

Use the prefix file:/// to link to local files.

The ALS CoreViewer Interface
This topic describes how to set up and use the ALS core photo interface. It is divided into:
l
l
l

Setting Up the ALS CoreViewer Interface
Using the ALS Interface
Removing the ALS Link
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Setting Up the ALS CoreViewer Interface
Before you can view core photos, you must first set up the ALS CoreViewer interface. To set up the
interface between Leapfrog Works and the ALS database, right-click on the Boreholes object and
select Add Core Photo Link. In the window that appears, select ALS CoreViewer and click OK. The
ALS Core Photo Settings window will appear. The Project Name is required to set up the link,
although the Encryption Key is optional.
For Application depths measured in, ensure that the units used for depth match in Leapfrog Works
and ALS.
For Open selection in new browser, choose whether each core photo will be opened in a separate
browser Window or Tab.
Click OK to save the information. If login is successful, the ALS Core Photo Link button ( ) will
appear in the toolbar:

A link will also appear in the project tree as part of the Boreholes object:

You can edit the link by double-clicking on it.

© 2020 Seequent Limited

274 | User Manual

Using the ALS Interface
To view core photos, click on a borehole in the scene, then click on the ALS Core Photo Link button in
the window that appears:

Your browser will be launched and you will be prompted to log in to the ALS database. Enter the User
Name and Password, which are case-sensitive. Remember to allow the browser to save the details so
that you will not be prompted to log in each time you wish to view a photo.
Your browser settings may require that you install a plugin or make changes to settings in order to
view core photos. If you are not able to access the ALS database from Leapfrog Works and have
ensured your Project Name, Encryption Key, User Name and Password have been entered
correctly, contact Customer Support as described in Getting Support.
The ALS Core Photo Link button ( ) in the toolbar allows you to view core photos in your browser in
rapid succession. To do this, first make sure you are already logged into the database. Then click on the
ALS Core Photo Link button ( ) to enable the rapid viewing mode. Each time you click on an interval
in the scene, the core photo link will open in your browser.
Position your browser window alongside the Leapfrog Works scene window to view borehole data in
Leapfrog Works alongside the core photo data.
To disable rapid viewing mode, click on another tool in the toolbar.
Removing the ALS Link
To remove the ALS link, right-click on it in the project tree and select Delete.
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The Coreshed Core Photo Interface
This topic describes how to set up and use the Coreshed core photo interface. It is divided into:
l
l
l

Setting Up the Coreshed Interface
Using the Coreshed Interface
Removing the Coreshed Link

Setting Up the Coreshed Interface
Before you can view core photos, you must first set up the Coreshed interface. To do this, right-click on
the Boreholes object and select Add Core Photo Link. In the window that appears, select Coreshed
and click OK. The Coreshed Photo Settings window will appear. Enter the information required and
select whether each core photo will be opened in a separate browser Window or Tab.
Click OK to save the information. The Coreshed Photo Link button ( ) will appear in the toolbar:

A link will also appear in the project tree as part of the Boreholes object:

You can edit the link by double-clicking on it.
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Using the Coreshed Interface
To view core photos, click on a borehole in the scene, then click on the Coreshed Photo Link button in
the window that appears:

Your browser will be launched and you will be prompted to log in to the Coreshed database. Enter the
Username and Password, which are case-sensitive. Remember to allow the browser to save the
details so that you will not be prompted to log in each time you wish to view a photo.
Your browser settings may require that you install a plugin or make changes to settings in order to
view core photos. If you are not able to access the Coreshed database from Leapfrog Works and
have ensured your Username and Password have been entered correctly, contact Customer
Support as described in Getting Support.
The Coreshed Photo Link button ( ) in the toolbar allows you to view core photos in your browser in
rapid succession. To do this, first make sure you are already logged into the database. Then click on the
Coreshed Photo Link button ( ) to enable the rapid viewing mode. Each time you click on an interval
in the scene, the core photo link will open in your browser.
Position your browser window alongside the Leapfrog Works scene window to view borehole data in
Leapfrog Works alongside the core photo data.
To disable rapid viewing mode, click on another tool in the toolbar.
Removing the Coreshed Link
To remove the Coreshed link, right-click on it in the project tree and select Delete.
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The Imago Core Photo Interface
This topic describes how to set up and use the Imago core photo interface. It is divided into:
l
l
l

Setting Up the Imago Interface
Using the Imago Interface
Removing the Imago Link

Setting Up the Imago Interface
Before you can view core photos, you must first set up the link between Leapfrog Works and the Imago
database. To do this, right-click on the Boreholes object and select Add Core Photo Link. In the
window that appears, select Imago and click OK. The Imago Settings window will appear. Select
whether each core photo will be opened in a separate browser Window or Tab. All other parameters are
optional.
Click OK to save the information. The Imago Link button ( ) will appear in the toolbar:

A link will also appear in the project tree as part of the Boreholes object:

You can edit the link by double-clicking on it.
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Using the Imago Interface
To view core photos, click on a borehole in the scene, then click on the Imago Link button in the
window that appears:

Your browser will be launched and you will be prompted to log in to the Imago database. Remember to
allow the browser to save the details so that you will not be prompted to log in each time you wish to
view a photo.
The Imago Link button ( ) in the toolbar allows you to view core photos in your browser in rapid
succession. To do this, first make sure you are already logged into the database. Then click on the Imago
Link button ( ) to enable the rapid viewing mode. Each time you click on an interval in the scene, the
core photo link will open in your browser.
Position your browser window alongside the Leapfrog Works scene window to view borehole data in
Leapfrog Works alongside the core photo data.
To disable rapid viewing mode, click on another tool in the toolbar.
Removing the Imago Link
To remove the Imago link, right-click on it in the project tree and select Delete.

Exporting Borehole Data
Changes made to the borehole data in Leapfrog Works only affect the Leapfrog Works database, not
the original data files. You can export Leapfrog Works borehole data, which is useful if you wish to keep a
copy of borehole data outside the project.
You can:
l
l
l

Export all data. See Exporting All Borehole Data.
Export all data in IFC format. See Exporting Borehole Data in IFC Format.
Export only a single data table. See Exporting a Single Borehole Data Table.
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These export options export the borehole data tables using To and From values to indicate location
information. If you wish to export data with X-Y-Z values, extract points data using one of the
following options:
l
l
l

Extracting Contact Points from Borehole Data
Extracting Intrusion Values from Borehole Data
Extracting Interval Midpoints from Borehole Data

Then export the data object as described in Exporting Points Data.

Exporting All Borehole Data
To export all borehole data, right-click on the Boreholes object and select Export. The Export
Borehole Data window will appear:

Once you have selected how you wish to export the data, click OK. The Export Borehole Data Files
window will appear:

The list shows the files that will be created, one for each data table. Choose the Folder where the files
will be saved, then enter a Base file name, which will be added to the front of each file name.
Click Export to save the files.

© 2020 Seequent Limited

280 | User Manual

Exporting Borehole Data in IFC Format
To export borehole data in IFC format, right-click on the Boreholes object and select Export > Export
to IFC. In the window that appears, select the objects you wish to include, then enter a filename.

When an object has more than one colouring option available, you must choose which one you wish to
export.
You can also:
l
l

Combine all outputs into a single archive, in ifczip format
Change the units used to export the data

Click Export to save the files.

Exporting a Single Borehole Data Table
To export a single borehole data table, right-click on that table and select Export. The Export
Borehole Data window will appear:

Once you have selected how you wish to export the data, click OK. You will be prompted for a filename
and location.
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Design Models
This topic describes how to import and work with designs and alignments in Leapfrog Works. It is
divided into:
l
l

Designs
Alignments

Designs
Leapfrog Works imports designs in the following formats:
l
l
l

DGN (*.dgn)
DWG (*.dwg)
DXF (*.dxf)

This includes Autodesk Civil 3D objects in *.dwg format.
For DGN files:
l

l

Xrefs are not supported and the externally referenced data will need to be imported into Leapfrog
Works separately.
For files that contain ‘Complex Elements’, it may be necessary to first ‘Drop Elements’ in the Bentley
design software before importing it into Leapfrog Works.

When you are importing Civil3D objects, note that some object types can be imported into Leapfrog
Works directly, while others must be exploded before they can be imported.
Object

Imported As

Notes

Alignments

Design line

Corridors

Design mesh

Feature lines

Design line

Fittings

Design mesh

Intersections

Design line

Parcels

Design line

Match lines

Design line

Pipes

Design mesh

Needs to be exploded in Civil3D

Pressure pipes

Design mesh

Needs to be exploded in Civil3D

Sample lines

Design line

Structures

Design mesh

Needs to be exploded in Civil3D

Surfaces

Design mesh

Needs to be exploded in Civil3D

Needs to be exploded in Civil3D
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To import a design, right-click on the Designs folder and select Import Designs. In the window that
appears, navigate to the folder where your design is stored and select the files you wish to import. You
can use the Shift and Ctrl keys to select multiple files. Click Open.
All models and layers available in the selected files will be displayed. Here three files have been selected
for import, FLYOVER_Tunnel, Tunnel and visualization_-_apt_block:

Select the layers you want to import. If the files contain information on more than one coordinate
system, select the system you want to use from the Coordinate system list. Click OK to import the
selected objects.
The model will be added to the project tree; expand it to see the different layers. For example, here a
Tunnel file has been expanded in the project tree, showing the different layers:

The layer colours are saved in the Layer colour object ( ), which you can double-click on to change
the colours used.
The meshes and lines in the model can be used as inputs to geological models and cross sections.

Reloading Designs
To reload a design, right-click on it in the project tree and select Reload. Navigate to the folder
containing the design file and select the file. Click Open.
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The process is the same as importing the model file. Click OK to reload the data. The original data will be
overwritten and dependent objects will be updated to reflect the new data.

Displaying Designs
Drag the different layers of the design into the scene to display them. Meshes can be displayed using a
Flat colour, the Face dip or the Layer colour. Design lines can be displayed using the Layer colour.
Double-click on the Layer colour object ( ) in the project tree to change the colours used:

Moving Designs
If all or part of the design are in the wrong location, you can move the entire design or part of it. Rightclick on the object you want to move and select the Move option. The Move Design window will
appear, together with tools in the scene for making changes. Select the part of the model you wish to
move from the Select Design Object list. Here the whole model has been selected and there is one set
of Offset values displayed in the Move Design:

Click on one of the arrows in the scene to move the design; you can only move in one plane at a time.
Updated values will be displayed in the Move Design window.
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To move just part of the model, select it from the dropdown list. The controls in the scene will adjust
only the location of the selected layer and its contents:

Click the Reset All button to return all location values to 0,0,0.
Click OK to close the Move Design window and save the new values. All parts of the model that have
been moved will be marked in the project tree with moved sign ( ). For example, here only the extent
has been moved:

You can edit the offset values by opening the Move Design window once again.

Working With Design Meshes
You can also carry out standard operations on the design meshes, including the options available for
working with meshes described in Cleaning Up a Mesh. Double-click on a design mesh in the project tree
to view the options available. Right-click on a mesh to see the other options available.
See Meshes for more information on working with meshes in Leapfrog Works.
A mesh marked with an exclamation mark ( ) is not closed.

Editing Design Lines
If you need to edit a design line, right-click on it and select Extract Polyline. The new polyline object
will appear in the Polylines folder. You can then edit the polyline and use it as an input to models and
cross sections.
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Exporting Designs
Leapfrog Works can export designs and design lines in Drawing file (2013/LT2013) (*.dwg) and Bentley
Drawing Files (v8) (*.dgn) formats.
Leapfrog Works can export design meshes in the following formats:
l
l
l
l
l
l

Leapfrog Files (*.msh)
DXF Files (11/12 [AC1009]) (*.dxf)
DXF Polyface Files (11/12 [AC1009]) (*.dxf)
Alias Wavefront Object Files (*.obj)
AutoCAD Drawing Files (2013/LT2013) (*.dwg)
Bentley Drawing Files (v8) (*.dgn)

Alignments
Leapfrog Works imports LandXML alignments as 3D alignments. The types of LandXML alignment
objects that can be imported are lines, curves and the following spiral types:
l
l
l
l
l

Clothoid
Bloss
Cubic parabola
Cubic (JP)
Sine half-wavelength diminishing tangent curve

The file should have, at a minimum, a horizontal alignment. Chainage information in the imported
alignment is taken from the horizontal alignment.
l
l

If the file contains a profile, that will appear in the project as a 3D alignment.
If the file contains a surface, that will appear as a projected alignment. An alignment can have multiple
projected alignments.

To import an alignment, right-click on the Designs folder and select Import Alignments. In the
window that appears, navigate to the folder where the alignments file is stored, select the file you wish
to import and click Open to start importing the file. If there is more than one alignment in the file, you
will be prompted to select which ones to import. Otherwise, the alignment will be imported and added
to the Designs folder.
Alignments are organised in the project tree by the imported file. For example, here two files have been
imported into Leapfrog Works. The first, 100kmAlignment.xml, contains a single alignment, whereas the
file Alignments.xml contains three separate alignments:
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The alignments in the parent file object can be expanded to show the separate parts. Here the file
imported contains a single alignment, which is made up of a horizontal alignment, a 3D alignment and a
projected alignment:

The Projected Alignments folder contains any CAD projections of the alignment that were included in
the imported file.

Reloading Alignments
To reload an alignment, right-click on its file in the project tree and select Reload:
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Navigate to the folder containing the alignment file and select the file. Click Open. You will be prompted
to select which alignments to reload:

Click OK to reload the data. The original data will be overwritten and dependent objects will be updated
to reflect the new data. If there are new alignments in the file, they will be added to the existing parent
alignment.
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Displaying Alignments
When an alignment is displayed, you can change how the chainage values are displayed using the Tick
spacing and Label occurrence controls in the properties panel. To hide the chainage values in the
scene, disable the text control (

) in the shape list.

The colour options in the shape list control the alignment colour and the tick mark and chainage values
colour:
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When the chainage values are displayed, there is also an option in the properties panel for showing the
curve points.
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Using Alignments in the Project
Alignments can be used as the basis for alignment serial sections:
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The Start Chainage value used in the New Alignment Serial Section window is taken from the
alignment selected, and the Chainage Spacing value is taken from the Tick spacing property in the
properties panel:

Note that the link between the alignment’s display properties and the alignment serial section is not
dynamic; changing the Tick spacing value does not update the value for the section.
Alignments can be evaluated onto sections as lines:
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Points Data
Points are sets of X-Y-Z coordinates, with or without associated values. In Leapfrog Works, points are
used to define surfaces and for interpolation. You can use the Points folder to:
l
l
l
l

Import points data
Extract contact points, intrusion values and interval midpoints from borehole data
Create guide points
Create grids of points that can be evaluated against geological and numeric models and exported for
use in other modelling

The rest of this topic describes importing and exporting points, setting elevation for points and
evaluating points. It is divided into:
l
l
l
l
l
l
l
l
l

Importing Points Data
Reloading Points Data
Appending Points Data
Importing a Column
Setting Elevation for Points
Evaluating Points Data
Displaying Points
Viewing Points Table Statistics
Exporting Points Data

Importing Points Data
Leapfrog Works supports the following file types for points data:
l
l
l
l

CSV files (*.csv)
ASCII text files (*.asc)
DXF files (*.dxf)
Leapfrog Works 3D Point Data files (*.pl3, *.ara)

Points data can be imported from:
l

l

Files stored on your computer or a network location. Right-click on the Points folder and select
Import Points. You will be prompted to select a file.
From any database that runs an ODBC interface. Right-click on the Points folder and select Import
Points via ODBC. See Selecting the ODBC Data Source below.

For each of these options, once the data source is selected, the process of importing the data is the
same.
The expected data columns are:
l
l

A borehole identifier
Depth

You can also import a holeID column, although this is optional.
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When importing a file that has multiple features, you will be prompted to select which ones to import.
You can also choose to:
l

l

Import the features as separate objects. Each feature will appear in the project tree as a separate
object.
Flatten all features into one object. Leapfrog Works will treat all features as a single object.

Once imported, the file will be added to the Points folder. If there are errors in the data, the errors can
be corrected as described in Correcting Data Errors in Leapfrog Works.
To view the imported data, double-click on the object that has been added to the Points folder.
Once points data has been imported to the project, it can be modified and evaluated against geological
and numeric models, as described in Evaluating Points Data.

Selecting the ODBC Data Source
When importing points data from an ODBC database, you will need to specify the ODBC data source.
Enter the information supplied by your database administrator and click OK.
Once the data source is selected, the import process is similar to that described above.

Reloading Points Data
Reloading data is necessary when the imported data is modified externally. Points data can be reloaded
by right-clicking on the table and selecting Reload Data.
Reloading points data overwrites all data in the existing table. If you have data you wish to add to the
project without overwriting existing data, use the Append Data option.
The process is similar to that for importing the original table.

Appending Points Data
If points data is stored in multiple files, you can import these files into the project and add them to
existing points data. To do this, right-click on the object you wish to append and select Append Data.
You will be prompted to select a file.
Next, the Import Tables For Appending window will be displayed.
Check the data to ensure that the correct information will be imported, then click Finish to add the new
file.

Importing a Column
Columns of points data that were not imported when the original data was imported or that are stored in
a separate file can be added to the table at any time. To do this, right-click on the points table in the
project tree and select Import Column.
The process is similar to importing the original table; select the file and map the columns you wish to
import.
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Setting Elevation for Points
You can set the elevation for points tables by projecting them onto a surface. This overwrites elevation
values in the z column of the points table, using the data from the selected surface. If the surface does
not intersect vertically with all points, you can choose how the z values for those unprojected points will
be handled.
To set the elevation for points from a surface, right-click on the points object in the project tree and
select Set Elevation. The Set Elevation window will appear:

Select from the surfaces available in the project.
Next, select how unprojected points should be handled. There are three options:
l
l
l

Assign elevation values to sets the z values to a fixed elevation for all unprojected points.
Leave elevation values empty clears the z values for all unprojected points.
Leave unchanged makes no changes to the z values for unprojected points.

Click OK to set elevation values.

Evaluating Points Data
Once points data has been imported to the project, it can be modified and evaluated against geological
and numeric models, as described in Evaluations.
In the case of geological models, you can also combine two or more models to evaluate the points data
and set the priority used for evaluation. To do this, click on the Combined Evaluation button in the
Select Models To Evaluate window. In the window that appears, select the evaluations to combined,
then set their priority. Click OK to create the combined evaluation, then click OK in the Select Models
To Evaluate window. The combined evaluation will be available from the colour list.
To delete a combined evaluation, click on the Delete Combined button in the Select Models To
Evaluate window.

Displaying Points
Points data can be displayed using a single flat colour, using a colour gradient or using the points values.
You can also import a colourmap, which is described in Colour Options.
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As with boreholes, points data can be displayed as flat points or as spheres. When Make points solid
button ( ) is enabled for points data, the data points are displayed as spheres. Here, the values are
displayed as flat points:

You can restrict the range of values displayed using the Value filter in the properties panel.
When using the spheres option, the points can be displayed using the values. To do this, the Radius
values list displays the columns available:

Select the column that will be used to determine the point size.
The Point radius control then determines the maximum point size displayed in the scene.
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Viewing Points Table Statistics
To view statistics on points data tables, right-click on a points table and select Statistics. The following
options are available:

See the Analysing Data topic for more information on each option:
l
l
l
l

Table of Statistics
Scatter Plots
Q-Q Plots
Box Plots

Exporting Points Data
To export points data, right-click on the points data object in the project tree and select Export. For
many points objects, you can select whether the exported file includes all rows, only changed rows or
only valid rows. You can also apply a query filter, if any have been defined for the table.
Points data can be exported in the following formats:
l
l
l
l

CSV Files (*.csv)
DXF Files (11/12 [AC1009]) (*.dxf)
Drawing Files (2013/LT2013) (*.dwg)
Bentley Drawing Files (v8) (*.dgn)

© 2020 Seequent Limited

Exporting Intrusion Values | 297

Additional export options are available for some types of points, which are described below.
Once you have selected how you wish to export the data, click Export. You will be prompted for a
filename and location.

Exporting Intrusion Values
Intrusion values can be extracted from borehole data as described in Extracting Intrusion Values from
Borehole Data.
There are two options for exporting intrusion values:
l

l

Export only the contact points. To do this, right-click on the intrusion values object and select
Export. If you choose this option, you can export the points in CSV format (*.csv), DXF format
(*.dxf) or DWG format (*.dwg).
Export all the points used in creating an intrusion. To do this, right-click on the intrusion values object
and select Export Volume Points. If you choose this option, you can only export the points in CSV
format (*.csv).

In both cases, you will be prompted for a filename and location.

Exporting Interval Midpoints
Interval midpoints can be extracted from borehole data, which is described in Extracting Interval
Midpoints from Borehole Data. You can also export midpoints directly from an RBF interpolant,
which is described in Exporting Numeric Model Midpoints.
To export interval midpoints, right-click on the points data object in the project tree and select Export.
Interval midpoints can be exported in the following formats:
l
l
l

CSV text file (*.csv)
Snowden Supervisor CSV file (*.csv)
Isatis 3D points file (*.asc)

The values exported are the midpoints of each segment, the X-Y-Z values and the hole ID. The Snowden
Supervisor and Isatis 3D points formats also include the interval length.
In each case, you will be prompted for a filename and location.

Extracting Points from Borehole Data
This topic describes extracting different types of points from imported borehole data. It is divided into:
l
l
l

Extracting Contact Points from Borehole Data
Extracting Intrusion Values from Borehole Data
Extracting Interval Midpoints from Borehole Data

If you wish to save and export points data with X-Y-Z information, use these options, then right-click
on the data object to export the data as described in Exporting Points Data.
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Extracting Contact Points from Borehole Data
Contact points define the boundary between two lithology layers. You can extract contact points from
interval tables to create a new points object in the Points folder. The values extracted are the x-y-z
values of the contact points.
To extract contact points from an interval table, right-click on the Points folder and select New
Contact Points. A window will appear listing the lithology and category columns available in the
project:

Select the required column and click OK.
Next, the New Contact Points window will appear:

Select the lithology required from the Select primary lithology list, then select the adjacent lithologies
you wish to extract in the Contacting lithologies list.
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Unspecified intervals are intervals that have no data. By default, unspecified intervals are ignored when
creating new contact points, but you can also treat them as the primary lithology or as contacting
lithologies.
For complex geologies, the up and down directions for the surface may not be clear. If this is the case,
untick the Horizontal Plane box. A reference plane will appear in the scene, with the up-facing surface
labelled A and the downward-facing surface labelled B:

When you disable the Horizontal plane option for the Reference Surface, the number of
contacts is longer displayed in the lithologies lists, as the number of contact points is not updated
when the reference surface used changes.
Controlling the position of the reference plane is similar to controlling the position of the moving plane:
l
l

Use the handles in the scene window to move the plane.
Set the Dip and Dip Azimuth values in the New Contact Points window. The reference plane will
be updated in the scene.

Once the reference plane is correctly oriented, click the Set From Plane button.
A reference plane set for contact points in the Points folder will be applied wherever the contact points
are used.
Click OK to create the points, which will appear in the project tree under the Points folder. To edit the
points, double-click on them.
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Extracted contact points can be exported as described in Exporting Points Data.

Extracting Intrusion Values from Borehole Data
You can extract intrusion points from interval tables to create a new points object in the Points folder.
To extract intrusion values from an interval table, right-click on the Points folder and select New
Intrusion Values. A window will appear listing the lithology and category columns available in the
project:

Select the required column and click OK.
Next, the New Intrusion window will appear:

Select the intrusion lithology, then move any younger lithologies to the Ignore list.
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Unspecified intervals are intervals that have no data. By default, unspecified intervals are ignored when
extracting intrusion values, but you can also treat them as the interior lithology or as exterior lithologies.
The settings in the Compositing tab are described in Category Composites.
Click OK to create the new points object, which will appear in the project tree under the Points folder.
To edit the points, double-click on the points object ( ) in the project tree. See Intrusion Point
Generation Parameters below.
When you view the intrusion points in the scene, you can display only the contact points or all the points
used determining the extrusion values. To display all points, click on the points object in the shape list
and tick the box for Show volume points:

Extracted intrusion points and values can be exported as described in Exporting Points Data.
Intrusion Point Generation Parameters
To change the way intrusion values are generated, double-click on the points object in the project tree:

The Edit Intrusion window will appear, displaying the Point Generation tab.
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Here, the surface and volume points are displayed to show the effects of the Surface offset distance
and Background fill spacing parameters:

The Surface offset distance parameter sets the top and bottom ends of the interval and affects how
a surface behaves when it approaches a contact point. A smaller distance restricts the angles that an
approaching surface can take. Another factor that affects the angles a surface will take is whether or not
a trend has been applied to the surface.
The Background Fill Spacing parameter determines the approximate length of segments in the
remaining intervals. If the remaining interval is not a multiple of the Background Fill Spacing value,
Leapfrog Works will automatically adjust the spacing to an appropriate value. A smaller value for
Background Fill Spacing means higher resolution and, therefore, slightly smoother surfaces.
However, computation can take longer.

Extracting Interval Midpoints from Borehole Data
You can extract interval midpoints from raw or composited numeric and category tables to create a new
points object in the Points folder. The extracted points will be dynamically linked to the original
borehole segments and can be evaluated against other data in the project. The values extracted are the
midpoints of each segment, the X-Y-Z values and the hole ID.
If you are exporting points data for use in Snowden Supervisor, use this option for extracting points
from borehole data. If you wish to export midpoints from an interpolant, see Exporting Numeric
Model Midpoints.
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To extract midpoints from an interval table, right-click on the Points folder and select New Interval
Mid Points. In the window that appears, select the required Source table, then select which data
columns to use:

Apply a query filter, if required, then click OK. The new points object will appear in the project tree under
the Points folder. To edit the points, double-click on the points object in the project tree.
Changes made to the source data table, such as changes to compositing parameters or special values
rules, will be reflected in the extracted points object.
Extracted interval midpoints can be exported as described in Exporting Points Data.

Creating Guide Points
Guide points can be created from any category point data in the project and added to surfaces. Category
data that can be used to create guide points includes:
l
l
l
l

Downhole category point data
LAS points
Category data on imported points
Interval midpoints

Guide points are classified into interior or exterior, and each guide point is assigned a distance value that
is the distance to the nearest point on the opposite side. Interior values are positive and exterior values
are negative.
Guide points are a good way of using blasthole data to control surfaces: create the guide points from the
downhole points, then add the guide points to the surface.
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To create guide points, right-click on the Points folder and select New Guide Points. A window will
appear listing the category columns available in the project:

Select the categories to assign to Interior (the positive side) and Exterior (the negative side).
You can also filter out distant values by ticking the Ignore distant values box and entering a value.
Often distant values have little effect on a surface and filtering out these values can improve processing
time.
Click OK. The guide points will appear in the project tree under the Points folder. To edit the points,
double-click on them.
Guide points can be exported as described in Exporting Points Data.

Categorising Points
When you wish to select a small portion of points and you don’t have suitable parameters to use a query
filter, you can select points in the scene and assign them to categories. This adds a new column to the
points object, preserving the original data.
To start categorising points, right-click on the points object in the project tree and select New
Category Selection.
The New Category Selection window will appear:

If you select an existing column as the Source Column, you can assign selected points to the existing
categories or create new categories. If you select <None> for the Source Column, you will have to
define each category manually.

© 2020 Seequent Limited

Categorising Points | 305

When you click OK, the points object will be added to the scene, along with a set of tools for selecting
points. To select points, click on the Select Points button ( ) and click the Add Points button ( ).
In the scene, draw a line across each point you wish to select:

Selected points are highlighted in the scene. If you accidentally select the wrong point, either:
l

Click the Remove points tool ( ) and draw across the point once again.

l

Hold the Ctrl key while drawing across the point.

You can also:
l

Select all visible points by clicking on the Select all tool ( ) or by pressing Ctrl+A.

l

Clear all selected points by clicking on the Clear selection tool ( ) or by pressing Ctrl+Shift+A.

l

Swap the selected points for the unselected points by clicking on the Invert selection tool ( ) or
by pressing Ctrl+I.

To change the width of the line used to select intervals, click on the Change line width button ( )
and enter a new value. You can keep the Set Line Width window open while you select intervals so
you can change the line width as required:
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Note that the current line width is indicated by the Change line width button.
When you have selected at least one point, click on the Assign to button, then select Create New
Lithology:

Dac
Enter a Name for the new category, then click OK.
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The new category will be created and the scene updated to reflect the changes:

Once you have created a new category, you can add to it by selecting further points, then selecting the
category from the Assign to list.
When you are finished, click the Save button ( ) and close the Category Selection window. The new
category column will appear in the project tree as an additional column in the points table. Select the
new column from the shape list to display it.
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Geophysical Data
The types of geophysical points and grids that can be imported into Leapfrog Works are:
l
l
l

2D Grids
UBC Grids
GOCAD Models

2D Grids
Leapfrog Works imports the following 2D grid formats:
l
l
l
l
l
l
l
l
l

Arc/Info ASCII Grid (*.asc, *.txt)
Arco/Info Binary Grid (*.adf)
Digital Elevation Model (*.dem)
Intergraph ERDAS ER Mapper 2D Grid (*.ers)
ESRI .hdr Labelled Image (*.img, *.bil)
SRTM .hgt (*.hgt)
Surfer ASCII or Binary Grid (*.grd)
Grid eXchange File (*.gxf)
Geosoft Grid (*.grd)

MapInfo files can be imported into the GIS Data, Maps and Photos folder. 2D grids in these files
will be saved into the into the GIS Data, Maps and Photos folder. See Importing a MapInfo Batch
File for more information.
To import a 2D grid, right-click on either the Geophysical Data folder and select Import 2D Grid.
Navigate to the folder that contains grid and select the file. Click Open to begin importing the data.
The Import 2D Grid window will appear, displaying the grid and each of the bands available. Select the
data type for each band and set the georeference information, if necessary. See Importing a Map or
Image for information on georeferencing imported files.
Once the grid has been imported, you can set its elevation, which is described in Setting Elevation for
GIS Objects and Images.
When you display the grid in the scene, select the imported bands from the shape list:

Grids can be displayed as points ( ) or as cells and the values filtered, as described in Displaying Points.
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UBC Grids
Leapfrog Works imports UBC grids in *.msh format, together with numeric values in properties files in
*.gra, *.sus, *.mag and *.den formats. UBC grids can be evaluated against geological and numeric
models, which can then be exported with the grid.

Importing a UBC Grid
To import a UBC grid, right-click on the Geophysical Data folder and select Import UBC Model. In
the window that appears, click Browse to locate the file to be imported. Click Add to add any
properties file, although these are not required.
For any properties file, click the Inactive Value field to mark cells as inactive. Doing so does not change
the data but ensures that cells with the inactive value can be hidden when the grid is displayed in the
scene. If you do not set this value when importing the grid, you can set it later by double-clicking on the
grid in the project tree.
Click Import. The grid will appear in the Geophysical Data folder.

Evaluating UBC Grids
UBC grids can be evaluated against geological and numeric models as described in Evaluations.
However, UBC grids cannot be evaluated against fault blocks and mutli-domained RBF interpolants,
although they can be evaluated against the parent geological model and the parent numeric model.
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Mapping Category Evaluations
When a UBC grid is exported with a category evaluation, category data is mapped to an editable numeric
value. You can edit this by double-clicking on the grid in the project tree, then clicking on the Export
Mappings tab:

Change the numeric value assigned to each lithology, if required. You can also change the value assigned
to blocks that have no lithology.
The Export Mappings tab does not appear for UBC grids that have no geological model
evaluations.

Exporting a UBC Grid
To export a UBC grid, right-click on it in the project tree and select Export. Select the evaluations to
export with the grid, then select a folder. Click OK to export the grid.
A UBC grid can also be exported as points to a CSV file. To do this, right-click on the grid and select
Export as Points. You will then be prompted to select a file name and location. Once you have clicked
Save, select the CSV export options for null values and numeric precision, then click OK.
The CSV file will contain:
l
l

l

X, Y and Z columns, which represent the centre of each grid block
I, J and K columns, which is the grid block index. I is in the range 1 to NI, J is in the range 1 to NJ and K
is in the range 1 to NK, where NI, NJ and NK are the grid dimensions.
One or more data columns
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GOCAD Models
To import a GOCAD model, right-click on the Geophysical Data folder and select Import GOCAD
Model. Leapfrog Works will ask you to specify the file location. Click Open to import the file.
In the window that appears, set the Subsample Rate and enter a Name for the model. Click OK to
import the model, which will appear under the Geophysical Data folder.
You can then evaluate geological models, interpolants and distance functions in the project on the
model. In the case of geological models, you can also combine two or more models to evaluate on the
model. To evaluate a model, right-click on the model object in the project tree and select Evaluations.
See Evaluations for more information.
A GOCAD model can be exported as points to a CSV file. To do this, right-click on the grid and select
Export as Points. You will then be prompted to select a file name and location. Once you have clicked
Save, select the CSV export options for null values and numeric precision, then click OK.
The CSV file will contain:
l
l

l

X, Y and Z columns, which represent the centre of each grid block
I, J and K columns, which is the grid block index. I is in the range 1 to NI, J is in the range 1 to NJ and K
is in the range 1 to NK, where NI, NJ and NK are the grid dimensions.
One or more data columns
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Structural Data
In Leapfrog Works, you can create and edit planar structural data tables directly or from other objects in
the project. Structural data can also be used to create and edit many surfaces. Downhole planar
structural data and lineations can also be imported, although structural data imported in this way cannot
be edited.
This topic describes how to work with structural data in Leapfrog Works. It covers:
l
l
l
l
l
l
l
l
l
l

Creating New Planar Structural Data Tables
Importing Planar Structural Data
Importing Lineations
Displaying Structural Data
Viewing Statistics on Structural Data
Assigning Structural Data to Categories
Editing the Orientation of Planar Structural Data
Declustering Planar Structural Data
Setting Elevation for Structural Data
Estimating Planar Structural Data

See Stereonets and Form Interpolants for information on tools for analysing structural data.
Leapfrog Works calculates strike using the American right-hand rule; when looking in the strike
direction, the plane should dip to the right.

Creating New Planar Structural Data Tables
There are two ways to create a new planar structural data table in Leapfrog Works:
l

l

Create a new table as part of creating or editing another object. See Editing Surfaces With Structural
Data.
Create a new table using the Structural Modelling folder. Use this technique when, for example,
you are creating structural data points from a map or image. Right-click on the Structural
Modelling folder and select New Planar Structural Data. In the window that appears, enter a
name for the new table and click OK.

Before creating the new data table, add the map, image or data object you wish to work from to the
scene and orient the scene for drawing the new data points.
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When a new structural data table is created, it will be added to the scene. The Planar Structural Data
window will open, together with a set of tools for adding structural data points:

Click on the New Structural Data Point button ( ) and click and drag along the strike line in the
scene to add a new data point:
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You can adjust the data point using the controls in the Planar Structural Data window:

Importing Planar Structural Data
Leapfrog Works supports planar structural measurements in .csv or text formats. This topic describes
importing structural data tables that include location information. Downhole structural data can also be
imported, as described in Importing Downhole Structural Data.
Structural data containing location information can be imported from:
l

l

Files stored on your computer or a network location. Right-click on the Structural Modelling folder
and select Import Planar Structural Data. You will be prompted to select a file.
From any database that runs an ODBC interface. Right-click on the Structural Modelling folder
and select Import Planar Structural Data via ODBC. See Selecting the ODBC Data Source
below.
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For each of these options, once the data source is selected, the process of importing the data is the
same. Leapfrog Works will display the data and you can select which columns to import:

Leapfrog Works expects East (X), North (Y), Elev (Z), Dip and Dip Azimuth columns. The
Polarity column is optional. The Base Category column can be used for filtering data once it has been
imported.
Click Finish to import the data. The structural measurements will appear in the Structural Modelling
folder.
Once the data has been imported, you can add new columns and rows and reload the data, which is
described in the Working With Data Tables topic.

Selecting the ODBC Data Source
When importing planar structural data from an ODBC database, you will need to specify the ODBC data
source. Enter the information supplied by your database administrator and click OK.
Once the data source is selected, the import process is similar to that described above.

Importing Lineations
Lineations containing location information can be imported from files stored on your computer or a
network location in .csv or text formats. To do this, right-click on the Structural Modelling folder and
select Import Lineations. You will be prompted to select a file.
Leapfrog Works expects East (X), North (Y), Elev (Z), Trend and Plunge columns. The Polarity
column is optional. The Category column can be used for filtering data once it has been imported.
Click Finish to import the data. The lineations will appear in the Structural Modelling folder.
Once the data has been imported, you can add new columns and rows and reload the data, which is
described in Adding and Updating Data for Existing Tables in the Working With Data Tables topic.
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Displaying Structural Data
Planar structural data is displayed as disks and lineations are displayed as cones. There are several ways
to change how this data is displayed. In the scene below, planar structural data is displayed using the
Flat colour option, with positive (red) and negative (blue) sides shown:

You can change the colours used to display the positive and negative sides using the controls in the
shape list. You can also display the data points as Thick disks, Flat disks or as Outlined flat disks. You
can change the Disk radius and the Disk size using the controls in the shape properties panel.
Another way of displaying planar structural data is to display the categories as different colours:

You can change the colours used to display the different categories by clicking on Edit Colours in the
shape list. In the window that appears, click on the colour chip for each category and change it as
described in Single Colour Display.
To set multiple categories to a single colour, use the Shift or Ctrl keys to select the colour chips you
wish to change, then click on one of the colour chips. The colour changes you make will be made to
all selected categories.
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The categories displayed can also be filtered by other columns in the data table, as described in Filtering
Data Using Values and Categories.
In the scene below, lineations are displayed using the Flat colour option in green:

Click the colour chip to change the colour used to display the cones in the shape list or select one of the
table’s columns:
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The length of the cones displayed in the scene is set in the properties panel. This can be a Fixed
Length, defined by the Cone length setting, or it can be scaled using the values from one of the table’s
columns:

Another way of displaying lineations is to display the categories as different colours:

You can change the colours used to display the different categories by clicking on Edit Colours in the
shape list. In the window that appears, click on the colour chip for each category and change it as
described in Single Colour Display.
To set multiple categories to a single colour, use the Shift or Ctrl keys to select the colour chips you
wish to change, then click on one of the colour chips. The colour changes you make will be made to
all selected categories.
The categories displayed can also be filtered by other columns in the data table, as described in Filtering
Data Using Values and Categories.
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Viewing Statistics on Structural Data
To view statistics on structural data and lineations, right-click on a table and select Statistics. The
following options are available:

See the Analysing Data topic for more information on each option:
l
l
l
l

Table of Statistics
Scatter Plots
Q-Q Plots
Box Plots

Bingham Analysis
The Bingham Analysis option shows the value, trend and plunge for each of the eigenvectors, along
with the Bingham mean plane and best-fit great circle:

You can select specific rows and copy them to the clipboard or copy all data to the clipboard. You can
also export the data in *.csv format.
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Fisher Statistics
The Fisher Statistics option shows the Fisher mean plane and confidence for the data in the selected
table:

You can select specific rows and copy them to the clipboard or copy all data to the clipboard. You can
also export the data in *.csv format.

Assigning Structural Data to Categories
There are two ways to initiate structural data selection: from the data object in the project tree/shape
list and from a stereonet. The advantage of initiating structural data selection from a stereonet is that
the data will be displayed both on the stereonet and in the scene window. This provides the most
flexibility for analysing what data belongs to what category. See Selecting Data in the Stereonet and
Using the Scene Window With the Stereonet for more information.
If you wish to assign planar structural data points or lineations to categories, right-click on the data table
in the project tree and select New Category Selection. First, select the Source Column. If you select
an existing column as the Source Column, you can assign selected data points to existing categories or
create new categories. If you select <None> for the Source Column, you will have to define each
category manually.
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Select points by clicking on the Select points tool ( ), then drawing over those points in the scene:

Once you have selected points, you can assign them to existing categories or create new ones. To create
a new category, click on the Assign to > Create New Category button:

Enter a name for the new category and click OK.
When you have finished selecting points and adding them to categories, close the Category Selection
window to close the editor.
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Editing the Orientation of Planar Structural Data
If you need to edit the orientation of planar structural data points, you can do so in two ways:
l

l

Edit the data in the table directly by double-clicking on the structural data table in the project tree.
See Working With Data Tables.
Edit the structural data orientation in the scene.

To edit the structural data in the scene, right-click on the table in the project tree and select Edit
Orientation in Scene. If the table is displayed in the scene, in the shape list, click on the Edit button (
). The Planar Structural Data window will appear in the scene, together with controls for editing
the data points. To edit a data point, click on it. Information about the selected point will be displayed in
the Planar Structural Data window, together with controls in the scene you can use to adjust the
point:

You can also add new data points in the same manner described in Creating New Planar Structural Data
Tables.

Declustering Planar Structural Data
If a planar structural data table contains multiple duplicate or near-duplicate measurements, you can
create a declustered structural data set that will make the table easier to work with. Declustering is
intended to work with large, machine-collected data sets rather than smaller sets that might be edited
manually.
Declustering preserves the original data table and creates the set as a “filter” by applying two
parameters: the Spatial search radius and the Angular tolerance.
l

l

The Spatial search radius determines the size of the declustering space. All points inside the
Spatial search radius are compared searching for duplicates.
The Angular tolerance measures whether points have the same or similar orientation. The
orientation of all points inside the Spatial search radius is measured and the mean taken. If a
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point’s orientation is less than the Angular tolerance from the mean, then the point is regarded as a
duplicate. The point that is retained is the one that is closest to the mean.
When a structural data set has a numeric column that gives some indication of the measurement’s
uncertainty, this column can be used to prioritise values. Select the Priority column and set how the
values should be handled.
Another factor in declustering the points is the category columns selected. When you choose multiple
category columns, all criteria must match for points to be regarded as duplicates. What this means is that
points will be kept if they have different category values in just one column, even if they meet the criteria
for duplicates established by the Spatial search radius and the Angular tolerance and match in
other columns. For example, in this table, assume that applying the Spatial search radius and the
Angular tolerance parameters without using the Lithology category results in three points. However,
including the Lithology column results in five points, indicated by the colours:

The more columns you select, the lower the likelihood that points will be regarded as duplicate.
The declustered set can be used like an ordinary structural data table. However, it is a filter on a planar
structural data table and can be used as such when the parent table is displayed in the scene. For
example, here the filters available for the planar structural data table include the query filters ( ) defined
for the table as well as the declustered set ( ):

To create a declustered structural data set, right-click on the Structural Modelling folder and select
New Declustered Structural Data. Select the source data table and a query filter, if required. Set the
parameters and the columns you wish to use, then click OK. The declustered set will be added to the
Structural Modelling folder.
Edit the set by right-clicking on it in the project tree and selecting Edit Declustered Structural Data.

Setting Elevation for Structural Data
You can set the elevation for planar structural data points or lineations by projecting the data onto a
surface. Any elevation data in the data table will be overwritten by the elevation values from the selected
surface.
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To set the elevation for planar structural data points or lineations, right-click on the table in the project
tree and select Set Elevation. The Set Elevation from Surface window will appear:

Select from the surfaces available in the project.
Unprojected points are data points that do not vertically intersect the selected surface. There are two
options for handling these points:
l
l

Leave the elevation field empty.
Assign a fixed elevation value.

Click OK to set elevation values.

Estimating Planar Structural Data
You can generate a set of planar structural measurements from points, polylines and GIS lines. To do
this, right-click on the points or lines object in the project tree and select Estimate Structural Data. In
the window that appears, enter a name for the structural data table, then click OK. The new structural
data table will appear in the project tree and you can view and edit it as described in Displaying Structural
Data and Editing the Orientation of Planar Structural Data.
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Meshes
In Leapfrog Works, meshes are used to represent surfaces in the form of vertices and triangles that
define the 3D shape of the surface. Meshes can be open or closed. Meshes are generated as part of the
model-building process, but can also be imported into a project or created directly in the project.
Leapfrog Works has several tools for adjusting meshes.
The Meshes folder contains all meshes imported into Leapfrog Works and created in Leapfrog Works
outside of the model building process.
Two types of meshes are stored in the Meshes folder:
l

l

Non-editable meshes ( ) are meshes imported into Leapfrog Works and meshes created in
Leapfrog Works from the moving plane, Meshes > Mesh Operations tools and by extracting mesh
parts from other surfaces in the project.
Editable meshes ( ) are created in Leapfrog Works from data objects such as points data, GIS data
and polylines. Editable meshes can be refined by adding more data. Editable meshes can be
interpolated meshes (using FastRBF) or triangulated meshes (using Delaunay triangulation).
Interpolated meshes can also be created from structural data and values objects.

The rest of this topic is divided into:
l
l
l
l
l

Cleaning Up a Mesh
Importing a Mesh
Reloading a Mesh
Displaying Surfaces
Exporting Meshes

Cleaning Up a Mesh
There are several options for cleaning up a mesh that can be applied to meshes imported into Leapfrog
Works and to non-editable meshes created in Leapfrog Works.
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To clean up a mesh, double-click on the mesh in the Meshes folder or right-click on the mesh and select
Open. The Cleanup Mesh window will be displayed:

The Cleanup Mesh window will also be displayed when you import meshes.
The first option, Combine identical vertices, is intended for snapping cases where vertices occupy
the exact same point in space. When enabled, vertices that have the exact same coordinates will be
merged.
When enabled, Combine identical vertices occurs before the other processing actions in the
Cleanup Mesh window.
The next option, Remove self-intersections for volumes, retriangulates self-intersecting triangles
and trims away remaining open surfaces, whether they lie inside or outside the mesh. Before applying
the Remove self-intersections for volumes option, check whether the mesh is open or closed. To
do this, right-click on it in the project tree and select Properties. Closed should be True:

A mesh may appear to be closed in the scene but the Closed property will be false. Such a mesh may be
made up of open parts that do not join up perfectly to make a closed mesh. If Remove selfintersections for volumes is enabled for such a mesh, it may disappear when it is trimmed.
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Remove self-intersections for volumes should not be enabled for surface-like open meshes.
You may wish to enable Remove self-intersections for volumes if a mesh is reporting as open but is
more volume-like than surface-like. Such a mesh may have a single open part that needs to be removed,
or it may have open parts that line up perfectly and can be retriangulated to form a closed mesh.
The next four options are automatically applied to meshes created in or imported into Leapfrog Works:
l
l
l
l

Consistently orient faces ensures that a mesh can be used for inside/outside testing.
Remove non-vertex points removes points that are not used by any triangles.
Remove degenerate faces removes triangles with duplicate vertices.
Orient concentric parts ensures that internal parts have the correct orientation.

Other options are:
l
l
l
l

Invert mesh orientation reverses the polarity of the mesh.
Remove vertical edges removes any vertical faces from the mesh boundary.
Rotate locations about X axis lets you rotate the mesh 90 degrees clockwise or anticlockwise.
Move Mesh lets you offset the mesh by a vector. Tick the Move Mesh box and enter the required
values. The offset values can be changed by opening the Clean Mesh window once again.

Select the options required, then click OK.
The mesh will be added to the project tree under the Meshes folder.

Importing a Mesh
Mesh formats Leapfrog Works supports include:
l
l
l
l
l
l

Leapfrog Works Attribute Binary Mesh Formats (*.msh, *.ara)
DXF Polyface Files (11/12 [AC1009]) (*.dxf)
Alias Wavefront Object Files (*.obj)
Leapfrog Model Files (*.lfm)
Bentley Drawing Files (v8) (*.dgn)
AutoCAD Drawing Files (2013/LT2013) (*.dwg)

Once a mesh has been imported to the project, you can evaluate it against any interpolant or distance
function in the project. See Evaluations for more information.
To import a mesh, right-click on the Meshes folder and select Import Mesh. Navigate to the folder
that contains the mesh file and select the file. You can select multiple files using the Shift and Ctrl keys.
Click Open to import the file.
The Cleanup Mesh window will be displayed. See Cleaning Up a Mesh. Select the options required,
then click OK.
The mesh will be added to the project tree under the Meshes folder.
Meshes imported into Leapfrog Works may exhibit geometries that cannot be used computationally
by Leapfrog Works. See Visualising Issues With Imported Meshes for information on how to identify
issues with imported meshes.
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Meshes With Textures
l
l
l
l
l

PNG Files (*.png)
JPEG Files (*.jpg, *.jpeg)
TIFF and GeoTIFF Files (*.tiff, *.tif)
Windows Bitmap Files (*.bmp)
Graphics Interchange Format Files (*.gif)

The texture is automatically imported when the mesh is imported and will appear in the project tree
under the mesh.

Reloading a Mesh
Meshes imported into Leapfrog Works and created from extracting mesh parts can be reloaded. To do
this, right-click on the mesh in the project tree and select Reload Mesh. Navigate to the file that should
be used and click Open.

Displaying Surfaces
Leapfrog Works assigns different colours to each side of a surface.
A basic mesh will have an inside (coloured red) and an outside (coloured blue):

In the case of contact surfaces, each side will be assigned a lithology. “Unknown” will be used if multiple
lithologies are contacted. Contact surfaces can be displayed using the assigned lithologies or the
younging direction:

When a contact surface is displayed by its younging direction, the younger side of the surface will be
displayed in green and the older side in brown.
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Surfaces that are part of a geological model or interpolant are, by default, displayed clipped to the model
boundary:

Disable the Clipped surface button ( ) to view the surface unclipped.

Draping an Image on a Mesh
You can drape images on any mesh in the Meshes folder. To do this, right-click on the mesh in the
Meshes folder and select one of the Drape Image options.
l

l

For the Import Image option, you will be prompted for a file location. Navigate to the folder
containing the image you wish to drape, select the file and click Open. Set georeferencing
information for the image, if required, then click OK. See Importing a Map or Image for more
information on georeferencing images. The imported image will appear in the project tree under the
mesh.
For the Select Existing Image option, select from the images available in the project and click OK.
A hyperlink to the image will appear in the project tree under the mesh.

You can drape as many images as required. When the mesh is displayed in the scene, you will be able to
select any draped images from the list of display options.
When you import and georeference an image, you can then export it as a GeoTIFF. To do this, rightclick on it in the project tree and select Export. You will be prompted for a filename and location.
Click Save.

Exporting Meshes
Leapfrog Works exports meshes in the following formats:
l
l
l
l
l

Leapfrog Files (*.msh)
DXF Files (*.dxf)
Alias Wavefront Object Files (*.obj)
Drawing Files (2013/LT2013) (*.dwg)
Bentley Drawing Files (v8) (*.dgn)

You can export single meshes or batch export meshes from the Meshes folder or from individual
models. Each of these is described below:
l
l
l

Exporting a Single Mesh
Exporting Multiple Meshes from the Meshes Folder
Exporting Multiple Meshes from Models

© 2020 Seequent Limited

330 | User Manual

Exporting a Single Mesh
To export a mesh, right-click on the mesh and select Export. The Export Mesh Parts window will
appear:

An Export clipped mesh option is available for meshes that are clipped to a boundary:

If the quality of the mesh produced is not acceptable, clip the mesh as described in Clipping a Mesh,
then export the mesh.
Select the Parts to Export, then click OK. You will be prompted for a filename and location.
When exporting a mesh that has multiple parts, you can distinguish between the different parts by
clicking on them in the Export Mesh Parts window. Here, the mesh was added to the scene before the
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Export Mesh Parts window was opened. Clicking on a mesh part in the list selects that part in the
scene:

If the mesh is not in the scene when the Export Mesh Parts window is opened, selecting a part in the
list will display it in the scene without reference to the other parts of the mesh:
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Use the Shift and Ctrl keys to select and view multiple mesh parts in the scene:

Exporting Multiple Meshes from the Meshes Folder
To export multiple meshes from those in the Meshes folder, right-click on the Meshes folder and select
Export Meshes. In the window that appears, select the meshes you wish to export:
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The filename that will be used for each mesh is shown in the Filenames column. To change the
filename for any of the meshes, click on its name in the Filenames column.
Next, select the format required and where to save the exported meshes. Available formats are:
l
l
l
l
l
l
l

Leapfrog Model Files (*.lfm)
Industry Foundation Classes Format 4 (*.ifc)
Leapfrog Files (*.msh)
DXF Files (*.dxf)
Alias Wavefront Object Files (*.obj)
Drawing Files (2013/LT2013) (*.dwg)
Bentley Drawing Files (v8) (*.dgn)

Click Export to save the meshes.

Exporting Multiple Meshes from Models
You can export multiple meshes from individual geological models, numeric models, combined models
and static models. To export meshes in this way, right-click on a model or interpolant and select Export.
In the window that appears, select the volumes and surfaces you wish to export:

For geological models, if you wish to export surfaces other than the output volumes, untick the Only
Output Volumes option.
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For faulted geological models, you also can select from the faulted volumes by ticking the Faulted
Volumes box:

The filename that will be used for each mesh is shown in the Filenames column. To change the
filename for any of the meshes, click on its name in the Filenames column.
Next, select the format required and where to save the exported meshes. Available formats are:
l
l
l
l
l
l
l

Leapfrog Model Files (*.lfm)
Industry Foundation Classes Format 4 (*.ifc)
Leapfrog Files (*.msh)
DXF Files (*.dxf)
Alias Wavefront Object Files (*.obj)
Drawing Files (2013/LT2013) (*.dwg)
Bentley Drawing Files (v8) (*.dgn)

For any of the export options other than Leapfrog Model Files format and Industry Foundation Classes
format, you can save the meshes as a zip file.
The Leapfrog Model File format exports a single *.lfm file. If the file is imported into the Meshes
folder, each output volume will appear as a single mesh.
Click Export to save the meshes.
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Visualising Issues With Imported Meshes
Meshes imported into Leapfrog Works may exhibit geometries that cannot be used computationally by
Leapfrog Works. For example, problems often arise when a mesh has holes, self-intersections or is nonmanifold, and such problematic meshes need to be fixed before they can be used in Leapfrog Works.
Leapfrog Works can identify and work with certain situations, such as non-manifold meshes with shared
edges with an even number of adjoining triangles, and for other cases Leapfrog Works provides some
tools that may fix some meshes. Note that blindly utilising these tools can result in undesirable side
effects, so it is best to have a good understanding of the precise nature of the problems prior to selecting
and utilising any repair options. Alternatively, understanding the location and nature of the problem may
permit manual intervention in the tool generating the mesh that is being imported to Leapfrog Works.
This topic describes how to identify issues in imported meshes. It is divided into:
l
l
l
l

Examining Mesh Properties
Visualising Self Intersections
Visualising Borders
Options for Handling Mesh Issues

Examining Mesh Properties
After importing a mesh, right click on it in the project tree and select Properties. Information in the
General tab can give some insight into any problems with the mesh. These are the Properties window
for an open mesh (left) and a closed one:

The Closed, Consistent and Manifold properties are shown for all meshes:
l
l
l

A “closed” mesh is one for which no borders have been detected.
A mesh is regarded as “consistent” when its inside can be distinguished from its outside.
A manifold mesh is a closed mesh for which Leapfrog Works can calculate a volume. If there are
issues with parts of the mesh and the volume cannot be calculated, the mesh will be flagged as “nonmanifold”, which, in Leapfrog Works, is a general term for geometry issues that limit a mesh’s use.
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Some non-manifold meshes can be utilised such as meshes with shared edges that have an even
number of adjoining triangles.
Information about Borders, Edges and Length is shown for open meshes:
l
l
l

“Borders” are boundary edges that are not connected to another triangle.
“Edges” indicates the number of triangle edges that make up the border.
“Length” is the total length of all border edges.

When Leapfrog Works detects errors in the mesh, additional information is provided in an Errors tab.

Visualising Self Intersections
A mesh with self-intersections is often regarded as open, which limits the mesh’s use in Leapfrog Works.
The Errors tab in the Properties window provides a full list of each self-intersection triangle, but this is
not useful for visualising where the self-intersections occur. There are three options for visualising selfintersections, which can be used alone or together.

© 2020 Seequent Limited

Visualising Self Intersections | 337

The first option is to add the mesh to the scene and display it by its self intersections, which is one of the
colouring options available in the shape list:

The self intersections may be so tiny that visualising them in this way is not useful. You could then use the
second option for displaying self-intersections: Using the self intersections object in the project tree.
The self intersections object is a sub-mesh that replicates the parts of its parent mesh that have the
problematic self-intersections. Its like a copy of the mesh with the valid parts filtered out, and it can be
displayed in the scene in the same manner as other meshes. Remove the whole mesh from the scene and
add only the self intersections object:
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Make sure Show faces ( ) is on and Smooth faces ( ) is off. Pick front and back face shading
colours that contrast with your chosen background colour, pale shades on dark backgrounds, dark
shades on pale backgrounds.
The problematic triangles can be invisibly small. Pressing the Home button and zooming in to fill the
screen can work well if triangles are few and close together.
Use the scroll wheel to quickly zoom in and out, and click-and-drag the left-and-right mouse buttons
to pan.
If, however, the self intersections are spaced at opposite ends of the original mesh, you probably still
won’t be able to see them, in which case, the third option for displaying self intersections may be useful.
This involves using the Extract Mesh Parts window to view different parts of the mesh. To do this,
clear the scene. Next, right-click on the mesh (not the self intersections sub-object) and select
Extract Mesh Parts:

In the window that appears, you can sort the mesh parts by either their volume or area and view only the
smaller volumes, those likely to be the self intersections, one by one:
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Whichever row is selected will appear in the scene behind, as seen above. There are buttons to Select
All and Remove All that tick or untick all the mesh parts. Remove Inside-Out will untick any selected
meshes that have a different 'sign' from the first mesh part in the list. If the first mesh part is positive, the
button will untick selected negative -volume meshes; if the first mesh part is negative, the button will
untick selected positive-volume meshes. Remove Below Current will untick all mesh parts below the
currently selected mesh part.
Tick the mesh parts you want to extract and click OK to have a new object added to the project tree that
contains only the extracted mesh parts. Now you can add only the selected mesh parts into the scene.
Once you’ve identified the areas of interest, add the whole mesh to the scene. Because you will have the
mesh itself and its self intersections displayed, you can independently control the visibility of each. On
the whole mesh, change the colouring selector to self intersections and the mesh will show hot colours
where the mesh is intersected. Try turning Show faces ( ) off but Show edges ( ) on to see just
the wireframe of the mesh. You can also adjust the opacity of the mesh to make the whole mesh into a
pale background so that the self intersection mesh stands out. To get a better picture of the geometry of
the mesh around the self-intersecting triangles, move the scene around to see the shape better in 3D.
Click the middle mouse button (scroll wheel button) on a self-intersecting triangle to set the centre of
rotation on that triangle. Then click-and-drag the scene up and down and left and right and around to
orbit around the point of interest. This will help you visualise the context better.

The self-intersecting triangles can at times look very simple, but zooming in very close to the corners,
edges and contacts between triangles may reveal some very small triangles you hadn’t previously
noticed.
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You can choose to Export the self intersections mesh sub-object, which will only offer the mesh parts
that Leapfrog Works has identified as self intersections. Right click the self intersections mesh subobject and select Export. You will get a similar mesh part selection window to the one described above,
but with the addition of a Flip Mesh option to invert the inside/outside identification of the mesh
surfaces.
The Cleanup Mesh window has a Remove self-intersections for volumes option that can be useful
in fixing some self intersections:

The Cleanup Mesh window can be opened by double-clicking on an imported mesh in the project
tree. See Cleaning Up a Mesh for more information.
The Remove self-intersections for volumes repair option re-triangulates self-intersecting triangles
and trims away remaining open surfaces, whether they lie inside or outside the mesh.
l

l

Before applying the Remove self-intersections for volumes option, check whether the mesh is
open or closed. A mesh may appear to be closed in the scene but the Closed property will be false.
Such a mesh may be made up of open parts that do not join up perfectly to make a closed mesh. If
Remove self-intersections for volumes is enabled for such a mesh, it may disappear when it is
trimmed.
Remove self-intersections for volumes should not be enabled for surface-like open meshes. You
may wish to enable Remove self-intersections for volumes if a mesh is reporting as open but is
more volume-like than surface-like. Such a mesh may have a single open part that needs to be
removed, or it may have open parts that line up perfectly and can be re-triangulated to form a closed
mesh.
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If you enable this option, check the resulting mesh’s properties and that is appears in the scene as you
expect.

Visualising Borders
Leapfrog Works may regard a mesh as open when it appears to be closed. Here a mesh that appears to
be a closed volume is displayed in the scene:

To visualise where the borders are on the mesh, add the border edges mesh sub-object to the scene.
Here a green line highlights where the small border is, representing a tear in the mesh:

You can right click the border edges sub-object in the project tree and select Export to export
Leapfrog Works polylines in *.LFPL format.
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Visualising Non-Manifold Edges
Non-manifold edges are a common reason that a volume cannot be calculated for the mesh. This mesh
is reporting a non-manifold mesh problem :

To visualise where the non-manifold edges are on the mesh, add the non-manifold edges mesh subobject to the scene. Here a green line highlights where the non-manifold edge is:
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You can right click the non-manifold edges sub-object in the project tree and select Export to export
Leapfrog Works polylines in *.LFPL format.

Options for Handling Mesh Issues
Key questions to ask with regard to mesh issues are:
l
l
l

Can the mesh be fixed in the application of origin?
Do you need to use the affected part of the mesh?
Can you extract the parts of the mesh you need to work with?

The best option for issues with an imported mesh is to fix the issues in the application of origin, and
diagnosing the issues in Leapfrog can be of some help in doing so. But when fixing the mesh outside
Leapfrog Works is not possible, there are mesh repair options available through the Cleanup Mesh
window. This is opened when meshes are imported, but you can also open it by double-clicking on a
mesh:

However, some options can have unexpected results and so it is best to have a good understanding of
the precise nature of the problems prior to selecting and utilising any repair options. The Cleanup Mesh
window can be opened by double-clicking on an imported mesh in the project tree. See Cleaning Up a
Mesh for more information.
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When these mesh repair options cannot fix the problems, consider whether you need to use the problem
part of the mesh. It could be that the issues you have identified lie outside the are in which you are
modelling. If Leapfrog Works does not limit the use of this mesh in your model, using the mesh might not
be an issue.
If you do not need to use the problem part of the mesh but Leapfrog Works limits your use of the mesh
due to the errors identified, you could use the Extract Mesh Parts tool to extract the parts of the mesh
you want to work with, leaving out the parts that have issues.
If you cannot resolve issues with a mesh, contact support as described in Getting Support. When doing
so:
l
l

Include a zipped copy of the project that includes the mesh.
Identify the source of the mesh.
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Non-Editable Meshes
Leapfrog Works provides you with several tools for creating non-editable meshes:
l
l
l
l
l
l

Mesh from the Moving Plane
Combining Meshes
Clipping a Volume
Clipping a Mesh
Merging 2D Meshes
Extracting Mesh Parts

These tools produce non-editable meshes ( ).

Mesh from the Moving Plane
When a vertical wall, flat fault plane or other flat geological surface is required, the moving plane can be
used to create a simple mesh.
To create a new mesh from the moving plane, first display the plane in the scene by clicking on the
Show Plane button ( ). Use the controls in the scene to position the plane, then right-click on the
Meshes folder and select Mesh From Moving Plane. The Mesh From Plane window will appear:

Set the Resolution for the mesh, enter a name and click OK. The new mesh will appear in the Meshes
folder.
See Surface Resolution in Leapfrog Works for more information on the resolution setting.
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Combining Meshes
To create a new mesh from two existing closed meshes, right-click on the Meshes folder and select
Mesh Operations > Boolean Volume. The Boolean Volume window will appear:

The Available list shows all closed meshes available in the project. Select a mesh by double-clicking on
it or by clicking on it, then on the arrow.
The Operation type can be Intersect or Union.
Click OK to save the new mesh, which will appear in the Meshes folder. To edit the mesh, double-click
on it. The Boolean Volume window will appear.
When any of the meshes used to create the volume is modified, the volume will be updated.

Clipping a Volume
To clip a closed mesh using another mesh, right-click on the Meshes folder and select Mesh
Operations > Clip Volume. The Clip Volume window will appear. Select the meshes you wish to use
and whether to retain the inside or outside of the clipped mesh.
Click OK to save the new mesh, which will appear in the Meshes folder. To edit the mesh, double-click
on it.
When either of the meshes used to create the clipped volume is modified, the clipped volume will also be
updated.
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Clipping a Mesh
This option creates a new mesh that consists of the parts of a Clip mesh that are inside, outside or
overlap with the Using mesh. To clip one mesh using another mesh or boundary in this manner, rightclick on the Meshes folder and select Mesh Operations > Clip Mesh. The Clip Mesh window will
appear:

Select the meshes to use, then choose whether to retain the inside or the outside of the clipped mesh.
Tick the Include overlap box to include the overlap between the two meshes as part of the new mesh.
Click OK to save the new mesh, which will appear in the Meshes folder. To edit the mesh, double-click
on it. The Clip Mesh window will appear.
When either of the meshes used to create the clipped mesh is modified, the clipped mesh will be
updated.

Merging 2D Meshes
This option creates a new mesh from two or more open meshes and specifies the priority in which input
meshes will be used to create the final mesh. This is useful when, for example, a single mesh is required
that represents the topography (with less detail) and the area around a site (with more detail). To merge
2D meshes, right-click on the Meshes folder and select Mesh Operations > Merge Meshes 2D. In
the window that appears, select the meshes you wish to use.

If you use more than one detailed mesh or base mesh, the meshes higher in the list will have higher
priority over those lower down in the list.
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The Buffer distance value determines the zone in which the selected meshes are merged and the
Resolution setting determines the resolution of that zone. For example, here the Buffer distance is
250:

Click OK to save the new mesh, which will appear in the Meshes folder. To edit the mesh, double-click
on it.
When any of the meshes used to create the merged mesh are modified, the merged mesh will be
updated.

Extracting Mesh Parts
To extract the triangles from a mesh and create a new mesh, right-click on the surface and select
Extract Mesh Parts. The Extract Mesh Parts window will appear:
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The Extract clipped mesh option is only available for meshes that are clipped to a boundary. The
largest part is initially selected. You can sort the mesh parts by Volume or by Area by clicking the
heading of the respective column. Other options are:
l
l

l

Select all parts by clicking the Select All button. To de-select all parts click the Remove All button.
Some mesh parts may have a negative volume. If the first mesh part has a negative volume, clicking
the Remove Inside-Out button will untick mesh parts with positive volumes; if the first mesh part
has a positive volume the Remove Inside-Out button will untick mesh parts with negative volumes.
To remove parts smaller than a given size, first click the Select All button. Select the last item you
want to keep and click the Remove Below Current button.

Click OK to save the new mesh, which will appear in the Meshes folder. The mesh generated is a noneditable mesh ( ).
Meshes created in this way are not connected to the mesh they were created from. Changes to the
original mesh will not be reflected in the selected parts.
If the quality of the mesh produced is not acceptable, clip the mesh as described in Clipping a Mesh.
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Interpolated Meshes
An interpolated mesh is a type of editable mesh ( ). An interpolated mesh uses FastRBF to fit and
interpolate surface data. The FastRBF is useful for creating meshes from sparse datasets or when data
has large areas where there are no points. Interpolated meshes can be created from points data, GIS
data, polylines, structural data and values objects.
Interpolated meshes can be edited by adding more data to the mesh and changing settings.
This topic describes creating and working with interpolated meshes. It is divided into:
l
l

Creating an Interpolated Mesh
Refining an Interpolated Mesh
l
l
l

Surface Resolution Settings
Snap Settings
Other Options

Creating an Interpolated Mesh
The steps for creating a mesh from data in the project are similar, regardless of the data used to create
the mesh. The exception is creating an offset mesh, which requires additional parameters. See Offset
Meshes for more information.
To create an interpolated mesh from data in the project, right-click on the Meshes folder and select
from the New Mesh options.
Here, a new mesh is being created from points:

Select the required object from the list.
When defining the mesh’s extents, you can set the extents to be independent of other objects in the
project (Own extents) or you can use the extents of another object (Shared with). When you select
the Shared with option, the mesh will be updated when the extents object it shares is updated.
Leapfrog Works automatically sets the surface resolution based on the data available in the project. You
can experiment with the surface resolution and adaptive settings once you have created the mesh. See
Surface Resolution in Leapfrog Works for more information on the effects of these settings.
Enter a name for the new mesh and click OK.
If you are creating the mesh from a polyline, you will be prompted to select an existing polyline or draw a
new one. If you draw a new polyline, it will not be able to be used elsewhere in the project unless it has
been shared. To share the polyline, expand the mesh in the project tree, right-click on the polyline and
select Share.
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The new mesh will appear in the Meshes folder. Expand the mesh in the project tree to see how it was
made. As further refinements are made to the mesh, that information will also be added to the mesh in
the project tree.

Refining an Interpolated Mesh
Editable interpolated meshes ( ) can be refined by adding data, as described in Adding Data to
Surfaces. The options available depend on how the mesh was created.
To add data to an editable mesh, right-click on it and select one of the options from the Add menu. A list
of objects available in the project will be displayed. Select the required object and click OK. The mesh will
be updated and the object used to modify it will appear under it in the project tree.
You can also refine editable interpolated meshes by changing the trend, transforming values, adjusting
the interpolant and changing the boundary. To do this, double-click on the mesh. The Edit Mesh
window will be opened:

See Offset Meshes for the options available for meshes from offset points.
Surface Resolution Settings
See Surface Resolution in Leapfrog Works for more information on the Surface resolution settings in
the General tab.
Snap Settings
The mesh can be set to snap to the data objects used to create it. There are four options:
l
l
l

l

Off. The mesh does not snap to the data.
All data. The mesh snaps to data within the Maximum snap distance.
Drilling only. The mesh snaps only to borehole data and data objects derived from borehole data
within the Maximum snap distance but not to other data. For example, the mesh will honour
points data derived from borehole data, but not points data imported into the Points folder.
Custom. The mesh snaps to selected data objects within the Maximum snap distance.
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Take care in enabling snapping and in selecting what data the surface will snap to, as the more data
you include, e.g. by setting a large Maximum snap distance or selecting All data for Snap to
data, the greater the possibility that errors in the data or assumptions inherent in interpretations
(e.g. polylines) will cause distortions in the meshes. If you do enable snapping, it is best to snap only
to drilling data. See Honouring Surface Contacts for more information on these settings.
When Snap to data is set to Custom, you can then set whether or not Snap is enabled for the objects
used to create the mesh, as discussed in Honouring Surface Contacts. Custom is the most flexible
options as you can select the specific data objects the mesh will or will not snap to.
If you will be exporting the mesh for use in another application, you may wish to adjust the snap settings.
Data used to create the mesh will appear in the Input list. When you add more data to the mesh, those
objects will also be listed. You can remove those additional objects by expanding the mesh in the project
tree, then right-clicking on the data object and selecting Remove.
Other Options
In the Boundary tab, you can change whether the mesh boundary is independent of other objects in the
project (Own extents) or you can use the extents of another object (Shared with). When you select
the Shared with option, the mesh will be updated when the extents object it shares is updated.
Options available in other tabs are similar to those available for interpolants. See:
l
l

Structural Trends
Clipping and Transforming Values for an RBF Interpolant

For information on the parameters in the Interpolants tab, see the Interpolant Functions topic.
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2D Interpolant Meshes
A 2D interpolant can be created using any points object in the project. A 2D interpolant is built using the
same algorithm as the project’s topography surface (see Defining a Topography). This often this gives a
smoother result in less time than when using the same data to build a 3D interpolated mesh. A 2D
interpolant can work with vertically-oriented data such as fault planes, whereas building a topography is
meant to work with primarily horizontal data.
To create a 2D interpolant, right-click on the Meshes folder and select New 2D Interpolant Mesh. In
the window that appears, select from the points objects available in the project.

The mesh’s extents can be independent of other objects in the project or you can use the extents of
another object. Surface resolution can be adaptive or non-adaptive. You can set a reference plane to set
the direction of the best fit through the data; this is useful when working with data that is not primarily
horizontal.
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Offset Meshes
You can create a new interpolated mesh by offsetting an existing mesh with any points object in the
project. To do this, first ensure the points and mesh you wish to use are already in the project. Next,
right-click on the Meshes folder and select New Mesh > From Offset Points. In the window that
appears, select the Mesh and Points to use:

When the mesh is created, it will automatically snap to the points, and points outside the Distance
Limits will be ignored. These settings can be changed once the mesh has been created.
An offset mesh may be distorted if points used to offset the mesh lie too far outside the mesh
extents. If this occurs, set a Maximum distance to exclude points far away from the mesh extents.
Enter a name for the new mesh and click OK. The new mesh will appear in the Meshes folder.
To edit the mesh, double-click on it. The Edit Offset Mesh window will appear:

The mesh can be set to snap to the data objects used to create it. There are four options:
l
l

Off. The mesh does not snap to the data.
All data. The mesh snaps to data within the Maximum snap distance.
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l

l

Drilling only. The mesh snaps only to borehole data and data objects derived from borehole data
within the Maximum snap distance but not to other data. For example, the mesh will honour
points data derived from borehole data, but not points data imported into the Points folder.
Custom. The mesh snaps to selected data objects within the Maximum snap distance.

Take care in enabling snapping and in selecting what data the surface will snap to, as the more data
you include, e.g. by setting a large Maximum snap distance or selecting All data for Snap to
data, the greater the possibility that errors in the data or assumptions inherent in interpretations
(e.g. polylines) will cause distortions in the meshes. If you do enable snapping, it is best to snap only
to drilling data. See Honouring Surface Contacts for more information on these settings.
When Snap to data is set to Custom, you can then set whether or not Snap is enabled for the objects
used to create the mesh, as discussed in Honouring Surface Contacts. Custom is the most flexible
options as you can select the specific data objects the mesh will or will not snap to.
If you will be exporting the mesh for use in another application, you may wish to adjust the snap settings.
Data used to create the mesh will appear in the Input list. When you add more data to the mesh, those
objects will also be listed. You can remove those additional objects by expanding the mesh in the project
tree, then right-clicking on the data object and selecting Remove.
You can modify an offset mesh by adding data, as described in Refining an Interpolated Mesh.
It is not possible to add structural data or polylines with orientation information to an offset mesh. If
you edit an offset mesh with a polyline, your options for editing the polyline will be limited.
You can also edit the mesh’s boundary, but you cannot apply a trend, clip and transform values or adjust
the interpolant as you can for other interpolated editable meshes.
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Triangulated Meshes
A triangulated mesh is a type of editable mesh ( ). A triangulated mesh uses Delaunay triangulation to
create the mesh and can handle more points than an interpolated mesh. Triangulated meshes can be
created from points data, GIS data and polylines. Large datasets representing horizontal surfaces can be
used to create a triangulated mesh.
The steps for creating a mesh from data in the project are similar, regardless of the data used to create
the mesh. To create a triangulated mesh from data in the project, right-click on the Meshes folder and
select from the New Triangulated Mesh options.
Here, a new triangulated mesh is being created from points:

Select the required object from the list.
When defining the mesh’s extents, you can set the extents to be independent of other objects in the
project (Own extents) or you can use the extents of another object (Shared with). When you select
the Shared with option, the mesh will be updated when the extents object it shares is updated.
The Use error threshold setting lets you exclude data points that fall within the threshold. This can be
useful if you are using a large dataset and you require a more coarse surface that omits some data. When
Use error threshold is disabled, the mesh will follow all the data.
Here, a mesh created from points has the Use error threshold disabled. The mesh follows all the
points:
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Here, a mesh has been created with the Distance set to 20. The mesh ignores points that fall outside
the threshold:

You will be able to change the Use error threshold setting once the mesh has been created.
Enter a name for the new mesh and click OK.
If you are creating the mesh from a polyline, you will be prompted to select an existing polyline or draw a
new one. If you draw a new polyline, it will not be able to be used elsewhere in the project unless it has
been shared. To share the polyline, expand the mesh in the project tree, right-click on the polyline and
select Share.
The new mesh will appear in the Meshes folder and you can edit its settings by double-clicking on it.
To add data to a triangulated mesh, right-click on it and select one of the options from the Add menu. A
list of objects available in the project will be displayed. Select the required object and click OK. The mesh
will be updated and the object used to modify it will appear under it in the project tree.
It is not possible to add structural data or polylines with orientation information to a triangulated
mesh. If you edit a triangulated mesh with a polyline, your options for editing the polyline will be
limited.
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Elevation Grids
Leapfrog Works imports and exports elevation grids in common formats.

Importing an Elevation Grid
Elevation grid formats Leapfrog Works supports include:
l
l
l
l
l
l
l

Arc/Info ASCII Grid Files (*.asc, *.txt)
Arc/Info Binary Grid Files (*.adf)
Digital Elevation Model Files (*.dem)
Surfer ASCII or Binary Grid Files (*.grd)
SRTM Files (*.hgt)
ESRI.hdr Labelled Image Files (*.img, *.bil)
GeoTIFF Image Files (*.tiff, *.tif)

There are two ways to import an elevation grid:
l

l

Import the grid to the Meshes folder. Right-click on the Meshes folder and select Import
Elevation Grid.
Import the grid as part of creating a topography. Right-click on the Topographies folder and select
New Topography > Import Elevation Grid.

Navigate to the folder that contains the elevation grid file and open the file. The Import Elevation Grid
window will be displayed:

Leapfrog Works automatically sets a Surface resolution based on the information in the file, but you
can change the value if you wish. A lower value will produce more detail, but calculations will take longer.
See Surface Resolution in Leapfrog Works for more information.
When importing an elevation grid, note that the resolution cannot be changed once the file has been
imported.
Data is automatically clipped to the clipping boundary, but you can change how the data is filtered to suit
any bounding box that exists in the project. If you do not wish to clip the data, untick Clip data to
bounding box.
The Margin value determines how far outside the selected Bounding box the elevation grid will extend.
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The No Data Handling option determines whether NoData values are displayed as gaps or at a fixed
elevation setting.
Click Import. If you are creating a new topography, you will then be prompted to enter a name for it and
click OK.
The elevation grid will be added to the Meshes folder. If you imported the grid as part of creating a
topography, a hyperlink to the grid in the Meshes folder will appear as part of the defined topography.

Exporting an Elevation Grid
For any mesh in a project, you can export an elevation grid for use in other software. Formats Leapfrog
Works can export are:
l
l
l
l

ARC/Info ASCII Grid (*.asc)
ESRI.hdr Labelled (*.bil)
ENVI Raster Image (*.img)
Surfer ASCII Grid (*.grd)

To export an elevation grid, right-click on the mesh and select Export Elevation Grid. The Export
Grid window will appear:

The Snap to Grid option changes the extents of the exported grid so that they coincide with the
elevation grid spacing.
Enter the information required, then click Export to enter a filename and choose a location and format
for the file.
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Thickness Grids
For any mesh in a project, you can export a grid made up of the area between two surfaces. Formats
Leapfrog Works can export are:
l
l
l
l

ARC/Info ASCII Grid (*.asc)
ESRI.hdr Labelled (*.bil)
ENVI Raster Image (*.img)
Surfer ASCII Grid (*.grd)

To export a thickness grid, right-click on the mesh and select Export Thickness Grid. The Export
Thickness Grid window will appear:

Select the surfaces required from the lists.
Enter the information required, then click Export. You will be prompted for a filename and location.
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Polylines
Leapfrog Works imports many common polyline formats and also has tools for drawing and exporting
polylines. This topic describes:
l
l
l
l
l
l

Creating Polylines
Displaying Polylines
Sharing and Unsharing Polylines
Importing Polylines
Reloading Polylines
Exporting Polylines

See Drawing in the Scene for information on drawing and editing polylines.

Creating Polylines
There are three ways to create polylines in Leapfrog Works:
l
l

l

Create a new polyline using the Polylines folder. These polylines are stored in the Polylines folder.
Create a new polyline as part of working with another tool. For example, a polyline can be drawn to
create a lateral extent in a geological model. These polylines are stored in the tool used to create them
and cannot be used elsewhere in the project unless they have been shared. To share a polyline, rightclick on it and select Share. The polyline will be moved to the Polylines folder and can be used
elsewhere in the project.
Create a new polyline from a GIS line. To do this, right-click on the GIS lines object ( or ) in the
GIS Data, Maps and Photos folder and select Extract Polyline. The new polyline object will
appear in the Polylines folder. It is not linked to the original GIS lines object.

See Drawing in the Scene for information on drawing and editing polylines.

Displaying Polylines
When polylines are displayed in the scene, you can control the colour of the positive and negative
surfaces of the line and of the line itself. In this example, the positive side of the polyline is red, the
negative side is blue and the polyline itself is green:

For contact surfaces, the colour of the positive and negative sides of a ribbon will be determined by
the lithologies or categories assigned to either side of the surface.
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With the Node size and Point size controls in the properties panel, you can change the size of nodes
and points in the scene to make working with the polyline easier.
Polylines have a Surface ribbon( ) and Normal ribbon( ) to help you to determine the orientation
of the polyline in the scene. The surface ribbon reflects the orientation of the polyline and the normal
ribbon is perpendicular to the surface ribbon. For example, click on the Surface ribbon button ( ) to
determine which side of the polyline is positive (red) and which side is negative (blue):

If you are having trouble seeing the ribbons, you can change their size using the Ribbon width control
in the properties panel.
Other aspects of polyline display are useful when creating and editing polylines. See Drawing in the
Scene.

Sharing and Unsharing Polylines
Some polylines are created as part of working with other objects and are not available elsewhere in the
project. An example of this is a polyline drawn as part of creating a model boundary. To share the
polyline, right-click on the object in the project tree and click Share. The shared polyline will be copied
to the relevant location in the project tree and a hyperlink added to the object it was shared from.
Polylines that have been shared can be unshared by making a local copy of the polyline. To do this,
right-click on the shared polyline and select Create Local Copy:
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The polyline in the Polylines folder remains, but a local copy of it is made and the hyperlink to the
Polylines folder copy is deleted. This means you can now work on, for example, the Polylines folder
copy without changes to it affecting the geological model’s copy.

Importing Polylines
Polyline formats Leapfrog Works supports include:
l
l
l
l
l

Drawing Interchange Polylines (*.dxf)
Old Leapfrog Polylines (*.lfpl)
Leapfrog Polylines (*.csv, *.txt)
AutoCAD Drawing Files (2013/LT2013) (*.dwg)
Bentley Drawing Files (v8) (*.dgn)

There are two ways to import a polyline:
l

l

Right-click on the Polylines folder and select Import Polyline. In the Import Polyline window,
navigate to the location where the polyline file is saved and select it. Click Open.
Drag and drop polyline files directly into Leapfrog Works.

If the polyline file is in Leapfrog, Gocad or DXF formats, the importing will start immediately. For all
other formats, the Polyline Import window will appear. If the polyline file is in one of the standard
formats listed above, the default settings can be used. Click Import to finish the process. If, however,
you wish to specify polyline import parameters, two pieces of information are required:
l
l

The columns the polyline vertex coordinates are in
How the polyline sections are separated in the file

Select the vertex coordinate columns by clicking on the heading at the top of a column and selecting one
of East (X), North (Y) or Elev (Z) from the list.
When importing a file that has multiple features, you will be prompted to select which ones to import.
You can also choose to:
l

l

Import the features as separate objects. Each feature will appear in the project tree as a separate
object.
Flatten all features into one object. Leapfrog Works will treat all features as a single object.

The polyline will be imported and added to the project tree under the Polylines folder.
See Drawing in the Scene for information on drawing and editing polylines.

Reloading Polylines
Reloading data is necessary when the imported data is modified externally. To reload a polyline, rightclick on it in the project tree and select Reload Data.
Reloading a polyline overwrites any changes you have made to the polyline. Any dependent objects
will be updated, which can take some time.
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Select the file to be reloaded and click Open. The polyline will be updated, as will any dependent objects.

Exporting Polylines
Export a polyline by right-clicking on it and selecting Export. Leapfrog Works exports polylines in the
following formats:
l
l
l
l
l

Leapfrog Polylines (*.lfpl)
Leapfrog Polylines (*.csv)
Drawing Interchange Polylines (*.dxf)
Drawing File (2013/LT2013) (*.dwg)
Bentley Drawing Files (v8) (*.dgn)
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Open Mining Format (OMF) Export and Import
Open Mining Format is a convenient format for exchanging data with other applications because
multiple geosciences objects can be moved as a single file. Leapfrog Works supports the export and
import of Open Mining Format v0.9.
This topic describes how to export and import OMF data. It is divided into:
l
l
l

OMF Export
OMF Import
Importing OMF Files From the Central Data Room

OMF export and import are available from the Leapfrog Works menu:

OMF Export
When you export objects in OMF format, you can select from the list of objects in the project. You
can also select the objects that are currently in the scene, and so setting up a scene before initiating
the export of an OMF file is a useful way of selecting a subset of data for export.
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To export data from a project in OMF format, click on the Leapfrog Works menu and select OMF >
Export. A list of objects in the project that can be exported in OMF format will be displayed:
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If you have information in the project tree’s Notes object, it will be added to the Description field in the
OMF Export window:
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Select the objects you wish to export, then specify the file name and the folder where it will be saved.
Click OK to export the file.
Exporting the file may take some time if you have selected a large number of objects.

OMF Import
To import data from an OMF file, click on the Leapfrog Works menu and select OMF > Import. In the
window that appears, select the file you wish to import and click Open. The objects in the file will be
displayed, organised into folders:

How the objects in these folders will be organised in the Leapfrog Works project tree is as follows:
l
l
l
l
l

Points objects will be added to the Points folder.
Lines objects will be added to the GIS Data, Maps and Photos folder.
Meshes will be added to the Meshes folder.
Block models will be added to the Block Models folder.
Colourmaps on imported objects will be added to the Colour Gradients folder.

Select the objects you wish to import and click OK.
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Importing OMF Files From the Central Data Room
See the The Project Data Room topic in the Central 4.0 help for information on how to work with a
Central project’s data room.
In order for OMF files to available for import to Central users, upload the OMF file to a Central project’s
data room. Here an OMF file in the Ultimate Wolfpass project’s data room can be imported into
Leapfrog projects on the same Central server:

To import data from an OMF file stored on Central, first make sure you are connected to a Central
server. Next, click on the Leapfrog Works menu and select OMF > Import from Central. In the
window that appears, select the project you wish to import data from. The OMF files stored in the
project’s data room will be displayed:
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How the objects in these folders will be organised in the Leapfrog Works project tree is as follows:
l
l
l
l
l

Points objects will be added to the Points folder.
Lines objects will be added to the GIS Data, Maps and Photos folder.
Meshes will be added to the Meshes folder.
Block models will be added to the Block Models folder.
Colourmaps on imported objects will be added to the Colour Gradients folder.

Select the objects you wish to import and click OK.
Objects imported from OMF files cannot be reloaded.
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Analysing Data
Leapfrog Works has a number of tools that help you to analyse your data.
l

l

l

l

l

l

l

The most basic information about an object is contained in the object’s Properties window, which is
specific to the type of object. Right-click on the object in the project tree and select Properties. See
Object Properties in the The Project Tree topic for more information.
Viewing statistical information about objects helps you to analyse your data. This is described further
below.
Visualising data using the shape list and the shape properties panel is an important part of
interpreting and refining data and making modelling decisions. The tools available depend on the
type of object being displayed, and many objects can be displayed evaluated on other objects.
Stereonets are useful for visualising structural data and identifying trends in 2D. Errors in
categorisation of structural data can also become apparent when the data is viewed on a stereonet.
Form interpolants are useful for visualising structural data and identifying broad trends in 3D. The
form interpolant’s meshes can then be used to control other surfaces in the project.
With the borehole correlation tool, you can view and compare selected boreholes in a 2D view. You
can then create interpretation tables in which you can assign and adjust intervals and create new
intervals. Interpretation tables are like any other interval table in a project and can be used to create
models.
You can plan boreholes, view prognoses for models in the project and export planned boreholes in
.csv format.

The rest of this topic describes the different statistics visualisations available in Leapfrog Works.

Statistics
The statistics options available in Leapfrog Works depend on the type of object. Common statistics
visualisations are described below:
l
l
l
l
l

Table of Statistics
Scatter Plots
Q-Q Plots
Box Plots
Univariate Graphs

Variations of these are described relative to the data objects for which they are relevant.
Leapfrog Works uses fixed 25%/75% quartiles.

Table of Statistics
For many data tables, you can view a table of statistics for multiple attributes. If the table has one or
more category columns, data can, optionally, be grouped by category. To open a table of statistics,
right-click on a data table then select Statistics. In the window that appears, select the Table of
Statistics option.
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In this example, we have the initial table of statistics for a merged table that has two category columns
and four numeric columns, plus an Interval Length column. However, nothing is displayed in the table
because data columns have not yet been selected.
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Select from the Numeric items available for the table. In this case, all columns have been selected,
including the Interval Length column:

Click the Add button to select from the category columns available in the table. An entry will be added to
the Categories list. Click on the arrow to select from the available category columns:
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Statistics for the selected category column will be displayed in the table. You can change what
categories are displayed by clicking on the second button and enabling or disabling categories:

If there is more than one category column, you can set lower levels. Here there are two category columns
displayed in the table, “ROCK” and “Domain”:
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You can hide empty categories (those with a count of zero) and inactive rows using the options below
the Categories list:

Group by category and Group by numeric item provide further options for the table organisation.
Here the Group by numeric item option has been selected:

You can filter the data using any Query filter defined for the data table. Statistics for interval tables can
be unweighted or weighted by interval length.
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Change the columns displayed in the table by clicking on the Edit table columns button ( ):

Once you have set up a table of statistics on a particular table, its settings will be saved so you can
easily review the statistics and export the table using the same settings.
To export the table in CSV format, click on the Export button in the toolbar ( ).
Click rows to select them, and select multiple rows by holding down the Shift or Ctrl key while clicking
rows. You can then copy rows by clicking the Copy button ( ), which allows you to copy the selected
row(s) or all rows in the table.
The arrow buttons quickly expand ( ) or collapse ( ) rows.

Scatter Plots
Scatter plots are useful for understanding relationships between two variables. An additional variable can
be introduced by setting the Colouring option to a data column. The example below plots the two
variables lead and zinc against each other, with gold being indicated by the colouring. You can make
either axis a log scale with the Log scale in X and Log scale in Y options. A Query filter may also be
applied.
The appearance of the chart can be modified by adjusting the Point size, Point shape, and White
background settings.
Enable Show X = Y line to aid in assessing how far off equal the distributions are.
When you select Show linear regression, a regression line is added to the chart and a function
equation is added below the chart title.
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Show conditional expectation plots a line that attempts to find the expected value of one variable
given the other. The X axis is divided into a number of bins specified by Bin count, and the data in each
bin is used to predict the expected Y value.

By default, the limits of the chart are automatically set to range between zero and the upper limit of the
variable data. You can adjust this by turning off Automatic X axis limits and/or Automatic Y axis
limits and specifying preferred minimum and maximum values for each axis.
There are three select tools at the top of the window:

With these tool, you can select or deselect points on the graph.
l

Use the Replace button ( ) to select points. This tool clears any previous selection.

l

Use the Add button ( ) to add more points to an existing selection.

l

Use the Remove button ( ) to deselect points.
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There are three ways to use each tool:
l
l
l

Click on individual points to select/deselect them.
Drag the cursor across points to select/deselect them.
Draw around a set of points to select/deselect them.

For example, here, using the Replace button ( ) to draw a loop around points selects those points:

You can also:
l

Select all visible points by clicking on the Select All button ( ) or by pressing Ctrl+A.

l

Clear all selected points by clicking on the Clear Selection button ( ) or by pressing Ctrl+Shift+A.

l

Swap the selected points for the unselected points by clicking on the Invert Selection button ( )
or by pressing Ctrl+I.
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Selected points can be filtered in the scene by selecting the scatter plot from the Query filter options in
the shape properties panel.
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Q-Q Plots
Quantile-Quantile plots are useful for validating your assumptions about the nature of distributions of
data. Select the data columns to show on the X Axis and Y Axis (which can optionally be set as log
scales). You can also select an X filter and/or Y filter to limit the values used from the data columns.
Enable Show X = Y line to plot the mirror line for the chart, which may not always be obvious when
the X and Y axis have different scales.
Show quartile line draws a line through two points on the chart, the lower quartiles and the upper
quartiles for each of the axes.

Box Plots
The box plot (or box-and-whisker plot) provides a visualisation of the key statistics for a data set in one
diagram.
Select a Numeric column to display, enabling Log scale if it helps to visualise the data more clearly. If
the table includes category data, set the Category column to one of the category columns to help
visualise the data. Select which categories to include from the Categories list.
You can also use a pre-defined Query filter to limit the data included in the chart.
Note these features of the plot:
l
l

The mean is indicated by the red diamond.
The median is indicated by the line that crosses the inside of the box.
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l
l

The box encloses the interquartile range around the median.
The whiskers extend out to lines that mark the extents you select, which can be the Min/Max
whiskers, the Outer fence whiskers or the Inner fence whiskers. Outer and inner values are
defined as being three times the interquartile range and 1.5 times the interquartile range respectively.
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Univariate Graphs

There are several different visualisation options. Histogram shows a probability density function for the
values, and Cumulative Histogram shows a cumulative distribution function for the values as a line
graph:

There are three options that show the charts with a log scale in the X-axis:
l

Select Histogram and enable Histogram of the log to see the value distribution with a log scale Xaxis.
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l

l

Select Cumulative histogram and enable Histogram of the log to see a cumulative distribution
function for the values with a log scale X-axis.
Log probability is a log-log weighted cumulative probability distribution line chart.

Percentage is used to change the Y-axis scale from a length-weighted scale to a percentage scale.
Bin width changes the size of the histogram bins used in the plot.
The Box Plot options control the appearance of the box plot drawn under the primary chart. The
whiskers extend out to lines that mark the extents you select, which can be the Min/max whiskers, the
Inner fence whiskers or the Outer fence whiskers. Inner and outer values are defined as being 1.5
times the interquartile range and 3 times the interquartile range respectively.
Some univariate graphs may include a Filtering option containing where a Query filter defined for the
data set can be selected.
The Limits fields control the ranges for the X-axis and Y-axis. Select Automatic X axis limits and/or
Automatic Y axis limits to get the full range required for the chart display. Untick these and manually
adjust the X limits and/or Y limits to constrain the chart to a particular region of interest. This can
effectively be used to zoom the chart.
The bottom left corner of the chart displays a table with a comprehensive set of statistical measures for
the data set.
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Borehole Correlation Tool
With the borehole correlation tool, you can view and compare selected boreholes in a 2D view. You can
then create interpretation tables in which you can assign and adjust intervals and create new intervals.
Interpretation tables are like any other interval table in a project and can be used to create models. You
can also save and export correlation set layouts and styles that can be exported and used in other
Leapfrog Works projects.
This topic describes creating correlation sets and creating interpretation tables. It is divided into:
l
l
l
l
l

Selecting Collars
The Correlation Set Window
Correlation Column Layouts
Managing Styles
Interpretation Tables

Selecting Collars
To select collars, you need to create a borehole correlation set, which you can do from the scene. First,
add the collars you wish to work with to the scene. A useful way of limiting the number of collars
displayed is to draw a slice in the scene and set it to a thick slice ( ) and set the slice width to hide
collars on either side of the slice.
Next, right-click on the Borehole Correlation folder and select New Borehole Set. The new set will
be created and opened, but is empty until you select collars. Click the Select Collars button ( ) to
switch to the scene and begin selecting collars:

The line in the scene indicates the order in which collars will appear in the set.
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l

l
l

l

l

To select collars one-by-one, click on the Select collar button ( ), then on the Add collar button (
). Click on a collar to add it to the nearest end of the set. Hold down the Ctrl key while clicking to
remove a collar from the set.
To temporarily switch to the Select button ( ), hold down the Shift key while clicking.
To select all collars visible in the scene, click on the Select all collars button ( ). This will select
collars using the best fit line.
To remove a collar from the selection, click on the Remove collar button ( ), then click on the
collar you wish to remove from the set.
To clear the selection, click on the Clear collar selection button ( ).

If you want to change the order, you can easily do so in the set tab once you have selected collars.
Once you have selected the required collars, click the Save button ( ). The selected collars will be
added to the set window:

The Correlation Set Window
Remove collars from the correlation set by either editing the set in the scene, as described in Selecting
Collars above, or right-click on a the borehole name in the column header and select Remove collar:
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You can change how data is displayed by right-clicking below the borehole name in the column header,
then selecting Format:

The options available depend on the type of column being formatted.
Click on boreholes and drag them in the correlation set window to change the order in which they
appear:
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Add columns to the set by dragging them from the project tree into the set window. Here, four columns
have been added to the set. From right to left they are a lithology column, an assay data column, a points
data column formatted as a line and a points data column formatted as points:

You can then format the columns to get a better view of relationships between them. Format columns
by right-clicking on their headers and selecting Format:

The styles used to display columns can be used by other sets in the project and can be exported to other
projects. See Managing Styles below.
You can also drag some types of columns on top of other columns, although it is not possible to display
category data on top of other category data. You can select multiple columns using the Shift and Ctrl
keys.

Navigating in the Correlation Set Window
Navigate in the correlation set window using the following mouse and keyboard combinations:
l
l
l
l

Use the scroll wheel to move up and down.
Hold down the Shift key while scrolling to move right and left.
Hold down the Ctrl key while scrolling to zoom in and out.
Hold down the Alt key while scrolling to stretch the data vertically.
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Correlation Column Layouts
Once you have organised data columns and how they are displayed, you can save this information as a
column layout that can be applied to other correlation sets. To do this, click the Layout button in the
toolbar and select Save Current Layout from the list:

You will be prompted for a name. Click OK to save the layout, which can then be applied to other
correlation sets by selecting the layout from the list.
To view the layouts available in the project, right-click on the Borehole Correlation folder in the
project tree and select Layout Manager. In the window that appears, you can easily see what columns
are used for each layout and apply a layout to all correlation sets in a project:

You can also export column layouts for use in other projects and import layouts from other projects.
Clicking Export all exports layouts as a text file.
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Managing Styles
The styles used to display data columns can also be exported to other projects. To view the styles used in
the project, right-click on the Borehole Correlation folder in the project tree and select Style
Manager:

Click Edit to change a style, which will update objects that use the selected style throughout the project.
Click Export all to export the styles in the project as a text file that can be imported into other projects.

Interpretation Tables
With interpretation tables, you can assign and adjust intervals and create new intervals. Interpretation
tables are like any other interval table in a project and can be used to create models.
To create an interpretation table, click the New Interpretation button in the correlation set window.
The New Interpretation Table window will be displayed:
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There are three options for creating an interpretation table:
l

l

l

Create the table without using a base table. Each borehole will have an empty legend and a single
empty interval from 0 to its maximum depth. Select <None> for the Source Column.
Create the table from a base column but have no intervals. This copies the base column’s legend but
no intervals. Select the Source Column, then select Empty Table.
Create a copy of a table. Select the Source Column, then select All Intervals.

Click OK to create the table. A new interpretation table will be added to the project tree under the
Boreholes object and the column will be added to the correlation set window:

Assigning Lithologies
If you have created the interpretation table without using a base table, you will need to assign lithologies
to the new table. Do this as part of working with the table in the correlation set window, which is
described below.

Modifying the Interpretation Table
In the correlation set window, the blue line that appears as you mouse over the columns is used to create
intervals. Position the blue line then right-click on it and select one of the options:

l
l
l
l

The Copy from option assigns intervals from the base table.
The Insert interval option adds an empty interval that overrides any intervals already defined.
The Unassign interval option clears the lithology assigned to the interval.
The Assign interval option opens the legend for the interpretation table so you can select a
lithology to assign to the interval. If you need to add lithologies, you can do so in this window.
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For example, to create an interval at the top of the table called “High Density”, move the blue line near to
where you wish to create the interval. You do not need to be precise as you can adjust the interval once
you have added it. Right-click and select Insert interval:

In the legend window, click the Add button and add a lithology called “High Density”:

Click OK to select the new lithology and close the legend window. The new lithology has been assigned
to the interval:
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To resize the interval, click and drag the interval end points:

You can move the interval end point and snap it to a data point in another column. To do this:
1. Click on the interval end point and drag it into position without releasing the mouse button.
2. Move the mouse across to the data point you wish to snap to.
3. Release the mouse.
You can also snap to points along the depth axis.
Continue making changes to the interpretation table, using the Undo button to step backwards if
necessary. Save changes to update the table.
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Stereonets
Stereonets are useful for visualising structural data and identifying trends in 2D. Errors in categorisation
of structural data can also become apparent when the data is viewed on a stereonet.
There are two types of stereonets available in Leapfrog Works: equatorial stereonets and polar
stereonets. The process of creating a stereonet is the same for both types; you can change the type of
stereonet by clicking the Options button in the stereonet window. Both Fisher and Bingham statistics
are available for stereonets.
This topic describes how to work with stereonets in Leapfrog Works. It covers:
l
l
l
l
l
l
l
l

Creating a Stereonet
Displaying the Stereonet in the 3D Scene
Plot Options
Data Display Options
Viewing Stereonet Statistics
Selecting Data in the Stereonet
Using the Scene Window With the Stereonet
Exporting a Stereonet

Creating a Stereonet
Create a stereonet by right-clicking on the Stereonets folder (in the Structural Modelling folder)
and selecting New Stereonet. The stereonet is created and opened in a new tab. Click the Add button
to add any structural data table in the project to the stereonet:

You can also drag and drop structural data objects from the project tree into the stereonet.
See Plot Options and Data Display Options below for information on the different options available for
stereonets.
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Displaying the Stereonet in the 3D Scene
You can display the stereonet in the 3D scene by dragging the stereonet from the project tree into the
scene or by clicking on the View button ( ) in the stereonet window:

You can display planes and poles in the 3D scene, but not contours. In the shape list, you can control
whether planes or poles are displayed in the scene:

Otherwise, the appearance of the stereonet in the 3D scene is controlled from the stereonet window.
In the scene, you can:
l
l
l

Resize the stereonet in the scene. Click on it and use the green arrows to resize it.
Move the stereonet around in the scene. The controls are the same as those for the moving plane.
Centre the stereonet on its input data. To do this, click on the stereonet in the shape list and then
select from its inputs in the Move to list.

© 2020 Seequent Limited

Plot Options | 395

Plot Options
Click Options to change plot options:

There are two types of stereonets available, Equatorial and Polar. You can also choose between Equal
area (Schmidt) and Equal angle (Wulff) projections.
The Desample rate affects how quickly data is displayed by combining points with duplicate
orientations, as determined by the Desample rate value. A low value will filter fewer data points,
whereas a higher value will filter out more data. Setting the Desample rate to 0 plots all points, which
may be slow for very large data sets that have not been declustered. The Desample rate applies only to
how data is displayed; it does not affect the data in the table.
Note that the settings in Edit plot options window only apply to the current stereonet. If you want to
create a stereonet “template” for your project, you can create a new stereonet with different plot
options and make copies of it in the project tree:

Data Display Options
Planar structural data can be displayed as planes ( ), poles ( ) or contours ( ), using the colouring
from any column in the structural data table. Lineations can be displayed as poles ( ) or contours ( ).
Contour methods available are Schmidt, Exponential Kamb and Kamb, and contours can be
displayed filled or outlined.
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Click on a line or pole to view information about the data point:

The information displayed includes whether or not there are duplicates of the selected data point in the
data set.
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Click the mean button ( ) to view the Fisher mean on the stereonet, which is displayed as a line for
planar structural data and as an X for lineations. You can also display the Bingham best-fit plane ( ) and
eigenvectors e1, e2 and e3:

For planar structural data, you can also display the Bingham mean plane ( ):
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A legend can be displayed for the stereonet as a whole ( ) and for the contours ( ). The stereonet’s
legend is generated from the categories that are visible in the list of colourings. Here, the categories
displayed are from the Bedding column:

You can apply query filters from those available in the project.
Declustered data can be viewed on stereonets in two ways:
l

l

Declustered data can be viewed directly on the stereonet. Simply drag the declustered table into the
stereonet.
If the declustered data’s parent data table is displayed on the stereonet, the declustered data is
available as a filter.

For example, here a structural data table is displayed on a stereonet along with a declustered table. The
declustered table is available as a query filter for its parent object:
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Viewing Stereonet Statistics
To view statistics on the data displayed on the stereonet, click either the Bingham button or the Fisher
button:

You can select specific rows and copy them to the clipboard or copy all data to the clipboard.

Selecting Data in the Stereonet
You can select data in the stereonet and assign it to new categories or existing ones. To do this, click on
the data table in the stereonet window and select New selection from the colouring list:

The New Category Selection window will appear:

The poles will be displayed in the stereonet, if they are not already visible, and the data table will also be
added to the scene window, together with tools for selecting points in the scene.
Organising the stereonet tab and the Scene View tab so they are displayed side-by-side can be
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useful in working with the data as you can select data in the stereonet or in the scene window. This is
described further in Using the Scene Window With the Stereonet below.
If you select an existing column as the Source Column, you can assign selected points to the existing
categories or create new categories. If you select <None> for the Source Column, you will have to
define each category manually.
When you click OK, a set of tools for selecting data will be added to the stereonet window:

There are two tools for selecting data in the stereonet, the polygon tool ( ) and the bullseye ( ) tool.
l

l

Use the polygon tool ( ) to draw around the points you wish to select. Closing the polygon will
select the points, and you can click on the vertices to refine the shape of the selection. Click outside
of the selection to clear the polygon.
Use the bullseye tool ( ) to:
l
l

Click on points one-by-one.
Click and drag around points.

The Add button ( ) and the Remove button ( ) determine whether selected points are being added
to or removed from the selection. For example, if you draw a polygon around a set of points with the
Add button enabled, the points will be added to the selection.
You can also:
l

Remove points from a selection while the Add button ( ) is enabled by holding down the Ctrl key
and selecting points.

l

Select all visible points by clicking on the Select All button ( ) or by pressing Ctrl+A.

l

Clear all selected points by clicking on the Clear Selection button ( ) or by pressing Ctrl+Shift+A.

l

l

Swap the selected points for the unselected points by clicking on the Invert Selection button ( )
or by pressing Ctrl+I.
Show or hide all unassigned points using the Unspecified Measurements button ( ).
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Statistics are shown for the currently selected set of points:

You can choose what type of statistics to display for selected points:
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Once you have selected a set of points, click the Assign to button in the stereonet window, then select
Create New Category. In the window that appears, enter a name for the category and assign a colour:

Click OK. The new category will be created and the stereonet will be updated to reflect the changes:

The scene window will also be updated.
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Once you have created a new category, you can add to it by selecting further points, then selecting the
category from the Assign to list.
When you are finished, click the Save button ( ) and close the category editor. You can make further
edits by clicking the Edit button ( ) in the stereonet window.

Using the Scene Window With the Stereonet
You can also select points in the scene window by clicking on the Select points tool ( ), then drawing
over those points in the scene:

Controls for assigning points to categories will remain in the stereonet window, and both the stereonet
window and the scene window will be updated to reflect the selected and assigned points.

Exporting a Stereonet
Stereonets can be exported in the following formats:
l
l
l

PDF Files (*.pdf)
Scalable Vector Graphics Files (*.svg)
PNG Image Files (*.png)

Click the Export button. Select a format and navigate to the folder where you wish to save the file.
Enter a name and click Save.
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Form Interpolants
A form interpolant is an RBF interpolant that uses planar structural data to control the RBF gradient.
The RBF gradient resembles the geology orientation, which makes form interpolants useful for
visualising structural data and identifying broad trends in 3D. The form interpolant’s meshes can then be
used to control other surfaces in the project.
This topic describes how to work with form interpolants in Leapfrog Works. It covers:
l
l
l

Creating a Form Interpolant
The Form Interpolant in the Project Tree
Form Interpolant Statistics

Once a form interpolant has been created, experiment with different Distance values. To do this,
double-click on the interpolant in the project tree and click on the Outputs tab.

Creating a Form Interpolant
To create a form interpolant, right-click on the Form Interpolants folder (in the Structural
Modelling folder) and select New Form Interpolant. In the window that appears, click the Add
button to add structural data tables to the interpolant:

Data can be filtered using the query filters defined for the selected structural data tables:
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Once you have created the interpolant, you can easily add and remove structural data tables and
change the filtering.
When generating the form interpolant, you can use the tangents and polarity or only the tangents. To
use both, leave the Use Polarity box ticked. To use only the tangents, untick the box.
The Boundary filter setting determines how data is handled when it lies outside the interpolant’s
boundary:
l

l

Boundary filter enabled. The interpolant is only influenced by the data that falls inside the
boundary.
Boundary filter disabled. The interpolant is influenced by the data both inside and outside the
boundary.

Setting a Trend
In the Trend tab, you can set a trend using the moving plane or by entering the required values. You can
also use the Set to list to choose different options used in the project. Isotropic is the default option
used when the function is created.
The Ellipsoid Ratios determine the relative shape and strength of the ellipsoids in the scene, where:
l
l

l

The Maximum value is the relative strength in the direction of the green line on the moving plane.
The Intermed. value is the relative strength in the direction perpendicular to the green line on the
moving plane.
The Minimum value is the relative strength in the direction orthogonal to the plane.

Adding Isosurfaces
The isosurfaces generated for the form interpolant are determined by the settings in the Outputs tab. If
you wish to add more isosurfaces to the interpolant, click the Add button and enter the required Iso
Value. Click on an isosurface and then on the Remove button to delete it.
The Default resolution setting is used for all new isosurfaces.

The Form Interpolant in the Project Tree
In the project tree, the form interpolant contains objects that represent different parts of the interpolant:

l
l

The Extents object represents the interpolant’s boundary settings, from the Boundary tab.
The Trend object describes the trend applied in the interpolant. See Global Trends for more
information.
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l

l

The structural data object ( ) contains a link to the data used in generating the interpolant. See
Form Interpolant Statistics for more information.
The Isosurfaces folder contains the isosurfaces defined in the Outputs tab.

To display the form interpolant:
l
l

Drag the interpolant into the scene.
Right-click on the interpolant and select View Isosurfaces.

Form Interpolant Statistics
To view information about the data used for the form interpolant, right-click on the structural data
object ( ) under the interpolant and select Properties. The General tab includes information about
how the data has been declustered:

You cannot change how data is declustered in the form interpolant, but if you wish to have more control
over this, create a declustered structural data set and use it as the input for the form interpolant. See
Declustering Planar Structural Data for more information.

Planning Boreholes
In Leapfrog Works, planned boreholes are organised into borehole groups. You can evaluate models
onto the borehole group and view drilling prognoses for all boreholes in the group.
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Planned borehole groups were introduced in Leapfrog Works 2.1. When a project from an earlier
version is opened in Leapfrog Works 2.1, all existing planned boreholes will automatically be assigned
to groups, based on the phases of each borehole.
If necessary, you can move planned boreholes between groups by opening both groups, then
dragging boreholes between the groups. This copies boreholes from group to group, so once copied,
you will need to delete the planned borehole from the group it does not belong to.
Planned boreholes are added to a project from a borehole group, and these are stored in the Planned
Boreholes folder. When displayed in the scene, the planned borehole is made up of a collar point, a
target location and a path defined by lift and drift parameters:

The rest of this topic is divided into:
l
l
l
l
l

Adding Planned Boreholes
Planning Options
Drilling Prognoses
Exporting Planned Boreholes
Importing Planned Boreholes
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Adding Planned Boreholes
To plan a borehole, first add the data objects to the scene that you will use in helping to define the
borehole, such as the topography and any existing boreholes. Next, right click on the Planned
Boreholes folder and select New Borehole Group. In the window that appears, you can define basic
information about the group, including the Prefix used for each borehole added to the group:

Start defining boreholes by clicking the Add Borehole button.

You can change whether Collar or Target is selected when this window is opened by clicking on the
Defaults button. See Planning Options below.
A name is automatically generated for the new planned borehole based on the Prefix defined for the
group.
There are three ways to define the borehole collar or target:
l

Click in the scene to set the collar or target location. First, click on the Select button ( ) for the
Collar or Target, then click in the scene to define the Collar or Target. The borehole will appear in
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the scene and you can adjust the coordinates using the controls in the Borehole Planning window.
Click the Slice along borehole button to draw a slice in the scene. This is useful in adjusting the
borehole path and in defining subsequent boreholes.
l

l

Draw the borehole in the scene. Click on the Select button ( ) for the Collar or Target, then click
and drag in the scene to define a basic path for the borehole. If you are defining the borehole from
the collar down, click first on or near the topography. Likewise, if you are defining the borehole from
the target up, click first at or near the target point.
Enter the coordinates for the Collar or the Target in the Borehole Planning window.

Clicking the Move Collar onto the Topography button adjusts the elevation of the borehole so that it
lies on the topography.
Click the Next Hole button to create another planned borehole. The new planned borehole will be
created at a specific distance from the currently displayed planned borehole using the Path settings for
the currently displayed borehole and the Offset To Next Hole settings in the Borehole Planning
Options window. See Planning Options below.
Once you have specified the collar or target, adjust the borehole path:
l
l
l

l

Lift is how much the borehole deviates upward.
Drift is how much the borehole deviates laterally.
Leapfrog Works automatically calculates the Depth value when the borehole is defined by the
Target location.
Adding an End of hole length extends the borehole past the Target location.

Once you have finished defining planned boreholes, click OK to return to the Borehole Group window.

You can change the automatically generated name by clicking on the borehole in the list and editing the
text.
Search for planned boreholes in the list by pressing Ctrl-F. A Find window will appear that you can
use to search the list.
Click the Edit button ( ) to change the settings for a planned borehole, or click OK to save the group.
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Any model in project can be evaluated on a borehole group, and evaluations can be exported when the
group is exported as interval tables. See Exporting Planned Boreholes below. Right-click on the group in
the project tree and select Evaluations. The Sample Distance setting applies to numeric evaluations
and determines the spacing between downhole evaluation points.
You can also define filters for a borehole group. A filter makes it easier to select a subset of the borehole
when the group is displayed in the scene. To define a filter, right-click on the group and select New
Filter. Select which boreholes to include in the filter and enter a name for it. The filter will be saved in
the project tree as part of the group.
Display planned borehole by dragging the group into the scene. Hide boreholes in the scene using any
defined filters or by opening the group and using the show/hide button ( ).
You can copy planned boreholes between groups by opening both groups, then dragging boreholes
between the groups. For example, here the boreholes selected in the first group are being copied into
the second group:

This copies boreholes from group to group, rather than moving them, so once copied, you will need to
delete the planned borehole from the group it does not belong to.

Planning Options
Borehole planning options are set on a per-project basis. To change borehole planning options, rightclick on the Planned Boreholes folder or on a borehole group and select Edit Planned Boreholes
Defaults. The Borehole Planning Options window will appear:
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Select whether new planned boreholes are specified by the Collar or by the Target.
The Offset To Next Hole values apply when defining multiple boreholes in the Borehole Planning
window.
Enter the information required and click OK. The new settings will be applied to the next new planned
borehole added to the project.

Drilling Prognoses
Planned boreholes can be evaluated against any model in the project. To view drilling prognoses for a
borehole, right-click on a borehole group in the project tree and select Drilling Prognoses. The
Drilling Prognoses tab will appear:

The dropdown list contains all evaluations on the borehole group, along with a Merged Intervals
option that combines the information from all evaluations. You can copy the information displayed to
your computer’s clipboard by selecting rows, then clicking the Copy button ( ). The information in the
selected rows will be copied as tab delimited text, which can be copied into a spreadsheet application
such as Excel.

Exporting Planned Boreholes
There are two ways to export planned boreholes: export their parameters or export interval tables that
contain the boreholes.

Export Parameters
Exporting planned borehole parameters exports the boreholes as a *.csv file. To export parameters for
planned boreholes, right-click on a borehole group and select Export Parameters. In the window that
appears, select the boreholes you want to export. The total length will be updated as you add or remove
boreholes.
In Leapfrog Works, positive dip points down for planned boreholes. To invert the dip for exported
planned boreholes so that negative dip points down, tick the box for Invert dip on export.
Click Export. Navigate to where you wish to save the file, then click Save.

Export as Interval Table
To export planned boreholes as an interval table, right-click on a borehole group and select Export as
Interval Table. Select the evaluations you wish to include, then click Export. In the Export Planned
Boreholes window, the files that will be created are listed, one each for the collar and survey table and
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one for each selected evaluation. Change the Base file name, if required, choose a folder in which to
save the files, then click Export to save the files.

Importing Planned Boreholes
Leapfrog Works imports planned boreholes from files in CSV format. The columns expected are:
l
l
l
l
l
l
l
l
l
l

A borehole identifier
X-Y-Z coordinates for the planned borehole
Azimuth
Dip
Lift rate
Drift rate
Distance
Extension
Target Depth
Comment

When importing planned boreholes, you can import them into a new group or into an existing group. To
import planned boreholes, right-click on the Planned Boreholes folder or on a group and select
Import Planned Boreholes. If the IDs in the file are already in the project, you will be prompted to
resolve the conflict:

You can:
l

l

l

Rename the imported boreholes. Leapfrog Works will automatically assign new names and import
the planned boreholes.
Exclude planned boreholes that already exist in the project. Planned boreholes will only be imported
if they have an identifier that does not already exist in the project.
Replace existing planned boreholes with the imported boreholes. Use this option if you are importing
information previously exported from the project and subsequently updated in an external
application.

Click OK to process the file.
If there are no conflicts, the planned boreholes will be added to the project.

Calculations and Filters
Calculations and Filters uses data and estimators to derive new values, resource classifications and
more. A powerful and versatile tool, it offers a simple and intuitive editor so you do not need to be an
expert programmer to make use of its pure functional language to define calculations. Even complex
calculations can be developed with ease.
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The rest of this topic describes:
l
l

Defining Calculations and Filters for drilling data tables, imported points and some derived points.
A Catalogue of Metadata, Syntax and Functions. It describes each of the items in the pinnable Insert
list and includes intentionally trivial examples to illustrate the use of the item, along with an
explanation of the effect of the expression.

Defining Calculations and Filters
Some aspects of this feature may be illustrated using examples including block models. Block models
are a feature that requires the Contaminant extension in Leapfrog Works. What is described for
points objects can also be applied to block models if you have the Contaminants extension.
This topic describes how to define calculations and filters for drilling data tables, imported points and
some derived points. It is divided into:
l
l
l
l
l

The Calculations Window
Creating a New Calculation or Filter
Understanding Errors Reported in the Errors Pane
Building Calculations and Filters
Null Values

The topic that follows, Catalogue of Metadata, Syntax and Functions, details each of the items in the
pinnable Insert list and includes intentionally trivial examples to illustrate the use of the item, along
with an explanation of the effect of the expression.
A printable guide is available that contains this topic and the Catalogue of Metadata, Syntax and
Functions topic. The guide is a useful reference to help you get started with the Calculations and
Filters editor. To download this guide, click here.
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The Calculations Window
Right-click on a drilling data table to find the Calculations option or on a points table to find the
Calculations and Filters option.

The Calculations and Filters option is not available for all points tables.
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When the Calculations window is first opened, the Insert list is pinned to the right-hand side. You can
untick the Pin Window box to get more screen space.

You can then select items by clicking on the Insert menu.

Items in this list are divided into Existing items and Syntax and functions. Existing items include
handy metadata items you can use immediately, e.g. row ID and point location coordinates. It also
includes evaluations that can be selected, such as estimators. Syntax and functions contains
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mathematical operators and other calculation elements, along with special values such as 'blank' and
'error' and pre-made functions such as unit conversions and log(n).
If the Calculations window is docked as a tab, you can tear the tab off to form a stand-alone window.
You might do this when arranging your windows so you can see the Calculations window at the same
time as the scene. The detached window can be docked again by dragging the tab back alongside the
other tabs, as described in Organising Your Workspace.
The toolbar in the Calculations window has three buttons that relate to copying, importing and
exporting calculations and filters between points objects and projects:

To copy calculations and filters from another points object, click the Copy items from another
object button ( ) and select the source to copy from.
To export calculations and filters, click the Export button ( ). You will be prompted for a file name and
location. The information is saved in *.lfcalc format, which is a binary file format. This format cannot be
read or written by any other program.
To import calculations, click on the Import button ( ) and select a calculations file to import.
The arrow buttons allow you to quickly expand ( ) or collapse ( ) all calculations and filters. You can
also individually expand or collapse a calculation or filter by clicking on the = symbol next to the
calculation or filter name.
Cut ( ), Copy ( ) and Paste ( ) buttons provide basic text operations on selected parts of
equations.
Undo ( ) and Redo ( ) buttons provide the ability to move back and forward in the edit history for
your equations.

Creating a New Calculation or Filter
Click the New Item button to add a calculation to the Calculations window.
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The New Item windows gives you the choice of creating a variable, a numeric calculation, a category
calculation, or a filter. Select one of these options, enter a name for the new item and click OK.
The item will appear in the list on the left-hand side of the Calculations window.

If you want to delete an item, click on it in the list, then select Delete:

Variables
A Variable is an expression that is given a name to make it simple to refer to the expression in other
parts of the Calculations window. Note that ‘variable’ is a homonym/homograph that in a different
context has a different meaning; ‘variable’ is at times used to refer to a mineral such as gold or silver. In
the context of calculations and filters, the meaning is aligned with the use of the word in mathematics
and scripting languages.
Using a variable in calculations can make the calculations easier to read and understand. It also makes it
simple to reuse an expression multiple times in different places. Any time you find the same expression
appearing in different calculations, or in different parts of a calculation, split that expression out into a
variable. You can even use a variable to represent a constant value, such as a particular density measure.
You can use it to hold a value you want to change as you experiment. If the value is used in multiple places
in other expressions and calculations, using a variable in those places means you only need to change the
value in one place instead of many.
Numeric Calculations
A Numeric calculation is an expression that evaluates to a number, or a number for each point
evaluation used as input. A numeric calculation can be viewed in the 3D scene as a points object.
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Category Calculations
A Category calculation is an expression that evaluates to text, usually used to label a category or
classification such as a lithology or grade description. If a points object is used as input, each point will be
assigned a text label to categorise it according to the evaluation value. A category calculation can be
viewed in the 3D scene as a points object.
Filters
A Filter is an expression that limits the data to specified constraints. When viewing a points object in the
scene view, filters can be selected in the properties panel's Query filter option to constrain which
points are displayed.

Understanding Errors Reported in the Errors Pane
Items in the Existing items list or in the Syntax and functions list can be selected and added to the
Calculations pane. While a calculation or filter is incomplete, the Error pane will identify what is needed
to make the calculation valid.
The errors pane will report when the syntax of an expression cannot be validly interpreted. It cannot
report when the expression is not correctly structured to do what was intended.
While you are in the process of constructing an expression, errors will be reported when the incomplete
expression cannot be validly interpreted:

The messages provide the reason the expression is not valid or complete, but it cannot tell you how to
complete or correct the equation.
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Other errors will be displayed when the type of result doesn't match the sort of calculation selected
when it was created. A numeric calculation needs to produce numbers, a category calculation needs to
produce text results, and filters need to produce true or false (boolean) results.

Text needs to be identified by enclosing it with quotation marks, so it is not mistaken by the calculation
engine as some sort of unspecified constant.

A processing error indicates a problem executing part of the calculation for at least one of the points.
The function may be syntactically correct, but the calculation cannot be performed for one or more
points for some other reason. In the example below, number will not be able to be calculated if
magnitude is ever below 3, as that will result in a divide by zero error. Because magnitude ranges from
about 0.1 upwards, this does indeed cause a processing error. Not all processing errors will be divide by
zero errors. The list of problems that will be reported as processing errors includes:
l
l
l
l
l
l
l
l
l
l

divide by zero
log of zero or a negative number
log base of 1
raising a negative number to a fractional power
sqrt of a negative number
numeric overflow, producing a number outside the range -1e308 to 1e308
a null value (blank, outside, without_value) in a set
multiple instances of the same value in a set
referencing a column that has been deleted
referencing a column that contains processing errors

Some processing errors will report that the problem is due to 'above errors', referring to errors higher in
the errors list.
Processing errors will include a count of the number of affected blocks. Note that processing errors will
only show up in the error list once processing has completed. You may need to unpause process
execution and Run All processes.
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You may have more than one error shown. As a rule of thumb, address the errors at the top first, as this
corrective action may address the subsequent error.

Building Calculations and Filters
Items in the Existing items list or in the Syntax and functions list can be selected and added to the
Calculations pane. Wherever a dotted box appears in the Calculations pane, you can add items and
operators. Select an insertion point by clicking the dotted box where the item is required. You will see
that the colour of the dotted box turns from black to orange to indicate that it is the currently selected
entry box. Insert an item from one of the lists by clicking on it.

Select additional operators, constants, evaluations or other items as required, or type in values.
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Some items you insert include placeholders that need to be replaced. For example, here, a value needs to
be entered at the cursor position and the terms ‘lower’ and ‘upper’ need to be replaced with other items.

The if (::) conditional statement can have additional rows added to it. Insert the cursor where you want
to insert a row and then click the Add Row button ( ) and a row will be added above the selected line.

You can hold the Shift key to add the row below the cursor. To delete the selected row, click the Delete
Row button ( ).
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A calculation or filter can be renamed after it has been created. Click on its name and select Rename
from the menu that appears:

Examples of Variables
Variables can produce numeric, boolean, or text results. You may create a variable because using a
variable in other expressions can make them easier to read and understand, or it can let you change a
value in just one place, even though it is used in many expressions.

While producing results similar to numeric calculations, category calculations or filters, variables cannot
be viewed on the block model in the 3D scene.
Example of a Numeric Calculation
Numeric calculations must produce numeric results, or an error will be reported.
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The results of the numeric calculation for the points object can be viewed in the 3D scene by rightclicking on the numeric calculation entry in the project tree and selecting View Object.

Example of a Filter
In this example, one of the selectors from the Complex Comparisons options was chosen from the
insert list. The value that will be tested is to be added at the insertion point between the comparators,
and the placeholder words ‘lower’ and ‘upper’ need to be replaced with constants.

Here the numeric column [time] has been specified as the value that will be tested, and lower and upper
limits have been specified.
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When you select View Object for the filter in the project tree, the Query filter is set to the selected
filter in the shape properties panel.

Example of a Category Calculation
This example uses a category calculation to organise events into quarters for the year 2014 using the if
(::) conditional statement.
The if(::) conditional statement contains two lines by default. Note the guiding cues within the dotted
entry boxes. The first line describes the test to be performed that, if it evaluates as true, will produce a
specified result. The ‘otherwise’ condition on the second line captures all the tested conditions that did
not evaluate as true in the test on the first line, and these all produce an alternate result:

In this case, all the values outside of the range of the filtering expression [Year] = 2014 are outside the
period of interest. We add the expression as the ‘test’ condition, and specify the label "2014" as the first
result, and use the label "Not Considered" in the bottom line for the ‘otherwise’ condition. So the labels
are not mistaken by the calculation engine as some sort of unspecified constant, make sure labels are
identified using quotation marks:

We need to extend this trivial example for organise the period into quarters, and to do this we can nest if
(::) conditional statements. Replace the "2014" label with a new if(::) item:
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Now if values pass the filter in the first test, they then get to be sorted using the second if(::) block. This
time we will test the month field and if it is less than or equal to 3 we will classify this as "Q1":

Shift-click the Add Row button ( ), and a new conditional row is added below the current one, where
we can specify that a Month value less than or equal to 6 will be classified as "Q2". Only values between
4 and 6 will be classified as "Q2" as the first line will have already classified all the values under 4 as "Q1".
Repeat to add another row specifying a Month value less than or equal to 9 to be classified as "Q3".
This leaves the ‘otherwise’ row in the nested if(::) block to catch values above 9 which are labelled "Q4":

The new 2014_quarter calculation we have constructed can be added to the scene view. Click the Edit
Colours button in the shape list to select which categories are visible.
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Null Values
Leapfrog Works can differentiate between different types of invalid or null values, which are shown in
the Calculations window:

If you are using the Contaminants extension adding block models, you will have additional invalid values:
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You can see how many points or blocks of each normal or invalid status occur in an evaluation by rightclicking on the evaluation in the project tree and selecting Properties:

Invalid values can be displayed in the scene. When a block model is displayed in the scene, you can
choose between displaying evaluation values or the Status. Highlighted below is a Kriging evaluation,
shown displayed on the block model. Next to the Kriging evaluation in the dropdown list is a Status
option:
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When the status option is selected, the model is displayed by block status. Click Edit Colours to change
what status values are displayed.

With block model statistics, you can view statistics for all evaluations and calculations made on a
block mode. Statistics can be broken down into categories and organised by numeric evaluations and
calculations. See Viewing Block Model Statistics in the Block Models topic for more information.

Catalogue of Metadata, Syntax and Functions
This catalogue details each of the items in the pinnable Insert list for Calculations and Filters. Each
item includes an intentionally trivial example to illustrate the use of the item, along with an explanation of
the effect of the expression.
Some aspects of this feature may be illustrated using examples including block models. Some
capabilities are specific to block models. Block models are a feature that requires the Contaminant
extension in Leapfrog Works. Unless otherwise stated, what is described for points objects can also
be applied to block models if you have the Contaminants extension.
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Existing Items
This section covers the items listed in the left-hand side of the pinnable Insert list:

To pin these lists to the Calculations tab, enable the Pin Window option:

Metadata

id
This metadata item is available for imported points objects. It is the row ID from the points table.

Example

Explanation
The filter even rows will select for points with a row [id] that has no remainder when divided by 2.
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x, y and z
These three metadata items are the variables for locating each point in a points object in X, Y and Z
coordinates. Select an item to add it to the expression at the insertion point. Note that whenever one of
these metadata items is added to an expression, it is wrapped in square brackets. This is not available for
block objects; use xc, xy and xz instead.

Example

Explanation
The numeric calculation YX will be assigned the value of the location of [y] multiplied by the location of
[x].

xc, yc and zc
These three metadata items are the variables for locating the centroid of each block, in X, Y and Z
coordinates. Select an item to add it to the expression at the insertion point. Note that whenever one of
these metadata items is added to an expression, it is wrapped in square brackets. This is not available for
points objects; use x, y and z instead.

Example

Explanation
The numeric calculation top will be assigned the value of the location of [zc] the altitude of each block
centroid from the zero reference, plus half the height of the block.

dx, dy and dz
These three metadata items are the variables for the block dimensions in X, Y and Z coordinates. Select
an item to add it to the expression at the insertion point. Note that whenever one of these metadata
items is added to an expression, it is wrapped in square brackets. This is not available for points objects.

Example

Explanation
The numeric calculation surface area will be calculated by figuring the area of each face of the block by
multiplying the X and Y dimensions, X and Z dimensions and Y and Z dimensions and adding them
together.
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volume
This metadata item provides the volume for each block. Note that when this metadata item is added to
an expression, it is wrapped in square brackets. This is not available for points objects.

Example

Explanation
The numeric calculation density will be assigned the value of the variable [mass] divided by the metadata
item [volume].

xi, yi and zi
These three metadata items are the variables for locating each block by X, Y and Z index. Select an item
to add it to the expression at the insertion point. Note that whenever one of these metadata items is
added to an expression, it is wrapped in square brackets. This is not available for points objects.

Example

Explanation
The numeric calculation remaining will be assigned the value of the block's AU_gpt evaluation, unless [zi]
the Z index of the block is greater than or equal to 40, in which case the block status will be set to the
invalid value outside.
Evaluations
Each of these items are automatically added to the list whenever an evaluation is added to the object.
When added to an expression, the item represents a placeholder in the calculation for an estimated
value, as the expression is evaluated for each of the locations in turn.
Note you can expand each evaluation in the list to see the attributes for the estimation evaluation that
may also be selected instead of or in addition to the estimated value.

Example

Explanation
The numeric calculation halved is defined by the evaluation [AU_gpt] divided by 2. Each location in the
object will have its own value for AU_gpt, and this calculation uses those values to create a new value
named halvedfor each location, using the formula above.
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Variables, Calculations and Filters
Each time you create a new variable, numeric calculation, category calculation, or filter in Calculations,
it will also be added to the Existing items list. You can select them from this list and they will be inserted
into your new expression at the insertion point. Note that whenever one of these named items is added
to an expression, it is wrapped in square brackets.

Example

Explanation
This example is only attempting to illustrate how variables, calculations and filters that have already been
defined can be referenced by name in new calculations; the calculation highlight is not intended to be
useful.
It is good practice to break your calculations down into parts, giving each part a relevant and readily
identifiable, unambiguous and easily understood name. This will make your calculations more readable
and clear. Using Variables to define a constant with a name makes it easy to understand the utility of
that particular constant when you use it in a calculation. You may also be able to re-use certain parts such
as filters or constant variables, so you do not need to define the same thing repeatedly.
Be careful not to inadvertently name something incorrectly, such as naming a volume as "area", as this
could give rise to difficult-to-locate errors in your calculation.
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Syntax and Functions
This section covers the items listed in the right-hand side of the pinnable Insert list.

To pin these lists to the Calculations tab, enable the Pin Window option:

Statements

(…) Brackets
Brackets are used to enclose an expression so the operations on the values within the brackets take
precedence over operations outside the brackets.
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Example

Explanation
1+2 will be calculated prior to calculating the result of the expression, following the standard order of
mathematical operations.

if(::) If block
The If block is used for conditional logic. This allows multiple pathways to results depending on selected
conditions, or categorisation based on values.
An If block will be evaluated by each test → result, row by row, separately and in order downwards by
row. . Each test has an output that can be ‘true’, ‘false’, or an invalid value, either ‘error’ or ‘blank’. Block
models can also have the invalid values‘without_value’ or ‘outside’ . The result output is produced by the
execution of the result expression. The If block output follows these rules:
l

l
l

l
l

l

l

If a test output is ‘error’, the If block output is ‘error’ and no further processing of subsequent rows is
done.
If a test output is ‘false’, the result expression is not executed, and the next row is considered.
If a test is ‘true’, the result expression is executed and the result output is used for the If block output
and no further processing of subsequent rows is done.
If all the tests are ‘false’, the ‘otherwise’ result expression is executed and its output is used.
If a test output is an invalid value (without_value, blank, outside) the result expression is not executed
and the test output’s invalid value is remembered. The subsequent rows are then run.
If a subsequent test output is ‘true’ after an earlier one produced an invalid value, the previous test
output is discarded and the new row’s result expression output is used as the output for the If block.
If all test outputs are invalid status values, the highest priority status of all the remembered invalid
statuses is used as the output result. The priority of non-error invalid status values is: outside >
without_value > blank.

Additionally, it is possible to choose to produce invalid values as the output of result expressions.

Example

Explanation
Cu_pct is the name of an evaluation applied to all the points in a points object. As the if(::) If block
calculation is run for each point, the evaluation for each point replaces this variable name in the
expression. If the value is greater than the value of the constant pi, the result for that point will be the
text string "Blue". Otherwise, if the value is less than or equal to pi, the result will be the string "Red".
Additional rows may be added. Each row follows on from the left-over results of the line before,
simplifying the logical expression that may be used.
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Explanation
Note the addition of the line [Cu_pct] > e → "Purple". This line can be interpreted to mean: if the value
estimated for a point is less than or equal to pi, but greater than e the result shall be "Purple". The part
about it being less than or equal to pi is implied because the line follows the previous line [Cu_pct] > pi →
"Blue".
Note that expression elements before and after the if expression can be entered. This allows the if(::) If
block to form part of a more complex or extensive expression.

Explanation
The earlier conditional classification has now been embedded within a concatenation function, forming
the first part of a two-part string concatenation. The concatenation function is adding the text string "ish" to whatever is produced by the if(::) If block. Thus, if the value of the block being evaluated is 1.2,
the result of the colour categorisation calculation will be "Red-ish".
Basic Operators

+ Add
An arithmetic addition operation.

Example

Explanation
next is assigned the value of the current imported points row [id] plus 1.

- Subtract
An arithmetic subtraction operation.

Example
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Explanation
prev is assigned the value of the current imported points row [id] minus 1.

* Multiply
An arithmetic multiplication operation. Note that implied multiplication, putting factors adjacent to one
another, is not supported. The * operator must be explicitly used.

Example

Explanation
product is assigned the value of [x] times [scale].

/ Divide
An arithmetic division operation.

Example

Explanation
quotient is assigned the value of [numerator] divided by [denominator].

% Modulo
An arithmetic modulo operation. This is an integer division operation that returns the remainder instead
of the integer quotient.

Example

Explanation
remainder is assigned the value of [numerator] modulo [denominator], or in other words, [numerator] is
divided by [denominator] to produce an integer quotient , the number of times [denominator] goes into
[numerator], and a remainder, which is the number returned by this modulo function.

^ Power
A mathematical exponentiation operation where a base is raised to the power of the exponent.

Example
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Explanation
area is assigned the value of pi * [radius]2 (because ^2 is interpreted as ‘to the power of the exponent 2’
or 'squared'). Because [radius] happened to be defined as equalling 2, the result of the expression pi * 22
is 12.56637..., as can be seen from the result at the end of the expression.

and Logical and
A logical and operation.

Example

Explanation
filter will be true if the point is classified in the 'Dacite' part of the geological model AND the [z]
coordinate for the point is above 2800; it will be false if either of these conditions are not true.

or Logical or
A logical or operation.

Example

Explanation
Dacite and ED will be true if the point is classified in the 'Dacite' part of the geological model OR the
point is classified in the 'Early Diorite' part of the geological model, but it will be false if neither of these
conditions is true.

not Logical not
A logical not operation.

Example

Explanation
Not Dacite will be true if the point is classified in the geological model as anything other than 'Dacite'.
The logical operator not inverts the logical expression that follows the operator.

= Equal
A logical equality operator.

Example
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Explanation
Dacite will be true if the point is classified in the 'Dacite' part of the geological model, and will be false for
all other values.

!= Not equal
A logical not-equal operator.

Example

Explanation
Not Dacite will be true if the point is classified in the geological model as anything other than 'Dacite',
and will be false when it is 'Dacite'.

< Less than
A logical less-than operator.

Example

Explanation
density under 1 will be true when the variable [density] is less than 1, and false otherwise.

< Less or equal
A logical less-than-or-equals operator.

Example

Explanation
density le 1 will be true when the variable [density] is less than or equal to 1, and false otherwise.

< Greater than
A logical greater-than operator.

Example

Explanation
density over 1 will be true when the variable [density] is more than 1, and false otherwise.
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< Greater or equal
A logical greater-than-or-equals operator.

Example

Explanation
density ge 1 will be true when the variable [density] is more than or equal to 1, and false otherwise.
Complex Comparisons

Lower < n < upper
A pair of comparisons, with a logical result to indicate if the tested value n is between the lower value
provided and the upper value provided.

Example

Explanation
filter will be true when the point evaluation [AU_gpt] is between the values of 5 and 8 (but not equalling
5 or 8); it will be false otherwise.

Lower <= n < upper
A pair of comparisons, with a logical result to indicate if the tested value n is between the lower value
provided and the upper value provided, or equal to the lower value.

Example

Explanation
filter will be true when the point evaluation [AU_gpt] is between the values of 5 and 8 (but not equalling
8); it will be false otherwise.

Lower < n <= upper
A pair of comparisons, with a logical result to indicate if the tested value n is between the lower value
provided and the upper value provided, or equal to the upper value.

Example
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Explanation
filter will be true when the point evaluation [AU_gpt] is between the values of 5 and 8 (but not equalling
5); it will be false otherwise.

Lower <= n <= upper
A pair of comparisons, with a logical result to indicate if the tested value n is between (or equal to either)
the lower value provided and the upper value provided.

Example

Explanation
filter will be true when the point evaluation [AU_gpt] is greater than or equal to 5 and less than or equal
to 8; it will be false otherwise.

x in {a,b,...}
A logical inclusion expression. This will return true if x matches any element of the set of listed items.

Example

Explanation
If [colour] is one of the items in the list within the curly brackets, filter will be true. If [colour] is anything
else, filter will be false.

x not in {a,b,...}
A logical exclusion expression. This will return true if x fails to match any element of the set of listed
items.

Example

Explanation
If [colour] is not one of the items in the list within the curly brackets, filter will be true. If [colour] matches
any item in the list, filter will be false.
Invalid Values
Invalid values are different types of results for “numeric” categorisation calculations that need special
non-numeric results for certain category results. These have special meanings of their own without
having to resort to interpreting negative numbers and zero as having special meaning.
blank means having no value, the value in the imported file is blank or has non-numeric data
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without_value is often used to mean the estimator cannot produce a value (specific to blocks)
outside is used to indicate the block is outside the boundary of the domain (specific to blocks)
error generates an error, and provides an ‘error’ status value for the affected block or point
error(‘message’) is similar to error but includes a custom message.

Multiple case example

Explanation
If the variable [area] is equal to 0, the point will be marked with the special value blank. If the variable
[area] is less than 0, the point will be marked with the special value outside. If [area] is greater than 0 and
the variable [result] is equal to 0, the point will be marked with the special value without_value. If [area] is
greater than 0 and [result] is greater than 0, the point will be will be assigned the value of the variable
[result]. If [area] is greater than 0 and [result] is less than 0, the point will be given the special value error
and status with the message 'negative result'.

is_normal(a)
A function that tests a to see if it is a normal value or an invalid value. If a is normal, it returns true. If a is
invalid, it returns false.

Example

Explanation
If [number] has a normal value, filter will be true for that block. If it produces an invalid value, filter will be
false.

is_blank(a)
A function that tests a to see if it is a blank invalid value. If a is blank, it returns true. If a is normal or
another invalid value, it returns false.

Example

Explanation
If [number] has a blank status, filter will be true for that block. If it produces any other invalid value or a
normal value, filter will be false.
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is_without_value(a)
A function that tests a to see if it is a without_value invalid value. If a is without_value, it returns true. If a
is normal or another invalid value, it returns false.

Example

Explanation
If [number] has a without_value status, filter will be true for that block. If it produces any other invalid
value or a normal value, filter will be false.

is_outside(a)
A function that tests a to see if it is an outside invalid value. If a is outside, it returns true. If a is normal or
another invalid value, it returns false.

Example

Explanation
If [number] has an outside status, filter will be true for that block. If it produces any other invalid value or
a normal value, filter will be false.
Mathematics

pi Constant
The constant pi is an existing item you do not need to define yourself. It is defined to 15 decimal places as
3.141592653589793.

Example

Explanation
area will be calculated as pi multiplied by the square of [radius]. Note that pi is not enclosed in square
brackets like user-created variables and constants, as it is an internal constant.

e Constant
The constant e, the base of the natural logarithm, is an existing item you do not need to define yourself.
It is defined to 15 decimal places as 2.718281828459045.

Example
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Explanation
comp will be calculated as e to the power of ([rate] minus 1). Note that e is not enclosed in square
brackets like user-created variables and constants, as it is an internal constant.

log(n) Base 10
The common logarithm, the logarithm with base 10, i.e. log10(n) or lg(n). This function will calculate the
common logarithm of the value provided as n.

Example

Explanation
scaled will be calculated as log10 of [measure].

log(n, base)
The logarithm of a number n to the base base.

Example

Explanation
scaled will be calculated as log2 of [measure].

ln(n) Natural log, base e
The natural logarithm, the logarithm with base e, i.e. loge(n). This function will calculate the natural
logarithm of the value provided as n.

Example

Explanation
scaled will be calculated as loge of [measure].

exp(n) Natural exponent
The natural exponent. This function will provide the result of en.

Example

Explanation
em will be calculated as e [measure].
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sqrt(n) Square root
The principle square root of the provided number n.

Example

Explanation
sqrtmwill be calculated as the square root of [measure].

abs(n) Absolute value
The absolute value of a number is it's value with the sign of the number disregarded. The absolute value
of -42 is 42. The absolute value of 42 is also 42.

Example

Explanation
absm will be whatever [measure] is, but without its sign; it will always be positive as a result.
Limits and Rounding

min (n, m, ...)
Returns the lowest of all the values in the set provided.

Example

Explanation
low will be the lowest of the three values provided, the metadata items for the X, Y, and Z point
coordinates.

max (n, m, ...)
Returns the highest of all the values in the set provided.

Example

Explanation
high will be the highest of the three values provided, the metadata items for the X, Y, and Z point
coordinates.
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clamp(n, lower)
This clamp function tests the value n against the threshold lower and if it is less than lower the result will
be lower; otherwise the result will be n. The effect is to push all the values below the threshold up to the
threshold.

Example

Explanation
The output for modified will range from 0.25 up to the maximum value of [AU_gpt].If [AU_gpt] is less
than 0.25, the output will be 0.25 instead. Otherwise, the output will be [AU_gpt].

clamp(n, lower, upper)
This clamp function tests the value n against the threshold lower and if it is less than lower the result will
be lower; it tests the value n against the threshold upper and if it is more than upper the result will be
upper; otherwise the result will be n. The effect is to squish all the values into a box between the lower
and upper thresholds.

Example

Explanation
The output for modified will range from 0.25 up to 8. If [AU_gpt] is less than 0.25, the output will be
0.25 instead. If [AU_gpt] is more than 8, the output will be 8 instead. Otherwise, the output will be [AU_
gpt].

round(n)
This function rounds the input value n to the nearest whole number.

Example

Explanation
The variable negative will be given the value -13 as the nearest whole number to -12.6789 used as the
input to the function. The variable positive will be given the value 13 as the nearest whole number to
12.6789 used as the input to the function.

round(n, dp)
This function rounds the input value n to the number of decimal places specified by dp, a positive integer.
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Example

Explanation
The variable negative will be given the value -12.3457, the value of -12.3456789 rounded to 4 decimal
places. The variable positive will be given the value 12.3457, the value of 12.3456789 rounded to 4
decimal places.

roundsf(n, sf)
This function rounds the input value n to the number of significant figures specified by sf, which must be
a positive integer >= 1. Rounding to a given number of significant figures is often preferred in scientific
applications over rounding to a given number of decimal places, as outputs can be rounded to the same
amount of significance as the inputs.

Example

Explanation
The variable negative will be given the value -12.35, the value of -12.3456789 rounded to 4 significant
figures. The variable positive will be given the value 12.35, the value of 12.3456789 rounded to 4
significant figures.

floor(n)
This function removes the fractional part of a real number n and returns the integer number below the
real number n. This remains true when n is a negative number.

Example

Explanation
The variable negative will be given the value -13, the integer below -12.3456789. The variable positive
will be given the value 12, the integer below 12.3456789.

ceiling(n)
This function removes the fractional part of a real number n and returns the integer number above the
real number n. This remains true when n is a negative number.
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Example

Explanation
The variable negative will be given the value -12, the integer above -12.3456789. The variable positive
will be given the value 13, the integer above 12.3456789.

truncate(n)
This function simply removes the fractional part of a real number n and returns the integer number
without the fractional part. This means that for positive real numbers, the result will be the integer less
than the real number n, but for negative real numbers, the result will be the integer greater than the real
number n.

Example

Explanation
The variable negative will be given the value -12, the integer part of -12.3456789. The variable positive
will be given the value 12, the integer part of 12.3456789.
Text

'abc' Text value
Use this item to add a text sequence to an expression. Selecting the item will add two single quotation
marks with the cursor between, ready for the text sequence to be typed. You can of course simply type
the quote marks into the expression yourself. Double quotations marks also work identically to the single
quotation marks used by this item. If you need to include a quote mark inside your text sequence, you
need to "escape" the character so it is not interpreted as the end of the text sequence, by entering two
quotation marks for each quotation mark you want inside the text sequence. Alternatively, you can use a
different type of quotation mark as the sequence wrappers; for instance to write Seequent's Region with
an internal apostrophe, you might wrap the sequence with double quotation marks: "Seequent's
Region".

Example

Explanation
The text sequence Seequent's Region (note: without the wrapping quotation marks and with only one
possessive apostrophe) will be used wherever the variables name1 or name2 are used in expressions.
Both techniques for including apostrophes in the text sequence have the same result.
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Enter text...
This selection opens a dialog box prompting you for text. After you enter it and click OK, the text will be
entered at the cursor, wrapped with quotation marks. This is an easy way to resolve any issues about
internal quotation marks, as the dialog box will convert the text into the necessary character sequence
required to generate your desired text.

Example

Explanation
This will produce a converted character sequence that produces a valid string and insert it to the
expression at the insertion point.

concat(t, u, ...)
This concatenates a series of text sequences together.

Example

Explanation
Each of the text sequences in the input are run together and combined. If [direction] is 'North' then
name will be Seequent_North_Region. If [direction] is 'South' then name will be Seequent_South_
Region.

startswith(t, 'prefix')
This function returns true if the text sequence t starts with prefix, and false otherwise. This is case
insensitive; 'prefix' will match 'PREFIX'.

Example

Explanation
filter will be true if [name] starts with Seequent.

endswith(t, 'suffix')
This function returns true if the text sequence t ends with suffix, and false otherwise. This is case
insensitive; 'suffix' will match 'SUFFIX'.
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Example

Explanation
filter will be true if [name] ends with Region.

contains(t, 'part')
This function returns true if the text sequence t contains part somewhere within, and false otherwise.
This is case insensitive; 'part' will match 'PART'.

Example

Explanation
filter will be true if [name] contains North somewhere within the character sequence.

like(t, 'pattern')
This function returns true if the text sequence t matches pattern, where [pattern] is follows SQL-style
LIKE matching rules. This is case insensitive, and pattern must match the whole of t, not just a portion of
it. Use _ as a wildcard for a single character, and % as a wildcard for any number of characters (including
no characters).

Example

Explanation
filter will be true if [name] matches the pattern %Seequent_Region%. Examples of [name] that will
match include:
l
l
l
l
l
l

SEEQUENT1Region
SEEQUENT1REGION
Seequent2region
NorthernSeequent1Region
SEEQUENT3regionExtra
#seequentXregion#

Examples that will not match include:
l
l
l

Seequent12Region
SeequentReg1ion
SeequentRegion
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regexp(t, 'pattern')
This function returns true if the text sequence t matches pattern, where [pattern] is follows regular
expression matching rules. This is case insensitive.

Example

Explanation
filter will be true if [name] matches the regexp pattern Seequent.Region. Examples of [name] that will
match include:
l
l
l
l
l
l

SEEQUENT1Region
SEEQUENT1REGION
Seequent2region
NorthernSeequent1Region
SEEQUENT3regionExtra
#seequentXregion#

Examples that will not match include:
l
l
l

Seequent12Region
SeequentReg1ion
SeequentRegion

Date/Time

'now' Current timestamp
Use this item to add the current date-and-timestamp at the insertion point.

Example

Explanation
While entering an expression, the 'now' selection has been chosen and a date-and-timestamp has been
entered at the insertion point.

'today' Current date
Use this item to add the current datestamp at the insertion point.

Example
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Explanation
While entering an expression, the 'today' selection has been chosen and a date-and-timestamp has been
entered at the insertion point.

dateonly(timestamp)
This function takes a date-and-timestamp and cuts off the timestamp to leave just the date.

Example

Explanation
While the [past] variable has a full date-and-timestamp, the dateonly function strips the time off and
leaves just the date.

Pick timestamp...
This selection opens a dialog box prompting you for a date and a time that will be entered at the
insertion point when you click OK.

Example

Explanation
Use the year picker, month picker, date selector and Time field to specify a date and time. If the above
date is entered, it will be represented in the expression as @2020-01-22 00:00:00.

Pick date...
This selection opens a dialog box prompting you for a date that will be entered at the insertion point
when you click OK.
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Example

Explanation
Use the year picker, month picker and date selector to specify a date. If the above date is entered, it will
be represented in the expression as @2020-01-22.
Unit Conversion

Mass/weight...
This selection opens a dialog box prompting for the From Unit and To Unit for the conversion.

When you have selected the two units, the dialog box disappears and the conversion function you
require will have been inserted into the expression at the cursor, and the cursor repositioned so you can
enter the source of the value to be converted.

Example

Explanation
The troy_oz_to_g function has been entered by the dialog box, and the variable [troyOz] has been
entered as the input. The numeric calculation grams will be given the output of the troy_oz_to_g
function.
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Distance...
This selection opens a dialog box prompting for the From Unit and To Unit for the conversion.

When you have selected the two units, the dialog box disappears and the conversion function you
require will have been inserted into the expression at the cursor, and the cursor repositioned so you can
enter the source of the value to be converted.

Example

Explanation
The ft_to_m function has been entered by the dialog box, and the variable [feet] has been entered as
the input. The numeric calculation metres will be given the output of theft_to_m function.

Area...
This selection opens a dialog box prompting for the From Unit and To Unit for the conversion.

When you have selected the two units, the dialog box disappears and the conversion function you
require will have been inserted into the expression at the cursor, and the cursor repositioned so you can
enter the source of the value to be converted.

Example

Explanation
The ha_to_acre function has been entered by the dialog box, and the variable [hectares] has been
entered as the input. The numeric calculation acres will be given the output of theha_to_acre function.
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Volume...
This selection opens a dialog box prompting for the From Unit and To Unit for the conversion.

When you have selected the two units, the dialog box disappears and the conversion function you
require will have been inserted into the expression at the cursor, and the cursor repositioned so you can
enter the source of the value to be converted.

Example

Explanation
The acre_ft_to_m3 function has been entered by the dialog box, and the variable [acre-ft] has been
entered as the input. The numeric calculation volm3 will be given the output of theacre_ft_to_m3
function.

Temperature...
This selection opens a dialog box prompting for the From Unit and To Unit for the conversion.

When you have selected the two units, the dialog box disappears and the conversion function you
require will have been inserted into the expression at the cursor, and the cursor repositioned so you can
enter the source of the value to be converted.

Example

Explanation
The degF_to_K function has been entered by the dialog box, and the variable [fahrenheit] has been
entered as the input. The numeric calculation Kelvin will be given the output of thedegF_to_K function.
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Pressure...
This selection opens a dialog box prompting for the From Unit and To Unit for the conversion.

When you have selected the two units, the dialog box disappears and the conversion function you
require will have been inserted into the expression at the cursor, and the cursor repositioned so you can
enter the source of the value to be converted.

Example

Explanation
The psi_to_kPa function has been entered by the dialog box, and the variable [pressure_psi] has been
entered as the input. The numeric calculation pressure_kPa will be given the output of thepsi_to_kPa
function.

Energy...
This selection opens a dialog box prompting for the From Unit and To Unit for the conversion.

When you have selected the two units, the dialog box disappears and the conversion function you
require will have been inserted into the expression at the cursor, and the cursor repositioned so you can
enter the source of the value to be converted.

Example

Explanation
The MJ_to_kWh function has been entered by the dialog box, and the variable [MegaJoules] has been
entered as the input. The numeric calculation kiloWatt Hours will be given the output of the MJ_to_kWh
function.

© 2020 Seequent Limited

Modelling
This section describes how to build models in Leapfrog Works.
l

l

l

l

l

It is not necessary to define a topography to model in Leapfrog Works, but a defined topography can
be used as an upper boundary for all models built in the project. A key advantage of defining a
topography is that it provides consistent elevation data for objects imported to and created in the
project. The quality of elevation information can be poor compared to X- and Y-coordinates, which
can create problems when using objects to build a model. A topography can be created from the
most reliable elevation data, and other objects can have elevation set from this topography.
Geological models can be built from lithology data or from any other suitable data in the project.
Visualising data in the scene is an important step in determining the model that will be built, and the
tools for doing this are described in Visualising Data. Once this has been determined, the next step is
to define a basic geological model and refine its boundaries. Modelling contact surfaces and setting
their cutting relationships determine how the basic model volume is divided into lithologies. Models
can also have a fault system that, once activated, will subdivided the model into fault blocks.
With the Numeric Models folder, you can interpolate downhole numeric data, composited borehole
data and points data.
Combined models use information from up to four geological models, interpolants and distance
functions in order to visualise relationships between different types of data in the project.
With the Hydrogeology extension, geological models created in Leapfrog Works can be used as the
basis for MODFLOW and FEFLOW models. You can create flow models directly in Leapfrog Works
and assign hydrological/material properties based on the lithologies in the geological model. Flow
models can be exported for use in other applications, and you can import existing flow models and
use them as the basis for the construction of new models. Flow models can be displayed in the scene,
and time-dependent data can also be visualised.

Assigning Attributes to Volumes
For geological models, numeric models and combined models, you can assign attributes to the model
volumes. To do this, right-click on the model in the project tree and select Volume Attributes. In the
window that appears, click the Add Attribute button ( ) to add a new column.
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Enter a name for the column and click OK. You can then edit the values in the table. When you click in
the scene, the values will be included in the information displayed about the selected volume:

Attribute information can be exported with IFC geometry.
Attribute information cannot be displayed in the Central Browser.
When you save scenes for viewing in Leapfrog Viewer, manually entered attributes will be displayed
when volume information is displayed.
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Defining a Topography
It is not necessary to define a topography to model in Leapfrog Works, but a defined topography can be
used as an upper boundary for all models built in the project.
A key advantage of defining a topography is that it provides consistent elevation data for objects
imported to and created in the project. The quality of elevation information can be poor compared to Xand Y-coordinates, which can create problems when using objects to build a model. A topography can
be created from the most reliable elevation data, and other objects can have elevation set from this
topography.
An important consideration when defining the topography is ensuring that it is large enough to
encompass the models you will be building in the project. If you create a small topography but then later
create a model that extends outside the topography, you will need to enlarge the topography, which can
result in considerable reprocessing of all objects in the project that use the topography as a boundary.
See Extending a Surface for more information.
This topic describes creating and working with a topography. It is divided into:
l
l
l
l
l
l
l

Topography From Elevation Grid
Topography From Surfaces, Points or GIS Vector Data
Fixed Elevation Topography
Adding Height Data to the Topography
Changing Topography Settings
Topography Display Options
Setting Elevation for Collar Points

The topography can be created from an imported elevation grid, points data, surfaces and GIS data. It is
not necessary to decide on a single source of information, as information can be combined, and you can
add and remove data as required.
Once defined, you can export the topography as a mesh or as an elevation grid. See:
l
l

Exporting Meshes
Exporting an Elevation Grid

Topography From Elevation Grid
There are two ways to create the topography from an elevation grid:
l

l

Right-click on the Topographies folder and select New Topography > Import Elevation Grid.
Import the grid as described in Importing an Elevation Grid.
Import the grid using the Meshes folder and then right-click on the Topographies folder and select
New Topography > From Surface.

Enter a name for the topography and click OK. A hyperlink to the elevation grid will appear in the
Topographies folder under the defined topography.
Once the topography has been defined, additional height data can be added by right-clicking on the
topography and selecting from the options available. See Adding Height Data to the Topography for
more information.
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Topography From Surfaces, Points or GIS Vector Data
To create the topography from a surface, points or GIS data, first import the data into the project.
l
l
l

Import surfaces into the Meshes folder.
Import borehole data into the project or points data into the Points folder.
Import GIS vector data into the GIS Data, Maps and Photos folder.

Next, right-click on the Topographies folder and select one of the New Topography options. A list of
suitable objects available in the project will be displayed. Select the required object and click OK. Enter a
name for the topography and click OK. A hyperlink to the source object will appear in the
Topographies folder under the defined topography.
Once the topography has been defined, additional height data can be added by right-clicking on the
topography and selecting from the options available. See Adding Height Data to the Topography for
more information.
See also Changing Topography Settings below.

Fixed Elevation Topography
If you don’t have any data suitable for creating a topography, you can set a fixed elevation. To do this,
right-click on the Topographies folder and select New Topography > Fixed Elevation. In the
window that appears, enter a value for the elevation and click OK. Enter a name for the new topography
and click OK.
The new topography will appear in the project tree under the Topographies folder.
Once a topography has been defined, the only way to set a fixed elevation is to remove the objects that
have been used to define the topography. To do this, right-click on the hyperlinked object and click
Remove. You will then be able to set a fixed elevation for the topography.
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Adding Height Data to the Topography
When creating the topography, it is not necessary to decide on a single source of information, as
information can be combined. Once the topography has been defined, additional height data can be
added by right-clicking on the topography and selecting from the options available:

It is not possible to add structural data or polylines with orientation information to the topography. If
you edit the topography with a polyline, your options for editing the polyline will be limited.
For points, surfaces and GIS vector data, you will be prompted to select from the data sources available
in the project. For an elevation grid, see Importing an Elevation Grid.
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All data objects used to define the topography will appear under the topography, hyperlinked to their
parent objects:

When you have added data to the topography, you may need to enlarge the topography extents. See
Changing Topography Settings below.
To remove data objects from the topography, either:
l

l

Delete the object from the topography. To do this, right-click on the hyperlinked object and click
Remove.
Delete the object from the project. If you choose this option, consider carefully the effects on other
objects in the project, as once an object is deleted, it cannot be recovered.

When the topography is defined from multiple objects, you can set the resolution of the topography by
double-clicking on it. See Changing Topography Settings below.
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Changing Topography Settings
When the topography is created from points or GIS data or when the topography is created by
combining data, you can change its boundary and resolution and apply a trend. To do this, double-click
on the topography in the project tree. The Edit Topography window will appear:

Changing the Size of the Topography
In the General tab, you can change the topography extents. Use the controls in the scene or enter the
required values in the Bounding Box fields.

Topography Resolution
The resolution of the topography depends on how it was created.
l

l

When the topography is created from a single mesh, the resolution of the topography is set from the
resolution of the mesh and can only be changed when the mesh is imported. If you wish to change
the resolution of the topography, you must first add more height data to the topography. See Adding
Height Data to the Topography.
When the topography is created by setting a fixed elevation, the resolution cannot be set.
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When the topography is created from points or GIS data or when the topography is created from
combining data, you can set its resolution in the Edit Topography window.
When you set a specific Surface resolution without enabling the Adaptive option, the triangles used
will be the same size for the whole topography. When you enable the Adaptive option, the resolution of
the topography will be affected by the availability and density of real data. See Surface Resolution in
Leapfrog Works for more information on these settings.

Applying a Trend to the Topography
In the Trend tab, you can apply a trend to the topography:

See Global Trends for more information.

Topography Display Options
To display the topography in the scene window, either:
l
l

Right-click on the topography in the project tree and select View Object.
Click on the topography object and drag it into the scene.

© 2020 Seequent Limited

Setting Elevation for Collar Points | 464

The topography will be displayed in the scene window and in the shape list:

The topography object in the shape list provides additional controls that can be used to change the way
the topography is displayed and highlight features of interest. For example, selecting an imported map
from the list results in it being displayed draped onto the topography:

The list is organised into:
l

l
l

Views. This contains options for creating and editing custom topography views and also lists any
views already defined. With custom topography views, you can view multiple GIS objects, maps and
contours. See Custom Topography Views for more information.
Maps and Photos. This lists all images stored in the GIS Data, Maps and Photos folder.
GIS objects. This lists all GIS data objects stored in the GIS Data, Maps and Photos folder.

Setting Elevation for Collar Points
You can set the elevation for all collar points or for a subset of collar points by projecting them onto a
surface. This overwrites elevation values in the z column of the collar table, using the data from the
selected surface. If the surface does not intersect vertically with the selected points, you can choose how
the z values for those unprojected points will be handled.
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To set the elevation for collar points from a surface, right-click on the collar table in the project tree and
select Set Elevation. The Set Elevation from Surface window will appear:

Select from the surfaces available in the project and set a query filter, if required.
Next, select how unprojected points should be handled. There are three options:
l
l
l

Assign elevation values to sets the z values to a fixed elevation for all unprojected points.
Leave elevation values empty clears the z values for all unprojected points.
Leave unchanged makes no changes to the z values for unprojected points.

Click OK to set elevation values.
The collar table will be updated with an additional column, z_on_terrain:
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The original z values are preserved in the z column. To switch back to the original z values, click on
Collar Elevation, then select the original column:

If you switch back to using the original z column, the z_on_terrain column will remain in the collar table.

© 2020 Seequent Limited

Geological Models
The model building process involves several key steps:
l
l
l
l

l
l
l

Creating the project and setting up the modelling environment
Importing borehole data and correcting errors
Importing other required data
Visualising the data in the scene and inspecting it to make sense of the model that will be built. It is at
this stage that you might create new borehole data columns to select data that will be the basis of
geological models.
Creating a basic GM, then refining its boundary and defining a fault system
Modelling the contact surfaces
Setting the cutting relationships between the different contact surfaces and generating volumes

A fault system can also be defined that divides the geological model into subunits in which the internal
structure can be defined independent of the other subunits in the model. This is described in Faulted
Models.
The rest of this topic describes the process of creating a geological model. It is divided into:
l
l
l
l
l
l
l

Creating a New Geological Model
The Geological Model in the Project Tree
Geological Model Display
Copying a Geological Model
Creating a Static Copy of a Geological Model
Geological Model Volumes and Surfaces Export Options
Extracting Model Volumes

A geological model can be created using only a basic set of parameters. The only parameter that cannot
be changed once the model has been created is the base lithology.

Creating a New Geological Model
To create a new geological model, right-click on the Geological Models folder and select New
Geological Model. The New Geological Model window will open, together with a set of controls in
the scene that help in defining the model extents.

The Base Lithology
Select the borehole data column that will be used as the basis of a model from the Base Lithology
Column list. If you do not wish to use lithology data as the basis for the model, select <None>. This may
be the case if, for example, you want to build a model from points data or from an imported map. If you
select <None>, you will need to manually define the lithologies that will be modelled.
If more than one column of lithology data is available for creating models, be sure to choose the
correct one as it cannot be changed once the initial model has been created. If after creating and
modifying the model, you find you need to modify the borehole data, resulting in a new lithology
column, you can use that new column to create contact surfaces using Other Contacts options.
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You can also filter the borehole data used to build the geological model using query filters. To do so,
select the required query filter from the Filter data list. Once the model has been created, you can
remove the filter or select a different filter.

Surface Resolution
The surface resolution setting Leapfrog Works automatically uses as the default is based on the data
available in the project. Set the surface resolution for the model as a whole and choose whether or not
the resolution will be adaptive. See Surface Resolution in Leapfrog Works for more information on the
effects of these settings.
Later, while refining the model, you can change the resolution of each surface and enable or disable
adaptive resolution. See Surface Resolution for a Geological Model.

Model Extents
A geological model is initially created with a basic rectangular set of extents aligned with the south/north
and east/west axes. You can define the model’s extents in three ways:
l
l

l

Enter the coordinates.
Select Enclose Object and choose from the list of objects in the project. If the model is based on
borehole data, select the lithology segments from the Enclose Object list.
Use the controls that appear in the scene. The orange handle adjusts the centre of the plane and the
red handles adjust the size.

See Object Extents for more information.
Enter a Name for the model that describes the purpose of the model. This Name will be used in naming
the objects that will be added to the model. Click OK to create the new model. The new geological
model will be created and added to the Geological Models folder.
See Editing a Geological Model for information on how to change the basic settings for the model.

The Geological Model in the Project Tree
The objects under the geological model in the project tree represent different parts of the model:

l

The Boundary object defines the limits of the geological model. When the model is first created, this
is the rectangular model extents. If a topography has been defined, it is automatically used for as the
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l
l

l

l

upper boundary. See Modifying a Geological Model’s Boundary for more information about
modifying the boundary.
The Fault System object defines faults and their interactions in the model. See Faulted Models.
The Lithologies object describes all the lithological units to be modelled and the colours that are
used to display them on the screen. It is generated automatically from all the lithologies identified in
borehole data selected when the model is created. If no column was selected, you will need to define
the lithologies manually before you start modelling the lithology layers.
The Surface Chronology object describes the contact surfaces in the model, organised in
chronological order, from youngest to oldest. These surfaces and their chronology determine how
the volume inside the model extents is divided into lithological units. When the model is first created,
the Surface Chronology is empty, but it will eventually hold all contact surfaces and inputs to them.
The Output Volumes folder contains all the volumes generated in building the geological model.
When the model is first created, the Surface Chronology is empty and so there is only a single
output volume in the Output Volumes folder. This volume fills the model’s extents and is called
“Unknown”. Once contact surfaces have been generated and added to the Surface Chronology
object, new volumes will be generated and added to the Output Volumes folder.

Geological Model Display
Right-click on the geological model in the project tree to view its display options:
l

l

l
l

The View Object option adds the geological model to the shape list as a single object. You can also
display the geological model in this way by dragging it from the project tree into the scene. Change
the visibility of the model’s volumes by clicking the Edit Colours button in the shape list.
The View Output Volumes option adds the model to the scene as a series of output volumes. It is
the equivalent of dragging the Output Volumes folder into the scene. Change the visibility of the
model’s volumes individually.
The View Surface Chronology option displays the surfaces that are used to divided up the model.
The View Fault Block Boundaries option is only available when a fault system has been defined
and enabled for the model. Selecting View Fault Block Boundaries displays the fault blocks
without displaying the lithology layers.

Copying a Geological Model
Creating a copy of a geological model is a useful way of experimenting with changes to a model.
To copy a geological model, right-click on it in the project tree and select Copy. Enter a name for the
copy of the model and click OK. The copy will be added to the project tree.

Creating a Static Copy of a Geological Model
Creating a static copy preserves a snapshot of a geological model that does not change, even when
changes are made to the data on which the original model was dependent. This is a useful way of storing
historical models and comparing models. Static copies can be exported from Leapfrog Works, as
described in Geological Model Volumes and Surfaces Export Options below.
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To create a static copy of a geological model, right-click on it in the project tree and select Static Copy.
Enter a name for the copy of the model and click OK. The copy will be added to the Geological Models
folder.
You can also import static geological models from Central, as described in Importing Central Data
Objects.
In the project tree, the static copy ( ) is made up of a Legend object ( ), a boundary ( ), a fault
system ( ), the output volumes ( ) and all surfaces created in building the model. The surfaces can be
used elsewhere in the project and exported for use in other projects.
To view the date a static copy was created, right-click on it in the project tree and select Properties.
The date the copy was created is shown in the General tab.

Geological Model Volumes and Surfaces Export Options
There are three options for exporting a geological model’s output volumes and surfaces. These are:
l

l

l

Export an output volume or a surface as a mesh. Right-click on it in the project tree and click Export.
You will be prompted for a file name and location. See Exporting a Single Mesh.
Export an output volume as a thickness grid. Right-click on it in the project tree and click Export
Thickness Grid. See Thickness Grids.
Export multiple output volumes and surfaces. Right-click on the geological model in the project tree
and select Export. See Exporting Multiple Meshes from Models.

When exporting output volumes, the Merge output lithology volumes setting in the geological
model’s General tab (see Editing a Geological Model) determines how the output volumes are handled
when they are exported. If this setting is enabled, internal walls and surface seams will be removed from
volumes of the same lithology.

Extracting Model Volumes
There are number of options for extracting meshes from geological model output volumes. These
options are available by right-clicking on volumes in the Output Volumes folder and selecting Extract
Mesh. There are five options:
l
l
l
l
l

Mesh Parts
Component Surfaces
Younger Surfaces
Older Surfaces
Boundary Surfaces

The Mesh Parts option is the same as the option available on meshes elsewhere in the project. See
Extracting Mesh Parts.
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The Younger Surfaces, Older Surfaces and Boundary Surfaces options extract different parts of
the selected volume, which are saved into the Meshes folder. Here, the boundary surfaces are shown in
blue, the younger surfaces in yellow and the older surfaces in orange:

Component Surfaces extracts a separate surface for each volume the selected volume interacts with,
including the boundary. The component surfaces are named after the boundary they are derived from
and saved into a subfolder in the Meshes folder. For example, here meshes have been extracted for
each contact with the Intermineral diorite volume:

Editing a Geological Model
Once a geological model has been created, you can change the model’s resolution and other basic
settings by double-clicking on the model in the project tree. The Geological Model window will open
with the General tab selected. The other tabs in the Geological Model window represent the different
parts of the geological model. It is generally more useful, however, to work with these parts of the model
on an individual basis by either double-clicking on the object in the project tree or right-clicking and
seeing what options are available.
The rest of this topic describes how to change the basic settings for a geological model. It is divided into:
l
l
l

Changing the Query Filter
Surface Generation Options
Volume Generation Options
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Changing the Query Filter
Although the Base lithology column cannot be changed once a geological model has been created,
you can change the filters applied to the data. Any filters defined for the lithology table used to define
the model can be applied to the Base lithology column:

Individual surfaces in the geological model can inherit the query filter from the parent geological model
or can use a different filter. To change what query filter is used for a surface, double-click on the points
used to create the surface and change the Query filter setting in the Lithology tab:

You may first need to disable the Inherit from GM option to change the Query filter.
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Surface Generation Options
The Surface Generation options apply to the model as whole, but can be overridden for individual
surfaces.

See Surface Resolution for a Geological Model for information on changing the Surface resolution
and Adaptive settings for individual surfaces.
When Exact clipping is enabled, model surfaces will be generated without “tags” that overhang the
model boundary. This setting is enabled by default when you create geological model.
Surfaces created in building the geological model can be set to snap to the data used in the model. There
are three options:
l
l

l

Off. Surfaces do not snap to the data used to create them.
All data. Surfaces snap to all data within the Maximum snap distance, which includes borehole
data and any data added to surfaces as part of the model refinement process.
Drilling only. Surfaces snap to borehole data within the Maximum snap distance but not to other
data used to modify surfaces.

Take care in enabling snapping and in selecting what data the surface will snap to, as the more data
you include, e.g. by setting a large Maximum snap distance or selecting All data for Snap to
data, the greater the possibility that errors in the data or assumptions inherent in interpretations
(e.g. polylines) will cause distortions in the meshes. If you do enable snapping, it is best to snap only
to drilling data. See Honouring Surface Contacts for more information on these settings.
If you need surfaces to honour borehole data but treat other data objects as interpretations, select
Drilling only. If you want finer control over what objects are snapped to, you can do this on a surfaceby-surface basis. See:
l
l
l
l
l

Surfacing Options for Deposits and Erosions
Surfacing Options for Intrusions
Surfacing Options for Veins
Changing Surfacing Options for an Offset Surface
Surfacing Options for a Structural Surface
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Volume Generation Options
The Merge output volumes setting determines whether or not output volumes of the same lithology
are merged when the volumes are exported. If Merge output volumes is set to Fast or Robust,
internal walls and surface seams will be removed from volumes of the same lithology. Either option is
suitable when you are using output volumes as extents for other models.
The difference between Fast and Robust is the algorithm used:
l
l

Fast removes back-to-back triangles before generating output volumes.
Robust uses the volume cutter, which tracks where the triangles originated and is, therefore, a slow
option for building output volumes.

If there are issues with surfaces exported to other modelling packages using the Do not merge output
volumes setting, try the Fast setting. If there are still issues, try the Robust setting.
When projects created in earlier versions of Leapfrog Works are opened in Leapfrog Works 4.0, the
Volume Generation setting for any existing geological models will not be changed.

Surface Resolution for a Geological Model
When you create a geological model (see Creating a New Geological Model), the surface resolution is set
for the model as a whole. When surfaces and boundaries are created as part of the model-building
process, their resolution is inherited from the geological model:
l

l
l

For deposit and erosion contact surfaces, stratigraphic sequences and model boundaries, the
resolution is the same as the geological model.
For intrusion contact surfaces, the resolution is half that set for the geological model.
For vein contact surfaces, the resolution is the same as the geological model, but the Adaptive
option does not apply.

You can change the resolution and enable or disable the adaptive isosurfacer on a surface-by-surface
basis. This is useful if you want to build a detailed model of some lithologies without increasing
processing time for other volumes.
To change the resolution settings for a contact surface, double-click on the surface in the project tree,
then click on the Surfacing tab:

For a lateral extent or fault, simply double-click on the surface in the project tree to change its resolution
settings.
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Untick the Inherit resolution from GM box to change the resolution settings for a surface. This
setting may be disabled, depending on the data used to create the boundary or surface.
The resolution of intrusion contact surfaces is also affected by the point generation parameters. See
Intrusion Point Generation Parameters for more information.

Modifying a Geological Model’s Boundary
Geological models are created with a basic set of rectangular extents that can then be refined using
other data in the project. These extents usually correspond to the ground surface and known
boundaries. Creating extents can also be used to restrict modelling to a particular area of interest; for
example, modelling can be restricted to a known distance from boreholes by applying a distance
function as a lateral extent. Extents do not need to be strictly vertical surfaces, and can be model
volumes. It is also possible to define a base that serves as the geological model’s base.
When a topography is defined for the project, it will be automatically applied as a geological model’s
upper boundary when the model is created.
The rest of this topic describes how to create and work with geological model extents. It is divided into:
l
l
l
l
l
l

Creating Extents for a Geological Model
Changing an Extent’s Settings
Adding Data to an Extent
Editing an Extent With a Polyline
Editing an Extent With Structural Data
Removing an Extent From a Geological Model

Creating Extents for a Geological Model
To create an extent, expand the geological model in the project tree. Right-click on the Boundary
object and select from the New Lateral Extent or New Base options. Follow the prompts to create
the extent, which will then appear in the project tree under the model’s Boundary object. For example,
this geological model has two lateral extents, one from a polyline and the other from GIS data:

New extents are automatically applied to the boundary being modified. Leapfrog Works usually orients a
new extent correctly, with red presenting the inside face of the extent and blue representing the outside
face. If this is not the case, you can change the orientation by right-clicking on the extent in the project
tree and selecting Swap Inside.
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Extent From a Polyline
You can create an extent from a polyline that already exists in the project or you can draw a new one. If
you want to use an imported polyline, import it into the Polylines folder before creating the new extent.
To create a new extent from a polyline, right-click on the model’s Boundary object and select New
Lateral Extent > From Polyline or New Base > From Polyline. In the window that appears, select
whether you will create a new polyline or use an existing one:

For lateral extents, you can create the extent as a Vertical Wall or Surface. If you create the lateral
extent as a Surface, you will be able to modify it using additional data, as described below. A lateral
extent created as a Vertical Wall, however, cannot be modified. A base is always created as a
surface and so can be modified as described below.
Click OK to generate the new extent. If you have chosen to create a New Drawing, the drawing
controls will appear in the scene and you can begin drawing, as described in Drawing in the Scene.
The new extent will appear in the project tree as part of the Boundary object.
If the surface generated does not fit the polyline adequately, you can increase the quality of the fit by
adding more points to the polyline. See Drawing in the Scene for information on adding points to
polylines.
Extents created from polylines can be modified by adding points data, GIS vector data and structural
data. You can also add polylines and structural data to the extent. See Adding Data to an Extent, Editing
an Extent With a Polyline and Editing an Extent With Structural Data for more information.
Extent From GIS Vector Data
GIS data in the project can be used to create a lateral extent or a base for a geological model. Once the
data you wish to use has been imported into the project, right-click on the model’s Boundary object
and select New Lateral Extent > From GIS Vector Data or New Base > From GIS Vector Data.
In the window that appears, select the data object you wish to use:
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For lateral extents, you can create the extent as a Vertical Wall or Surface. If you create the lateral
extent as a Surface, you will be able to modify it using additional data, as described below. A lateral
extent created as a Vertical Wall, however, cannot be modified. A base is always created as a
surface and so can be modified as described below.
If you select the Surface option, you can use the GIS data object with its own elevation data or
projected onto the topography:

Using the On Topography option makes sense for GIS data as it is, by nature, on the topography. The
On Topography option also mitigates any issues that may occur if elevation information in the GIS data
object conflicts with that in the project.
Click OK to create the new extent. The new extent will appear in the project tree as part of the
Boundary object.
Extents created from GIS data can be modified by adding points data, GIS vector data and structural
data. You can also add polylines and structural data to the extent. See Adding Data to an Extent, Editing
an Extent With a Polyline and Editing an Extent With Structural Data for more information.
Extent From Points
To create a new extent from points data, right-click on the Boundary object for the model you are
working on and select New Lateral Extent > From Points or New Base > From Points. The
Select Points To Add window will be displayed, showing points data available in the project:

Select the information you wish to use and click OK.
The new extent will appear in the project tree as part of the Boundary object.
Extents created from points can be modified by adding points data, GIS vector data and structural data.
You can also add polylines and structural data to the extent. See Adding Data to an Extent, Editing an
Extent With a Polyline and Editing an Extent With Structural Data for more information.
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Extent From Structural Data
Planar structural data can be used to create a lateral extent or a base for a geological model. You can
create a new structural data table or use a table that already exists in the project. If you want to use
categories of structural data in creating the extent, use an existing table and create filters for those
categories before creating the lateral extent.
To start, right-click on the Boundary object for the model you are working on and select New Lateral
Extent > From Structural Data or New Base > From Structural Data. The New Structural
Data window will be displayed, showing structural data available in the project:

Select the New Drawing option to draw the structural data points directly in the scene.
Select the Existing Structural Data option to use a table in the Structural Modelling folder. With
this option, you will be able to select from the categories available in the data table, if query filters have
been created for those categories:

Click OK to generate the new extent. If you have chosen to create a New Drawing, the drawing
controls will appear in the scene and you can begin drawing, as described in Creating New Planar
Structural Data Tables. To share the new structural data table, right-click on it and select Share. The
table will be saved to the Structural Modelling folder.
The new extent will appear in the project tree as part of the Boundary object.
Extents created from structural data can be modified by adding points data, GIS vector data and
structural data. You can also add polylines and structural data to the extent. See Adding Data to an
Extent, Editing an Extent With a Polyline and Editing an Extent With Structural Data for more
information.
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Extent From a Surface
To use a surface as an extent for a geological model, right-click on the model’s Boundary object and
select New Lateral Extent > From Surface or New Base > From Surface. The Select Boundary
window will appear, showing all the meshes that can be used as an extent:

Select the required mesh and click OK. The extent will be added to the model’s Boundary object.
You cannot modify an extent created from a mesh by adding data, editing with polylines or structural
data or by applying a trend. However, the extent is linked to the mesh used to create it, and updating the
mesh will update the extent.
Extent From Distance to Points
Leapfrog Works can calculate the distance to set of points and use the resulting distance buffer as a
lateral extent for a geological model. To create a new lateral extent from a distance buffer, right-click on
the Boundary object for the model you are working on and select New Lateral Extent > From
Distance To Points. The Smoothed Distance Buffer window will appear:

Select the Distance and set an Anisotropy, if required.
The Ellipsoid Ratios determine the relative shape and strength of the ellipsoids in the scene, where:
l
l

l

The Maximum value is the relative strength in the direction of the green line on the moving plane.
The Intermed. value is the relative strength in the direction perpendicular to the green line on the
moving plane.
The Minimum value is the relative strength in the direction orthogonal to the plane.
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You can also use the Set to list to choose different options Leapfrog Works has generated based on the
data used to build the model. Isotropic is the default option used when the model is created.
Click OK to create the new extent, which will appear in the project tree as part of the Boundary object.
To change the extent’s settings, expand the model’s Boundary object in the project tree and doubleclick on the extent. Adjust the Distance and Anisotropy, if required.
The resolution of extents is automatically inherited from the geological model. You can change the
resolution for an extent if you want more or less detail than for the geological model as a whole. To do
so, untick the box for Inherit resolution from GM and change the setting.
Extents created from a distance to points function can be modified by adding points data and GIS vector
data. See Adding Data to an Extent.
Extent From a Distance Function
A distance function calculates the distance to a set of points and can be used to bound a geological
model. You can use an existing distance function as a lateral extent or create a new one.
To use a distance function as a lateral extent, right-click on the Boundary object for the model you are
working on and select New Lateral Extent > From Distance Function. If there are no distance
functions in the project, you will be prompted to create a new one. See Distance Functions for
information on defining and editing the distance function.
When there are already distance functions in the project, you will be prompted to choose between
creating a new function or using an existing one:

To use an existing function, select it from the list and set a Buffer distance. Click OK to create the
lateral extent.
When you create a new distance function, it will be part of the model’s Boundary object and will not be
available elsewhere in the project. To share it within the project, expand the lateral extent in the project
tree and right-click on the distance function. Select Share. The distance function will be saved to the
Numeric Models folder.
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To change the extent’s settings, expand the model’s Boundary object in the project tree and doubleclick on the extent. The Edit Distance Buffer window will appear.

The resolution of extents is automatically inherited from the geological model. You can change the
resolution for an extent if you want more or less detail than for the geological model as a whole. To do
so, untick the box for Inherit resolution from GM and change the setting.
Base From Lithology Contacts
To create a base from lithlogy contacts, right-click on the Boundary object and select either New Base
> From Base Lithology or New Base > From Other Contacts.
The only difference in the two methods is that when creating a base from other contacts, you must
first select the lithology column from those available in the project.
When defining the base, select the primary lithology and the contacts to use:

For complex geologies, the up and down directions for the base may not be clear. If this is the case,
untick the Horizontal Plane box. A reference plane will appear in the scene, with the up-facing surface
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labelled A and the downward-facing surface labelled B. Controlling the position of the reference plane is
similar to controlling the position of the moving plane:
l
l

Use the handles in the scene window to move the plane.
Set the Dip and Dip Azimuth values in the New Contact Points window. The reference plane will
be updated in the scene.

When you disable the Horizontal plane option for the Reference Surface, the number of
contacts is longer displayed in the lithologies lists, as the number of contact points is not updated
when the reference surface used changes.
Once the reference plane is correctly oriented, click the Set From Plane button.
Click OK to create the base, which will appear under the Boundary object. The new base will
automatically be added to the model.
Each geological model can have only one base defined, so if you wish to define a new base, you must
first delete the existing base from the model. Do this by right-clicking on the Base object and
selecting Delete. You can also choose not to use the base you have defined. See Removing an Extent
From a Geological Model for more information.

Changing an Extent’s Settings
For geological model extents created from polylines, GIS data, points and structural data, you can
change the extent’s settings by double-clicking on it in the project tree.

In the Surfacing tab, you can change surface resolution and contact honouring options, which are
described below. In the Trend tab, you can apply a trend to the extent, which is described in Applying a
Trend.
Surface Resolution
For geological models, the resolution of extents and whether or not the adaptive isosurfacer is used is
automatically inherited from the geological model. You can change these settings for an extent if you
want more or less detail than for the geological model as a whole. To do so, untick the box for Inherit
resolution from GM and make the required changes.
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Contact Honouring
Often, surfaces should honour borehole data and treat data objects such as polylines and GIS data as
interpretations. For extents, the Snap to data setting in the Surfacing tab determines whether or not
the extent honours the data used to create it. Options are:
l
l

l

l

Off. The extent does not snap to the data used to create it. This is the default setting.
All data. The extent snaps to all data within the Maximum snap distance, which includes
borehole data and any data added to the extent.
Drilling only. The extent snaps to borehole data and data objects derived from borehole data within
the Maximum snap distance, but not to other data used to modify the extent. For example, the
extent will honour points data derived from borehole data, but not points data imported into the
Points folder.
Custom. The extent snaps to the data objects indicated in the Inputs tab that are within the
Maximum snap distance.

Take care in enabling snapping and in selecting what data the surface will snap to, as the more data
you include, e.g. by setting a large Maximum snap distance or selecting All data for Snap to
data, the greater the possibility that errors in the data or assumptions inherent in interpretations
(e.g. polylines) will cause distortions in the meshes. If you do enable snapping, it is best to snap only
to drilling data. See Honouring Surface Contacts for more information on these settings.
The snap setting for the geological model will be used if Snap to data is set to Inherit from GM.
Whatever the setting, you can see what objects are snapped to by clicking on the Inputs tab.
If you need the extent to honour borehole data but treat other data objects as interpretations, select
Drilling only. To honour some data objects while treating others as interpretations, select Custom,
then click on the Inputs tab to enable snapping for individual objects.
Applying a Trend
You can adjust an extent created from polylines, GIS data, points and structural data by applying a trend
to it. To do this, add the extent to the scene. Next, double-click on the extent in the project tree and click
the Trend tab.
Often the easiest way to apply a trend is to click on the Draw plane line button ( ) and draw a plane
line in the scene in the direction in which you wish to adjust the surface. You may need to rotate the
scene to see the plane properly.
The Ellipsoid Ratios determine the relative shape and strength of the ellipsoids in the scene, where:
l
l

l

The Maximum value is the relative strength in the direction of the green line on the moving plane.
The Intermed. value is the relative strength in the direction perpendicular to the green line on the
moving plane.
The Minimum value is the relative strength in the direction orthogonal to the plane.

Once you have adjusted the plane to represent the trend you wish to use, click the Set From Plane
button to copy the moving plane settings.
The Set to list contains a number of different options Leapfrog Works has generated based on the data
used in the project. Isotropic is the default option used when the extent was created. Settings made to
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other surfaces in the project will also be listed, which makes it easy to apply the same settings to many
surfaces.
Click OK to apply the changes.
See Global Trends for more information.

Adding Data to an Extent
Extents created from polylines, GIS data, points and structural data can be modified by adding points
data objects, GIS vector data and structural data. Extents created from a distance to points function can
be modified by adding points data and GIS vector data. To add data to an extent, right-click on the
extent in the project tree and select the data type you wish to use from the Add menu.
l
l
l

Points data. Select from the points data objects available in the project and click OK.
GIS vector data. Select from the GIS vector data available in the project and click OK.
Structural data. Select from the structural data tables available in the project. If the selected table has
query filters defined, you can apply one of these filters by selecting the required query from the list.
Click OK to add the selected data to the extent. An alternative to adding an existing structural data
table to an extent is to edit the extent with structural data. This is described in Editing an Extent With
Structural Data below.

You can also add a polyline that already exists in the project. To do this, right-click on the extent in the
project tree and select Add > Polyline. You will be prompted to choose from the polylines in the
Polylines folder.

Editing an Extent With a Polyline
You can edit an extent using a polyline, which is described in Editing Surfaces With Polylines. A polyline
used to edit an extent will be added to the project tree as part of the extent. To edit the polyline, rightclick on it and select Edit Polyline or add it to the scene and click the Edit button ( ) in the shape list.
If you wish to remove the polyline from the extent, right-click on it in the project tree and select Delete
or Remove.
To add an existing polyline to a geological model extent, use the Add > Polyline option.

Editing an Extent With Structural Data
You can edit an extent using structural data, which is described in Editing Surfaces With Structural Data.
A structural data table will be added to the project tree as part of the extent. To edit the table, right-click
on it and select Edit In Scene or add it to the scene and click the Edit button ( ) in the shape list. If
you wish to remove the table from the extent, right-click on it in the project tree and select Delete or
Remove.

Removing an Extent From a Geological Model
If you have defined an extent and want to remove it from the model, there are two options. The first is to
right-click on the extent in the project tree and click Delete. This deletes the extent from the model, but
does not delete parent objects from the project unless they were created as part of the model, e.g. a
polyline used as a lateral extent but not shared within the project. Use this option only if you are sure you
do not want to use the extent.
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The second method is useful if you are making changes to the extent and do not want to recompute the
model with each change. Double-click on the model’s Boundary object or double-click on the model
and click on the Boundary tab. The Boundaries part of the window lists all objects used as extents for
a geological model:

Untick the box for extents to temporarily disable them in the model. The model will be reprocessed, but
you can then work on the extent without reprocessing the model. Disabled extents will be marked as
inactive in the project tree:

Model Lithologies
To view the lithologies used for a geological model, you can:
l
l

Double-click on the geological model in the project tree and then click on the Lithologies tab.
Double-click on the Lithologies object for the geological model in the project tree.
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All the lithologies defined for the geological model are displayed, together with the colours used to
display them:

Click a colour chip to change the colours used to display the lithologies.
The order of the lithologies in this window is the order used for the model’s legend when the model is
displayed in the scene. Click on a lithology in the list and use the arrow keys to reorder the list.

Use the Shift or Ctrl keys to select multiple lithologies. This is useful for changing multiple colour
chips to a single colour or for moving multiple lithologies up and down in the list.
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If the geological model was created from borehole data, the lithologies are automatically generated from
that data. There is also an additional lithology, “Unknown”, which is used to label lithologies that cannot
be labelled using known lithologies. This is the case when a geological model is first created and no
contact surfaces have been defined. The entire model volume has no identified lithologies and so is
assigned as “Unknown”.
An alternative to setting unidentified lithologies to “Unknown” is to select one of the defined lithologies
as the “background lithology”. To do this, double-click on the model’s Surface Chronology and set
Background lithology to one of the available lithologies. When you set the background lithology for a
geological model and then enable the fault system, the background lithology will be copied to each fault
block.
If there is no borehole data in the project or if the model is not based on borehole data, you will need to
define the lithologies one-by-one. To do this, click on the Add button, enter a name for the lithology
and choose a colour.

Faulted Models
This topic describes how to use the fault system to create and organise faults:
l
l
l
l
l

The Fault System
Fault Interactions
Activating the Fault System
Copying the Surface Chronology to an Empty Fault Block
Faulted Model Display Options

Each geological model is created with a Fault System object that is used to construct faults. Once the
faults are active in the geological model, the geological model will be divided into separate fault blocks,
which will appear in the project tree as part of the model. Here, the geological model has been divided
into five fault blocks:

Each fault block has its own Surface Chronology, which can be modified without affecting other fault
blocks in the geological model. There is no top-level Surface Chronology for the geological model
once the Fault System has been activated. This means that lithology layers can be constructed for a
faulted model in two ways:
l

l

Define the Surface Chronology before enabling the Fault System. All surfaces defined for the
unfaulted model will automatically be copied to each fault block. Some surfaces defined for the model
as a whole will not occur in every fault block, which can be corrected by working with the surfaces in
each fault block.
Enable the Fault System before any surfaces are defined in the unfaulted model, then define the
Surface Chronology for each fault block. An aid to working with a faulted model in this way is the
ability to copy contact surfaces from one faulted block to another. See Copying the Surface
Chronology to an Empty Fault Block below.
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Which approach is best depends on the model being built. You may already know where the faults are
and choose to define them and subdivide the geological model before defining any lithology layers. On
the other hand, sometimes it is not apparent where the faults are until the layers have been built, in
which case you can add the new fault, activate it in the model, then work with the surfaces in each fault
block.

The Fault System
When a geological model is first created, the Fault System object is empty. To create faults, right-click
on the Fault System object and select from the options available. Many of these options are similar to
those for creating lateral extents. For more information, see:
l
l
l
l
l

Extent From a Polyline
Extent From GIS Vector Data
Extent From Points
Extent From Structural Data
Extent From a Surface

Faults created from polylines and GIS vector data can be created as vertical walls or surfaces. Faults
created as surfaces can be modified by adding further data, as described in Editing Faults.
Creating a fault from the base lithology or other contacts is similar to creating contact surfaces. See
Deposits and Erosions From the Base Lithology and Deposits and Erosions From Other Lithology
Contacts for more information.
Faults ( ) will appear in the project tree as part of the Fault System object ( ) and can be expanded
to show how they were created. Here, Fault 1 was created from a GIS line draped on the topography ( )
and structural data ( ):

Once faults have been created, you can modify them as described in Editing Faults.
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Fault Interactions
Once all the faults required have been created, you can start defining the interactions between the faults
by double-clicking on the Fault System object. The Geological Model will be opened with the Fault
System tab displayed:
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To add an interaction, click on a fault, then click the Add button. Select the Interaction Type and set
how the faults interact:
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Once you have defined each fault interaction, click OK to generate the fault system. Add the Fault
System object to the scene to check that the faults interact correctly.
You can also edit fault interactions by double-clicking on individual faults. The Edit Fault window will
open, which shows only the interactions for the selected fault:

Faults are not active in the geological model until the box is ticked for each fault in the Fault System
window, as described in Editing Faults. This means you can check the fault system without
regenerating the geological model.

Activating the Fault System
Activating the fault system divides the geological model into fault blocks, which can result in
considerable processing time for complex models. It is important, therefore, to define fault
interactions before enabling the fault system, otherwise a large number of fault blocks could be
generated that significantly increase processing time. See Fault Interactions above.
To activate the fault system in the geological model, double-click on the Fault System object once
again and tick the box for each fault. The model will be divided into separate fault blocks that can be
worked with in a similar manner to the geological model as a whole.

Copying the Surface Chronology to an Empty Fault Block
If you are working with a faulted model and have defined the Surface Chronology for one fault block,
you can copy the Surface Chronology to the empty fault blocks. To do this, right-click on the
Surface Chronology for which you have defined surfaces and select Copy Chronology To. In the
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window that appears, select the fault blocks you want to copy contacts to and click OK. The surfaces will
be copied and you can modify them without affecting the surfaces in the other fault blocks.

Faulted Model Display Options
Drag the model into the scene or right-click on it and select View Object; these options add the model
to the shape list as a single object and you can change the visibility of each lithology by clicking the Edit
Colours button. You can also add the model to the scene as a series of output volumes by right-clicking
on the model and selecting View Output Volumes.
Another display option lets you view the individual fault blocks without displaying the lithology layers.
Right-click on the model and select View Fault Block Boundaries.
To work with a specific fault block, click on it in the scene. The window that appears displays the name
of the selected fault block:

You can also view the output volumes for each individual fault block by right-clicking on the fault block in
the project tree and selecting View Output Volumes.

Editing Faults
Once a fault has been defined, you can refine it in several ways:
l

l

l

Add other data. This option is available for faults created as surfaces, but not for those created as
vertical walls. Right-click on the surface to see the options available, which will depend on how the
surface was created.
Edit the surface with a polyline. Right-click on the surface in the project tree and select either Edit >
With Polyline. See Editing Surfaces With Polylines for more information.
Edit the surface using structural data. Right-click on the surface and select Edit > With Structural
Data. See Editing Surfaces With Structural Data for more information.

The rest of this topic describes other options for editing faults. It is divided into:
l
l
l

Surfacing Options for Faults
Changing Fault Inputs
Applying a Trend to a Fault

Surfacing Options for Faults
To change surfacing options for a fault, double-click on the fault in the project tree, then click on the
Surfacing tab.
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See Surface Resolution for a Geological Model and Honouring Surface Contacts for information about
the settings in the Surfacing tab.
The settings in the Surfacing tab will be disabled if the fault inputs have been replaced with a mesh.
Boundary Filtering
When data objects are added to a fault, there are two ways to handle the data that lies outside the fault
boundary:
l
l

Filter the data. The fault is only influenced by the data that falls inside the fault boundary.
Leave the data unfiltered. The fault is influenced by the data both inside and outside the fault
boundary.

The Boundary filter setting determines how data used to define the fault is filtered:
l
l
l
l

Off. Data is not filtered.
All data. All data is filtered.
Drilling only. Only borehole data and data objects derived from borehole data are filtered.
Custom. Only the data objects specified in the Inputs tab are filtered.

Snapping to Data
There is a Snap to data setting for a geological model as a whole that is set in the Geological Model >
General tab (see Editing a Geological Model). Snap to data can also be set on a surface-by-surface
basis by double-clicking on the surface in the project tree and then clicking on the Surfacing tab.
For faults, the options are:
l
l
l

l

l

Inherit from GM. The setting for the geological model as a whole is used. This is the default setting.
Off. The fault surface does not snap to the data used to create it.
All data. The fault surface snaps to all data within the Maximum snap distance, which includes
borehole data and any data added to the fault.
Drilling only. The fault surface snaps to borehole data and data objects derived from borehole data
within the Maximum snap distance but not to other data used to modify the fault. For example,
the fault surface will honour points data derived from borehole data, but not points data imported
into the Points folder.
Custom. The fault surface snaps to the data objects indicated in the Inputs tab.

Take care in enabling snapping and in selecting what data the surface will snap to, as the more data
you include, e.g. by setting a large Maximum snap distance or selecting All data for Snap to
data, the greater the possibility that errors in the data or assumptions inherent in interpretations
(e.g. polylines) will cause distortions in the meshes. If you do enable snapping, it is best to snap only
to drilling data. See Honouring Surface Contacts for more information on these settings.
If you need the fault surface to honour borehole data but treat other data objects as interpretations,
select Drilling only. To honour some data objects while treating others as interpretations, select
Custom, then click on the Inputs tab to enable snapping for individual objects.
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Changing Fault Inputs
For faults, the Inputs tab shows all the data objects used to create the fault and whether the Snap and
Boundary filter options are enabled for each object used to define the fault. If an input has any query
filters defined, you can select one in this window.

You can also replace the fault’s inputs with a single mesh or add more data to the fault.
Replacing Fault Inputs With a Single Mesh
To replace the fault inputs with a single mesh, click on the Mesh option, then select from the meshes
available in the project.
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When you select a single mesh to define the fault, all other inputs listed in the Inputs tab will be
removed from the fault. This can result in objects being deleted from the project. For example, if the
fault has been edited using a polyline, the polyline will be deleted when the inputs are replaced with
the mesh. If you wish to retain such inputs, be sure to share the object before changing the inputs.
See Sharing Objects for more information.
The snap and boundary filtering controls in the Surfacing tab will be disabled as the settings from the
geological model will be used. The settings in the Trend tab will also be disabled as it is not possible to
set a trend for a fault defined from a mesh.
Adding Data to the Fault
To add more data to the fault, click on the Select Objects button, then select from the suitable objects
available in the project.
Snap Settings for Individual Inputs
The Snap setting determines whether or not the faults surface honours a particular data object. Often,
surfaces should honour borehole data and treat data objects such as polylines and GIS data as
interpretations, as discussed in Honouring Surface Contacts. To change snap settings for a fault, click on
the Surfacing tab and set Snap to data to Custom. You will then be able to change Snap settings in
the Inputs tab.
Boundary Filtering Settings for Individual Inputs
When data objects are added to a fault, there are two ways to handle the data that lies outside the fault
boundary:
l
l

Filter the data. The fault is only influenced by the data that falls inside the fault boundary.
Leave the data unfiltered. The fault is influenced by the data both inside and outside the fault
boundary.

To change the Boundary filter settings for each object used to define a fault, click on the Surfacing
tab and set Boundary filter to Custom. You will then be able to change Boundary filter settings in
the Inputs tab.
Applying a Trend to a Fault
To apply a trend to a fault, either:
l
l

Double-click on the fault in the project tree, then click on the Trend tab.
Right-click on the fault in the project tree and select Adjust Surface. This opens the Edit Fault
window with the Trend tab displayed.

See Global Trends for information on using the controls in this tab.
The settings in the Trend tab will be disabled if the fault inputs have been replaced with a mesh.
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Contact Surfaces
Defining the internal structure of a geological model involves generating contact surfaces that
correspond to the boundaries between lithological units, refining the contact surfaces, arranging them in
chronological order and then using the surfaces and the chronological order to divide the geological
model into units. The Surface Chronology object represents the collection of contact surfaces and
defines how they interact to produce the volumes of the geological model. Factors that influence the
interaction of contact surfaces with the volumes of the geological model are:
l

l
l

The order of the contact surfaces in the Surface Chronology. See Contact Surfaces in the Surface
Chronology.
The type of contact surface. See Contact Surfaces Types for more information.
The orientation of the older and younger sides of the surface. See Younging Direction.

The remainder of this topic describes how the different types of contact surface interact and will help
you in deciding how to model different units. For specific information on creating the different types of
contact surfaces, see:
l
l
l
l
l

Deposits and Erosions
Intrusions
Veins
Vein Systems
Stratigraphic Sequences

Contact Surfaces in the Surface Chronology
When a geological model is first created, it is simply a volume that is assigned the background lithology.
This background lithology is initially “Unknown”, as although the model has lithologies defined,
Leapfrog Works cannot determine what lithology to use for the background lithology.
The contact surfaces and their order in the Surface Chronology determine how they divide this larger
“Unknown” volume into known lithological units. The scene below shows the Surface Chronology for
four deposit contact surfaces and two intrusion contact surfaces, bounded by the geological model
extents (pink). The two intrusion contacts are labelled as Unknown on the outside and the intrusion
lithology on the inside:
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The Surface Chronology is open, showing the contact surfaces in chronological order, with the
youngest at the top of the list. This is the order in which contact surfaces will be used to cut the
“Unknown” volume of a newly created model. The different types of contact surfaces cut older volumes
in different ways, which are described below in Contact Surfaces Types.
For the model shown above, the first contact surface to cut the geological model volume is the oldest
surface, D5 - D4 contacts. The volume is divided into D5 (red) below and D4 (green) above:

When the next contact surface (D4 - D3 contacts) is enabled in the model, the volume above the
contact surface is labelled with the lithology assigned to the surface’s younger side (blue):

Therefore, any volume in a geological model is labelled with the lithology assigned to the youngest side
of the surface that last cut the volume.
With a simple deposit geological model, as long as each side of each contact surface is assigned a
lithology, all volumes will be labelled with known lithologies. Intrusive contact surfaces, however, are
often of unknown lithology on the outside, as they contact multiple lithologies. When the two intrusive
surfaces in the model above are enabled but all deposit surfaces are disabled, the unknown lithology is
replaced with each intrusive lithology on the inner sides of each contact surface, but outside each
intrusive contact surface the lithology is not known:
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If the outside of the older contact surface (green) is assigned a lithology (red), the volume outside each
intrusion is known and, therefore, the surrounding volume can be labelled:

If, however, the outside of the younger intrusion is known but the outside of the older intrusion is
unknown, it is not possible to determine the lithology of the surrounding volume as the lithology on the
outer side of the surface making the first cut is not known:

Contact Surfaces Types
The different types of contact surfaces result in different shapes and cut older volumes in different ways.
The contact surface types are:
l

l

l

l

Deposit. Deposit contact surfaces tend to be sheet-like, with the primary lithology on the young side
and the contacting/avoided lithologies on the older side. Deposits do not cut older volumes. A
volume defined by a deposit contact surface will, therefore, appear conformably on top of older
volumes.
Erosion. Erosion contact surfaces are similar to deposits, but cut away other contact surfaces on the
older side of the erosion contact surface.
Intrusion. Intrusion contact surfaces are rounder in shape, with an interior lithology that represents
the intrusion lithology. The intrusion removes existing lithologies and replaces them with the intrusive
lithology on the younger side of the contact surface. Often, the older side of an intrusion contact
surface is labelled “Unknown” as typically intrusions displace multiple older lithologies.
Vein. Vein contact surfaces remove existing lithologies and replace them with the vein lithology
within the boundaries defined by hangingwall and footwall surfaces and points and a reference
surface.

These terms are indicative of the resulting shape and cutting behaviour of a surface rather than of the
geological formations that can be modelled. In fact, it might make sense to model something like
basement granite as a deposit rather than as an intrusion when it forms the lowest layer in the geological
model. If there are no older layers for an intrusion-type contact surface to remove and it is apparent from
the borehole data that the lithology simply fills the lowermost parts of the model, then it makes sense to
model it as a deposit.
An important consideration in building contact surfaces is that they have an older side and a younger
side. This is described in more detail in Younging Direction below, but it is sufficient to understand, at this
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point, that younging direction is one factor in determining how the different types of contact surfaces
cut older surfaces.
Deposit and Erosion Contact Surfaces
Deposits and erosions are both roughly flat surfaces. The difference between the two is that deposits
appear conformably on top of underlying older volumes and do not occur in regions defined by older
deposits, while erosions remove existing lithologies on the older side of the erosion. This difference is
illustrated here, using a model made up of three deposits, A, B and C:

The contact surfaces that define the three output volumes are the B-C contacts surface (pink) toward
the top of the model extents and the A-B contacts surface (gold) lower down:

An erosion contact surface (C-D contacts) added to the model cuts across the A-B and B-C contacts.
The younger (purple) side of the C-D contact surface faces up:
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Once the model is recalculated, the erosion (D) has cut away the deposits on the older side of the
erosion:

However, if the C-D contact surface is changed to be a deposit surface, D only occurs on the younger
side of the C-D contact surface and does not cut away the A, B and C volumes:

See Deposits and Erosions for information on techniques for creating deposits and erosions.
Intrusion Contact Surfaces
An intrusion is a type of contact surface that removes existing lithologies and replaces them with the
intrusive lithology. Intrusions are rounder in shape than deposits and erosions, with an interior lithology
that represents the intrusion lithology on the inside of the shape.
Adding an intrusion (E) surface added to the example model above as the youngest surface cuts away
the other lithologies on the inside of the surface:

Note that the intrusion contacts multiple units. This is typical of intrusion contact surfaces as an intrusion
will usually displace multiple older lithologies. Although the outside of the intrusion is not labelled with a
lithology, the lithology of each volume the intrusion comes into contact with can be known from the
lithologies assigned to the deposit contact surfaces.
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However, when all contact surfaces are intrusions, the lithology of the surrounding volume cannot be
known, which results in intrusion volumes surrounded by an Unknown volume:

In this instance, the contact surfaces each have a known side and an unknown side:

Adding the boreholes to the scene helps in understanding what lithology the outside of each intrusion
should be:
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In this case, opening the Surface Chronology and assigning AvT as the background lithology results in
a model for which all volumes are labelled with a known lithology:

See Intrusions for information on techniques for creating intrusions.
Vein Contact Surfaces
Veins remove existing lithologies and replace them with the vein lithology within the boundaries defined
by hangingwall and footwall surfaces and points and a reference surface. Here, a slice has been made
horizontally through a model made up of three deposits:

Adding five dykes modelled as veins and enabling them in the model results in the veins cutting away
each deposit at the point of contact:

Here the sliced deposits are displayed but the veins are hidden in order to show how they cut away the
deposits:
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See Veins for information on techniques for creating veins.

Younging Direction
An important factor in determining how surfaces interact is the younging direction of each surface. Each
contact surface has a younger side and an older side. For deposit and erosion contact surfaces, Leapfrog
Works will, by default, put the younger side up, since this is geologically reasonable in most situations. If,
for example, you know that the geology is overturned, you can change the younging direction once the
surface has been created.
For intrusion contact surfaces, the younger side of the surface is the inside, although this can be
swapped if Leapfrog Works has assigned it incorrectly, as may be the case with flatter intrusion surfaces.
When contact surfaces are displayed in the scene, you can choose whether to display the surfaces using
the lithology or the younging direction. When the younging direction is displayed, the younger side is
typically green and the older side is brown:

When a contact surface is displayed using the younging direction, Leapfrog Works by default colours the
younger side green and the older side brown.

Deposits and Erosions
This topic describes creating and editing deposits and erosions. The topic is divided into:
l
l
l
l

Creating Deposits and Erosions
Deposits/Erosions in the Project Tree
Refining Deposits and Erosions
Surfacing Options for Deposits and Erosions

For a general introduction to how deposits and erosions interact with other contact surfaces, see
Deposit and Erosion Contact Surfaces in Contact Surfaces.
Creating Deposits and Erosions
Lithology data is often the most reliable data source to use when building geological surfaces, and it is
best to derive contact surfaces from lithology data when it is available. If no lithology data is available,
you can create deposits and erosions from other data in the project. You can also create offset surfaces
from other surfaces in the project, which is useful for creating a series of surfaces. See Offset Surfaces
for more information.
Deposits and Erosions From the Base Lithology
It is best to derive contact surfaces from lithology data, when it is available. There are two ways to create
contact surfaces from lithology data:
l

Using the base lithology column assigned when the model was created. This is the process described
below.
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l

Using other lithology information available in the project. This is useful when you have created an
additional lithology column as part of correcting and working with the borehole data. For example, if
when building a geological model it becomes apparent that changes need to be made to the borehole
data, you can import additional data or create a new column using the split lithology, group lithology
or interval selection tools. See Deposits and Erosions From Other Lithology Contacts for more
information.

Selecting the From Base Lithology option opens the New Contact Points window:

Select the lithology you wish to use to create the surface from the Select primary lithology list; this
will be the older lithology (lower down) in the geological model. The Contacting/Avoided lithologies
list shows the lithologies that contact the primary lithology and the number of contacts. This helps in
selecting which contacts to use to create the contact surface.
The options in the Lithology tab are useful for creating a surface when one lithology is interbedded with
another. For example, here we can see that the coarse sand is interbedded with alluvium:
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The solution to this is to create two surfaces from the Alluvium contacts, one using the contacts above
(younger contacts) and the other using the contacts below (older contacts):

Note that the gravel contacts should be excluded for the surface created from the Use contacts below
option, as we can see from the borehole data that gravel appears lower down in the model than the
surface we are creating. Do this by dragging the contacts that should be excluded to the Ignored
lithologies list:

Unspecified intervals are intervals that have no data. By default, unspecified intervals are ignored when
creating a contact surface, but you can also treat them as the primary lithology or as avoided lithologies.
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For complex geologies, the up and down directions for the surface may not be clear. If this is the case,
untick the Horizontal Plane box. A reference plane will appear in the scene, with the up-facing surface
labelled A and the downward-facing surface labelled B:

When you disable the Horizontal plane option for the Reference Surface, the number of
contacts is longer displayed in the lithologies lists, as the number of contact points is not updated
when the reference surface used changes.
Controlling the position of the reference plane is similar to controlling the position of the moving plane:
l
l

Use the handles in the scene window to move the plane.
Set the Dip and Dip Azimuth values in the New Contact Points window. The reference plane will
be updated in the scene.

Once the reference plane is correctly oriented, click the Set From Plane button.
Setting a reference plane for contact points is different from applying a global trend to a surface. To
apply a global trend to a surface, double-click on the surface in the project tree and click on the
Trend tab. See Global Trends.
Data can be composited at the borehole level or on a surface-by-surface basis. To composite the data
used to generate the contact surface, click on the Compositing tab. See Category Composites for
more information.
Click OK to create the contact surface, which will appear in the project tree under the Surface
Chronology. See Refining Deposits and Erosions below for more information on refining the contact
surface.
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Deposits and Erosions From Other Lithology Contacts
Creating deposit and erosion contact surfaces using the From Other Contacts option is useful when
you have created an additional lithology column as part of correcting and working with the borehole
data. For example, if when building a geological model it becomes apparent that changes need to be
made to the borehole data, you can import additional data or create a new column using the split
lithology, group lithology or interval selection tools. See Splitting Lithologies, Grouping Lithologies and
Interval Selection for more information.
The process is similar to creating a surface from the base lithology column, but you must first select the
lithology column you will use:

Select the First Lithology and Second Lithology, if known. Click OK. The New Contact Points
window will appear. Assign the Primary lithology, Contacting/Avoided lithologies and the
Ignored lithologies. These can only be selected from the model’s base lithology.
The rest of the process is similar to defining a contact surface from the base lithology. See Deposits and
Erosions From the Base Lithology above for more information.
Be sure to add the contact surface to the scene to view it and check that it is oriented correctly.
See Refining Deposits and Erosions below for more information on the different techniques that can be
used for adjusting a contact surface.
Deposits and Erosions From Other Data
If suitable lithology data is not available, deposits and erosions can be created from other data in the
project, such as GIS data, structural data, points, polylines and surfaces. The steps for creating deposits
and erosions from other data are similar, regardless of the data used to create the surface:
l

l

l

l

Right-click on the Surface Chronology and select one of the data types from the New
Deposit/Erosion menu.
Select the data object that will be used to define the surface. This must already be in the project,
unless you are using a polyline, in which case you are given the option to create a new polyline.
Select the First lithology and Second lithology. These are the lithologies that will be assigned to
each side of the contact surface. The lithologies you can choose from are those defined for the
geological model in the Lithologies object (see Model Lithologies).
Set whether the First lithology is older or younger than the Second lithology. Leapfrog Works
will, by default, put the younger side of a contact surface up, but this can be changed later.
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Here, a points data object is being used to create a deposit:

For polylines, you first set the lithologies and the younging order, then click OK to move on to the next
step:

You can draw the polyline in the scene directly by selecting the New Drawing option. You can also use
any polyline in the project by selecting the Existing Polyline option. You can then select the required
polyline from the list.
The new contact surface will appear in the project tree under the Surface Chronology. Add the
contact surface to the scene to view it and check that it is oriented correctly.
Expand the surface in the project tree to see how it was made. Here, a number of surfaces have been
created using different types of data:

If creating a surface from a new polyline, the polyline will not be able to be used elsewhere in the project
unless it has been shared. To share the polyline, expand the contact surface in the project tree, rightclick on the polyline and select Share. The polyline will then be available elsewhere in the project.
As further refinements are made to the surface, that information will also be added to the contact
surface in the project tree.
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Deposits/Erosions in the Project Tree
The name Leapfrog Works automatically assigns to a deposit or an erosion is the lithologies assigned to
each side of the surface. In the project tree, expand the surface to see how it was made:

Double-click on the surface to edit it. Double-click on the contact points object ( ) to edit the lithology
and change compositing parameters.
As further refinements are made to the surface, that information will also be added to the project tree.
See Refining Deposits and Erosions below for more information.
Refining Deposits and Erosions
You can refine deposits and erosions in several ways:
l

l

l

Add other data. Right-click on the surface to see the options available, which will depend on how the
surface was created. See Adding Data to Surfaces for more information.
Edit the surface with a polyline. Right-click on the surface in the project tree and select either Edit >
With Polyline. See Editing Surfaces With Polylines for more information.
Edit the surface using structural data. Right-click on the surface and select Edit > With Structural
Data. This option is available for deposits and erosions created from lithology data and other data in
the project, but not for offset surfaces. See Editing Surfaces With Structural Data for more
information.

To edit the surface’s settings, double-click on it in the project tree. In the Lithologies tab, change the
lithologies assigned to each side of the surface, if required.
You can swap the younging direction if the direction was assigned incorrectly when the surface was
created. The change will be reflected in the scene. Note that changing the younging direction does not
change which lithology is older or younger.
The difference between deposit and erosion contact surfaces is how they cut older lithologies, as
described in Contact Surfaces. For this reason, it is possible to change between the two types using the
Contact Type setting.
For information on other techniques for refining deposits and erosions, see:
l
l

Surfacing Options for Deposits and Erosions
Offset Surfaces

Surfacing Options for Deposits and Erosions
Surfacing options for deposits and erosions can be changed by double-clicking on the surface in the
project tree and then clicking on the Surfacing tab. There are additional settings related to boundary
filtering and snapping to data in the Inputs tab.
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Boundary Filtering
When data objects are added to a surface, there are two ways to handle the data that lies outside the
surface’s boundary:
l
l

Filter the data. The surface is only influenced by the data that falls inside the surface’s boundary.
Leave the data unfiltered. The surface is influenced by the data both inside and outside the surface’s
boundary.

The Boundary filter setting determines how data used to define the surface is filtered:
l
l
l
l

Off. Data is not filtered.
All data. All data is filtered.
Drilling only. Only borehole data and data objects derived from borehole data are filtered.
Custom. Only the data objects specified in the Inputs tab are filtered.

Snapping to Data
Often, surfaces should honour borehole data and treat data objects such as polylines and GIS data as
interpretations. See Honouring Surface Contacts.
There is a Snap to data setting for a geological model as a whole that is set in the Geological Model >
General tab (see Editing a Geological Model). Snap to data can also be set on a surface-by-surface
basis by double-clicking on the surface in the project tree and then clicking on the Surfacing tab.
For individual contact surfaces, the options are:
l
l
l

l

l

Inherit from GM. The setting for the geological model as a whole is used. This is the default setting.
Off. Surfaces do not snap to the data used to create them.
All data. Surfaces snap to all data within the Maximum snap distance, which includes borehole
data and any data added to the surfaces.
Drilling only. Surfaces snap to borehole data and data objects derived from borehole data within
the Maximum snap distance but not to other data used to modify the surfaces.
Custom. Surfaces snap to the data objects indicated in the Inputs tab for each surface.

Take care in enabling snapping and in selecting what data the surface will snap to, as the more data
you include, e.g. by setting a large Maximum snap distance or selecting All data for Snap to
data, the greater the possibility that errors in the data or assumptions inherent in interpretations
(e.g. polylines) will cause distortions in the meshes. If you do enable snapping, it is best to snap only
to drilling data. See Honouring Surface Contacts for more information on these settings.
If you need a surface to honour borehole data but treat other data objects as interpretations, select
Drilling only. To honour some data objects while treating others as interpretations, select Custom,
then click on the Inputs tab to enable snapping for individual objects.
Setting the Surface Resolution
See Surface Resolution for a Geological Model for information about the surface resolution settings in
the Surfacing tab.
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Applying a Trend to a Deposit/Erosion
There are two ways to change the trend for a deposit or an erosion:
l
l

Right-click on the surface in the project tree and select Adjust Surface.
Double-click on the surface in the project tree and then click on the Trend tab.

See Global Trends for more information.

Intrusions
This topic describes creating and editing intrusions. The topic is divided into:
l
l
l
l
l
l
l
l

Creating Intrusions
Intrusions in the Project Tree
Displaying Intrusion Points
Refining Intrusions
Surfacing Options for Intrusions
Applying a Trend to an Intrusion
Clipping Values for Intrusions
Interpolation Settings

For a general introduction to how intrusions interact with other contact surfaces, see Intrusion Contact
Surfaces in Contact Surfaces.
Creating Intrusions
Lithology data is often the most reliable data source to use when building geological surfaces, and it is
best to derive contact surfaces from lithology data when it is available. If no lithology data is available,
you can create intrusions from other data in the project.
One thing to keep in mind for all intrusion contact surfaces is that an intrusion removes all the existing
material on the younger side of the contact surface. Therefore:
l

l

An intrusion should always have the younger side of its surface labelled with the intruded material.
This is called the “interior lithology”.
The older side will typically be labelled “Unknown” as an intrusion will usually displace multiple older
lithologies. This is called the “exterior lithology”.

Intrusions from Lithology Contacts
Lithology data is often the most reliable data source to use when building geological surfaces, and it is
best to derive contact surfaces from lithology data when it is available. There are two ways to create
intrusions from lithology data:
l
l

Using the base lithology column assigned when the model was created.
Using other lithology information available in the project. This is useful when you have created an
additional lithology column as part of correcting and working with the borehole data. For example, if
when building a geological model it becomes apparent that changes need to be made to the borehole
data, you can import additional data or create a new column using the split lithology, group lithology
or interval selection tools.
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To create a new intrusion from lithology contacts, right-click on the Surface Chronology object and
select either New Intrusion > From Base Lithology or New Intrusion > From Other Contacts.
The only difference in the two methods is that when creating an intrusion from other contacts, you must
first select the lithology column from those available in the project and specify the First lithology and
the Second lithology.
Select the intrusive lithology as the interior lithology. Other lithologies will be displayed in the Exterior
lithologies list. Drag any younger lithologies to the Ignore list.

Unspecified intervals are intervals that have no data. By default, unspecified intervals are ignored when
creating an intrusion, but you can also treat them as the interior lithology or as exterior lithologies.
Sometimes intrusive boundaries are poorly defined, with fragments of country rock intermixed with the
intrusive body. This can result in very small segments near the edges of the intrusion. Modelling the fine
detail is not always necessary, and so compositing can be used to smooth these boundaries.
Compositing parameters are set in the Compositing tab:

The settings in this tab are described in Category Composites.
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Click OK to create the intrusion, which will be added to the project tree as part of the Surface
Chronology object.
Intrusions from Other Data
If suitable lithology data is not available, intrusions can be created from other data in the project, such as
GIS data, structural data, points, polylines and surfaces. The steps for creating intrusions from other data
are similar, regardless of the data used to create the surface:
l

l

l

l

Right-click on the Surface Chronology and select one of the data types from the New Intrusion
menu.
Select the data object that will be used to define the surface. This must already be in the project,
unless you are using a polyline, in which case you are given the option to create a new polyline.
Select the First lithology and Second lithology. These are the lithologies that will be assigned to
each side of the contact surface. The lithologies you can choose from are those defined for the
geological model in the Lithologies object (see Model Lithologies).
Set whether the First lithology is older or younger than the Second lithology. Leapfrog Works
will, by default, put the younger side of a contact surface up, but this can be changed later.

Here, a points data object is being used to create an intrusion:

For polylines, you first set the lithologies and the younging order, then click OK to move on to the next
step:

You can draw the polyline in the scene directly by selecting the New Drawing option. You can also use
any polyline in the project by selecting the Existing Polyline option. You can then select the required
polyline from the list.
The new intrusion will appear in the project tree under the Surface Chronology. Add the contact
surface to the scene to view it and check that it is oriented correctly.
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Expand the surface in the project tree to see how it was made.
If creating a surface from a new polyline, the polyline will not be able to be used elsewhere in the project
unless it has been shared. To share the polyline, expand the contact surface in the project tree, rightclick on the polyline and select Share. The polyline will then be available elsewhere in the project.
As further refinements are made to the surface, that information will also be added to the contact
surface in the project tree.
Intrusions in the Project Tree
The name Leapfrog Works automatically assigns to an intrusion is the name of the intrusive lithology. In
the project tee, expand the intrusion to see how it was made:

Double-click on the intrusion to edit it. Double-click on the points object ( ) to edit the intrusion
lithology, change compositing parameters and change point generation options.
As further refinements are made to the surface, that information will also be added to the project tree.
See Refining Intrusions below for more information.
Displaying Intrusion Points
When you view the intrusion points in the scene, you can display only the contact points or all the points
used in creating the intrusion. To display all points, click on the points object ( ) in the shape list and
tick the box for Show volume points. Here, only the contact points are displayed:
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When the volume points are displayed, points with negative values are those outside the surface, while
points with positive values are those inside. Show text ( ) has been enabled in the shape list so that
the values are displayed:

You can change the way intrusion points are generated by double-clicking on the points object ( ) in
the project tree. See Intrusion Point Generation Parameters.
Refining Intrusions
You can refine intrusions in several ways:
l

l

l

Add other data. Right-click on the surface to see the options available, which will depend on how the
surface was created. See Adding Data to Surfaces for more information.
Edit the surface with a polyline. Right-click on the surface in the project tree and select either Edit >
With Polyline. See Editing Surfaces With Polylines for more information.
Edit the surface using structural data. Right-click on the surface and select Edit > With Structural
Data. See Editing Surfaces With Structural Data for more information.

To edit an intrusion’s settings, double-click on it in the project tree. In the Lithologies tab, change the
lithologies assigned to each side of the surface, if required.
Surfacing Options for Intrusions
Surfacing options for an intrusion can be changed by double-clicking on the surface in the project tree
and then clicking on the Surfacing tab. There are additional settings related to boundary filtering and
snapping to data in the Inputs tab.
Boundary Filtering
When data objects are added to a surface, there are two ways to handle the data that lies outside the
surface’s boundary:
l
l

Filter the data. The surface is only influenced by the data that falls inside the surface’s boundary.
Leave the data unfiltered. The surface is influenced by the data both inside and outside the surface’s
boundary.

The boundary of an intrusion can be the geological model boundary or a fault block boundary.
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The Boundary filter setting determines how data used to define the surface is filtered:
l
l
l
l

Off. Data is not filtered.
All data. All data is filtered.
Drilling only. Only borehole data and data objects derived from borehole data are filtered.
Custom. Only the data objects specified in the Inputs tab are filtered.

Snapping to Data
Often, surfaces should honour borehole data and treat data objects such as polylines and GIS data as
interpretations, as discussed in Honouring Surface Contacts.
There is a Snap to data setting for a geological model as a whole that is set in the Geological Model >
General tab (see Editing a Geological Model). Snap to data can also be set on a surface-by-surface
basis by double-clicking on the surface in the project tree and then clicking on the Surfacing tab.
For individual contact surfaces, the options are:
l
l
l

l

l

Inherit from GM. The setting for the geological model as a whole is used. This is the default setting.
Off. Surfaces do not snap to the data used to create them.
All data. Surfaces snap to all data within the Maximum snap distance, which includes borehole
data and any data added to the surfaces.
Drilling only. Surfaces snap to borehole data and data objects derived from borehole data within
the Maximum snap distance but not to other data used to modify the surfaces.
Custom. Surfaces snap to the data objects indicated in the Inputs tab for each surface.

Take care in enabling snapping and in selecting what data the surface will snap to, as the more data
you include, e.g. by setting a large Maximum snap distance or selecting All data for Snap to
data, the greater the possibility that errors in the data or assumptions inherent in interpretations
(e.g. polylines) will cause distortions in the meshes. If you do enable snapping, it is best to snap only
to drilling data. See Honouring Surface Contacts for more information on these settings.
If you need a surface to honour borehole data but treat other data objects as interpretations, select
Drilling only. To honour some data objects while treating others as interpretations, select Custom,
then click on the Inputs tab to enable snapping for individual objects.
Surface Resolution
See Surface Resolution for a Geological Model for information about the surface resolution settings in
the Surfacing tab.
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Clicking Additional options adds Value Clipping and Interpolant tabs to the window and also
allows the use of a structural trend in the Trend tab:

These are described in Applying a Trend to an Intrusion, Clipping Values for Intrusions and Interpolation
Settings below.
Applying a Trend to an Intrusion
There are two ways to change the trend for an intrusion:
l
l

Right-click on the surface in the project tree and select Adjust Surface.
Double-click on the surface in the project tree and then click on the Trend tab.

See Global Trends for more information.
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You can also use a structural trend for an intrusion. To do this, click the Additional options button in
the Surfacing tab, then click on the Trend tab.

Click on Structural Trend, then select the required trend from the list. See Structural Trends for more
information.
Clipping Values for Intrusions
You can change settings for intrusions by double-clicking on the contact surface in the project tree. The
Value Clipping tab is only available for intrusion contact surfaces.
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In the Value Clipping tab, you can manipulate the data distribution by clipping the data:

Clipping caps values that are outside the range set by the Lower bound and Upper bound values. For
example, if you change the Upper bound from 16.00 to 10.00, distance values above 10.00 will be
regarded as 10.00.
The Automatic clipping setting has different effects based on whether a global trend or structural
trend is set in the Trend tab:
l

l

When a global trend is applied, Leapfrog Works automatically clips the values. That is, the
Automatic clipping setting is Do clipping and Leapfrog Works sets the Lower bound and Upper
bound from the data. To disable clipping, untick Automatic clipping, then untick Do clipping. To
change the Lower bound and Upper bound, untick Automatic clipping, then change the values.
When a structural trend is applied, Leapfrog Works automatically does not clip the values. To clip
values, untick Automatic clipping, then tick Do clipping. Again, Leapfrog Works sets the Lower
bound and Upper bound values from the data and you can change them, if required.

Interpolation Settings
You can change settings for an intrusion by double-clicking on the intrusion in the project tree and
clicking on the Interpolant tab. For more information on the settings in this tab, see the Interpolant
Functions topic.
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Veins
This topic describes creating and editing veins. It is divided into:
l
l
l
l
l
l
l
l

Creating Veins
Veins in the Project Tree
Displaying Veins
Refining Veins
Surfacing Options for Veins
The Vein Reference Surface
The Vein Boundary
Editing Vein Segments

For a general introduction to how veins interact with other contact surfaces, see Vein Contact Surfaces
in Contact Surfaces.
A vein is a type of contact surface that removes existing lithologies and replaces them with the vein
lithology within the boundaries defined by hangingwall and footwall surfaces constructed from selected
input data. A reference surface is defined that is the best fit for the hangingwall and footwall surfaces.
The reference surface can be curved or planar.
Creating Veins
Options for creating veins are:
l

l
l

From lithology data, using the base lithology used to define the geological model or other contacts
available in the project. See Veins From Lithology Contacts below.
From GIS vector data, point data and polylines. See Veins From Other Data below.
Creating a vein system. This results in a single lithology that represents all the veins in a model. Veins
and their interactions are defined within the vein system. See Vein Systems.

Veins From Lithology Contacts
To create a new vein from lithology contacts, right-click on the Surface Chronology object and select
either New Vein > From Base Lithology or New Vein > From Other Contacts. The only
difference in the two methods is that when creating a vein from other contacts, you must first select the
lithology column from those available in the project and specify the Vein lithology and Outside
lithology.
In the New Vein window, select the Vein lithology:

When extracting the hangingwall and footwall points, Leapfrog Works automatically includes points at
the ends of the boreholes. To exclude these points, untick the Include points at the ends of holes.
Once the vein has been created, this setting can be changed by double-clicking on the vein segments
object ( ) in the project tree.
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Click OK to create the vein, which will be added to the project tree as part of the Surface Chronology
object.
Veins From Other Data
If suitable lithology data is not available, veins can be created from other data in the project, such as GIS
data, points and polylines. The steps for creating veins from other data are similar, regardless of the data
used to create the surface:
l
l

l

Right-click on the Surface Chronology and select one of the data types from the New Vein menu.
Select the data objects for the Hangingwall and Footwall. These objects must already be in the
project.
Select the Vein lithology and the Outside lithology. The lithologies you can choose from are
those defined for the geological model in the Lithologies object (see Model Lithologies).

Here, points data is being used to create a vein:

Select points data objects for both the Hangingwall and Footwall, then click OK to create the new
vein. The new contact surface will appear in the project tree under the Surface Chronology. Expand
the vein in the project tree to see how it was made.
Veins in the Project Tree
Veins are stored in the project tree as part of the Surface Chronology object. Further modifications
can be made to the vein by working on the objects that make up the vein. Expand the vein in the project
tree to view these objects.
Here, the hangingwall and footwall surfaces and points are displayed in the scene for a vein defined from
lithology data. The reference surface (yellow) and the vein segments (red and blue cylinders) used to
create the vein are also shown:
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This vein is made up of:
l

Hangingwall and footwall surfaces ( ), which, when expanded, show the hangingwall and footwall
data objects used to create the surfaces.
o

Export hangingwall and footwall surfaces as described in Exporting Meshes and Exporting an
Elevation Grid.

o

Add points and GIS vector data to these surfaces ( ) by right-clicking on them and selecting
Add.
Edit the hangingwall and footwall surfaces with polylines by right-clicking on them and selecting
one of the Edit options.
Change contact honouring and boundary filtering options as described in Surfacing Options for
Veins below.

o

o

l

Vein segments and pinch out segments ( ) extracted from borehole data.
l
l

l

A reference surface ( ) calculated as the best fit surface using the hangingwall and footwall
surfaces.
o
o
o

l

These are only included when a vein is created from lithology contacts.
If Vein Pinch Out

The reference surface can be curved, planar or another surface in the project can be used.
You can add points, GIS vector data and polylines to a curved reference surface.
If a curved reference surface is made up of multiple objects, you can switch between the objects
and change how they are filtered in order to see the effects on the vein.

A boundary object ( ), which is empty when the vein is first created.
l

The Vein Boundary

It is not possible to add structural data or polylines with orientation information to the hangingwall,
footwall and reference surfaces. If you edit these surfaces with a polyline, your options for editing the
polyline will be limited.

Displaying Veins
You can change the way the different objects that make up the vein are displayed using options in the
shape list:

Refining Veins
To edit a vein’s settings, double-click on it in the project tree. In the Lithologies tab, change the
lithologies assigned to each side of the surface, if required. For information on the settings in the
Surfacing and Inputs tabs, see Surfacing Options for Veins below.
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Surfacing Options for Veins
Surfacing options for veins can be changed by double-clicking on the surface in the project tree and
then clicking on the Surfacing tab. There are additional settings related to boundary filtering and
snapping to data in the Inputs tab.
Boundary Filtering
When data objects are added to a surface, there are two ways to handle the data that lies outside the
surface’s boundary:
l
l

Filter the data. The surface is only influenced by the data that falls inside the surface’s boundary.
Leave the data unfiltered. The surface is influenced by the data both inside and outside the surface’s
boundary.

The boundary of a vein can be the geological model boundary or a fault block boundary.
The Boundary filter setting determines how data used to define the surface is filtered:
l
l
l
l

Off. Data is not filtered.
All data. All data is filtered.
Drilling only. Only borehole data and data objects derived from borehole data are filtered.
Custom. Only the data objects specified in the Inputs tab are filtered.

The Filter segments by boundary setting in the Inputs tab is enabled by default when the Boundary
filter setting in the Surfacing tab is All data or Drilling only. When Filter segments by boundary
is enabled, the vein surface will only be influenced by the segments that falls inside the vein boundary.
Snapping to Data
Often, surfaces should honour borehole data and treat data objects such as polylines and GIS data as
interpretations, as discussed in Honouring Surface Contacts.
There is a Snap to data setting for a geological model as a whole that is set in the Geological Model >
General tab (see Editing a Geological Model). Snap to data can also be set on a surface-by-surface
basis by double-clicking on the surface in the project tree and then clicking on the Surfacing tab.
For individual contact surfaces, the options are:
l
l
l

l

l

Inherit from GM. The setting for the geological model as a whole is used. This is the default setting.
Off. Surfaces do not snap to the data used to create them.
All data. Surfaces snap to all data within the Maximum snap distance, which includes borehole
data and any data added to the surfaces.
Drilling only. Surfaces snap to borehole data and data objects derived from borehole data within
the Maximum snap distance but not to other data used to modify the surfaces.
Custom. Surfaces snap to the data objects indicated in the Inputs tab for each surface.

Take care in enabling snapping and in selecting what data the surface will snap to, as the more data
you include, e.g. by setting a large Maximum snap distance or selecting All data for Snap to
data, the greater the possibility that errors in the data or assumptions inherent in interpretations
(e.g. polylines) will cause distortions in the meshes. If you do enable snapping, it is best to snap only
to drilling data. See Honouring Surface Contacts for more information on these settings.

© 2020 Seequent Limited

Surface Resolution | 524

If you need a surface to honour borehole data but treat other data objects as interpretations, select
Drilling only. To honour some data objects while treating others as interpretations, select Custom,
then click on the Inputs tab to enable snapping for individual objects.
Surface Resolution
Note that although you can change the Surface resolution for a vein, the Adaptive option is not
available, even when the resolution for the geological model is set to be Adaptive.
Vein Thickness
Veins have two thickness settings that force the vein to maintain a minimum or maximum thickness. If
footwall and hangingwall points are in pairs, it is not usually necessary to set the Minimum thickness
or Maximum thickness.
l

l

If the vein intersects itself, set the Minimum thickness to a value that is less than the minimum
distance between any two contact points.
If the vein widens out toward the edges of the geological model set the Maximum thickness to a
value that limits the effects of long segments.

If the Pinch out option is enabled, you will not be able to set the Minimum thickness.
If you set the Maximum thickness and Pinch out, the Pinch out is applied before the Maximum
thickness.
Note that if Snap to data is enabled, snapping occurs after the vein thickness has been calculated. If
it appears that the vein surface is not honouring the thickness setting, check what data the surface is
snapping to.
Vein Pinch Out
Vein walls can be set to pinch out where borehole data indicates they do not occur. This is achieved by
creating ‘outside’ intervals on boreholes that do not have an interior vein segment. These intervals are
then flipped with respect to interior vein intervals, which, in effect means the footwall and hangingwall
orientation has the opposite sense to the nearest interior intervals. This forces the hangingwall and
footwall surfaces to cross, thereby pinching out.
The Pinch out option is disabled when a vein is first created. To enable it, double-click on the vein in the
project tree and click on the Surfacing tab. Tick the box for Pinch out. Click OK to process the
changes. The vein will be updated and pinch out points ( ) will be added to the vein in the project tree.
For this vein, the surface occurs even where the vein lithology (green cylinders) does not occur and
terminates at the boundary of the geological model:
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When the vein is set to pinch out, it tapers out where the vein lithology does not occur:

You can change how much the vein pinches out by excluding some pinch out segments. To do this,
right-click on the pinch out segments ( ) in the project tree and select Edit in Scene. The Pinch Out
Properties window will appear in the scene. Click on a segment to view information about it and set it
to be Excluded, if required. Note that the segments displayed in the scene below are the pinch out
segments rather than the borehole segments shown in earlier scenes. The grey segments are excluded
and the currently selected segment is highlighted in the scene:

Click the Save button ( ) to view the effect of the excluded pinch out segments on the vein. Excluding
the two segments results in the vein terminating at the boundary of the geological model:

The Vein Reference Surface
A vein includes a reference surface ( ) that is the best fit for the objects that make up the hangingwall
and footwall surfaces.
A vein can have a curved reference surface, a planar reference surface or it can use another mesh in the
project. Double-click on the reference surface in the project tree; this opens the Edit Vein Reference
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Surface window and you can see what option is being used for the surface. In this example, the B1 vein
has been created from lithology data and so it has a curved reference surface and the midpoints for the
vein lithology are used as Input values:

Each option is described below:
l
l
l

Curved Reference Surface
Planar Reference Surface
Custom Reference Surface

Curved Reference Surface
The Curved reference surface option is the default for veins created from lithology data and the
objects used to build the reference surface are shown in the Input values part of the Edit Vein
Reference Surface window:
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You can enable or disable the different data objects to see their effects on the vein by ticking and
unticking the Active box, then clicking OK to reprocess the vein.
The Boundary filter setting for each object determines whether or not the data that lies outside the
reference surface’s boundary is filtered.
l

l

Tick Boundary filter so that the surface is only influenced by the data that falls inside the reference
surface’s boundary.
Untick Boundary filter if you want the surface to be influenced by the data both inside and outside
the reference surface’s boundary.

Boundary filtering for the midpoints used to create a curved reference is controlled by the setting for
the vein itself. See Boundary Filtering in Surfacing Options for Veins for more information.
The Curved reference surface option is the default for veins created from lithology data, whereas the
Planar reference surface option is the default for veins created from other types of data. In order for
a vein created from data other than lithology data to use a curved reference surface, other data must be
added to it. To add data, right-click on the reference surface in the project tree and select Add or Edit.
Using the Add option, you can add points data, GIS data or polylines to the surface. Using the Edit
option, you can add a polyline to the reference surface, but its editing options are limited in that you
can not add tangents or normals to the polyline.
Planar Reference Surface
Veins created from objects other than lithology data use a planar reference surface by default. To edit a
planar reference surface, double-click on the reference surface in the project tree. This will open the Edit
Vein Reference Surface window and display controls in the scene for adjusting the plane.
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These handles work in the same manner as the moving plane controls, as described in The Moving
Plane.
To use a planar reference surface for a vein created from lithology data, double-click on the reference
surface to open the Edit Vein Reference Surface window, then select the Planar reference
surface option. Adjust the plane in the scene, then click OK to reprocess the vein.
Custom Reference Surface
If you wish to use another surface in the project as a reference surface, double-click on the reference
surface to open the Edit Vein Reference Surface window. Enable the Custom reference surface
option, then select the mesh from those available in the project:

This option is useful if you wish to use a mesh in the project as, for example, a common reference surface
for all veins in a geological model. To do this, edit the reference surface for each vein so they all use the
common surface for the Custom reference surface option:
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The Vein Boundary
When a vein is first created, its boundary ( ) is empty:

Once a vein has been created, you can change its boundary by adding a polyline an adjusting the
boundary plane.
To edit the boundary using a polyline, right-click on it in the project tree and select Edit. The current
vein boundary will appear in the scene, together with drawing controls. Begin drawing the new
boundary, as described in Drawing in the Scene, ensuring that the polyline drawn closes and does not
intersect itself.

When you save the boundary, the vein will be updated to reflect the changes made. If you want to revert
to the original boundary, right-click on the boundary object ( ) and select Delete Polyline.
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The other option is to adjust the boundary plane. To do this, right-click on the boundary in the project
tree and select Adjust Plane. The plane will be displayed in the scene, along with the Adjust
Boundary Plane window. You can use the handles on the plane to adjust its position or you can enter
the information in the Adjust Boundary Plane window.

Click OK to apply the changes to the vein.
To revert to the original boundary plane, right-click on the boundary object and select Adjust Plane. In
the Adjust Boundary Plane window, click on the Set to Default button and click OK.
Editing Vein Segments
When a vein has been created from contact points, you can change the vein segment settings by
double-clicking on the vein segments object ( ) in the project tree. This opens the Edit Vein window:

When extracting the hangingwall and footwall points, Leapfrog Works automatically includes points at
the ends of the boreholes. To exclude these points, untick the Include points at the ends of holes
option in the Edit Vein window.
If you need to change the orientation of individual vein segments, e.g. for curved veins, you can do this
by right-clicking on the vein segments object ( ) in the project tree and selecting Edit In Scene. If the
vein segments object is already in the scene, you can edit it by clicking the Edit button ( ) in the shape
list.
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The Vein Segment Orientations window will appear in the scene. Click on a vein segment to view
information about that segment:

Points A and B are labelled in the scene and can be changed by unticking the box for each point and
choosing whether to exclude the point or make it a hangingwall or footwall point. Once you have
finished editing vein segments, click the Save button ( ).
If you wish to return to the default settings, ensure the Auto box is ticked for each point.

Vein Systems
This topic describes creating a vein system for a geological model. The topic is divided into:
l
l
l
l
l

Creating a Vein System
Adding Veins to the Vein System
Editing the Veins
Changing Vein System Lithology Settings
Setting Vein Interactions
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An alternative to defining veins one-by-one is to create a vein system. The vein system represents a
single lithology within the geological model. For example, for a model of a sedimentary system cross-cut
by vertical intersecting dykes, we could model the veins one-by-one, in which case each “vein” in the
model is represented by a separate lithology, as shown here:

Modelled as a vein system, however, the veins are grouped into a vein system object ( ) that defines
the lithology for the vein system as a whole:

Note that the individual veins are defined as part of the vein system.
The vein system defines how the veins interact, and veins can be added to it using the same techniques
used to create individual veins.
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Creating a Vein System
To create a vein system, right-click on the Surface Chronology and select New Vein System. In the
window that appears, select the Vein lithology:

If the vein system contacts only one lithology, set the Outside lithology. Otherwise, leave Outside
lithology set to Unknown.
Click OK. An empty vein system ( ) will be added to the project tree under the Surface Chronology.
Double-click on it to change the lithologies.
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Adding Veins to the Vein System
Once the vein system has been created, you can create veins using the same techniques described in
Veins From Lithology Contacts and Veins From Other Data.
To add veins to the vein system, right-click on the vein system and select one of the New Vein options:

Veins will appear in the project tree as part of the vein system object and can be expanded to show how
they were created.
Editing the Veins
The techniques for editing vein system veins are the same as those for veins created one-by-one. See
Refining Veins.
Changing Vein System Lithology Settings
You can change the lithology settings for a vein system by double-clicking on the vein system ( ) in the
project tree. In the Lithology tab, change the Vein lithology or the Outside lithology.
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Setting Vein Interactions
Once all the veins required have been created, you can start defining the interactions between them by
double-clicking on the vein system ( ), then clicking on the Vein System tab:

The veins appear in the list from highest priority to lowest. Organise the veins in chronological order
before defining interactions.
The Vein priority determines which veins other veins can interact with. You cannot define an
interaction for the highest priority vein in the list, and other veins in the list can interact only with
those of higher priority.
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Here, Vein B can only interact with Vein A, the higher priority vein:
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The lowest priority vein, Vein D, can interact with all the other veins in the system:
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To define an interaction, click on a vein, then click the Add button. Add an interaction for each vein and
then set the Side on which they interact.

Once you have defined the required vein interactions, tick the box for each vein, then click OK. Once the
Vein System object has been processed, add it to the scene to check that the veins interact correctly.
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You can also edit vein interactions by double-clicking on the individual veins, which opens the vein’s Edit
window:

Veins and the vein system are not active in the geological model until the box is ticked for each vein in
the Edit Vein System window and the vein system is enabled in the Surface Chronology. This
means you can check the vein system without regenerating the geological model.

Stratigraphic Sequences
When you have a series of continuous layers in a geological model, you can model each layer separately,
as part of a single stratigraphic sequence or using the offset surface tool. Modelling a stratigraphic
sequence works best for sequences uniform in thickness with a consistent stacking order. If a layer varies
in thickness, the contact surface may not match the contact points in some places. This will be a
consideration when choosing whether to model layers as separate layers, as offset surfaces or as part of
a stratigraphic sequence. For information on the offset surface tool, see Offset Surfaces.
Once you have created a stratigraphic sequence, you can refine it by adding and removing layers and by
adjusting the surfaces produced.
This topic describes using the stratigraphic sequence tool and is divided into:
l
l
l

Creating a Stratigraphic Sequence
Editing the Stratigraphic Sequence
Editing Individual Surfaces
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Creating a Stratigraphic Sequence
To create a stratigraphic sequence, right-click on the Surface Chronology object and select New
Stratigraphy. The New Stratigraphic Sequence window will appear:

Select the lithologies at the top and bottom of the stratigraphic sequence. To do this, select the
Lithology Above and Lithology Below from the lithologies available in the geological model:

You can add lithologies to the Stratigraphic Lithologies list first, but if you set the Lithology

© 2020 Seequent Limited

541 | User Manual

Above and Lithology Below first, those lithologies will be filtered out when you select the
Stratigraphic Lithologies.
Next, click the Add button ( ) to view available lithologies:

Select the lithologies that you want to use in the stratigraphic sequence, then click OK to add the layers
to the Stratigraphic Lithologies list. Make sure they arranged in the correct order, using the arrows
alongside the window to rearrange them, if necessary:

In the New Stratigraphic Sequence window, select whether the Bottom Contact Type is an
erosion or a deposit.
When the Surfaces avoid borehole segments option is enabled, the surfaces in the stratigraphic
sequence will not cut through intervals of lithologies that are selected for the stratigraphic sequence.
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Next, click on the Surfacing tab to set the surfacing settings for each surface created for the sequence:

For the Boundary filter and Snap to data options, it is possible to override these settings for the
individual contact surfaces that are part of the stratigraphic sequence. To do this, select Custom. Once
the stratigraphic sequence has been created, expand it in the project tree and double-click on each
surface to change its surfacing options, as described in Contact Honouring and Boundary Filtering for
Individual Surfaces below.
Boundary Filtering
When data objects are added to a surface, there are two ways to handle the data that lies outside the
surface’s boundary:
l
l

Filter the data. The surface is only influenced by the data that falls inside the surface’s boundary.
Leave the data unfiltered. The surface is influenced by the data both inside and outside the surface’s
boundary.

The Boundary filter setting determines how data used to define the surface is filtered:
l
l
l
l

Off. Data is not filtered.
All data. All data is filtered.
Drilling only. Only borehole data and data objects derived from borehole data are filtered.
Custom. Only the data objects specified in the Inputs tab are filtered.

All contact surfaces that make up a stratigraphic sequence will inherit the Boundary filter setting from
the stratigraphy unless Boundary filter is set to Custom.
Snapping to Data
There is a Snap to data setting for a geological model as a whole that is set in the Geological Model >
General tab (see Editing a Geological Model). Snap to data can also be set on a surface-by-surface
basis by double-clicking on the surface in the project tree and then clicking on the Surfacing tab.
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For a stratigraphic sequence, the options are:
l
l
l

l

l

Inherit from GM. The setting for the geological model as a whole is used. This is the default setting.
Off. Surfaces do not snap to the data used to create them.
All data. Surfaces snap to all data within the Maximum snap distance, which includes borehole
data and any data added to the surfaces.
Drilling only. Surfaces snap to borehole data and data objects derived from borehole data within
the Maximum snap distance but not to other data used to modify the surfaces.
Custom. Surfaces snap to the data objects indicated in the Inputs tab for each surface.

Take care in enabling snapping and in selecting what data the surface will snap to, as the more data
you include, e.g. by setting a large Maximum snap distance or selecting All data for Snap to
data, the greater the possibility that errors in the data or assumptions inherent in interpretations
(e.g. polylines) will cause distortions in the meshes. If you do enable snapping, it is best to snap only
to drilling data. See Honouring Surface Contacts for more information on these settings.
All contact surfaces that make up a stratigraphic sequence will inherit the Snap to data setting from the
stratigraphy unless Snap to data is set to Custom.
Surface Stiffness
The Surface Stiffness controls the smallest bend a surface will make, where a higher value will result in
a smoother surface that bends less. The default value is 0, which is no stiffening.
Click OK to create the stratigraphy, which will be added to the project tree as part of the Surface
Chronology object.
Editing the Stratigraphic Sequence
The objects that make up the stratigraphic sequence include the generated contact surfaces and any
points that result in pinch-out errors:

Correcting Pinch-Out Errors
Add the pinch-out errors object ( ) to the scene to view the points that are causing errors. To find out
more about the errors, right-click on the sequence and select List Errors.
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In the Stratigraphic Errors window, information is provided about the different errors that occur in
the stratigraphic sequence, with pinch-out errors and other errors listed separately:

Use this information, together with the pinch-out error points, to either remove lithologies from the
sequence or adjust surfaces using any of the tools available for individual surfaces, as described in Editing
Individual Surfaces below.
Remove lithologies from the sequence by double-clicking on the sequence in the project tree, then
reorganising the lithologies in the Chronology tab.
You can also ignore an error by ticking the Ignored box in the Stratigraphic Errors window.
Surfacing Options
To change a stratigraphic sequence’s surfacing options, double-click on the sequence in the project tree
and click on the Surfacing tab. See Boundary Filtering and Snapping to Data above for more
information on the settings in this tab. Note that boundary filtering and snap settings can also be set for
the individual surfaces that make up the stratigraphic sequence, which is described in Contact Honouring
and Boundary Filtering for Individual Surfaces below.
Applying a Trend
To apply a global trend to a stratigraphic sequence either right-click on it in the project tree and select
Adjust Surface or double-click on the stratigraphic sequence and then click on the Trend tab. You can
then apply a trend to the surface as described in Global Trends.
Editing Individual Surfaces
Individual surfaces that make up a stratigraphic sequence can be modified by:
l
l
l

Contact Honouring and Boundary Filtering for Individual Surfaces
Adding Data to Individual Surfaces
Editing Surface Contacts

Contact Honouring and Boundary Filtering for Individual Surfaces
There are general boundary filtering and snap settings for the stratigraphic sequence as a whole, but it is
possible to override these settings for the individual surfaces that are part of the stratigraphic sequence.
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To do this, first double-click on the stratigraphic sequence itself, then click on the Surfacing tab.
l

l

To change boundary filtering for an individual surface, Boundary filter must be set to Custom for
the stratigraphic sequence.
To change the snap setting for an individual surface, Snap to data must be set to Custom for the
stratigraphic sequence.

Next, double-click on an individual surface in the project tree. The window that appears shows all the
data objects used to create the surface:

See Boundary Filtering and Snapping to Data for more information.
Adding Data to Individual Surfaces
You can also refine the individual surfaces in a stratigraphic sequence in several ways:
l

l

Add other data. Right-click on the surface to see the options available, which will depend on how the
surface was created. See Adding Data to Surfaces for more information.
Edit the surface with a polyline. Right-click on the surface in the project tree and select either Edit >
With Polyline. See Editing Surfaces With Polylines for more information.

It is not possible to add structural data or polylines with orientation information to individual surfaces
in a stratigraphic sequence. If you edit a surface with a polyline, your options for editing the polyline
will be limited.
Editing Surface Contacts
You can edit the contacts used to generate the surface by expanding the contact surface in the project
tree and double-clicking on the points object ( ). See Extracting Contact Points from Borehole Data
for more information on the settings in the Edit Contacts window.
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Offset Surfaces
The offset surface tool is useful way of creating a series of deposit or erosion contact surfaces from a
reference mesh. The surface can be offset from the reference mesh by points or by a fixed distance, and
additional options for offsetting to points can be adjusted once the surface has been created.
Here a deposit contact surface (blue) has been created using the reference mesh (green) offset to points
(red):

Important considerations when creating offset surfaces is the characteristics of the reference mesh,
especially in relation to the geological model’s boundary.
l

l

It is best to use a reference mesh that extends beyond the model’s boundary. If the reference mesh is
too small, the offset surface may be distorted where the reference mesh does not occur.
If the reference mesh changes significantly near the model’s boundary, offset surfaces may show
unexpected changes. Offset surfaces are projected in the direction the reference mesh is going, and
if the reference mesh changes direction just inside the boundary, that change will be reflected in the
offset surface. This is normal if there is data that takes the reference mesh in a different direction, but
if this is not desirable for the offset surface, consider making the geological model’s boundary
smaller.

The rest of this topic describes creating and working with an offset surface. It is divided into:
l
l
l
l
l
l
l

Creating an Offset Surface
The Offset Surface in the Project Tree
Refining an Offset Surface
Changing Surfacing Options for an Offset Surface
Changing Offset Limits
Changing the Reference Mesh
Editing the Reference Mesh

© 2020 Seequent Limited

547 | User Manual

Creating an Offset Surface
To start creating an offset surface, right-click on the Surface Chronology and select New
Deposit/Erosion > From Offset Surface. The New Offset Surface window will appear:

In the window that appears, you need to select a reference mesh, then either select Surface points to
offset to or set a Constant offset.
Click Select reference mesh to view the meshes available in the project.
If you wish to offset from the reference mesh using a fixed distance, click Constant offset and set the
Distance. For Direction, selecting Forward offsets the surface on the younger side of the reference
mesh, and selecting Backward offsets on the older side.
If you wish to offset to points, click Add. You can offset to:
l
l

Base lithology contacts or other lithology contacts in the project.
Other data in the project. GIS data, points data and polylines can be used.

If you offset to points, you will be able to set additional options such as distance limits once the surface
has been created. See Changing Offset Limits below for more information.
Select the First Lithology and Second Lithology from the lithologies defined for the model. If you
have added base lithology contacts or other contacts to the surface, these will be set automatically from
the data used.
Click OK to create the surface, which will appear in the project tree as part of the Surface Chronology.
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The Offset Surface in the Project Tree
The name Leapfrog Works automatically assigns to an offset surface is the lithologies assigned to each
side of the surface. In the project tree, expand the surface to see how it was made:

Double-click on the surface to edit it. Double-click on the contact points object ( ) to edit the lithology
and change compositing parameters.
As further refinements are made to the surface, that information will also be added to the project tree.
See Refining an Offset Surface below for more information.
Refining an Offset Surface
You can refine an offset surface by:
l

l

Adding other data. Right-click on the surface to see the options available, which will depend on how
the surface was created. See Adding Data to Surfaces for more information.
Editing the surface with a polyline. Right-click on the surface in the project tree and select either
Edit. See Editing Surfaces With Polylines for more information.

It is not possible to add structural data or polylines with orientation information to an offset surface. If
you edit an offset surface with a polyline, your options for editing the polyline will be limited.
To edit the surface’s settings, double-click on it in the project tree. In the Lithologies tab, change the
lithologies assigned to each side of the surface, if required.
You can swap the younging direction if the direction was assigned incorrectly when the surface was
created. The change will be reflected in the scene. Note that changing the younging direction does not
change which lithology is older or younger.
An offset surface can be created as a deposit or as an erosion. The difference between deposit and
erosion contact surfaces is how they cut older lithologies, as described in Contact Surfaces. For this
reason, it is possible to change between the two types using the Contact Type setting.
An offset surface cannot be adjusted by applying a trend.

Changing Surfacing Options for an Offset Surface
Surfacing options for an offset surface can be changed by double-clicking on the surface in the project
tree and then clicking on the Surfacing tab. There are additional settings related to boundary filtering
and snapping to data in the Inputs tab.
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Boundary Filtering
When data objects are added to a surface, there are two ways to handle the data that lies outside the
surface’s boundary:
l
l

Filter the data. The surface is only influenced by the data that falls inside the surface’s boundary.
Leave the data unfiltered. The surface is influenced by the data both inside and outside the surface’s
boundary.

The Boundary filter setting determines how data used to define the surface is filtered:
l
l
l
l

Off. Data is not filtered.
All data. All data is filtered.
Drilling only. Only borehole data and data objects derived from borehole data are filtered.
Custom. Only the data objects specified in the Inputs tab are filtered.

Snapping to Data
Often, surfaces should honour borehole data and treat data objects such as polylines and GIS data as
interpretations, as discussed in Honouring Surface Contacts.
There is a Snap to data setting for a geological model as a whole that is set in the Geological Model >
General tab (see Editing a Geological Model). Snap to data can also be set on a surface-by-surface
basis by double-clicking on the surface in the project tree and then clicking on the Surfacing tab.
For individual contact surfaces, the options are:
l
l
l

l

l

Inherit from GM. The setting for the geological model as a whole is used. This is the default setting.
Off. Surfaces do not snap to the data used to create them.
All data. Surfaces snap to all data within the Maximum snap distance, which includes borehole
data and any data added to the surfaces.
Drilling only. Surfaces snap to borehole data and data objects derived from borehole data within
the Maximum snap distance but not to other data used to modify the surfaces.
Custom. Surfaces snap to the data objects indicated in the Inputs tab for each surface.

Take care in enabling snapping and in selecting what data the surface will snap to, as the more data
you include, e.g. by setting a large Maximum snap distance or selecting All data for Snap to
data, the greater the possibility that errors in the data or assumptions inherent in interpretations
(e.g. polylines) will cause distortions in the meshes. If you do enable snapping, it is best to snap only
to drilling data. See Honouring Surface Contacts for more information on these settings.
If you need a surface to honour borehole data but treat other data objects as interpretations, select
Drilling only. To honour some data objects while treating others as interpretations, select Custom,
then click on the Inputs tab to enable snapping for individual objects.
There is also a snap setting that can be used when offset limits are used. This option is discussed in
Changing Offset Limits below.
Surface Resolution
The surface resolution for an offset surface can be inherited from the geological model or it can be set
specifically for the surface. To change the surface resolution for an offset surface, double-click on the
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surface in the project tree and then click on the Surfacing tab. See Surface Resolution for a Geological
Model for information about the surface resolution settings in the Surfacing tab.
Smoothing
The Smoothing parameter in the Surfacing tab can be used for all offset types other than Constant.
If your reference surface is highly curved, you may see distortions in the offset surface. If this is the case,
set Smoothing to a higher value.
Increasing the Smoothing parameter will generally result in faster processing when offsetting to large
distances. If you are finding that processing time is excessively long for an offset surface, consider
increasing Smoothing. In some situations, however, increasing Smoothing can exaggerate
imperfections in the reference surface.
If you are offsetting by a small distance and processing is taking longer than expected, consider setting
Smoothing to None.
Changing Offset Limits
There are four options for Offset limits in the Surfacing tab. Three relate to offsetting to points and
the fourth to offsetting to a fixed distance from the reference mesh.
l

l

l

l

The None option is the default setting used when a surface is created as an offset to points. No
distance limits are used in creating the offset surface, and it simply follows the points used.
The Unidirectional limits option allows you to set distance limits in one direction. Points outside
the limits will be disregarded.
The Bidirectional limits option allows you to set distance limits in both directions, and points
outside these limits are disregarded. This setting is useful for modelling folded surfaces such as veins.
The Constant offset option offsets the surface to a fixed distance from the reference mesh.

The Forward direction is the younger side of the reference mesh.
If the Snap to data outside limits setting is enabled, the surface will honour data, even if it is outside
the distance limits. This option will be greyed out if Snap to data is off.
Changing to a Constant Offset
To use a constant offset rather than points, select the Constant offset option and set the Distance
and Direction to offset the surface. Selecting Forward offsets the surface on the younger side of the
reference mesh, whereas selecting Backward offsets on the older side.
If you created a surface as an offset to points and switch to using a constant offset, the points added to
the surface when it was created will be disabled.
Changing to an Offset to Points
If you created an offset surface using a constant offset, you can change the surface to offset to points,
but you must first add data to it. Do this by right-clicking on it in the project tree and selecting Add.
Once you have added the data you wish to use, double-click on the surface and click on the Surfacing
tab. Change the Offset limits option from Constant offset to one of the other three options.
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Changing the Reference Mesh
To change the surface used as the reference mesh, click on the Inputs tab, then click on the reference
mesh:

Select from the surfaces available in the project, keeping in mind the considerations discussed in
Changing the Reference Mesh.
Editing the Reference Mesh
You can also edit the reference mesh as you would other surfaces. All dependent offset surfaces will be
updated as you make changes to the reference mesh.
Changing the younging direction of the reference mesh affects how offset surfaces are generated.
l

l

For a constant offset surface, the younging direction of the reference mesh determines the forward
and backward direction of the offset surface and, therefore, determines the location of the offset
surface. Changing the younging direction of the reference mesh results in dependent offset surfaces
changing location; the updated offset surface will be the mirror image of the original relative to the
reference mesh.
For surfaces offset to points, the location is determined by the points themselves. If the reference
mesh’s younging direction is changed, the offset surface’s younging direction will also be flipped.
The offset surface will still honour the contact data and will still appear at the same location relative to
the reference mesh.

Structural Surfaces
A structural surface uses contact data and non-contact structural data to create a surface. A structural
surface can interact with other volumes in the model as a deposit, an erosion or an intrusion contact
surface. The shape of the structural surface is suggested by the non-contact structural data used.
When creating a structural surface, there are two options for declustering the non-contact structural
data:
l

l

The input data is automatically declustered as part of creating the structural surface. There are no
additional controls that determine how the data is declustered.
Use a declustered structural data set as the non-contact input to the surface. This approach is
recommended over the first approach as you can change how the data is declustered.

The rest of this topic describes how to create and work with a structural surface. It is divided into:
l
l

Creating a Structural Surface
The Structural Surface in the Project Tree
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l
l
l
l
l

Refining a Structural Surface
Surfacing Options for a Structural Surface
Non-Contact Structural Inputs Settings
Applying a Trend to a Structural Surface
Value Clipping

Creating a Structural Surface
To create a new structural surface, right-click on the Surface Chronology and select New Structural
Surface. The New Structural Surface window will appear:

Use the Add buttons to add non-contact structural data and on-surface contacts, then set the First
lithology and Second lithology. Other settings are:
l
l
l

Query Filter. Select from the query filters defined for the selected structural data object.
Use Polarity. Untick the box to use tangents only.
Contact Type. Structural surfaces can be deposit, erosion or intrusion contacts. The same
algorithm is used for each setting; the only difference is in how the surface interacts with other
surfaces.
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The Structural Surface in the Project Tree
The name Leapfrog Works automatically assigns to a structural surface is the lithologies assigned to each
side of the surface. In the project tree, expand the surface to see how it was made:

As further refinements are made to the surface, that information will also be added to the project tree.
See Refining a Structural Surface below for more information.
To add more non-contact structural data to the surface, right-click on it in the project tree and select
Add > Structural Data. In the window that appears, tick the box for Non-contact Structural
Data:

Refining a Structural Surface
You can refine structural surfaces in several ways:
l

l

l

Add other data. Right-click on the surface to see the options available, which will depend on how the
surface was created. See Adding Data to Surfaces for more information.
Edit the surface with a polyline. Right-click on the surface in the project tree and select either Edit >
With Polyline. See Editing Surfaces With Polylines for more information.
Edit the surface using structural data. Right-click on the surface and select Edit > With Structural
Data. See Editing Surfaces With Structural Data for more information.

To edit the surface’s settings, double-click on it in the project tree. In the Lithologies tab, change the
lithologies assigned to each side of the surface, if required.
You can swap the younging direction if the direction was assigned incorrectly when the surface was
created. The change will be reflected in the scene. Note that changing the younging direction does not
change which lithology is older or younger.
The Contact Type setting determines how the structural surface interacts with other lithologies, as
described in Contact Surfaces. A structural surface can be a deposit, erosion or intrusion contact surface.
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For information on other techniques for refining structural surfaces, see Surfacing Options for a
Structural Surface below.
Surfacing Options for a Structural Surface
Surfacing options for a structural surface are accessed by double-clicking on the surface in the project
tree and clicking on the Surfacing tab. There are additional settings related to boundary filtering and
snapping to data in the Inputs tab.
Setting the Surface Resolution
See Surface Resolution for a Geological Model for information about the surface resolution settings in
the Surfacing tab.
Boundary Filtering
When data objects are added to a surface, there are two ways to handle the data that lies outside the
surface’s boundary:
l
l

Filter the data. The surface is only influenced by the data that falls inside the surface’s boundary.
Leave the data unfiltered. The surface is influenced by the data both inside and outside the surface’s
boundary.

The boundary of a structural surface can be the geological model boundary or a fault block boundary.
The Boundary filter setting determines how data used to define the surface is filtered:
l
l
l
l

Off. Data is not filtered.
All data. All data is filtered.
Drilling only. Only borehole data and data objects derived from borehole data are filtered.
Custom. Only the data objects specified in the Inputs tab are filtered.

Snapping to Input Data
Often, surfaces should honour borehole data and treat data objects such as polylines and GIS data as
interpretations. See Honouring Surface Contacts.
There is a Snap to data setting for a geological model as a whole that is set in the Geological Model >
General tab (see Editing a Geological Model). Snap to data can also be set on a surface-by-surface
basis by double-clicking on the surface in the project tree and then clicking on the Surfacing tab.
For individual contact surfaces, the options are:
l
l
l

l

l

Inherit from GM. The setting for the geological model as a whole is used. This is the default setting.
Off. Surfaces do not snap to the data used to create them.
All data. Surfaces snap to all data within the Maximum snap distance, which includes borehole
data and any data added to the surfaces.
Drilling only. Surfaces snap to borehole data and data objects derived from borehole data within
the Maximum snap distance but not to other data used to modify the surfaces.
Custom. Surfaces snap to the data objects indicated in the Inputs tab for each surface.

Take care in enabling snapping and in selecting what data the surface will snap to, as the more data
you include, e.g. by setting a large Maximum snap distance or selecting All data for Snap to
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data, the greater the possibility that errors in the data or assumptions inherent in interpretations
(e.g. polylines) will cause distortions in the meshes. If you do enable snapping, it is best to snap only
to drilling data. See Honouring Surface Contacts for more information on these settings.
If you need a surface to honour borehole data but treat other data objects as interpretations, select
Drilling only. To honour some data objects while treating others as interpretations, select Custom,
then click on the Inputs tab to enable snapping for individual objects.
Non-Contact Structural Inputs Settings
For the non-contact structural inputs, you can:
l

l
l

Change the Query Filter setting. Select from the query filters defined for the selected structural
data object.
Change the Use Polarity setting. Untick the box to use tangents only.
Change the Boundary filter setting, if the Boundary filter setting in the Surfacing tab is set to
Custom.

Applying a Trend to a Structural Surface
There are two ways to change the trend for a structural surface:
l
l

Right-click on the surface in the project tree and select Adjust Surface.
Double-click on the surface in the project tree and then click on the Trend tab.

See Global Trends for more information.
Value Clipping
In the Value Clipping tab, you can manipulate the data distribution by clipping the data. Clipping caps
values that are outside the range set by the Lower bound and Upper bound values. For example, if you
change the Upper bound from 16.00 to 10.00, distance values above 10.00 will be regarded as 10.00.
When Automatic clipping and Do clipping are enabled, Leapfrog Works sets the Lower bound and
Upper bound from the data. To change the Lower bound and Upper bound, untick Automatic
clipping, tick Do clipping and then change the values.

The Surface Chronology
When you create a contact surface, it appears in the project tree under the Surface Chronology
object, but it is not enabled and, therefore, does not affect the geological model volumes. This means
you can work on the surface without having to reprocess the model whenever you make a change to
the surface. In Leapfrog Works, you can easily define, enable and remove contact surfaces from a
model, and you can experiment with modelling lithologies using different techniques in order to arrive
at a geologically reasonable model.
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To add a contact surface to the surface chronology, double-click on the Surface Chronology object.
The Surface Chronology window will be displayed:

In the project tree, the surfaces are also arranged in chronological order:

The Surface Chronology determines the overall chronological order of the contact surfaces in the
model. If you build your models from the bottom up, you will find that often the contact surfaces are in
the correct chronological order when you first open the Surface Chronology window. However, you
can easily rearrange the chronology using the arrows alongside the table of contact surfaces. Tick the
boxes for surfaces you wish to include in the model. When you click OK, the included surfaces will be
used to subdivide the geological model into lithological volumes. The volumes will appear in the Output
Volumes folder.
Output volumes are named according to the lithologies assigned to each side of the contact surfaces
that bound each volume. If the lithology assigned to an output volume cannot be determined, it will be
assigned the Background lithology.
If you are working with a faulted model and have defined the Surface Chronology for one fault
block, you can copy the Surface Chronology to the empty fault blocks. See Copying the Surface
Chronology to an Empty Fault Block.
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Refined Models
When you have built a geological model and want to model further within one of the volumes, you can
do this by creating a refined geological model. This changes the way the original (parent) geological
model is organised in the project tree and makes it possible to create a sub-model within one or more of
the lithological volumes.
Before starting to refine lithological volumes, it is a good idea to make a copy of the original
geological model.
To start refining a lithological volume, first create the refined geological model. To do this, right-click on
the Geological Models folder and select New Refined Model:

In the window that appears, select the geological model to refine and then select from its lithologies.

Next, set the Base lithology column, Filter data and Surface resolution. You cannot change the
Base lithology column once the refined geological model has been established, but you will be able to
change the resolution and data filter settings.
Click OK to create the refined lithology.
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A new refined model ( ) will be created in the project tree and the parent geological model will be
moved into it. Here, a model called “M Campaign GM” has been used to created a new refined model,
with the QzP volume selected as the refined lithology ( ):

The sub-model ( ) is created inside the refined geological model and has its own Boundary,
Lithologies, Surface Chronology and Output Volumes objects.
You can work with the sub-model in the same manner you would a normal geological model. The
exceptions are:
l

l

The sub-model’s boundary cannot be refined directly. However, changes to the parent geological
model will be updated in the sub-model’s boundary.
The sub-model cannot have its own fault system. If the parent geological model is faulted, the submodel will have its own fault blocks in which you can work.

See Editing the Sub-Model below for more information.
You can still work with the parent geological model in the usual manner. Any changes to the parent
geological model that change the extents of the sub-model will be reflected in the sub-model’s
boundary.
You can create additional sub-models by right-clicking on the refined model ( ) and selecting Refine
Lithology:
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A sub-model can be viewed and evaluated in the same manner as normal geological models. However,
sub-models cannot be used as layer guides for flow models.
Deleting the refined geological model deletes all models it contains. To return to the original project
tree organisation for a geological model, delete the sub-models:

Once there are no more sub-models, the refined model object is also deleted, leaving the parent
geological model.
The refined model has its own Lithologies table, which contains all the lithologies from the parent
model and any sub-model lithologies. You cannot add lithologies to this table, but you can change the
colours used to display them in the scene, as described in Model Lithologies. To add more lithologies to a
refined model, add them to the lithology table in either the sub-model or the parent geological model.
The refined model also has its own Output Volumes folder that combines information from the parent
geological model and the sub-model. If no surfaces have been created in the sub-model, adding the
refined model to the scene will simply display the volumes from the parent geological model. If surfaces
have been created in the sub-model, then the volumes of the sub-model will be displayed alongside the
volumes from the parent geological model.
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Editing the Sub-Model
Work with the sub-model in the same manner described in:
l
l
l

Editing a Geological Model
Contact Surfaces
The Surface Chronology

The sub-model can have resolution settings that are different from those of the parent model. See
Surface Resolution in Leapfrog Works and Surface Resolution for a Geological Model.
To change the sub-model’s resolution settings, double-click on it ( ) in the project tree. The
Geological Model window appears:

This window has only three tabs:
l

l

There is no Boundary tab because the sub-model’s boundary can only be modified by modifying the
parent geological model.
There is no Fault System tab because a sub-model cannot have its own fault system.
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Numeric Models
The FastRBF algorithm employs interpolation functions to estimate values from known data. From these
estimated values, geological surfaces are constructed as part of the model-building process.
With the Numeric Models folder, you can create numeric models and change their parameters.
l

l

l

An RBF interpolant describes a physical quantity that varies continuously in space. An RBF
interpolant can be used to model, for example, RQD data, with isosurfaces values set to represent
both high-quality and low-quality rock. See RBF Interpolants.
A multi-domained RBF interpolant is an RBF interpolant that has a number of individual subinterpolants that are bounded by the fault blocks or output volumes of a selected geological model.
Changes to all sub-interpolants can be made by editing the parent interpolant, while sub-interpolants
can be edited to account for local influences on the values used, the trend and interpolation
parameters. See Multi-Domained RBF Interpolants.
A distance function calculates the distance to a set of points, which is useful for restricting processing
to a specific region. To do this, create a distance function, select the objects to use, then add at least
one buffer. You can then use one of the distance function’s isosurfaces as a lateral extent for another
model. See Distance Functions.

Values that can be interpolated include downhole numeric data, composited borehole data and points
data. See Interpolant Functions for a general introduction to interpolation.
The rest of this topic describes:
l
l
l
l

Copying a Numeric Model
Creating a Static Copy of a Numeric Model
Exporting Numeric Model Volumes and Surfaces
Exporting Numeric Model Midpoints

Importing a Variogram Model
Leapfrog Works can import spheroidal variogram models exported from Snowden Supervisor. The
settings that can be imported are:
l
l

The anisotropy settings in the Trend tab
The Nugget, Total Sill, Base Range and Alpha settings in the Interpolant tab

To import a variogram model, first create an interpolant. Next, right-click on the interpolant and select
Import Variogram Parameters. In the window that appears, navigate to the folder that contains the
XML file and select it. Click Open. The interpolant will be updated with the parameters in the XML file.
The imported variogram model overwrites the parameters in the interpolant, which cannot be
undone. If you wish to save the original settings, make a copy of the interpolant before importing the
new parameters.
Once the interpolant has been updated, you can edit it further by double-clicking on the interpolant in
the project tree.
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Copying a Numeric Model
Creating a copy of a numeric model is a useful way of experimenting with changes to a model.
To copy a numeric model, right-click on it in the project tree and select Copy. Enter a name for the copy
of the model and click OK. The copy will be added to the project tree.

Creating a Static Copy of a Numeric Model
Creating a static copy preserves a snapshot of a numeric model that does not change, even when
changes are made to the data on which the original model was dependent. This is a useful way of storing
historical models and comparing models. Static copies can be exported from Leapfrog Works, as
described in Exporting Numeric Model Volumes and Surfaces below.
To create a static copy of a numeric model, right-click on it in the project tree and select Static Copy.
Enter a name for the copy of the numeric model and click OK. The copy will be added to the Numeric
Models folder.
The objects that make up a static copy of a numeric model depend on the type of model:
l

l

l

For an RBF interpolant, a static copy is made up of a Legend object, a Boundary object, and all
isosurfaces and output volumes created in building the model.
For a multi-domained RBF interpolant, a static copy is made up of a Legend object, a Boundary
object, and the output volumes created in building the model. There are also static copies of the subinterpolants, which are the same as static copies of RBF interpolants.
For an indicator RBF interpolant, a static copy is made up of a Legend object, a Boundary object,
the model’s isosurface and the output volumes.

To view the date a static copy was created, right-click on it in the project tree and select Properties.
The date the copy was created is in the General tab.

Exporting Numeric Model Volumes and Surfaces
There are three options for exporting a numeric model’s output volumes and surfaces. These are:
l

l

l

Export an output volume or a surface as a mesh. Right-click on it in the project tree and click Export.
You will be prompted for a file name and location. See Exporting a Single Mesh.
Export an output volume as a thickness grid. Right-click on it in the project tree and click Export
Thickness Grid. See Thickness Grids.
Export multiple output volumes and surfaces. Right-click on the interpolant in the project tree and
select Export. See Exporting Multiple Meshes from Models.

Exporting Numeric Model Midpoints
To export interval midpoints from a numeric model, right-click on the model’s values object ( ) and
select Export. Interval midpoints can be exported in the following formats:
l
l
l

CSV text file (*.csv)
DXF file (*.dxf)
Snowden Supervisor CSV file (*.csv)
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l
l

Isatis 3D points file (*.asc)
Drawing Files (2013/LT2013) (*.dwg)

The values exported are the midpoints of each segment, the X-Y-Z values and the hole ID. The Snowden
Supervisor and Isatis 3D points formats also include the interval length, when the model has been
created from borehole data.
In each case, you will be prompted for a filename and location.
You can extract interval midpoints from borehole data and then export them from the Points folder.
See Extracting Interval Midpoints from Borehole Data for more information.

RBF Interpolants
If the data is both regularly and adequately sampled, different RBF interpolants will produce similar
results. In practice, however, it is rarely the case that data is so abundant and input is required to ensure
an interpolant produces geologically reasonable results. For this reason, only a basic set of parameters
are required when an RBF interpolant is first created. Once the interpolant has been created, you can
refine it to factor in real-world observations and account for limitations in the data.
The rest of this topic describes how to create and modify RBF interpolants. It is divided into:
l
l
l
l
l
l

Creating an RBF Interpolant
The RBF Interpolant in the Project Tree
Interpolant Display
RBF Interpolant Statistics
Modifying an RBF Interpolant’s Boundary With Lateral Extents
Changing the Settings for an RBF Interpolant
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Creating an RBF Interpolant
To create an RBF interpolant, right-click on the Numeric Models folder and select New RBF
Interpolant. The New RBF Interpolant window will be displayed:

This window is divided into four parts that determine the values used to create the interpolant, the
interpolant boundary, any compositing options and general interpolant properties.
If you are unsure of some settings, most can be changed later. However, the Numeric values object
selected when the interpolant is created cannot be changed.

Values Used
In the Values To Interpolate part of the New RBF Interpolant window, you can select the values
that will be used and choose whether or not to filter the data and use a subset of those values in the
interpolant.
You can build an interpolant from either:
l
l

Numeric data contained in imported borehole data.
Points data imported into the Points folder.

All suitable data in the project is available from the Numeric values list.
Applying a Query Filter
If you have defined a query filter and wish to use it to create the interpolant, select the filter from the
Query filter list. Once the interpolant has been created, you can remove the filter or select a different
filter.
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Applying a Surface Filter
All available data can be used to generate the interpolant or the data can be filtered so that only the data
that is within the interpolant boundary or another boundary in the project influences the interpolant. The
Surface Filter option is enabled by default, but if you wish to use all data in the project, untick the box
for Surface Filter. Otherwise, you can select the Interpolant Boundary or another boundary in the
project.
You can use both the Query Filter option and the Surface Filter option together.
The Interpolant Boundary
There are several ways to set the Interpolant Boundary:
l
l
l

l

Enter values to set a Custom boundary.
Use the controls in the scene to set the Custom boundary dimensions.
Select another object in the project from the Enclose Object list, which could be the numeric values
object being interpolated. The extents for that object will be used as the basis for the Custom
boundary dimensions.
Select another object in the project to use as the Interpolant Boundary. Click the Existing model
boundary or volume option and select the required object from the list.

Once the interpolant has been created, you can further modify its boundary. See Modifying an RBF
Interpolant’s Boundary With Lateral Extents and Adjusting the Interpolant Boundary below.
Compositing Options
When numeric values from borehole data are used to create an interpolant, there are two approaches to
compositing that data:
l

l

Composite the borehole data, then use the composited values to create an interpolant. If you select
composited values to create an interpolant, compositing options will be disabled.
Use borehole data that hasn’t been composited to create an interpolant, then apply compositing
settings to the interpolated values. If you are interpolating values that have not been composited and
do not have specific Compositing values in mind, you may wish to leave this option blank as it can
be changed once the model has been created.

If you are interpolating points, compositing options will be disabled.
See Numeric Composites for more information on the effects of the Compositing length, For end
lengths less than, Minimum coverage and Additional weighting column settings.
General Interpolant Properties
Set the Surface resolution for the interpolant and whether or not the resolution is adaptive. See
Surface Resolution in Leapfrog Works for more information on the effects of these settings. The
resolution can be changed once the interpolant has been created, so setting a value in the New RBF
Interpolant window is not vital. A lower value will produce more detail, but calculations will take longer.
The Volumes enclose option determines whether the interpolant volumes enclose Higher Values,
Lower Values or Intervals. Again, this option can be changed once the interpolant has been created.
Enter a Name for the new interpolant and click OK.
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Once you have created an RBF interpolant, you can adjust its properties by double-clicking on it. You can
also double-click on the individual objects that make up the interpolant.
See also:
l
l
l

Copying a Numeric Model
Creating a Static Copy of a Numeric Model
Exporting Numeric Model Volumes and Surfaces

The RBF Interpolant in the Project Tree
The new interpolant will be created and added to the Numeric Models folder. The new interpolant
contains objects that represent different parts of the interpolant:

l
l

l

l
l

The Boundary object defines the limits of the interpolant. See Adjusting the Interpolant Boundary.
The Trend object describes the trend applied in the interpolant. See Changing the Trend for an RBF
Interpolant.
The points data values object contains all the data used in generating the interpolant. See Adjusting
the Values Used.
The Isosurfaces folder contains all the meshes generated in building the interpolant.
The Output Volumes folder contains all the volumes generated in building the interpolant.

Other objects may appear in the project tree under the interpolant as you make changes to it.

Interpolant Display
Display the interpolant by:
l

l

Dragging the interpolant into the scene or right-clicking on the interpolant and selecting View
Output Volumes. Both actions display the interpolant’s output volumes.
Right-clicking on the interpolant and selecting View Isosurfaces.
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RBF Interpolant Statistics
You can view the approximated mean for each output volume by right-clicking on the interpolant and
selecting Properties. Click on the Statistics tab:

You can copy the information displayed in the Statistics tab to the clipboard for use in other
applications.

Modifying an RBF Interpolant’s Boundary With Lateral Extents
RBF interpolants are created with a basic set of rectangular extents that can then be refined using other
data in the project. These extents usually correspond to the ground surface and known boundaries.
Creating extents can also be used to restrict modelling to a particular area of interest; for example,
modelling can be restricted to a known distance from boreholes by applying a distance function as a
lateral extent. Extents do not need to be strictly vertical surfaces and can be model volumes.
Creating Lateral Extents
To create an extent, expand the RBF interpolant in the project tree. Right-click on the Boundary object
and select from the New Lateral Extent options. Follow the prompts to create the extent, which will
then appear in the project tree under the interpolant’s Boundary object.
New extents are automatically applied to the boundary being modified. Leapfrog Works usually orients a
new extent correctly, with red presenting the inside face of the extent and blue representing the outside
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face. If this is not the case, you can change the orientation by right-clicking on the extent in the project
tree and selecting Swap Inside.
Extent From a Polyline
You can create an extent from a polyline that already exists in the project or you can draw a new one. If
you want to use an imported polyline, import it into the Polylines folder before creating the new extent.
To create a new extent from a polyline, right-click on the interpolant’s Boundary object and select New
Lateral Extent > From Polyline. In the window that appears, select whether you will create a new
polyline or use an existing one:

You can create the extent as a Vertical Wall or Surface. If you create the lateral extent as a
Surface, you will be able to modify it using additional data, as described below. A lateral extent
created as a Vertical Wall, however, cannot be modified.
Click OK to generate the new extent. If you have chosen to create a New Drawing, the drawing
controls will appear in the scene and you can begin drawing, as described in Drawing in the Scene.
The new extent will appear in the project tree as part of the Boundary object.
If the surface generated does not fit the polyline adequately, you can increase the quality of the fit by
adding more points to the polyline. See Drawing in the Scene for information on adding points to
polylines.
Extents created from polylines can be modified by adding points data, GIS vector data and structural
data. You can also add polylines and structural data to the extent. See Adding Data to an Extent, Editing
an Extent With a Polyline and Editing an Extent With Structural Data for more information.
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Extent From GIS Vector Data
GIS data in the project can be used to create a lateral extent for an RBF interpolant. Once the data you
wish to use has been imported into the project, right-click on the interpolant’s Boundary object and
select New Lateral Extent > From GIS Vector Data.
In the window that appears, select the data object you wish to use:

You can create the extent as a Vertical Wall or Surface. If you create the lateral extent as a
Surface, you will be able to modify it using additional data, as described below. A lateral extent
created as a Vertical Wall, however, cannot be modified.
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If you select the Surface option, you can use the GIS data object with its own elevation data or
projected onto the topography:

Using the On Topography option makes sense for GIS data as it is, by nature, on the topography. The
On Topography option also mitigates any issues that may occur if elevation information in the GIS data
object conflicts with that in the project.
Click OK to create the new extent. The new extent will appear in the project tree as part of the
Boundary object.
Extents created from GIS data can be modified by adding points data, GIS vector data and structural
data. You can also add polylines and structural data to the extent. See Adding Data to an Extent, Editing
an Extent With a Polyline and Editing an Extent With Structural Data for more information.
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Extent From Points
To create a new extent from points data, right-click on the interpolant’s Boundary object and select
New Lateral Extent > From Points. The Select Points To Add window will be displayed, showing
points data available in the project:

Select the information you wish to use and click OK.
The new extent will appear in the project tree as part of the Boundary object.
Extents created from points can be modified by adding points data, GIS vector data and structural data.
You can also add polylines and structural data to the extent. See Adding Data to an Extent, Editing an
Extent With a Polyline and Editing an Extent With Structural Data for more information.
Extent From Structural Data
Planar structural data can be used to create a lateral extent for an RBF interpolant. You can create a new
structural data table or use a table that already exists in the project. If you want to use categories of
structural data in creating the extent, use an existing table and create filters for those categories before
creating the lateral extent.
To start, right-click on the interpolant’s Boundary object and select New Lateral Extent > From
Structural Data. The New Structural Data window will be displayed, showing structural data
available in the project:

Select the New Drawing option to draw the structural data points directly in the scene.
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Select the Existing Structural Data option to use a table in the Structural Modelling folder. With
this option, you will be able to select from the categories available in the data table, if query filters have
been created for those categories:

Click OK to generate the new extent. If you have chosen to create a New Drawing, the drawing
controls will appear in the scene and you can begin drawing, as described in Creating New Planar
Structural Data Tables. To share the new structural data table, right-click on it and select Share. The
table will be saved to the Structural Modelling folder.
The new extent will appear in the project tree as part of the Boundary object.
Extents created from structural data can be modified by adding points data, GIS vector data and
structural data. You can also add polylines and structural data to the extent. See Adding Data to an
Extent, Editing an Extent With a Polyline and Editing an Extent With Structural Data for more
information.
Extent From a Surface
To use a surface as lateral extent for an RBF interpolant, right-click on the interpolant’s Boundary
object and select New Lateral Extent > From Surface. The Select Boundary window will appear,
showing all the meshes that can be used as an extent:

Select the required mesh and click OK. The extent will be added to the interpolant’s Boundary object.
You cannot modify an extent created from a mesh by adding data, editing with polylines or structural
data or by applying a trend. However, the extent is linked to the mesh used to create it, and updating the
mesh will update the extent.
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Extent From Distance to Points
Leapfrog Works can calculate the distance to set of points and use the resulting distance buffer as a
lateral extent for an RBF interpolant. To create a new lateral extent from a distance buffer, right-click on
the interpolant’s Boundary object and select New Lateral Extent > From Distance To Points. The
Smoothed Distance Buffer window will appear:

Select the Distance and set an Anisotropy, if required.
The Ellipsoid Ratios determine the relative shape and strength of the ellipsoids in the scene, where:
l
l

l

The Maximum value is the relative strength in the direction of the green line on the moving plane.
The Intermed. value is the relative strength in the direction perpendicular to the green line on the
moving plane.
The Minimum value is the relative strength in the direction orthogonal to the plane.

You can also use the Set to list to choose different options Leapfrog Works has generated based on the
data used to build the interpolant. Isotropic is the default option used when the interpolant is created.
Click OK to create the new extent, which will appear in the project tree as part of the Boundary object.
To change the extent’s settings, expand the interpolant’s Boundary object in the project tree and
double-click on the extent. Adjust the Distance and Anisotropy, if required.
Extents created from a distance to points function can be modified by adding points data and GIS vector
data. See Adding Data to an Extent.
Extent From a Distance Function
A distance function calculates the distance to a set of points and can be used to bound an RBF
interpolant. You can use an existing distance function as a lateral extent or create a new one.
To use a distance function as a lateral extent, right-click on the interpolant’s Boundary and select New
Lateral Extent > From Distance Function. If there are no distance functions in the project, you will
be prompted to create a new one. See Distance Functions for information on defining and editing the
distance function.
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When there are already distance functions in the project, you will be prompted to choose between
creating a new function or using an existing one:

To use an existing function, select it from the list and set a Buffer distance. Click OK to create the
lateral extent.
When you create a new distance function, it will be part of the interpolant’s Boundary object and will
not be available elsewhere in the project. To share it within the project, expand the lateral extent in the
project tree and right-click on the distance function. Select Share. The distance function will be saved
to the Numeric Models folder.
To change the extent’s settings, expand the interpolant’s Boundary object in the project tree and
double-click on the extent. Adjust the Distance and Anisotropy, if required.
Changing a Lateral Extent’s Settings
For lateral extents created from polylines, GIS data, points and structural data, you can change the
extent’s settings by double-clicking on it in the project tree.

In the Surfacing tab, you can change surface resolution and contact honouring options, which are
described below. In the Trend tab, you can apply a trend to the extent, which is described in Applying a
Trend.
Surface Resolution
For RBF interpolants, the resolution of lateral extents is inherited from the settings in the interpolant’s
Outputs tab, but the adaptive isosurfacer is automatically disabled. Enter a different Surface
resolution value, if required, and tick Adaptive to enable the adaptive isosurfacer.
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Contact Honouring
Often, surfaces should honour borehole data and treat data objects such as polylines and GIS data as
interpretations. For extents, the Snap to data setting in the Surfacing tab determines whether or not
the extent honours the data used to create it. Options are:
l
l

l

l

Off. The extent does not snap to the data used to create it. This is the default setting.
All data. The extent snaps to all data within the Maximum snap distance, which includes
borehole data and any data added to the extent.
Drilling only. The extent snaps to borehole data and data objects derived from borehole data within
the Maximum snap distance, but not to other data used to modify the extent. For example, the
extent will honour points data derived from borehole data, but not points data imported into the
Points folder.
Custom. The extent snaps to the data objects indicated in the Inputs tab that are within the
Maximum snap distance.

Take care in enabling snapping and in selecting what data the surface will snap to, as the more data
you include, e.g. by setting a large Maximum snap distance or selecting All data for Snap to
data, the greater the possibility that errors in the data or assumptions inherent in interpretations
(e.g. polylines) will cause distortions in the meshes. If you do enable snapping, it is best to snap only
to drilling data. See Honouring Surface Contacts for more information on these settings.
Whatever the setting, you can see what objects are snapped to by clicking on the Inputs tab.
If you need the extent to honour borehole data but treat other data objects as interpretations, select
Drilling only. To honour some data objects while treating others as interpretations, select Custom,
then click on the Inputs tab to enable snapping for individual objects.
Applying a Trend
You can adjust an extent created from polylines, GIS data, points and structural data by applying a trend
to it. To do this, add the extent to the scene. Next, double-click on the extent in the project tree and click
the Trend tab.
Often the easiest way to apply a trend is to click on the Draw plane line button ( ) and draw a plane
line in the scene in the direction in which you wish to adjust the surface. You may need to rotate the
scene to see the plane properly.
The Ellipsoid Ratios determine the relative shape and strength of the ellipsoids in the scene, where:
l
l

l

The Maximum value is the relative strength in the direction of the green line on the moving plane.
The Intermed. value is the relative strength in the direction perpendicular to the green line on the
moving plane.
The Minimum value is the relative strength in the direction orthogonal to the plane.

Once you have adjusted the plane to represent the trend you wish to use, click the Set From Plane
button to copy the moving plane settings.
The Set to list contains a number of different options Leapfrog Works has generated based on the data
used in the project. Isotropic is the default option used when the extent was created. Settings made to
other surfaces in the project will also be listed, which makes it easy to apply the same settings to many
surfaces.
Click OK to apply the changes.
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See Global Trends in the Trends and Anisotropy topic for more information.
Adding Data to an Extent
Extents created from polylines, GIS data, points and structural data can be modified by adding points
data objects, GIS vector data and structural data. Extents created from a distance to points function can
be modified by adding points data and GIS vector data. To add data to an extent, right-click on the
extent in the project tree and select the data type you wish to use from the Add menu.
l
l
l

Points data. Select from the points data objects available in the project and click OK.
GIS vector data. Select from the GIS vector data available in the project and click OK.
Structural data. Select from the structural data tables available in the project. If the selected table has
query filters defined, you can apply one of these filters by ticking Use query filter and then selecting
the required filter from the list. Click OK to add the selected data to the extent. An alternative to
adding an existing structural data table to an extent is to edit the extent with structural data. This is
described in Editing an Extent With Structural Data below.

You can also add a polyline that already exists in the project. To do this, right-click on the extent in the
project tree and select Add > Polyline. You will be prompted to choose from the polylines in the
Polylines folder.
Editing an Extent With a Polyline
You can edit an extent using a polyline, which is described in Editing Surfaces With Polylines. A polyline
used to edit an extent will be added to the project tree as part of the extent. To edit the polyline, rightclick on it and select Edit Polyline or add it to the scene and click the Edit button ( ) in the shape list.
If you wish to remove the polyline from the extent, right-click on it in the project tree and select Delete
or Remove.
To add an existing polyline to a lateral extent, use the Add > Polyline option.
Editing an Extent With Structural Data
You can edit an extent using structural data, which is described in Editing Surfaces With Structural Data.
A structural data table will be added to the project tree as part of the extent. To edit the table, right-click
on it and select Edit In Scene or add it to the scene and click the Edit button ( ) in the shape list. If
you wish to remove the table from the extent, right-click on it in the project tree and select Delete or
Remove.
Removing an Extent from an Interpolant
If you have defined an extent and want to remove it from the interpolant, there are two options. The first
is to right-click on the extent in the project tree and click Delete. This deletes the extent from the
interpolant, but does not delete parent objects from the project unless they were created as part of the
interpolant, e.g. a polyline used as a lateral extent but not shared within the project. Use this option only
if you are sure you do not want to use the extent.
The second method is useful if you are making changes to the extent and do not want to recompute the
interpolant with each change. Double-click on the interpolant’s Boundary object or double-click on the
interpolant and click on the Boundary tab. The Boundaries part of the window lists all objects used as
extents for the interpolant. Untick the box for extents to temporarily disable them in the interpolant. The
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interpolant will be reprocessed, but you can then work on the extent without reprocessing the
interpolant. Disabled extents will be marked as inactive in the project tree.

Changing the Settings for an RBF Interpolant
To change the settings for an RBF interpolant, you can either double-click on the interpolant in the
Numeric Models folder or right-click and select Open. When creating an RBF interpolant, only a basic
set of parameters is used. The Edit RBF Interpolant window provides finer controls over these basic
parameters so you can refine the interpolant to factor in real-world observations and account for
limitations in the data.
For a multi-domained RBF interpolant, these parameters can be changed for the parent interpolant, and
the trend, clipping, transformation and interpolation settings can be changed for the sub-interpolants.
Adjusting the Values Used
The Values tab in the Edit Interpolant window shows the values used in creating the interpolant and
provides options for filtering the data. Although you cannot change the values used to create an
interpolant, you can filter the values using the Query filter and Surface filter options.
You can adjust the values using a contour polyline or by adding points. Both options are available by
expanding the interpolant in the project tree, then right-clicking on the values object:

These options are described below in Adding a Contour Polyline and Adding Points.
To apply a query filter, tick the Query filter box in the Values tab and select the available queries from
the list.
To change the object used as the Surface filter, select the required object from the list. Note that the
list contains an object that defines the interpolant’s own boundary, which can be adjusted in the
Boundary tab.
Adding a Contour Polyline
Adding a contour polyline is a useful tool for manually adjusting a surface to make it more geologically
reasonable. To start adding a contour polyline, draw a slice where you wish to adjust the surface and
decide what value you will assign to the contour line. Next, right-click on the values object and select
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New Contour Polyline. The next step is to choose whether you will draw a new polyline or use one
already in the project:

Only GIS lines, polylines imported into Leapfrog Works or polylines created using the straight line
drawing tool can be used to create contour lines.
Enter the value to be used for the contour and a name for it. Click OK. If you have chosen the New
Drawing option, the new object will be created in the project tree and drawing tools will appear in the
scene. Start drawing in the scene as described in Drawing in the Scene. When you have finished
drawing, click the Save button ( ). The new contour will automatically be added to the interpolant and
will appear in the project tree as part of the interpolant’s values object.
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To change the value assigned to a contour polyline, double-click on the interpolant in the project tree. In
the Values tab, contour polylines and their assigned values are shown in the User contour values
table:

To change the value on a contour, click in the Value column and edit the entry.
To edit the polyline, right-click on it in the project tree and select Edit Polyline or add it to the scene
and click the Edit button ( ) in the shape list. If you wish to remove a contour polyline from the
interpolant, right-click on it in the project tree and select Delete or Remove.
Adding Points
To add points to an RBF interpolant, right-click on the values object in the project tree and select Add
Values. Leapfrog Works will display a list of all suitable points objects in the project. Select an object and
click OK.
A hyperlink to the points object will be added to the values object in the project tree. To remove the
points object, right-click on the points object and select Remove.
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Compositing Parameters for an RBF Interpolant
When an RBF interpolant has been created from data that has not been composited, compositing
parameters can be changed by double-clicking on the interpolant in the project tree, then clicking on the
Compositing tab.

The Compositing tab will only appear for interpolants created from borehole data that has not been
composited.
You can composite in the entire borehole or only where the data falls inside the interpolant boundary.
See Numeric Composites for more information on the effects of the Compositing length, For end
lengths less than and Minimum coverage settings.
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Adjusting the Interpolant Boundary
See Modifying an RBF Interpolant’s Boundary With Lateral Extents above for information on creating
and working with lateral extents.
To change an RBF interpolant’s boundary, double-click on the interpolant in the project tree, then click
on the Boundary tab:

Controls to adjust the boundary will also appear in the scene.
Tick the Use Topography box to use the topography as a boundary. The topography is normally not
used as a boundary for interpolants and so this option is disabled when an interpolant is first created.
The Boundaries list shows objects that have been used to modify the boundary. You can disable any of
these lateral extents by unticking the box.
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Lateral extents can be used to restrict modelling to a particular area of interest; for example, modelling
can be restricted to a known distance from boreholes by applying a distance function as a lateral extent.
Clipping and Transforming Values for an RBF Interpolant
To clip data and apply a transformation to an RBF interpolant, double-click on the interpolant in the
project tree, then click on the Value Transform tab:

The options for Transform Type are None and Log. Log uses a natural logarithm to compress the data
values to a smaller range. This may be useful if the data range spans orders of magnitude. The function
used is:
ln(x+s)+c
where s is the Pre-log shift and c is a constant. In order to avoid issues with taking the logarithm of
zero or a negative number, Pre-log shift is a constant added to make the minimum value positive. The
value of the pre-log shift will automatically be chosen to add to the minimum value in the data set to raise
it to 0.001. This constant is then added to all the data samples. You can modify the value of the Pre-log
shift, as increasing this value further away from zero can be used to reduce the effect of the natural
logarithm transformation on the resultant isosurfaces.
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Note that a further constant, c, is added to the natural logarithm of the data with the pre-log shift added
to it. If there are any negative numbers that result from taking the natural log of the data, the absolute
value of the most negative number is taken and added to all the transformed data results. This will raise
the value of all the data so the minimum data value is zero. The value of c is chosen automatically and
cannot be modified.

Click on the Options button to change the histogram’s display, including the Bin Width.
If you tick the Do pre-transform clipping option, you can set the Lower bound and the Upper
bound to cap values that are too low or too high. For example, if you set the Upper bound from 14.00
to 10.00, grade values above 10.00 will be regarded as 10.00.
Changing the Trend for an RBF Interpolant
You can apply a global trend or a structural trend to an RBF interpolant. To do this, add the interpolant
to the scene, then double-click on the interpolant in the project tree. Click on the Trend tab in the Edit
RBF Interpolant window.
See:
l
l

Using a Global Trend
Using a Structural Trend
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Using a Global Trend
The easiest way to change the trend applied to an interpolant is using a global trend set from the moving
plane.
Click View Plane to add the moving plane to the scene, then click on the plane to view its controls. You
may need to hide part of the interpolant to click on the moving plane:

You can also use the Set to list to choose different options Leapfrog Works has generated based on the
data used to build the interpolant. Isotropic is the default option used when the interpolant is created.
The Ellipsoid Ratios determine the relative shape and strength of the ellipsoids in the scene, where:
l
l

l

The Maximum value is the relative strength in the direction of the green line on the moving plane.
The Intermed. value is the relative strength in the direction perpendicular to the green line on the
moving plane.
The Minimum value is the relative strength in the direction orthogonal to the plane.

Click OK to regenerate the interpolant and view changes.
Using a Structural Trend
You can also set the trend for an RBF interpolant from a structural trend. First, you must create or import
the required mesh and create a structural trend. See Structural Trends in the Trends and Anisotropy
topic for more information.

© 2020 Seequent Limited

585 | User Manual

Once the structural trend has been created, add it to the interpolant by double-clicking on the
interpolant in the project tree, then clicking on the Trend tab. Select the Structural Trend option,
then select the required trend from the list:
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Click OK. The trend will be added to the interpolant and will appear as part of the interpolant, as shown:

When you apply a structural trend, you cannot use the Linear interpolant. See Interpolant Functions for
more information.
Once a structural trend has been defined for the interpolant, you can edit it by clicking on the trend
hyperlink in the project tree, then opening the structural trend applied to the interpolant. The
Structural Trend window will appear. See Structural Trends in the Trends and Anisotropy topic for
more information on the settings in this screen.
The structural trend information included as part of the interpolant is a link to the original structural
trend. When you change the structural trend that is part of the interpolant, the changes are also
made for the original structural trend.
When a structural trend that is Strongest along meshes or Blending is used, the interpolant will
regress to the global mean trend away from the meshes. The global trend that will be used is set in the
Global Trend tab for the structural trend.
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Adjusting Interpolation Parameters
To adjust interpolation parameters for an RBF interpolant, double-click on the interpolant in the project
tree, then click on the Interpolant tab:

Two models are available, the spheroidal interpolant and the linear interpolant. See the Interpolant
Functions topic for more information on the settings in this tab.
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Output Settings for an RBF Interpolant
You can change the parameters used to generate RBF interpolant outputs by double-clicking on the
interpolant, then clicking on the Outputs tab.

The Evaluation limits apply when interpolants are evaluated against other objects in the project. When
the limits are enabled, all values outside the limits will be set to the Minimum and Maximum.
When Exact clipping is enabled, the interpolant isosurface will be generated without “tags” that
overhang the interpolant boundary. This setting is enabled by default when you create an interpolant.
To add a new isosurface, click the Add button and enter the required value. To delete an isosurface, click
on it in the list, then click the Remove button. You can also change the colours used to display the
isosurfaces by clicking on the colour chips.
If you find that grade shells are overlapping, the resolution may be too coarse. Set Default
resolution to a lower value or enable adaptive resolution in the Outputs tab. See Surface Resolution
in Leapfrog Works.

Multi-Domained RBF Interpolants
This topic describes creating and editing multi-domained RBF interpolants:
l
l
l

Creating a Multi-Domained RBF Interpolant
Compositing and Filtering the Values Used
Selecting Domains
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l
l
l
l
l
l
l

Clipping and Transforming Values
Setting the Trend
Interpolation Parameters
Output Options
The Multi-Domained RBF Interpolant in the Project Tree
Interpolant and Sub-Interpolant Display
Sub-Interpolant Statistics

A multi-domained RBF interpolant is an RBF interpolant that has a number of individual sub-interpolants
bounded by the domains of a geological model.
l
l

Changes to all sub-interpolants can be made by editing the parent interpolant.
Sub-interpolants can be edited to account for local influences on the values used, the trend and
interpolation parameters.

A multi-domained RBF interpolant is a single object that can be evaluated as a single column on points
and block models.

Creating a Multi-Domained RBF Interpolant
Creating a multi-domained RBF interpolant is a two-step process:
l
l

Selecting the values to be used and the domains in which sub-interpolants will be created.
Setting the multi-domained RBF interpolant’s properties.

To start creating a multi-domained RBF interpolant, right-click on the Numeric Models folder and
select New Multi Domained RBF Interpolant. The New Multi-domained RBF Interpolant
window will be displayed:
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In this window, select the basic parameters for the multi-domained RBF interpolant. You will be able to
set additional properties once you click OK.
l

l

Select the Values To Interpolate from the suitable data available in the project. You will be able to
change how data is filtered at the next step, but you will not be able to change the values used.
Select the domains used to generate sub-interpolants. These options cannot be changed once the
multi-domained RBF interpolant has been created, although you will be able to select which volumes
are used to generate sub-interpolants.
l
l
l

Select from the geological models available in the project.
If the selected Model has no faults defined, the Volume Type will be set to output volumes.
If the selected Model is a faulted model, the Volume Type can be output volumes, faulted output
volumes or fault blocks.

Click OK to move on to the next step. The Edit RBF Interpolant window will appear:

Compositing and Filtering the Values Used
In the Values tab, you can apply any query filters that have been defined for the data used.
When numeric values from borehole data are used to create an interpolant, there are two approaches to
compositing that data:
l

l

Composite the borehole data, then use the composited values to create an interpolant. If you select
composited values to create an interpolant, compositing options will be disabled.
Use borehole data that hasn’t been composited to create an interpolant, then apply compositing
settings to the interpolated values. If you are interpolating values that have not been composited and
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do not have specific Compositing values in mind, you may wish to leave this option blank as it can
be changed once the model has been created.
If you are interpolating points, compositing options will be disabled.
See Numeric Composites for more information on the effects of the Compositing length, For end
lengths less than, Minimum coverage and Additional weighting column settings.

Selecting Domains
In the Domains tab, you can select the volumes in which sub-interpolants will be generated. You cannot,
however, change the geological model or the types of volumes used.

Clipping and Transforming Values
In the Value Transform tab, clip data and apply a transformation, if required. See Clipping and
Transforming Values for an RBF Interpolant for more information about the settings in this tab.
You will be able to change the Value Transform settings for individual sub-interpolants once the parent
interpolant has been created.

Setting the Trend
In the Trend tab, you can apply a global or structural trend to the interpolant. See Changing the Trend
for an RBF Interpolant for more information about these options.
You will be able to change the Trend settings for the interpolant and individual sub-interpolants once
the parent interpolant has been created.

Interpolation Parameters
In the Interpolant tab, you can change interpolation parameters. See Adjusting Interpolation
Parameters for more information about these options.
You will be able to change the Interpolant settings or import variogram parameters for the interpolant
and individual sub-interpolants once the parent interpolant has been created.

Output Options
In the Outputs tab, you can change the parameters used to generate interpolant outputs.
The Evaluation limits apply when interpolants are evaluated against other objects in the project. When
the limits are enabled, all values outside the limits will be set to the Minimum and Maximum.
Set the Default resolution for the interpolant and whether or not the resolution is adaptive. See
Surface Resolution in Leapfrog Works for more information on the effects of these settings. The
resolution can be changed once the interpolant has been created, so setting a value when creating the
parent interpolant is not vital. A lower value will produce more detail, but calculations will take longer.
When Exact clipping is enabled, the interpolant isosurface will be generated without “tags” that
overhang the interpolant boundary. This setting is enabled by default when you create an interpolant.
To add a new isosurface, click the Add button and enter the required value. To delete an isosurface, click
on it in the list, then click the Remove button. You can also change the colours used to display the
isosurfaces by clicking on the colour chips.
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The Volumes enclose option determines whether the interpolant volumes enclose Higher Values,
Lower Values or Intervals. This option can be changed once the interpolant has been created.
Enter a Name for the new interpolant and click OK.
Once you have created a multi-domained RBF interpolant, you can adjust its properties as described in
Changing the Settings for an RBF Interpolant. You can also change trend, clipping, transformation and
interpolation settings for a sub-interpolant. To do this, double-click on a sub-interpolant. For the
settings you wish to change, untick the Inherit parameters from parent box:

See also:
l
l
l
l

Importing a Variogram Model
Copying a Numeric Model
Creating a Static Copy of a Numeric Model
Exporting Numeric Model Volumes and Surfaces
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The Multi-Domained RBF Interpolant in the Project Tree
The new multi-domained RBF interpolant will be created and added to the Numeric Models folder. It
contains objects that represent different parts of the interpolant:

l
l

l

l

l

There is a link to the geological model from which domains are selected for the sub-interpolants.
The Trend object describes the trend applied in the interpolant. See Changing the Trend for an RBF
Interpolant for more information.
The points data values object contains all the data used in generating the interpolant. See Adjusting
the Values Used for more information.
The Sub-interpolants folder contains the sub-interpolants, which can be edited to change the
trend, clipping, transformation and interpolation settings. Each sub-interpolant has its own
boundary, trend, isosurfaces and output volumes.
The Output Volumes folder contains all the volumes generated in building the interpolant.

Other objects may appear in the project tree under the interpolant as you make changes to it.

Interpolant and Sub-Interpolant Display
Display the interpolant by:
l

l

Dragging the interpolant into the scene or right-clicking on the interpolant and selecting View
Output Volumes. Both actions display the parent interpolant’s output volumes.
Right-clicking on the interpolant and selecting View Isosurfaces. This displays the isosurfaces of
each sub-interpolant.
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Sub-Interpolant Statistics
You can view the approximated mean for each output volume of a sub-interpolant by right-clicking on
the sub-interpolant and selecting Properties. Click on the Statistics tab:

You can copy the information displayed in the Statistics tab to the clipboard for use in other
applications.

Distance Functions
A distance function calculates the distance to a set of points. This topic describes how to create and
modify distance functions. It is divided into:
l
l

Creating a Distance Function
The New Distance Function in the Project Tree
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Creating a Distance Function
To create a distance function, right-click on the Numeric Models folder and select New Distance
Function. The New Distance Function window will be displayed:

Click Select objects to choose from the objects available in the project. For boreholes, points, GIS
points and imported GIS lines, you can apply any filter that has been defined for that object.
If any of the objects selected are closed surfaces, you can choose whether these surfaces are treated as
Volumes or as Surfaces.
l

l

When treated as Volumes, buffers will be generated only on the outside of the mesh. If the mesh is
inverted, buffers will appear on its inner surface.
When treated as Surfaces, buffers will be generated on both sides of the mesh.
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For example, here a distance function has been created using a sphere and one isosurface set to 2. The
inner surface of the sphere is red, indicating that it is the inside of the mesh. The sphere is treated as a
volume and there is a single isosurface (yellow) outside of the sphere:

When the orientation of the sphere is reversed, indicated by the blue inside of the sphere, the isosurface
(yellow) is generated on the inner surface of the sphere:
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However, when the sphere is treated as a surface rather than as a volume, isosurfaces are generated on
both sides of the sphere:

If you are unsure of some settings, most can be changed later. For a basic distance function click Select
Objects to select from the suitable objects available in the project, then click on the Buffers tab to
define at least one buffer so that the distance function can be visualised in the scene.
See:
l
l
l
l

Setting the Boundary
Setting a Trend
Adding Buffers
The New Distance Function in the Project Tree

Setting the Boundary
In the Boundary tab, you can set whether the function boundary is clipped or unclipped. No distance
buffer clipping is the default setting, but if you choose to clip the buffers, you can choose between:
l
l

Sharing another object’s extents
Defining a set of extents that is independent of other objects in the project.

When you select the Shared with option, the distance function will be updated when the extents object
it shares is updated.
Setting a Trend
In the Trend tab, you can set a trend using the moving plane or by entering the required values. You can
also use the Set to list to choose different options used in the project. Isotropic is the default option
used when the function is created.
The Ellipsoid Ratios determine the relative shape and strength of the ellipsoids in the scene, where:
l
l

The Maximum value is the relative strength in the direction of the green line on the moving plane.
The Intermed. value is the relative strength in the direction perpendicular to the green line on the
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l

moving plane.
The Minimum value is the relative strength in the direction orthogonal to the plane.

Adding Buffers
To add buffers, click on the Buffers tab, then click the Add button:

Enter the required value. To delete a buffer, click on it in the list, then click the Remove button. You can
also change the colours used to display the buffers by clicking on the colour chips.
There are two options for Volume Type that affect how the buffers are calculated when more than one
buffer is used. Selecting Concentric produces higher distance buffers that include the lower distance
buffers, whereas selecting Intervals produces discrete, non-intersecting buffers.
The Default resolution setting is used for all new buffers and for existing buffers that use the default
resolution.

The New Distance Function in the Project Tree
Click OK to create the distance function, which will be added to the Numeric Models folder. The new
distance function contains objects representing different parts of the function, which can be expanded
to show the inputs to each part of the function:
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l
l
l
l

The Trend object that describes the trend applied.
Hyperlinks to objects used for the distance function.
An Isosurfaces folder that contains all the meshes generated in building the distance function.
An Output Volumes folder that contains all the distance buffer meshes.

Other objects may appear in the project tree under the function as you make changes to it.
Display the function by dragging it into the scene or by right-clicking on it and selecting View Buffers.
Once you have created a distance function, you can adjust its properties by double-clicking on it. You can
also double-click on the individual objects that make up the function.
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Combined Models
This topic describes creating and working with combined models. It is divided into:
l
l
l
l
l

Creating a Combined Model
The Combined Model in the Project Tree
Editing a Combined Model
Creating a Static Copy of a Combined Model
Combined Model Export

A combined model uses information from up to four geological models, interpolants and distance
functions in order to visualise relationships between different types of data in the project. For example,
you could combine a geological model with an interpolant to see what lithologies higher grades are
occurring in.

Creating a Combined Model
To create a combined model, right-click on the Combined Models folder in the project tree and select
New Combined Model. In the window that appears, select the models you wish to combine, then click
OK:

Once you have created a combined model, you cannot edit it to add new models or remove existing
ones.
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The next step is to select the output volumes to use in the combined model and arrange them in order of
priority. For this combined model, the QzP volume from the selected geological model will be subdivided
using information from the Au interpolant:

If you are using a distance buffer with concentric buffers, you will be able to select only one volume.
Click OK to generate the model, which will appear in the project tree in the Combined Models folder.

The Combined Model in the Project Tree
In the project tree, the combined model includes hyperlinks to the models used to create the combined
model:

Changes made in the original models will be reflected in the combined model.
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Add the model to the scene to view the results:

To change the colours used to display the model, double-click on the Legend object ( ). In the window
that appears, click on the colour chip for each category and change it as described in Single Colour
Display.
To set multiple categories to a single colour, use the Shift and Ctrl keys to select the colour chips you
wish to change, then click on one of the colour chips. The colour changes you make will be made to
all selected categories.

Editing a Combined Model
To change how the volumes from the source models are combined, double-click on the combined model
in the project tree. Once you have created a combined model, you cannot add new models to it, nor can
you remove a selected model.

Creating a Static Copy of a Combined Model
Creating a static copy preserves a snapshot of a combined model that does not change, even when
changes are made to the data on which the original model was dependent. This is a useful way of storing
historical models and comparing models. Static copies can be exported from Leapfrog Works, as
described in Combined Model Export below.
To create a static copy of a combined model, right-click on it in the project tree and select Static Copy.
Enter a name for the copy of the model and click OK. The copy will be added to the Combined Models
folder.
The static copy ( ) is made up of a Legend object ( ) and the output volumes ( ). To view the date
a static copy was created, right-click on it in the project tree and select Properties. The date the copy
was created is in the General tab.
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Combined Model Export
There are two options for exporting a combined model’s output volumes. These are:
l

l

Export an output volume as a mesh. Right-click on it in the project tree and click Export. You will be
prompted for a file name and location. See Exporting a Single Mesh.
Export multiple output volumes. Right-click on the combined model in the project tree and select
Export. See Exporting Multiple Meshes from Models.
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Contaminant Models
The Contaminants extension adds the Contaminant Models folder to the project tree. The
Contaminant Models folder contains two folders:
l

l

With the Estimation folder, you can define a boundary and values to be used for a contaminant
estimation. Once a contaminant estimation is defined, you can then define variograms, sample
geometries and estimators inside it.
With the Block Models folder, you can import block models in CSV format and create block models.
You can then evaluate estimators on the block model and carry out reporting and validation tasks.

The contaminant modelling workflow is as follows:
l

l

l

l

l
l

Data analysis. First, gain a thorough understanding of your data. Leapfrog Works has general tools
that help you understand your data, which are described in Analysing Data. These tools help you
become familiar with your data, identify possible errors and identify or confirm different
mineralisation populations. Make sure that the data is clean, with special and invalid values in the
assay data properly handled. See Handling Special Values for more details.
Set up a contaminant estimation. A contaminant estimation defines the boundary and values that will
be used in contaminant modelling. See Contaminant Estimations.
Variography. A theoretical variogram model is proposed and tested using experimental variography.
Kriging, nearest neighbour, inverse distance weighting or RBF estimators are defined. See
Experimental Variography and Variogram Models.
Define standard estimators. These will use the variogram models defined during variography and may
also make use of a variable orientation. See Standard Estimators and Variable Orientations.
Visualise estimators on block models. See Visualising Estimators and Block Models.
Validate the models and report the results. Tools for validating and reporting results include block
model interrogation, swath plots and reports. See Validation and Reporting.

Contaminant Estimations
The features described in this topic are only available if you have the Contaminants extension.
A contaminant estimation describes the boundary and values to be used for an estimation. Once a
contaminant estimation is defined, you can then define variograms and estimators inside it.
This topic describes how to create and work with a contaminant estimation. It is divided into:
l
l
l
l

Creating a Contaminant Estimation
The Contaminant Estimation in the Project Tree
Viewing Statistics
Copying a Contaminant Estimation
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Creating a Contaminant Estimation
To create a contaminant estimation, right-click on the Estimation folder and select New
Contaminant Estimation. The New Contaminant Estimation window will be displayed:

This window is divided into three parts:
l
l
l

The domain definition
The values used in the estimation and how they are composited
The value distribution and boundary validation chart

Tools in the window allow you to validate the domain and select whether the boundary should be a hard
or soft boundary.
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Defining the Domain
Click on the Select domain button to select from the suitable objects available in the project:

Any closed mesh can be selected to be used as the domain, including boundary objects and model
volumes.
The selected domain can be used with a Hard boundary or Soft boundary. It is essential to the
integrity of an estimate to select the type of boundary according to the real nature of the geology. This is
discussed in more detail in Boundary Validation below.
A Hard boundary uses only data within the domain’s boundary. This can be seen when you add an
estimation to the scene; the values used do not extend beyond the boundary:
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A Soft boundary will also make use of data beyond the domain boundary, up to the distance specified
in the Range field. Here, the range is set to 10 and we can see that values outside the boundary are used:

The Soft Boundary option provides the ability to create estimation objects strictly within the selected
boundary, but to inform those estimation objects using relevant data immediately adjacent to but
beyond the boundary.
l
l

A fully soft boundary can be achieved by setting the Range to its maximum value.
A semi-soft boundary can be achieved by constraining the Range to a lower value.

When a soft boundary is used, the values are taken within the specified range, measured
perpendicular to the domain rather than along a borehole. This prevents errors arising from
boreholes at acute angles to the domain boundary.

Selecting Values
In the Values part of the New Contaminant Estimation window, select the values that will be used. If
you have defined a query filter, you can use it to filter the values for the contaminant estimation by
selecting it from the Query Filter list. Once the contaminant estimation has been created, you can
remove the filter or select a different filter.
You can build a contaminant estimation from either:
l
l

Numeric data contained in imported borehole data, including composited data
Points data imported into the Points folder

All suitable data in the project is available from the Numeric values list.
It is usually necessary to Transform the contaminant values data using a natural logarithm function. By
default the Transform Type is Log but None can be chosen when no transformation of the data is
required. A Pre-log shift value automatically offsets all the data values by the same amount to bring the
minimum data value to zero, but the value can be changed to an alternative offset value that also
provides positive input values to the log function. The Value Distribution tab shows a histogram of the
transformed data values.
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As well as applying a pre-log shift before the log transform, a constant calculated shift is applied after
the transform to bring the resulting transformed data set minimum data value to zero. The complete
function used is as follows:
transformed_value = ln(input_value + Pre-log shift) + post-log_shift
where input_value is each value in the selected values set, and the constant post-log_shift is
calculated as:
post-log_shift = 0.0 - ln (min_value + Pre-log shift)
where min_value is the lowest value in the selected value set.

Setting Compositing Options
When numeric values from borehole data are used to create the contaminant estimation, you can
composite the data to simplify the geology for the purposes of estimation. If you do not have specific
Compositing values in mind, you may wish to leave this option blank as it can be changed once the
model has been created.
If the numeric values selected have already been composited, the Compositing settings will not be
available in the New Composited Estimation window. Borehole data can be composited directly
by right-clicking on the Composites folder (under the Boreholes object) and selecting New
Numeric Composite. See Numeric Composites.
There are three compositing options:
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l
l
l

No compositing
Entire borehole
Within boundary

The compositing settings available depend on whether the boundary type is a hard or soft boundary. For
soft boundaries, compositing is limited to the Entire borehole option, whereas for hard boundaries,
compositing can also be limited to the data within the contaminant estimation’s boundary.
See Numeric Composites for more information on the Compositing length, For end lengths less
than, Minimum coverage and Additional weighting column settings.
When selecting compositing options, you may see a message: Warning: missing numeric data.
This is not an error, but alerts you that some intervals are missing data.

Boundary Validation
Once you have selected the domain and the values you wish to use and set compositing options, the
boundary analysis tools in the New Contaminant Estimation window help you to determine the best
type of boundary to use:

If compositing is enabled for the contaminant estimation, the boundary validation information
displayed is that for the uncomposited data.
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A histogram of the sample count for each bin is included, so you can ignore things like an anomalous
spike in mean value associated with a very small sample count. Adjust the size of the horizontal axis bins
using the Bin spacing setting.
The pale blue bars show the sample count for each bin, and the red dotted line segment plot shows the
mean value for the bin. The position of the Hard boundary is marked with a solid black vertical line.
When a Soft boundary is selected, a vertical dotted blue line appears to show what values will be
included, based on the Range setting. You can click on the soft boundary line and drag it to adjust the
range.
When the mean value line segment plot shows a sharp change at the boundary, a hard boundary may be
appropriate. Click on points in the line segment plot to see statistics relating to the selected point.
To zoom the x-axis of the chart:
l

Use the scroll wheel on your mouse to zoom in or out.

l

Reset the zoom level by clicking the Reset view button ( ).

The number to the left of the Bin spacing is the Clipping distance. This constrains the calculation of
the graph to the specified distance from the domain, to improve application responsiveness. You can
choose to set the distance to be right at the limit of the x-axis for maximum performance, or increase the
distance to plot additional points to be visible when zooming out.
You can export the graph for use in external reports and other documents. Select the export button ( )
to see two options:
l
l

The Export graph image option saves a PDF, SVG or PNG file of the chart.
The Export data option saves a CSV file containing the data so it can be reproduced and
reformatted in a spreadsheet application.

Alternatively, you can choose the Copy option to save a copy of the graph image to the Windows
clipboard for pasting into another application.
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Note that when the Export data option is used, it is the last three columns (Starting bin distance
from domain, Mean value and Sample count) that are required to reproduce the chart. The first
two columns, Distance from domain to value column and the values column contain all the data
points required to create a new chart with different bin spacing.

The Contaminant Estimation in the Project Tree
Once you have entered a name for the contaminant estimation, click OK. The contaminant estimation
will be added to the project tree in the Contaminant Models > Estimation folder. You can edit its
settings by double-clicking on it.
A contaminant estimation is made up of the following objects:
l

l

l

l

l

l

The Domain defines the limits of the estimation object. To select another domain, double click on
the contaminant estimation and click the Domain button to select a new mesh.
The points data values object contains all the data used in generating the estimation object. These
comprise midpoints for all the value intervals. You can easily change the values used by selecting a
different Numeric values column or by applying an optional query filter.
The Spatial Models folder contains variogram models. Create a variogram model by right-clicking
on the Spatial Models folder and selecting New Variogram Model. See Experimental
Variography and Variogram Models for more information.
The Variable Orientation folder is used for creating objects that make it possible to re-orient the
search and variogram according to local characteristics. See Variable Orientations for more
information.
The Sample Geometry folder contains data density functions that can be used when declustering
data. See Standard Estimators for more information.
The Estimators folder contains estimators that can be evaluated onto block models. Estimators are
similar to Leapfrog RBF interpolants, with the exception that estimators select and refer to an
independently constructed variogram model. See Standard Estimators for more information.
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You can view a contaminant estimation by dragging it into the scene; this adds the Domain and Values
objects to the scene.

Viewing Statistics
You can view statistics for the values used in the contaminant estimation by right-clicking on the numeric
data object and selecting Statistics:

What happens when Statistics is selected depends on whether or not the data values were
composited.
l

If the values were composited, a popup window will offer the choice between:
l
l
l

l

Univariate Graphs
Compositing Comparison
Compositing Interval Lengths

If the values were not composited, a dockable tab window opens displaying the Univariate
histogram of the point values.

For more details on these statistics options, see Analysing Data.
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Copying a Contaminant Estimation
Reusing the same variograms, spatial models and estimators can be achieved by copying an estimation
and then changing its boundary and values. Organising estimations in this way allows you to define a set
of spatial functions and estimators that can then be reused with different values. For example, if you
have multiple domains to estimate, you can define one, copy it, then change that copy’s domain to one
of the additional domains. Or you could experiment with different hypotheses: once you have defined a
set of spatial functions and estimators, you can make a copy of the estimation and change that copy’s
values and boundary. Because the variograms and sills are normalised to the data variance when copying
a estimation, you can change the values selection to a different data column and the sills and variance
will be rescaled to the new data column's variance.

The Ellipsoid Widget
The features described in this topic are only available if you have the Contaminants extension.
Features in the Contaminants extension make use of an ellipsoid widget in the scene. This widget is used
in a variety of situations:
l
l
l

To visualise anisotropy proportions and orientation
To visualise the variogram model in the scene, including rotation and ranges
To depict search neighbourhoods

To aid in the visualisation of the ellipsoid, the major, semi-major and minor axes are also drawn as red,
green and blue lines respectively. Additionally, translucent planes can be seen within the ellipsoid if the
opacity of the ellipsoid is reduced. This assists in visualising the orientation and shape of the ellipsoid.
These planes show the major-semi-major plane and the semi-major-minor plane.
Display and Editing Modes
An ellipsoid may appear in the scene in a display mode or an editing mode. In display mode, the ellipsoid
has no visible handles, and in editing mode the widget has drag handles on the outer edges of the
ellipsoid to change its shape and orientation. For instance, you can drag the variogram model into the
scene from the project tree, and it will appear in the scene in display mode.
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You can also open the variogram model and switch back to the scene or undock the variogram tab and
move it away to see the scene, and because the variogram model is open for editing, the ellipsoid widget
appears in the scene with drag handles.

Changing Movement Handles
Ellipsoid widgets can be repositioned, perhaps so the ellipsoid is not obstructing the view of part of the
model. To reposition the widget, select the widget in the shape list then click the widget in the scene. If
the ellipsoid does not have arrows in the centre, click the ellipsoid and the movement arrows will appear.
You can click the ellipsoid again to turn them off.

In the properties panel for the selected widget, settings control the Centre Point of the ellipsoid. The
X, Y and Z position can be specified directly.
There are two modes for the widget movement handles. In the properties panel for the selected widget,
Align movement handles to has the options Axes and Camera.
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If the option is set to Align movement handles to Axes the drag handles in the centre of the widget
will be red, green and blue and point along the directions of the project axis lines.

You can click on one of the red, green or blue movement handles and drag it in the scene, and the
ellipsoid will move forward or back in the direction of the selected project axis.

Don’t confuse the red, green and blue centre point arrows with the red, green and blue axis adjustment
arrows that may appear on the edge of the widget.
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If the option is set to Align movement handles to Camera the drag handles in the centre of the
widget will be orange and point up/down/left/right across the scene view.

You can click anywhere on the orange handles and drag it in the scene, and the ellipsoid will move across
the viewing plane
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Changing Look Direction
When an ellipsoid widget is selected in the shape list, the Look button in the properties panel provides
options for quickly changing the camera viewpoint.

Changing Controls in Edit Mode
The ellipsoid widget only has handles when it is in editing mode. If there are no drag handes on the
edges of the ellipsoid widget, it is in display mode and cannot be directly modified.
If your ellipsoid widget is in edit mode, you will see drag handles on the edges of the widget. There are
two modes for these controls. Click on the widget to toggle between control modes. Each mode offers
different handles for directly manipulating the ellipsoid widget. When the arrows on the edge of the
widget are yellow, blue and red, the handles adjust the ellipsoid trend.
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Drag a yellow arrow handle to adjust the Dip, blue to adjust the Dip Azimuth and red to adjust the
Pitch.
When the arrows on the edge of the widget are red, green and blue, the handles adjust the ellipsoid
ranges.

Drag a red arrow handle to adjust the Maximum axis range, green to adjust the Semi-major range and
blue to adjust the Minimum range.
If you click on the widget and the outer arrows do not change, you probably have a variogram model
with a second structure defined. Once the second structure is defined, the structure that is controlled
by the arrows would be ambiguous, which is why the range arrows are disabled for multiple structure
variograms.
As you modify the ellipsoid by manipulating the drag handles, the respective settings values are updated.

Experimental Variography and Variogram Models
The features described in this topic are only available if you have the Contaminants extension.
After data analysis and domaining comes the key part of the contaminant estimation workflow:
variography. A theoretical variogram model is proposed and tested using experimental variography.
Kriging, nearest neighbour, inverse distance weighting or RBF estimators are defined and potentially
combined.
Variography is the analysis of spatial variability of values within a region. Understanding how sample
values relate to each other in space is a vital step in informing estimates in a contaminant model. A
variogram is used to quantify this spatial variability between samples.
In estimation, the variogram is used for:
l

l

Selecting appropriate sample weighting in Kriging and RBF estimators to produce the best possible
estimate at a given location
Calculating the estimators’ associated quality and diagnostic statistics

In Leapfrog Works contaminant estimations, variograms are created and modified using the Spatial
Models folder. To create a new variogram model, right-click on the Spatial Models folder and select
New Variogram Model.
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A new variogram model is not auto-fitted and should not be assumed to be the initial hypothesis for
the workflow. While some reasonable defaults have been selected for the variogram model, the
geologist’s personal hypothesis should be the starting point for the estimation workflow.
You can define as many variograms as you wish; when you define an estimator that uses a variogram
model, you can select from those available in the contaminant estimation’s Spatial Models folder:

Working with variograms is an iterative process. The rest of this topic provides an overview of the
Variogram Model window and describes how to use the different tools available for working with
variograms. This topic is divided into:
l
l
l

The Variogram Model Window
Variogram Model Controls
Experimental Controls

See The Ellipsoid Widget for information that is useful in working in the Variogram Model window.
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The Variogram Model Window
The Variogram Model window is divided into three parts:

The variogram model controls ( ) are for adjusting the variogram model type, trend and orientation.
See Variogram Model Controls below. The graphs ( ) plot the selected variogram. Finally, the
experimental controls ( ) are for verifying the theoretical variogram model. See Experimental Controls
below.
When you edit a variogram model in the Variogram Model window, an ellipsoid widget is automatically
added to the scene. The ellipsoid widget helps you to visualise the variogram in 3D, which is useful in
setting variogram rotation and ranges and in defining search neighbourhoods.
If the Variogram Model window is docked as a tab, you can tear the window off. As a separate
window, you can move and resize the window so you can see the ellipsoid change in the 3D scene while
you make adjustments to the model settings. The detached window can be docked again by dragging
the tab back alongside the other tabs, as described in Organising Your Workspace.
There are two ways to save the graph for use in another application:
l

l

Click the Export button ( ) and select Export graph image from the options to export the graph
as a PDF, PNG or SVG file.
Click the Copy graph button ( ) to copy the graph to the clipboard. You can then paste it into
another application.
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Additionally, you can save variogram parameter data by selecting a theoretical variogram from the list,
clicking the Export button ( ) and selecting Export data from the options. Note that Export data is
not available for the experimental variogram or the Radial Plot.

There are two buttons for refreshing the graphs when changes are made:
l

l

When Auto Refresh is enabled, recalculations will be carried out each time you change a variogram
value. This can produce a brief lag.
When auto refresh is disabled, you can click the Refresh button ( ) whenever you want the graphs
to be updated. This is the best option to use when working with a large dataset.
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If auto refresh is disabled and values have been changed without the graphs being updated, the chart will
turn grey and a reminder will be displayed over it:

Variogram Model Controls
The Variogram Model controls adjust the variogram model type, trend and orientation; the graph will
update to reflect changes you make to model parameters. The ellipsoid in the scene will also reflect the
changes you make to the Variogram Model.
Multi-structured variogram models are supported, with provision for nugget plus two additional
structures.
The Nugget represents a local anomaly in values, one that is substantially different from what would be
predicted at that point based on the surrounding data. Increasing the value of Nugget effectively places
more emphasis on the average values of surrounding samples and less on the actual data point and can
be used to reduce noise caused by inaccurately measured samples.
Each additional structure has settings for the component Sill and the normalised sill, labelled Norm.
sill, model Type, Alpha (if the model type is spheroidal), and the Major, Semi-Major and Minor
ellipsoid ranges.
The Sill defines the upper limit of the model, the distance where there ceases to be any correlation
between values. The Sill can be set for the Nugget, Structure 1 and Structure 2.
Piecewise models rise to the Sill at the Range and stay there for increasing distances beyond the
Range. Distances beyond the Range in the domain are uncorrelated.
Asymptotic models approach the sill asymptotically near the range and continue to approach it for
increasing distances beyond the range. For asymptotic models, the Range parameter used in the model
has no equivalent physical meaning, as it does for piecewise models. Common practice is to instead use a
scaling of the Range parameter so that the value entered in this screen somewhat mimics the sill/range
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behaviour of a piecewise model. Typically, this scaling parameter is chosen so that the ‘practical range’
or ‘effective range’ entered corresponds to a point on the asymptotic function that is a defined
percentage of the total sill. There is no universally accepted way of defining what this scaling parameter
should be. The practical range used in Leapfrog Works is noted below for each variogram model Type.
A linear model has no sill in the traditional sense, but, along with the ellipsoid ranges, the sill sets the
slope of the model. The two parameters Sill and Range are used instead of a single gradient parameter
to permit switching between interpolant functions without also manipulating these settings.
The Norm. sill represents the same information as the Sill, but proportionally scaled to a range
between 0 and 1, where 1 represents the data Variance. As you select the radio buttons for Sill and
Norm. sill, the Y-axis scale on the displayed chart will change to correspond to your selection.
The Total sill is the sum of the component sills for both the data sills and the normalised sills.
The Lock sill icon indicates if the sill is unlocked ( ) or locked ( ). Click the icon to change the lock
state. If unlocked, changing a sill value will adjust the Total sill by the same amount. If locked, adjusting
any sill value will not change the Total sill at all, but other sill values will change to keep the Total sill
fixed.
The Variance is calculated automatically from the data and shows the magnitude of the variance for the
dataset.
Linear, Spherical and Spheroidal Model Options
Leapfrog Works provides a variety of ‘authorised’ variogram model types to ensure the spatial character
of continuity can be modelled. ‘Authorised’ variogram models are guaranteed to have the mathematical
property of ‘positive definiteness’ for the associated covariance function, meaning the model is
guaranteed to produce a valid result when used in Kriging. The model Type provides the options Linear,
Spherical, Spheroidal, Gaussian, Exponential, Cubic and Generalised Cauchy.
Variogram models can be bounded or unbounded. Linear is the only unbounded type provided by
Leapfrog Works, where the value of the variogram increases as a linear function of distance. Linear
models cannot be combined with the bounded models.
All other model types provided in Leapfrog Works are bounded models that rise to a sill. These can be
separated into two further types:
l
l

Piecewise models that rise to a sill at a range, then are constant beyond that range
Asymptotic models that approach but never reach a sill

Spherical and Cubic models are piecewise; Spheroidal, Gaussian, Exponential and Generalised
Cauchy are asymptotic.
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The functions vary in how quickly they rise toward the sill both initially and at (and beyond) the range.
Which function you select will depend on the variable you are modelling, as well as the performance
required. For instance, Generalised Cauchy is provided as it is faster than the Gaussian function
when applied to an RBF estimator, but provides reasonably similar results.

Variogram model types Cubic, Gaussian and Generalised Cauchy are included specifically for
modelling variables with high continuity and local correlation such as dispersed groundwater
contaminants. Screening effects and negative Kriging weights can be more pronounced when using
these models with continuous behaviour, so use the block model interrogation tool to check the Kriging
plan is optimal and the Kriging weights are appropriate.
Each of the variogram model Types are described below. For each, a formula is presented for the
model. They all use the following terms:
l
l
l
l

γ (h) is the value of the variogram at distance h
C0 is the sill
h is the distance on the x axis
a is the range parameter

For each model type, the effect of the interpolation function is depicted by evaluation onto a grid of
points, using as input just four samples, A = 7, B = 14, C = 2 and D = 8. A thin slice is taken through the
grid of points to provide a sort of 2D visualisation of the operation of the function. One of the points has
been selected in each view to display the value being estimated for a specific location.

Type = Linear
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Linear is a general-purpose multi-scale option suited to sparsely and/or irregularly sampled data. It is
typically used for modelling of categorical variables.

Type = Spherical

Spherical is suitable for modelling most variables where there is a finite range beyond which the
influence of the data should fall to zero. Because the spherical model is piecewise, beyond the range the
variogram value is the constant sill.

Type = Cubic

Cubic, like Spherical, is a piecewise model that has a finite range beyond which the influence of the
data should fall to zero, and the variogram value is the constant sill. It has been included specifically for
modelling variables with high continuity and local correlation such as dispersed groundwater
contaminants. Screening effects and negative Kriging weights can be more pronounced when using the
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cubic model type with continuous behaviour, so use the block model interrogation tool to check the
Kriging plan is optimal and the Kriging weights are appropriate.

Type = Exponential
The Exponential variogram model type is used in modelling precious metals such as gold. It has a
steeper slope toward the origin than other model types.

The Exponential model is asymptotic and approaches but never quite reaches the Sill.
An exponential model with a range parameter of a reaches a value of ~95% of the sill at a distance of 3 x
a. The Range value is scaled by a factor of 1/3 in the formulation. This has the effect of ensuring that the
exponential variogram reaches ~95% of the sill at the ‘practical range’. Beyond the practical range, a
point has a small but non-zero correlation.

Type = Gaussian
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The Gaussian model is asymptotic and approaches but never quite reaches the Sill.
Gaussian has been included specifically for modelling variables with high continuity and local
correlation such as dispersed groundwater contaminants. Screening effects and negative Kriging
weights can be more pronounced when using these models with continuous behaviour, so use the block
model interrogation tool to check the Kriging plan is optimal and the Kriging weights are appropriate.
A Gaussian model with a range parameter of a reaches a value of ~95% of the sill at a distance of √3 x
a. The Range value is scaled by a factor of 1/√3 in the formulation. This has the effect of ensuring that
the Gaussian variogram reaches ~95% of the sill at the ‘practical range’. Beyond the practical range, a
point has a small but non-zero correlation.

Type = Generalised Cauchy
The Generalised Cauchy model is asymptotic and approaches but never quite reaches the Sill.
The Generalised Cauchy covariance can be expressed as:

By considering only particular values for the exponent α this expression can be simplified to derive a
standardised Generalised Cauchy covariance function of order m, where m = 2α

This can in turn be expressed as a variogram function for the Generalised Cauchy variogram of order
m:

Select the order m by selecting from the Alpha options of 3, 5, 7 or 9, which are the only values allowed
in Leapfrog Works. For a given range parameter a, the variograms of order m reach the same proportion
of total sill at quite difference distances. In order to equate the shape of the variogram to the entered
Range parameter, scaling parameters are applied.
For a Generalised Cauchy variogram of order 9, the value of γ at the specified range parameter is
95.58% of the total sill. Because the convention is arbitrary, Leapfrog Works considers that a variogram
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of order 9 does not require a re-scaling of the range parameter. Leapfrog Works then uses this sill
proportion of 95.58% to calculate scaling factors for variograms of order 3, 5 and 7. In practice, a lookup
table is used with ideal values rounded to 10 decimal places:
Order (m)

Range scaling factor

3

0.3779644730

5

0.6347188807

7

0.8339047224

9

1.0000000000

This has the effect of ensuring that the Generalised Cauchy variogram reaches 95.58% of the sill at
the ‘practical range’. Beyond the practical range, a point has a small but non-zero correlation. For
further details on the derivation see The Spheroidal Family of Variograms Explained on the Seequent
blog.
This chart shows the relative differences for different values of Alpha, which is the order (m) of the
function, in comparison to a spherical curve:

Type = Spheroidal
The Spheroidal model is asymptotic and approaches but never quite reaches the Sill. However, the
first part of the function is linear.
Spheroidal is suitable for modelling most variables where there is a finite range beyond which the
influence of the data should fall to zero. The spheroidal variogram was developed by Seequent primarily
for use in RBF interpolants. Seequent wanted an effectively compact spatial function that has linear
behaviour near the origin and an asymptotic approach to the sill. This was developed by taking a
commonly used family of radial functions and linearizing them near the origin. This results in a variogram
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that combines the Linear model with the Generalised Cauchy variogram model. The transition point
between these two is the inflection point on the Generalised Cauchy model.

where

Select the order m by selecting from the Alpha options of 3, 5, 7 or 9, which are the only values allowed
in Leapfrog Works. For a given range parameter a, the variograms of order m reach the same proportion
of total sill at quite difference distances. In order to equate the shape of the variogram to the entered
Range parameter, scaling parameters are applied.
For a Spheroidal variogram of order 9, the value of γ at the specified range parameter is 96% of the
total sill with no nugget. Because the convention is arbitrary, Leapfrog Works considers that a variogram
of order 9 does not require a re-scaling of the range parameter. Leapfrog Works then uses this sill
proportion of 96% to calculate scaling factors for variograms of order 3, 5 and 7. In practice, a lookup
table is used with ideal values rounded to 10 decimal places:
Order (m)

Range scaling factor

3

0.3731574337

5

0.6319995630

7

0.8327312240

9

1.0000000000

This has the effect of ensuring that the Spheroidal variogram reaches 96% of the sill at the ‘practical
range’ with no nugget. Beyond the practical range, a point has a small but non-zero correlation. For
further details on the derivation see The Spheroidal Family of Variograms Explained on the Seequent
blog.
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This chart shows the relative differences for different values of Alpha, which is the order (m) of the
function, in comparison to a spherical curve:

Alpha is only available when the model Type is Spheroidal or Generalised Cauchy. The Alpha
constant determines how steeply the interpolant rises towards the Sill. A low Alpha value will produce a
variogram that rises more steeply than a high Alpha value. A high Alpha value gives points at
intermediate distances more weighting, compared to lower Alpha values. For Spheroidal, an Alpha of
9 provides the curve that is closest in shape to a spherical variogram. In ideal situations, it would probably
be the first choice; however, high Alpha values require more computation and processing time, as more
complex approximation calculations are required. A smaller value for Alpha will result in shorter times to
evaluate the variogram.
RBF estimators will only work when the Structure 2 model Type is set to None.
When Structure 2 is defined, the model ranges cannot be adjusted by manipulation of drag handles
on the ellipsoid. Because it would not be clear which structure was being manipulated, the drag
handles to change the range settings do not appear.
Normalised Y Axis
A key use of copying a variogram is to apply it to another correlated contaminant. This would typically be
accomplished, having determined the appropriate variogram using the values for one contaminant, by
copying the domained estimation and changing the Numeric values field to a different contaminant.
However, the absolute values for the nugget and sills for each structure would be completely
inappropriate for the new contaminant; while we desire the shape to be the same, the values for
different compounds will inevitably be different. To make this work correctly, the variogram is
normalised or standardised, rescaling the range of Y-axis values to between 0 and 1, where 1 is equivalent
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to the data Variance. This makes the variogram information portable between domained estimations.
This is performed automatically, requiring no intervention on your part.
You can freely switch between the Sill and Norm. sill options. The selection only changes the Y-axis
scale on the displayed chart.
You do not need to select the Normalised option before copying the domained estimation and using
it as the basis for a different mineral resource. The normalised scale will always be used when
applying the variogram model to the new data set.
As you adjust the Nugget or the Structure 1 or Structure 2 sill values, the Total sill will change both
for the absolute Sill values and the Norm. sill values. The Norm. sill total may end up being something
other than 1.0. This is expected, as the value reference for the normalised scale uses the data Variance
for 1.0, not the total sill.
Note that the data Variance is recorded in the Y axis label so the chart scale is always meaningful,
including when the chart is exported.
Direction
The trend Direction fields set the orientation of the variogram ellipsoid. Adjust the ellipsoid axes
orientation using the Dip, Dip Azimuth and Pitch fields.
The Set From Plane button sets the trend orientation of the model ellipsoid based upon the current
settings of the moving plane.
The View Ellipsoid button adds a 3D ellipsoid widget visualisation to the scene, in case it has been
deleted from the scene since the variogram model window was opened for editing.
Experimental Controls
A variogram model can be verified through the use of the experimental variography tools that use sample
data. Use these to find the directions of maximum, intermediate and minimum continuity.
The variogram displayed in the chart is selected from the variograms listed in the panel in the top left
corner of the window.
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The top entry in the variograms list is the theoretical variogram model rather than an experimental
variogram:

All other variograms in the list and the other controls on the left-hand side of the screen relate to
Experimental Variograms.
Besides the theoretical Variogram Model, a set of experimental Axis Aligned Variograms are
available, including a Radial Plot variogram and a variogram for each axis of the variogram ellipsoid.
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Click on one of these experimental variograms to select it and display its parameters. The displayed
graph will change to match this selection. For example, here the graph and settings for the combined
Axis Aligned Variograms are displayed:
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Selecting the Semi-major Axis variogram changes the chart and settings displayed:

Adjust the model variogram parameters to see the effect different parameters have when applied to the
actual data.
Experimental Variogram Parameters
The experimental variogram controls along the left side of the window define the search space, define
the orientation for custom variograms and change how the variograms are displayed.
Capping
Data Capping fields limit the values of the Lower bound and Upper bound for the data as specified.
This is not a filter that discards these points, but values below or above the caps are treated as if the value
was the lower or upper bound.

These Capping controls only affect the data values considered for the purposes of experimental
variography, and they do not cap the values of the data points used in estimation. If you wish to also
cap values used in estimation, set the Lower bound and Upper bound limits in the Value Clipping
tab in the applicable estimator. To eliminate an anomalous data point or discard certain data values,
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you should modify the domain definition options using a Query Filter.
Defining the Search Space
The search space for experimental variography is not shown in the scene. It is not an ellipsoid, and
should not be confused with either the variogram model ellipsoid or the estimator's search ellipsoid.
The first set of parameters controls the search space.
l

l

Lag distance controls the size of the lag bins. The first bin will be one quarter of the size of the Lag
distance. Experimental variograms generally measure lags as distances along a direction vector,
though downhole variograms measure lags as distances along the boreholes.
Lag tolerance allows for the reality that data pairs are rarely the same distance apart. The data is
scanned and pairs are assembled after applying a Lag tolerance to the Lag distance. If the Lag
tolerance Auto box is ticked, Leapfrog Works defaults to using a Lag tolerance of half the Lag
distance. Controlling the Lag tolerance explicitly allows you to test the sensitivity of the
variogram. Typically, a larger value will be used for sparse datasets and a smaller value for dense
datasets.

Some software treats a Lag tolerance of 0 as a special value that does not mean ‘no lag tolerance’
but instead is interpreted as meaning half the Lag distance. In Leapfrog Works, it is possible to set
Lag tolerance to 0, but this means literally what the number implies: there is no Lag tolerance and
the only data pairs that are displayed are those that occur exactly at the Lag distance spacing.
l
l

Number of lags constrains the number of lag bins in the search space.
The In Plane and Off Plane Angle tolerance and Bandwidth settings define the search shape,
and the effects of these settings are discussed in more detail below.
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The search shape usually approximates a right rectangular pyramid on a rectangular parallelepiped. The
pyramid and parallelepiped will be square if the In Plane Angle tolerance and Bandwidth are used
without defining Off Plane values. Using the Off Plane Angle tolerance and Bandwidth fields will
make the shape rectangular. The plane being referred to is the major-intermediate axis plane of the
variogram ellipsoid, the same plane used for the radial plot. The Angle tolerance is the angle either side
of a direction vector from the data point origin. Once the sides of the pyramid defined by the angle
tolerances extend out to the limits specified by the Bandwidth, the search neighbourhood is
constrained to the bandwidth dimensions.

The search shape becomes a more complex “carpenter’s pencil” shape when a wide In Plane angle and
a narrow Bandwidth are defined along with a narrow Off Plane angle and a wide Bandwidth, or vice
versa. This rendering should assist in visualising the shape; the major axis is shown in red, the semi-major
axis is shown in green, and the orthogonal minor axis in a transparent blue:

Note that although not shown here, the outer ends of the search shapes are not flat, but rounded, being
defined by the surface of a sphere with a radius of the maximum distance defined by the number of lags
and their size.
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Off Plane Angle tolerance and Bandwidth settings cannot be set for the minor axis variogram.
Because the angle tolerance and bandwidth are described relative to the major-intermediate plane
and because the minor axis is orthogonal to this plane, only one angle can be described. This results
in a square pyramid search shape.

The In Plane Bandwidth also cannot be set for the Minor Axis.
Note that although not shown here, the outer ends of the pyramids are rounded, defined by the
surface of a sphere with a radius of the maximum distance defined by the number of lags and their
size.
Radial Plot Parameters
Radial Plot has parameters specifically for the radial plots in Axis Aligned Variograms.
Increasing the Radial divisions slices the space into a larger number of sectors, with each block in the
radial plot covering a smaller arc of the compass. As a result, each block has a smaller volume; this also
means that the amount of data in each block is reduced. Because the bandwidth angle above and below
the major-intermediate plane matches the angle used to slice the plot into its sectors, increasing the
Radial divisions also reduces the number of data points used above and below the plane. Using a
smaller number of Radial divisions will be faster. If you increase the number of divisions, you may want
to turn off Auto Refresh Graphs first and click Refresh graphs afterwards. Experiment with the
number of divisions and choose the lowest number of Radial divisions that helps you gain the best
understanding of continuity; this will maximise the data that falls in each division.
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Mean Value will display radial plot bins coloured to indicate the mean value for each bin. Contour will
display a plot showing lines of equal value. Fill shades the chart between the contour lines.

Changing Axis Limits
The Axis Limits settings control the chart scaling.
X axis limits and Y axis limits control the ranges for the X-axis and Y-axis and can effectively be used
to zoom the chart. You can directly control these by manipulating the axes with your mouse. Click and
drag an axis to increase or decrease the maximum limit of the axis. Right-click and drag an axis to
reposition the axis so the minimum value on the axis is not zero. Double-click the axis to reset the axis
minimum and maximum range to the default values. Fit Graph will auto-fit the graph to the available
data.

Changing Variogram Display
The Display settings change how the variogram is displayed:
l
l
l

l

Show model variogram plots the variogram on the chart.
Show pair count annotates the chart with the count of data point pairs.
Tick the Scale points to pair size checkbox and the chart will display the plotted points with dots
that scale to the size of the pair count. Choose Actual so the dots represent the pair size
proportionally and Inverse to see larger dots for lower pair counts.
Tick Moving avg for a rolling mean variogram value, drawn on the variogram plots in orange. Next
to it, select a value for the window size relative to the Lag distance.The window size will be the
given number times the lag distance. This window, centred on x, will be used to plot y, the average of
all the variogram values falling inside the window. The lag multiplier field has a useful tooltip reminder;
hover your mouse pointer over the field to see the tooltip.
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Axis Aligned Variograms
The Axis Aligned Variograms are useful for determining the direction of maximum, intermediate and
minimum continuity. When you select the Axis Aligned Variograms option, all four variograms are
displayed in the chart:
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The radial plot and each of the axes variograms can be viewed in greater detail by clicking on them in the
variogram tree:

In the axes variogram plots, you can click-and-drag the plus-shaped dragger handle to adjust the range
and the sill. A triangular dragger handle adjusts the nugget. A solid line shows the model variogram, and
dotted horizontal lines show the Total Sill and, if Sill is chosen instead of Norm. sill, the variance.
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In the radial plot, you can click-and-drag the axes arrows to adjust the pitch setting, between the values
0 and 180 degrees. Each bin in the mean value radial plot shows the mean semi-variogram value for pairs
of points binned by direction and distance. When the contour plot is selected, lines follow the points of
equal value.

The experimental variogram controls can be different for each axis direction.

Standard Estimators
The features described in this topic are only available if you have the Contaminants extension.
This topic describes creating and working with the different types of estimators the Contaminant
extension supports:
l
l
l
l

Inverse Distance Estimators
Nearest Neighbour Estimators
Kriging Estimators
RBF Estimators

Estimators can be copied, which makes it easy to experiment with different parameters. Simply rightclick on the estimator in the project tree and select Copy.
Inverse Distance Estimators
The basic inverse distance estimator makes an estimate by an average of nearby samples weighted by
their distance to the estimation point. The further a data point is from the estimate location, the less it
will be relevant to the estimate and a lower weight is used when calculating the weighted mean.
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To create an inverse distance estimator, right-click on the Estimators folder and select New Inverse
Distance Estimator. The New Inverse Distance window will appear:

Leapfrog Works extends the basic inverse distance function with the option for anisotropic distance.
In the Interpolant tab:
l

l
l

Exponent adjusts the strength of the weighting as distance increases. A higher exponent will result
in a weaker weight for the same distance.
Ellipsoid Ranges identify the Max, Int and Min ranges set in the Ellipsoid tab.
A chart depicts the resultant weights that will be applied by distance.

In the Ellipsoid tab:
l

l

The Ellipsoid Definition sets the anisotropic distance and direction, scaling distances in three
orthogonal directions proportionally to the range for each of the directions of the ellipsoid axes. This
effectively makes the points in the direction of greater anisotropy appear closer and increases their
weighting. Adjust the Ellipsoid Ranges and Directions to describe the anisotropic trend.
Click View Ellipsoid to see an ellipsoid widget in the scene that helps to visualise the anisotropic
trend.

In the Search tab The Minimum Samples and Maximum Samples parameters determine the
number of samples required or used within the search neighbourhood.
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In the Value Clipping tab, you can enable value clipping by ticking the Clip input values box. This
caps values outside of the range set by the Lower bound and Upper bound to the bounding values.
In the Outputs tab, you can specify attributes that will be calculated when the estimator is evaluated on
a block model. Value and Status attributes will always be calculated, but you can choose additional
attributes that are useful to you when validating the output and reporting. These attributes are:
l
l

l

l

l

The number of samples (NS) is the number of samples in the search space neighbourhood.
The distance to the closest sample (MinD) is a cartesian (isotropic) distance rather than the ellipsoid
distance.
The average distance to sample (AvgD) is the average distance using cartesian (isotropic) distances
rather than ellipsoid distances.
The number of duplicates deleted (ND) indicates how many duplicate sample values were detected
and deleted by the estimator.
When the estimator must select from equidistant points to include or exclude in the search space
because it found more samples than the Maximum Samples threshold, the number of equidistant
points detected (EquiD) is recorded. You can use this output as a trigger for further investigation.

Nearest Neighbour Estimators
Nearest neighbour produces an estimate for each point by using the nearest value as a proxy for the
location being estimated. There is a higher probability that the estimate for a location will be the same as
the closest measured data point, than it will be for some more distance measured data point.
To create a nearest neighbour estimator, right-click on the Estimators folder and select New Nearest
Neighbour Estimator. The New Nearest Neighbour window will appear:

Nearest Neighbour uses an astral search algorithm to determine what point is considered the nearest.
Leapfrog Works includes support for anisotropy when determining what is considered the ‘nearest’
value. Adjust the Ellipsoid Ranges and Directions to describe the anisotropic trend.
Click View Ellipsoid to see an ellipsoid widget in the scene that helps to visualise the anisotropic trend.
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In the Value Clipping tab, you can enable value clipping by ticking the Clip input values box. This
caps values outside of the range set by the Lower bound and Upper bound to the bounding values.
In the Outputs tab, you can specify attributes that will be calculated when the estimator is evaluated on
a block model. Value and Status attributes will always be calculated, but you can choose additional
attributes that are useful to you when validating the output and reporting. These attributes are:
l
l

l

The number of samples (NS) is the number of samples in the search space neighbourhood.
The distance to the closest sample (MinD) is a cartesian (isotropic) distance rather than the ellipsoid
distance.
The average distance to sample (AvgD) is the average distance using cartesian (isotropic) distances
rather than ellipsoid distances.

Kriging Estimators
Kriging is a well-accepted method of interpolating estimates for unknown points between measured
data. Instead of the simplistic inverse distance and nearest neighbour estimates, covariances and a
Gaussian process are used to produce the prediction.
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To create a Kriging estimator, right-click on the Estimators folder and select New Kriging Estimator.
The New Kriging window will appear:

In the Interpolant tab:
l
l
l

l
l
l

l

Both Ordinary and Simple Kriging are supported.
For Simple Kriging, specify a Mean value for the local mean to use in the Kriging function.
Discretisation sets the number of discretisation points in the X, Y and Z directions for block Kriging.
Block Kriging provides a means of estimating the best value for a block instead of only at the centre
of the block. Each block is broken down (discretised) into a number of sub-units without actually
sub-blocking the blocks. A geologist will consider a variety of factors including spatial continuity
when deciding on the discretisation to use. Set the X, Y and Z parameters to 1 for point Kriging. To
use additional discretisations, copy the estimator and change the Discretisation parameters.
Search Ellipsoid identifies the Max, Int and Min ranges set in the Ellipsoid tab.
Select from the Variogram Model list of models defined in the Spatial Models folder.
The View button will show an ellipsoid widget in the scene to assist in visualising the variogram
model ranges and direction.
A chart depicts colour-coded semi-variograms for the variogram model.
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If you select a Kriging estimator to be evaluated onto points, it will always use Point Kriging (Block
Kriging with a discretisation of 1x1x1), overriding any discretisation settings specified for the Kriging
estimator.
In the Ellipsoid tab:
l
l

The Ellipsoid Definition sets the Ellipsoid Ranges and Direction.
Click the View Ellipsoid definition to show an ellipsoid widget in the scene to assist in visualising the
search ellipsoid. Note that this is not the same as the variogram model ellipsoid, unless the Set to
option is used to select the variogram model to copy the details.

In the Search tab the Minimum Samples and Maximum Samples parameters determine the number
of samples required or used within the search neighbourhood.

In the Value Clipping tab, you can enable value clipping by ticking the Clip input values box. This
caps values outside of the range set by the Lower bound and Upper bound to the bounding values.
Kriging Attributes
In the Outputs tab, you can specify attributes that will be calculated when the estimator is evaluated on
a block model. Value and Status attributes will always be calculated, but you can choose additional
attributes that are useful to you when validating the output and reporting. These attributes are organised
into two categories, Sample properties and Estimation results.
Sample properties are output attributes that relate to data sample statistics:
l
l

l

l

The number of samples (NS) is the number of samples in the search space neighbourhood.
The distance to the closest sample (MinD) is a cartesian (isotropic) distance rather than the ellipsoid
distance.
The average distance to sample (AvgD) is the average distance using cartesian (isotropic) distances
rather than ellipsoid distances.
The number of duplicates deleted (ND) indicates how many duplicate sample values were detected
and deleted by the estimator.

Estimation results are additional information produced by the estimation:
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l
l

l

l

l

l

l

l

Value will always be included as it is the actual estimate result.
Status will always be included as it classifies the estimation result as a Normal result, or non-normal
Blank, Without-value, Outside or Error result.
The Kriging mean (KM) is the local mean used for the estimate based around the selected sample
data. For simple Kriging, this is the specified global mean. For ordinary Kriging, it is the unknown
locally constant mean that is assumed when forming the Kriging equations. This value is only
dependent on the covariance function and the sample locations and values for the chosen
neighbourhood. It does not depend on the evaluation volume and therefore will be the same for block
Kriging and point Kriging. It can give some indication of suitability of the assumptions when doing
ordinary Kriging.
The Kriging variance (KV) is important in assessing the quality of an estimate. It grows when the
covariance between the samples and the point to estimate decreases. This means that when the
samples are further away from the evaluation point, the quality of the estimation decreases. For
simple Kriging, the value is capped by the value of the covariance between the target volume and
itself. For ordinary Kriging, higher values indicate a poor value.
The Kriging efficiency (KE) is calculated based on the block variance and Kriging variance (KV). It
should be 1 when the Kriging variance is at is minimum and 0 when the Kriging variance equals the
block variance.
The slope of regression (SoR) is the slope of a linear regression of the actual value, knowing the
estimated value. For simple Kriging it is 1 and for ordinary Kriging a value of 1 is desired as it indicates
that the resulting estimate is conditionally unbiased. Conditional bias is to be avoided as it increases
the chance that blocks will be misclassified when considering a cutoff value.
The sum of weights (Sum) is the sum of the Kriging weights. For ordinary Kriging, the sum is
constrained to being equal to 1.
The sum of negative weights (SumN) can be used to assess the quality of an estimation. Negative
weights are to be avoided or at least minimised. If there are negative weights, it is possible that the
estimated value may be outside the range of the sample values. If the sum of negative weights is
significantly large (when compared to the total sum), then it could result in a poorly estimated value,
depending on the sample values.

When selecting the block model evaluation to display in the 3D scene, you can select either the Kriging
values, or from these additional selected attributes.
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RBF Estimators
The RBF estimator brings the Radial Basis Function used elsewhere in Leapfrog into estimation. Like
Kriging, RBF does not use an overly-simplified method for estimating unknown points, but produces a
function that models the known data and can provide an estimate for any unknown point. Where
Kriging is limited to a local search neighbourhood, RBF utilises a global neighbourhood. An
RBF estimator is good for grade control where there is a large amount of data.
To create an RBF estimator, right-click on the Estimators folder and select New RBF Estimator. The
New RBF window will appear:

Like other estimators, a spatial model defined outside the estimator as a separate Variogram Model
can be selected. The View button will show an ellipsoid widget in the scene to assist in visualising the
variogram model ranges and direction.
Alternatively, in a feature unique to RBF estimators, a Structural trend can be used, if one is available in
the project. Set the Outside value at the long-range mean value of the data.
Otherwise, the RBF estimator behaves very similarly to the RBF interpolant in Leapfrog.
Drift is used to specify what the estimates should trend toward as distance increases away from data.
The RBF estimator has different Drift options from the non-estimation RBF interpolants. The RBF
estimator function offers the Drift options Specified and Automatic. When selecting Specified,
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provide a Mean Value for the trend away from data. Automatic is equivalent to the Constant option
offered by non-estimation RBF interpolants, and Linear is not supported. Specified drift with a Mean
Value of 0 is equivalent to None.
In the Value Clipping tab, you can enable value clipping by ticking the Clip input values box. This
caps values outside of the range set by the Lower bound and Upper bound to the bounding values.
In the Outputs tab, the Minimum and MaximumEvaluation Limits constrain the values. Values
outside the limits are set to either the minimum or maximum limit, as appropriate. To enable a limit, tick
the checkbox and set a limit value.
In the Outputs tab, you can also define isosurfaces for an RBF estimator:
l

l

l
l
l

The Default resolution will be used for all isosurfaces, unless you change the Surface Resolution
setting for an individual isosurface. See Surface Resolution in Leapfrog Works for more information
on the Adaptive setting. The resolution can be changed once the estimator has been created, so
setting a value in the New RBF window is not vital. A lower value will produce more detail, but
calculations will take longer.
The Volumes enclose option determines whether the volumes enclose Higher Values, Lower
Values or Intervals. Again, this option can be changed once the estimator has been created.
Click the Restore Defaults button to add a set of isosurfaces based on the estimator’s input data.
Use the Add to add a new isosurface, then set its Iso Value.
Click on a surface and then on the Remove button to delete any surface you do not wish to generate.
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Variable Orientations
The features described in this topic are only available if you have the Contaminants extension.
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The principal direction of contamination can change across a domain, such as when the domain features
an undulating, gently-folded structure. Using a single fixed orientation for the sample search and the
variogram can result in poor sample selection and weighting locally. Using a variable orientation makes it
possible to re-orient the search and variogram according to local characteristics, which results in
improved local value estimates. For example, here a variable orientation has been created using a mesh;
disks indicate the local search space orientation and are coloured with the dip direction.

Variable orientations can have multiple inputs, including veins, the contact surfaces in a stratigraphic
sequence and any mesh in the project.
A variable orientation can be applied to Kriging and inverse distance estimators. You can make as many
variable orientations as you wish for each domained estimation, which allows you to experiment with a
wide variety of scenarios.
Variable orientations cannot be used with RBF estimators. To achieve a similar capability for RBF
estimators, use a structural trend.
The rest of this topic describes how to create and work with variable orientations. It is divided into:
l
l
l
l
l

Visualisation Options for Variable Orientations
Creating Variable Orientations
The Variable Orientation in the Project Tree
Applying a Variable Orientation
Exporting Rotations

Visualisation Options for Variable Orientations
Variable orientations can be viewed as disks or lines. The grid used for visualisation can be any block
model or sub-blocked model in the project or a custom grid can be specified as part of setting up the
variable orientation.
Here a variable orientation is visualised on a custom grid, with disks coloured using the Dip direction
values at each point on the grid. Enabling text display ( ) shows the values in the scene. The disks are a
representation of the local orientation of the maximum-intermediate plane calculated at the chosen
centroids. They represent both the search ellipsoid and the variogram, by indicating their principal plane.
The line on each disk indicates the position and direction of the major axis.
Search ellipsoids are described using axes of maximum, intermediate and minimum continuity.
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Variogram ellipsoids are described using major, semi-major and minor axes. Because both the local
search ellipsoid and local variogram orientation are indicated by variable orientation disk and line
objects in the scene, we will avoid potential confusion by using the terms maximum, intermediate and
minimum in this topic, unless specifically discussing variograms.

Click on a disk to view further information about it.
There is also the Show as lines option ( ), which hides the disks to reduce visual clutter while still
showing the fundamental orientation information in the form of the maximum axis direction for each
search space local to each centroid:

You can also change the Anisotropy used to display the variable orientation. Options are Isotropic and
any variogram models and search spaces defined in the estimation:

When anisotropy is displayed, the ratio of the maximum-intermediate axis of the chosen object is
indicated as a ratio. The actual range is not shown.
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Creating Variable Orientations
Variable orientations are created on a per-contaminant estimation basis. You can copy variable
orientations and make adjustments to them, but you cannot copy them to another contaminant
estimation.
To create a variable orientation, right-click on the domained estimation’s Variable Orientation folder
and select New Variable Orientation. Inputs and the Global Plunge are set in the General tab, and
how the variable orientation will be displayed is set up in the Visualisation tab.

Selecting the Inputs
Inputs to a variable orientation can include veins, a stratigraphic sequence and any mesh in the project.
When a mesh is used, it should be an open mesh that draws out the shape of the undulations of the
structure, rather than a closed mesh such as the domain. The facing direction of the surface is relevant; it
is used to determine the direction of the surface normal vectors. Each vertex of the mesh is used to
generate the orientation, so the resolution of the mesh should be sufficient to capture subtle changes in
trend without adversely increasing processing time.
Using closed meshes such as the mesh of the domain used in the estimation is not advised. Doing so
may result in boundary effects and inconsistent vector orientations, and the vector may become
undefined in the middle of a mesh if components interpolate to zero.
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At each vertex of the input mesh, a normal unit vector is calculated from the average orientation of the
faces that meet at that vertex. This normal vector is then resolved into three orthogonal component
vectors, Δx, Δy and Δz. Take a close look at this slice of an undulating part of a hangingwall mesh shaded
according to the face dip:

In the above image, the component vectors have been added as explanatory annotations; these are
not part of the scene.
Three radial basis functions are then created, one for each of the three orthogonal component vectors.
These RBFs use a biharmonic splice basis function of degree zero and ‘reduce’ fit type. Accuracy is set at
1%. These parameters are fixed and cannot be customised or controlled.

© 2020 Seequent Limited

655 | User Manual

Now that RBFs have been created and we have a continuous function throughout the space of interest,
the component vectors for any point in space can be determined, not just at the vertices in the mesh.
From the component vectors, the normal vectors can be constructed at any point in space, again, not
just at the vertices in the mesh.

When a normal is reconstructed at any given point in the model, this defines the minimum axis, and,
implicitly, the orientation of the principal plane that the maximum and intermediate axes lie on
orthogonal to the minimum axis.

Note that although radial basis functions are used in this process to create functions that allow for the
determination of normals at any point in space, a variable orientation is not available for use with RBF
estimators; it is limited to Kriging and inverse distance estimators. To achieve a similar capability for
RBF estimators, use a structural trend.
An important consideration in achieving a reasonable result is inputs that have consistently oriented
normals on the mesh used at the start of this process.
l
l

When multiple meshes are used, you need to ensure that the meshes are consistently oriented.
Veins and stratigraphic sequences are made up of multiple surfaces, and the normals for these
surfaces are combined into a single cloud of normal vectors.
l

When a vein is used as an input, the hangingwall and footwall surfaces are used. To make normal
directions consistent, the hangingwall normals are flipped to point in the same direction as the
footwall normals. Common vertices in the footwall and hangingwall, where the vein pinches out,
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l

produce duplicate locations with slightly different normals. The two normals at these locations are
averaged to give a single normal vector for that location.
When a stratigraphic sequence is used, each point of each contact surface produces a normal
vector.

Closed surfaces have a consistent inside and outside direction. Normals on a closed surface will
therefore point either inwards or outwards, resulting in the normals on the opposite side of the mesh
pointing in the opposing direction. Interpolating these conflicting normals will lead to sudden
unpredictable changes in orientation.
Setting the Global Plunge
Next, the Global Plunge is used to determine the direction of the principal axis on the principal plane.
The Global Plunge is a vector defined by either the major axis of the global variogram or globally
defined search, or it is set from the view. This vector is used to determine where the direction of the
principal axis should lie within the direction of the locally re-oriented principal plane. This is achieved by
finding the direction on the local plane that is closest in orientation to the global vector. In practise this
amounts to projecting the shadow of the global plunge vector, in the direction of the local normal
vector, onto the re-oriented local plane.
You have two choices for the Global Plunge:
l

l

Use one of the variogram models defined for the contaminant estimation. Select one from the
dropdown list.
Set a Custom Direction. Click and drag in the scene to align the view to the direction of the
perceived maximum continuity, then click Set From Viewer. Capture the current scene to
bookmark the direction you have set, as the Custom Direction cannot be visualised in the scene.
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The projected Global Plunge is represented by the black pitch line on each of the variable orientation
disks. Visually validate the disk's pitch lines to confirm that the Global Plunge has been applied in the
manner you expect.
The Global Plunge is projected onto the principal plane to define the direction of the principal axis.
Imagine a flashlight shining down the normal vector towards the principal plane and shining through a
variogram model ellipsoid. The shadow cast by the major axis defines the principal direction.

The intermediate axis will lie on the principal plane at 90° to the principal direction axis. Together the
normal vector, the principal direction and the intermediate axis orthogonal to them define the
orientation for the minimum, maximum and intermediate axes for use at each point required for
estimation, reorienting the search and variogram for that specific location in space. These directions are
determined for each required location.
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When visualised as lines, only the principal direction is shown, pointing away from the reference point.
When visualised as disks, a circular disk is added to indicate the principal plane.

If the Custom Direction is left at the default settings of Azimuth = 0 and Plunge = 0, this will be
the vector that is projected onto the principal plane. The resulting reorientation of the search space
and variogram will likely be inappropriate, particularly for steeply oriented veins. Leapfrog Works
relies upon the expertise of an informed expert to specify a reasonable and valid direction instead of
defaulting to a best-guess that may appear meaningful at a cursory glance but may be just as invalid
as the more obvious zero values chosen as defaults.
Setting Visualisation Options
In the Visualisation tab, you can choose between visualising the variable orientation on an existing
block model or on a custom grid.
Using a block model or sub-blocked model for visualisation does not evaluate the variable orientation
on the selected model. All block models and sub-blocked models in the project can be selected.
Here a variable orientation created from a mesh is visualised on a Custom Grid:

See Visualisation Options for Variable Orientations for more information on displaying the variable
orientation.
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The Variable Orientation in the Project Tree
Enter a name for the variable orientation and click OK to create it. It will be added to the project tree in
the Variable Orientation folder. Expand it to see its parts:

The variable orientation includes links to the variogram model, if used, and to the inputs.
Drag the variable orientation into the scene to check it, and double-click on the variable orientation in
the tree to edit it.
You can make multiple copies of a variable orientation, but you cannot copy them to another
contaminant estimation.
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Applying a Variable Orientation
Leapfrog Works supports variable orientations in Kriging and inverse distance estimators. Double-click
on the estimator, then click on its Ellipsoid tab. Tick the box for Variable Orientation and select from
those available for the contaminant estimation:

When a variable orientation is applied to an estimator, the local search can be visualised using the block
model interrogation tool.
Here one block in a block model is shown with the search area indicated by the ellipsoid widget. The
orientation of the ellipsoid reflects the direction set by variable orientation for this block:

See Block Estimate Interrogation for more information on the interrogation tool.
Exporting Rotations
When a variable orientation is evaluated onto a block model or sub-blocked model, the Dip Direction
and Dip in the variable orientation are represented in the rotation using the ZXZ convention. Rot1Z is

© 2020 Seequent Limited

661 | User Manual

the value of the rotation about the z axis. This turns y into y' and x into x', which is equivalent to the Dip
Direction in the variable orientation:

Rot2X is the value of the rotation about the x' axis and is equivalent to Dip:

When a variable orientation is evaluated onto a block model, you can click on a block to view the rotation
information:
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If required, you can export the rotations for use in other packages. When exporting the block model, be
sure to select the variable orientation evaluation:

Block Models
The features described in this topic are only available if you have the Contaminants extension.
This topic describes importing block models in Isatis and CSV formats, creating block models in
Leapfrog Works, viewing block model statistics and exporting block models. It is divided into:
l
l
l
l
l

Importing a Block Model
Creating a Block Model
Displaying a Block Model
Viewing Block Model Statistics
Exporting Block Models

Importing a Block Model
Leapfrog Works imports block models in the following formats:
l
l

CSV + Text Header (*.csv, *.csv.txt)
CSV with Embedded Header (*.csv)

Note that neither CSV format requires a header; once you start the import process, Leapfrog Works
will use the data in the file to locate the minimum and maximum centroids. You can view this
information and change how the data is mapped before the file is saved into the project.
Block models imported in CSV format must be regular, rotated only about the Z axis. You will also need
to map the data in the file to the block model format Leapfrog Works expects.
To import a block model in CSV format, right-click on the Block Models folder and select Import
Block Model. Select the file you wish to import and click Open. An import window will be displayed in
which you can map the columns in the file to those Leapfrog Works expects. Once you have mapped the
required columns, click Next to define the grid.
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In the next window, Leapfrog Works uses the data in the file to check the grid definition and confirm
that the centroids match. The Values to enter list gives you different options for mapping the data in
the file, and you can preview the file data and use it to choose the best option.

The easiest way to define the blocks is to use the Block size, Minimum centroid, Maximum
centroid option. In defining the grid, you can select information in the file and drag it to the
corresponding values on the left-hand side:

You can also enter the grid definition values manually.
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Once the grid has been defined, Leapfrog Works will display a message indicating that the data in the file
matches the grid definition:

Click Finish. The block model will be imported and will appear in the Block Models folder.

Creating a Block Model
To create a new block model, right-click on the Block Models folder and select New Block Model.
The New Block Model window will appear, together with a set of controls that will help you set the
size, location and orientation of the model in the scene:

The block model is defined from its Base point, and the reference centroid is the Base point plus one
half the Block size. Block models cannot have partial blocks, and when changes are made to the Block
size parameter, the model’s extents will be enlarged to match the Block size.
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If you know the values you wish to use for the model’s Extents, enter them in New Block Model
window. You can also:
l

Use the controls in the scene to set the extents.
l
l
l

l

The orange handle sets the Base point.
The red handles adjusts the size of the boundary.
The blue handle adjusts the Azimuth.

Use another object’s extents. Select the object from the Enclose Object list.

It is a good idea to use larger values for the Block size as processing time for large models can be
considerable. Once you have created a block model, you can change its properties to provide more
detail.
You can also evaluate the block model against geological models, interpolants and distance functions in
the project. To do this, click on the Evaluations tab. All objects available in the project will be displayed.
Move the models you wish to use into the Selected list.
Enter a Name for the block model and click OK. The model will appear under the Block Models folder.
You can make changes to it by double-clicking on it.

Displaying a Block Model
When a block model is displayed in the scene, there is an Index Filter option for displaying the grid:

The Index Filter can be set to Subset or Sliced.
l
l

Subset shows the union of the selected X, Y and Z ranges.
Sliced shows the intersection of the selected X, Y and Z ranges.

The range sliders have two modes: coarse control and fine control. Here an index filter is used for a set of
values that ranges from 1 to 160; it is displayed in dark blue, to show the full range of values in coarse
control mode:

You can restrict the data displayed by dragging on the handles. Here the range of values is restricted to 1
to 50:

You can click and drag on the selected range to change the values displayed:
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To switch to fine control, double-click anywhere along the range slider. Here the range of 52-101 has
been expanded along the whole slider, giving you more control over the position of the range end
points:

The slider is displayed in light blue in fine control mode.
Now you can use the handles to further restrict the range displayed:

Right-click on the slider to return to coarse control and the full range of values. Here, right-clicking
reverts to coarse control, with the range restricted to the original range of 52-101:

Viewing Block Model Statistics
To view statistics on a block model, right-click on the model in the project tree and select Statistics.
The following options are available:

See the Analysing Data topic for more information on each option:
l
l

Table of Statistics
Scatter Plots
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l
l

Q-Q Plots
Box Plots

Right-clicking a block model evaluation or a numeric calculation and selecting Statistics opens a
univariate graph for the selection. See Univariate Graphs in the Analysing Data topic for more
information.
Table of Statistics
You can view statistics for all evaluations and calculations made on a block model broken down into
categories and organised by numeric evaluations and calculations. To view statistics, right-click on a
block model in the project tree, select Statistics then select the Table of Statistics option.
You can view statistics for as many numeric and category columns as you wish. When you have at least
one Category column selected, you can organise the information displayed in two ways: Group by
Category or Group by Numeric. Here, statistics are displayed organised by the category data
columns:

The Query filter option uses a related filter to constrain the data set to a selected subset.
Statistics can be unweighted, weighted by volume or weighted by tonnage. Select the option you
require from the Statistics weighting list.
You can also set the Density to be a Constant value that you specify, or you can use the one of the
columns in the table.
The Categories list provides category classification options. When selected, the set of statistics
measures for each evaluation or numeric calculation will be shown for each category.
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You can hide empty categories (those with a count of zero) and inactive rows using the options below
the Categories list:

Group by category and Group by numeric column provide options for the table organisation. You
can also change what columns are displayed in the table by clicking the Edit columns button ( ). This
opens a window in which you can select the columns that are displayed in the table:

Click rows to select them, and select multiple rows by holding down the Shift or Ctrl key while clicking
rows. You can then copy rows by clicking the Copy button ( ), which allows you to copy the selected
row(s) or all rows in the table.
The arrow buttons quickly expand ( ) or collapse ( ) rows.

Exporting Block Models
Block models created in Leapfrog Works can be exported in the following formats:
l
l
l

CSV + Text Header (*.csv, *.csv.txt)
CSV with Embedded Header (*.csv)
CSV as points (*.csv)
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To export a block model, right-click on the block model in the project tree and select Export. You will be
prompted to select the file format.
Enter a name and location for the file and click Save. Next, you will be able to choose custom settings
for the selected format.
The selections you make when you export a block model will be saved. This streamlines the process
of subsequent exports of the model.
When you choose to export a block model in CSV format, you must first choose the type of CSV export.
Options are:
l
l
l

With an embedded header file. The block model definition is included at the top of the CSV file.
With a separate text header. The block model definition is written as a separate text file.
As points. The CSV file does not include the block sizes and model description.

Click Next. The steps that follow are:
l
l
l
l
l

Selecting From Evaluated Items
Setting Row Filtering Options
Setting Numeric Precision
Setting Status Code Text Sequences
Selecting the Character Set

Selecting From Evaluated Items
Choose which objects will be included in the exported file. The Available items list includes all
evaluations made onto the model. The order of columns in the exported file will match the order shown
in the project tree.
Click Next.
Setting Row Filtering Options
You can use a Query filter to filter rows out of the data exported.
This is different from exporting filters as columns, as selected in the previous step.
The second option in this window is useful when all block results are consistently the same non-Normal
status. Select from Error, Without value, Blank or Outside; all rows that consistently show the
selected statuses will not be included in the exported file.
Click Next.
Setting Numeric Precision
There are three encoding options for Numeric Precision:
l
l
l

The Double, floating point option provides precision of 15 to 17 significant decimal places.
The Single, floating point option provides precision of 6 to 9 significant decimal places.
The Custom option lets you set a specific number of decimal places.
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To change either the Centroid and size precision and Column data precision options, untick the
box for Use default precision and select the required option.
Click Next.
Setting Status Code Text Sequences
When a block model is exported, non-Normal status codes can be represented in the exported file using
custom text sequences.
The Status Code sequences are used for category status codes and filter status codes exported as
columns. For filter status codes, Boolean value results will show FALSE and TRUE for Normal values or
the defined Status Codes for non-Normal values.
Numeric Status Codes can be represented using custom text sequences. This is optional; if no
separate codes are defined for numeric items, the defined Status Codes will be used.
Click Next.
Selecting the Character Set
The selection you make will depend on the target for your exported file. You can choose a character set
and see what changes will be made.
Click Next to view a summary of the selected options, then click Export to save the file.

Visualising Estimators
The features described in this topic are only available if you have the Contaminants extension.
Estimators can be visualised by evaluating them on block models. To evaluate an estimator on a block
model, right-click on the block model in the project tree and select Evaluations. See Block Models on
how to work with the different types of block models available in Leapfrog Works.
Calculations and filters further enhance the visualisation options, adding computational analysis and
processing of data capabilities to create new types of data to visualise. To create calculations and filters,
right-click on a block model in the project tree and select Calculations and Filters. See Defining
Calculations and Filters for information on creating filters and building calculations.
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When you select Evaluations, the block model’s main window will be opened with the Evaluations tab
displayed:

You can add all of, for example, a contaminant estimations estimators to the Selected evaluations list
by double-clicking on the contaminant estimation itself.
Click OK to process the evaluations, which will be added to the block model in the project tree:

Display an evaluation by dragging it into the scene or by right-clicking on it in the project tree and
selecting View Object.
Each evaluation will appear in the list of block model evaluations:
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Any Attributes generated along with the estimator can also be displayed evaluated on the blocks:

Validation and Reporting
Leapfrog Works provides tools to validate the contaminant estimation models and report the results.
Block estimation interrogation is used to inspect the contaminant estimate results. Swath plots and
reports add additional insights and provide the basis for visual assets for inclusion in reporting
documents.
The rest of this topic describes these tools. See:
l
l
l

Block Estimate Interrogation
Swath Plots
Reports

Block Estimate Interrogation
It is good practise to check the estimates produced for blocks, inspecting the data used to create the
estimate. The block estimate interrogator exposes the data used to produce an estimate. Right-click on a
block model in the project tree and select Interrogate Estimator.

The Block Model Interrogation window will open as a dockable tab, showing the input data used in
producing the estimates and other results. Additionally, in the scene view, the block details window will
display inside the scene, containing properties for the currently selected block. These are primarily result
properties.
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Use the filter selector ( ) to see all the Found data points in the block estimate interrogator table, or
only the data points Included in the estimate, or only the data points that are Clamped. The Clamped
option will only be present if Outlier Restrictions are being used by the estimator.
You can change the Estimator to select between the inverse distance and Kriging estimators evaluated
on the block model. Other estimators are not supported by the block model interrogation feature.
Click the Open Estimator button to inspect the estimator used in the estimate. This will open in a new
window.
View Ellipsoid will display the search ellipsoid in the scene. The axial planes of the ellipsoid are shaded,
which helps to visualise the 3-dimensional shape of the ellipsoid as well as it’s orientation.
Click a block in the scene or set the Block Index Definition X, Y and Z coordinates to select a specific
block.
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Enable Filter block model to see only the selected block in the scene, which will reduce the visual noise
of all the other blocks. This will help you see the associated data points and the search ellipsoid in relation
to the selected block:

In the block estimate table, you will see all the input data columns for each data point. Data points can
been hidden or made visible in the scene using the visibility button ( ).

Block information is shown in the bottom left corner of the Block Model Interrogation window, so it
is not necessary to refer back to the scene and select the block information for the appropriate block.
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In the Weights column, negative values are highlighted in red to make them easier to see.

The block estimate interrogator table data can be exported for use in other programs such as Microsoft
Excel. Click the Export button to save a CSV file, which will include the table data and the search
statistics (found, clamped, included, equidistant, duplicates, etc) and the block information (index,
centroid, Kriging attributes, etc). Click the Copy button to put a copy of the table data on the operating
system clipboard, and you can then paste it into another program.
Swath Plots
Swath plots are an important validation tool for providing comparisons between sample points
(composited or uncomposited) and estimated values to identify any bias towards under-estimation or
over-estimation or any smoothing in the results. The effect of different estimation methods and
parameters can also be compared.
The swath plot is a one-dimensional graph in a specific direction of interest. A swath is a sectional slice
through the block model with a specified thickness. The swath plot shows the average values for the
blocks in the swath, along with the averaged sample values in the swath.
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To create a swath plot, right-click on a block model and select New Swath Plot:

A new Swath window will open:
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Click the add button ( ) to add data sets to the plot. You can select individual items from the list of
Available Numeric Items or you can select a parent object to select all the child items within it. Click
the right arrow button to move the selected items into the Selected Numeric Items list:

The graph plots the averaged sampled values against the averaged block values for a series of swaths
slicing through the block model in a selected direction. The Swath size can be altered for finer or more
coarse slices. The Scene view overlays a bounding cuboid that shows the Swath size and direction:
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Changing the swath direction to Swath in Y is reflected in the scene:

The Index filter can be used to graph a reduced set of the swaths. Either the minimum or maximum
threshold for the Index filter can be dragged to change the width of the filter, and the selected portion
can be changed by sliding the inner bar. The swath indicator widget in the Scene is updated to show
what the Swath plot is depicting:
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Selected data sets in the chart can be hidden or revealed by clicking the line segment visibility button ( )
next to the data set. The histogram visibility button ( ) will reveal or hide a histogram showing the
volume of blocks used in the swath calculation. The block volume may not be identical for all estimators.

The colour for the line segment plots and histograms can be changed for each data set by clicking the
colour chip, and selecting a new colour from the colour picker:

Selecting an evaluation will show an Associated Values panel. This provides options to set the visibility
and colour preference for the evaluation's raw data values and declustered values for the evaluation's
input data.
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Changes you make to swath plots are preserved. Multiple swath plots can be created to show different
points for analysis and reference.
You can export the graph for use in external reports and other documents. There are three options:
l
l

The Export button saves a PDF, SVG or PNG file of the graph.
The Copy button opens a menu to offer the options of copying a image of the graph to the Windows
clipboard, or copying the graph data as CSV data to the Windows clipboard, where they can be
pasted into another application. It also allows you to select the resolution of a copied image: a low
resolution Screen Image, a Medium Quality, 300 dpi image, or a High Quality, 600 dpi image.
Choose your preferred resolution before selecting Copy Graph Image.

Reports
The contaminant report is a pivot table for reporting on contaminants, with the freedom to customise
the table to the unique needs of the project requirements. A contaminant report can display multiple
categories and multiple numeric columns.
To create or view a contaminant report, right-click on a block model in the project tree and select
Report. In the window that appears, click the Select Columns button to choose from the Category
columns and Value columns evaluated onto the block model. If you wish to set a Cut-off value, select
from any numeric column evaluated on the block model and set the cut-off value. The column selected
for the Cut-off does not need to be a column included in the resource report. You can also apply a Filter
to the report.
Select between Block size in metres and Block size in feet to ensure units are correctly converted.
Select Constant value from the list of Density options and specify a numeric constant, or select a
density data measurement from the numeric columns listed. Specify the appropriate Density unit to
match the Density selection.
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You can also choose to Show material content columns, Show empty rows, Show volume
column and Show density column.

If you have an estimator that produces outside, blank, without_value or error statuses for blocks,
these will result in #Invalid entries in the resource report table. To address this:
l

l

Create a filter (or modify your existing filter) to discard blocks with an invalid status, and select
this filter in the Filter field above the resource report table, or
Create a calculation that sets invalid values to an appropriate acceptable value, and select this
column instead.

Click on a column to customise how the information is displayed. You can change the column title by
editing the Heading field.
Enabling Show total will add a category row called Total with a summation for the categories. Any row
that is a summation of categories will appear in bold in the table. It is possible to get a sub-total of some
of the categories by grouping them, and these will also be shown in bold. To group categories, select
multiple items in the Visible categories list by holding down the Ctrl key as you click the mouse. Click
the Group button to add the new category.
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Note that some of the Visible categories can be unticked to hide them; these hidden categories can
still be included in a grouped category:

Select a category and click the up or down buttons to reorder them in the list. Delete a grouped category
by selecting it and clicking the Delete button ( ).

If there are multiple category columns, these can be reordered to select one as the primary
categorisation, with the others shown as sub-categories. Click anywhere in a category column and drag
it to a new location. While you hold down the mouse button, a vertical bar will appear where the column
will be inserted:
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When Average Value columns are selected, it is possible to change:
l
l
l

l

The Heading
The Data unit
The Display unit to use in the table, which may be the Same as data or some other unit to convert
to
The number of Decimal places to display in the table

Data unit has the options Unknown, Grams per tonne, Parts per million, Parts per billion,
Percent, Troy ounces per short ton, Dollars per tonne, Dollars per short ton, Milligrams per
kilogram, Micrograms per kilogram, Milligrams per gram and Micrograms per gram. The Data
unit may be automatically set based on indicators in the selected column name, but must be checked for
correctness. Make sure that the column data matches the Data unit selected. Note that "dollars" is used
as a general term to refer to whichever currency you are using.
When Dollars per tonne or Dollars per short ton are selected as the Data unit, the Display unit
option is not selectable, and must be Same as data.
Material Content columns can have the Heading changed, as well as the column’s Unit and Decimal
places.

The Report tab has Export and Copy options for making use of the resource report in external
documents.
l

l

Select Export to save the table as a Microsoft Excel spreadsheet, a CSV file, or an HTML file.
Formatting is preserved in the spreadsheet and HTML file so the table will be arranged identically to
the report in Leapfrog Works. CSV files do not contain formatted data. If you select CSV, you will
also be asked if you would like to use the Rounded numbers used in the table, or Full precision
numbers. You can also select between ASCII characters only and Allow all characters, with
UTF-8 encoding, as required by the software you are exporting to.
If you select Copy, then Copy Table, the table is copied to the operating system clipboard, and you
can paste it into another application such as Microsoft Excel or Microsoft Word. Formatting is
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preserved so the table will be arranged identically to the report in Leapfrog Works and only the
column and row sizes need to be adjusted to your preferences.
Reports you create appear in the Graphs and Tables section under the relevant block model. To delete
a report, right-click the report and select Delete from the context menu.
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Flow Models
Geological models created in Leapfrog Works can be used as the basis for MODFLOW and FEFLOW
models. You can create flow models directly in Leapfrog Works and assign hydrological/material
properties based on the lithologies in the geological model. Flow models can be exported for use in other
applications, and you can import existing flow models and use them as the basis for the construction of
new models. Flow models can be displayed in the scene, and time-dependent data can also be visualised.
Working with MODFLOW and FEFLOW models is available with the Hydrogeology extension.
Contact Customer Support as described in Getting Support for more information about the
Hydrogeology extension.
If the Flow Models folder appears in the project tree as Restricted, you will be able to display
models in the scene and change how they are displayed, but you will not be able to make changes to
the models themselves.
All tools for building flow models are accessed by right-clicking on the Flow Models folder and the
objects in it. Imported objects and objects created while building a flow model are also stored in the
Flow Models folder, and more complex functions can be carried out by right-clicking on individual
objects.

MODFLOW Models
These features are only available as part of the Hydrogeology extension. See Flow Models for more
information.
Once you have created a geological model, you can use it as the basis for a MODFLOW model. You can
also import existing MODFLOW models and assign lithologies from a geological model.
Steps for creating a MODFLOW model that can be exported and run outside Leapfrog Works are:
1. Create a geological model.
2. Create the MODFLOW model using the geological model to set the grid spacing and layers.
3. Evaluate the new model against a geological model, if it wasn’t when it was created.
4. Edit the hydrological properties.
5. Export the MODFLOW model to MODFLOW or Groundwater Vistas.
Once the model has been processed outside of Leapfrog Works, the model can be imported into
Leapfrog Works and visualised in the scene.
Creating MODFLOW models in Leapfrog Works has the advantage that the resolution can be easily
changed and the properties of the grid can be made to honour boundaries defined in geological models.
See Creating a MODFLOW Model.
See MODFLOW Model Display for information on options for displaying models in the scene.
Models created in Leapfrog Works can be evaluated against a geological model when they are created.
Models imported into Leapfrog Works or that were not evaluated when they were created can be
evaluated as described in MODFLOW Evaluations.
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Once a model has been defined and evaluated against a geological model, hydrological properties can be
assigned and the grid can be exported. See MODFLOW Hydrological Properties and MODFLOW Model
Export.

Creating a MODFLOW Model
This feature is only available with the Hydrogeology extension. See Flow Models for more
information.
To create a new MODFLOW model, you must first have at least one geological model defined in the
project. Once this has been defined, add the geological model to the scene. Right-click on the Flow
Models folder and select MODFLOW > New Structured Model. The New MODFLOW Model
window will be displayed, together with controls in the scene that will help you to set the grid extents:

The new MODFLOW grid will be based on the geological model in the Gridding from setting. If you
wish to use a geological model other than the one selected when the window is opened, select it from
the list. The grid dimensions will be updated in the scene.
If the Evaluate Gridded Model box is ticked, the selected geological model will be evaluated on the
new grid and set as the evaluation for export. If you do not wish to evaluate the geological model on the
grid, untick the box. You will still be able to use the layers in the geological model to control the grid
layers.
The Preserve Existing Grid Lines option is used when setting a non-uniform grid in the scene
window. If you are going to define a non-uniform grid in this way, create the model with the Default
Cell Size set to the smallest cell size you wish to use, then edit it as described in Editing a MODFLOW
Model.
The grid should be slightly smaller than the selected geological model. Any MODFLOW cells that
exist outside the geological model will be marked as inactive when the grid is exported to MODFLOW
.

© 2020 Seequent Limited

687 | User Manual

Horizontal Grid Spacing
By default, the horizontal grid for the model is uniform, with the size of each cell set by the Default Cell
Size value. You can change the horizontal grid by editing row and column spacings. When you click on
Row Spacings or Column Spacings, the Edit Spacings window will be displayed:

Changes made in the Edit Spacings window will be reflected in the scene.
There are four ways to change the spacings:
l
l

l

l

Click on a value to edit it.
Divide a row or column. Click on a row or column, then on the Divide Row or Divide Column
button. Two new rows or columns will appear in the list.
Merge rows or columns. Hold down the Shift key while clicking on each item, then click on the
Merge Rows or Merge Columns button. The selected items will be combined.
Set uniform spacing on selected rows or columns. You will be prompted to enter the number of cells
you wish to create from the selected rows or columns.
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Click OK.
For example, here, the rows and columns away from the model boundary have been divided to provide
more detail. The different spacings are reflected in the scene:

Use close spacing for steep gradients and increase or decrease spacing gradually.
Vertical Grid Layering
The vertical grid layers are based on the geological model selected in the New MODFLOW Model
window. Click on the Layers tab to view the layers:
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Initially, there are two layers equally spaced between the topography and the geological model. Change
the layers by clicking on Select Layer Guides button. The Layer Guides window will appear, showing
the layers available in the selected geological model:

If the grid is required to follow a geological model lithology contact surface, move the layer into the
Selected list and it will be honoured in the gridding process.
Click OK to return to the New MODFLOW Model window, in which the selected layers will be
displayed:

Click OK to create the new MODFLOW grid, which will appear in the Flow Models folder. You can edit
the model by expanding it in the project tree and double-clicking on the grid object ( ). See Editing a
MODFLOW Model.
For further information on working with the new model, see:
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l
l
l
l
l
l

MODFLOW Model Display
MODFLOW Evaluations
MODFLOW Hydrological Properties
Head Values and MT3D Concentrations
Generating a Head Value Mesh
MODFLOW Model Export

Editing a MODFLOW Model
This feature is only available with the Hydrogeology extension. See Flow Models for more
information.
Once you have created a MODFLOW model, you can edit it by expanding the model in the project tree
and double-clicking on the grid object ( ). The Edit MODFLOW Grid window will appear. You can
edit the grid spacings as described in Creating a MODFLOW Model, using the information in the scene
window as a guide.
Another way to edit the grid is to use the controls in the scene to apply different cell size settings in
different parts of the grid. For example, you may want to define a grid that has smaller cells in the centre
than at the outer edges:

To set cell sizes in this way, it is best to start with a MODFLOW model where the Default Cell Size is
set to the smallest cell size you will use in the model.
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For this example, we will start with a new grid with a Default Cell Size of 50. We will set the adjacent
cell size to 100 and the cell size at the outer boundary to 200.
First, we need to reduce the area that uses the cell size of 50 by using the red handles in the scene:

The blue box in the scene is the geological model extents for the model used to define the MODFLOW
model and represents the unedited boundary of the MODFLOW model.
Next, enter the cell size to use for the area adjacent to the 50.0 cells in the New Cell Size field. Then,
drag the red handles to enlarge the grid. The centre part of the grid is still set to 50, while the new area is
set to 100:

If the Preserve Existing Grid Lines option is enabled, grid lines for cells already defined will not be
moved to account for new cells.
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Enter the next cell size in the New Cell Size field and then use the handles to enlarge the grid again:

Click OK to update the grid.
For further information on working with the new model, see:
l
l
l
l
l
l

MODFLOW Model Display
MODFLOW Evaluations
MODFLOW Hydrological Properties
Head Values and MT3D Concentrations
Generating a Head Value Mesh
MODFLOW Model Export

Importing a MODFLOW Model
This feature is only available with the Hydrogeology extension. See Flow Models for more
information.
Leapfrog Works imports .nam files and .mfi and .mfn variations of .nam files.
To import a MODFLOW model, right-click on the Flow Models folder and select MODFLOW >
Import Model. Leapfrog Works will ask you to specify the file location, and then will display the data in
the file in the Import MODFLOW Model window:

If the world origin is available, the Grid Position will be displayed but cannot be edited.
Click OK to import the grid. The new MODFLOW model will appear in the project tree in the Flow
Models folder. See MODFLOW Model Display for information on displaying the model.
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If the world origin was not available when the model was imported, you can change the Grid Position.
To do this, expand the imported model in the project tree and double-click on its grid object ( ).
To associate lithologies with the grid, see MODFLOW Evaluations.

MODFLOW Evaluations
This feature is only available with the Hydrogeology extension. See Flow Models for more
information.
When a MODFLOW model is exported, the evaluated geological model is used to assign lithologies to
the cells in the grid. If the grid has not been evaluated against a geological model, you must do so before
you can edit the hydrological properties and before you can export the grid.
To evaluate a MODFLOW model, expand the model in the project tree, then right-click on the grid
object ( ) and select Evaluations. Although you can evaluate an interpolant or distance function, they
cannot be exported with the grid and are simply used for displaying the grid in Leapfrog Works.
A window will appear listing all objects in the project that can be used for an evaluation. Once you have
selected one or more objects, click OK. You will then be able to select the evaluations from the view list,
as described in Evaluations.
Assigning an Evaluation for Export
For MODFLOW models created in Leapfrog Works, the evaluation used when creating the model will
automatically be assigned as the evaluation for export. A hydrological properties table ( ) will appear in
the project tree as part of the model.
If the model was imported into Leapfrog Works or created without being evaluated against a geological
model, you will need to manually set the evaluation for export. To do this:
l
l

Evaluate the grid against one or more geological models, as described above.
Right-click on the model ( or ) in the project tree and select Set Evaluation for Export. The
Select Evaluation window will appear showing all geological models evaluated on the grid. Select
the required evaluation and click OK.

A hydrological properties table will be added to the model in the project tree. Edit hydrological
properties by double-clicking on the table. See MODFLOW Hydrological Properties.
Combined Evaluations
You can combine geological models and set the priority used for evaluation. This is useful when you have
geological models available that describe different parts of the area of interest or if you have a refined
geological model for part of the model. To combine geological models for evaluation, select the required
models in the Select Models To Evaluate window, then click on the Combined Evaluation button.
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In this example, there are three geological models selected:

The GM and GM from contacts models describe similar areas, but GM has more detail. The GM larger
model describes a larger area but with less detail. Tick the models to combine them and set their priority.
Click OK to create the combined evaluation, then click OK in the Select Models To Evaluate window.
The combined evaluation will be available from the view list and can be selected as the evaluation for
export.
To delete a combined evaluation, click on the Delete Combined button in the Select Models To
Evaluate window.

MODFLOW Hydrological Properties
This feature is only available with the Hydrogeology extension. See Flow Models for more
information.
When a MODFLOW model is evaluated against a geological model, a hydrological properties table ( ) is
added to the model in the project tree. You can edit hydrological properties by double-clicking on the
table. You can also open the table by right-clicking on the model in the project tree and selecting Edit
Hydrological Properties.
If the model has been imported into Leapfrog Works and has not yet been evaluated against a geological
model, you will be prompted to do so. Expand the model in the project tree, right-click on the grid object
and select Evaluations. See MODFLOW Evaluations for more information.
Hydrological properties are assigned to model blocks based on the position of the block’s centroid
relative to the geological model used to evaluate the grid. The position of the centroid is calculated and
Leapfrog Works then determines which lithology the centroid falls inside. The K values for the assigned
lithology are assigned to the entire block; there is no averaging.
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If more than one object has been evaluated on the grid, you can set hydrological properties separately
for each evaluation. Select the required evaluation from the Evaluation list:

However, the only hydrological properties information that will be exported is that set for the evaluation
to be exported.

Setting Hydrological Properties
In the Edit MODFLOW Parameters window, you can enter the values for hydrological properties
manually or you can use the values from an interpolant.
To enter values manually, click on a cell, then enter the value in the Value field:

Press the Enter key to move down the columns.
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To use the values from an interpolant, click the Interpolant button, then select an interpolant from the
list. The interpolant that will be used for the selected value will be displayed in the field:

To use the interpolant for all the values in the selected column, click the All Lithologies button. The
window will be updated to show that the interpolant values will be used for that column:

Zone Numbers
When the model is exported, the zone numbers are used to indicate the assignment of lithologies to
blocks and are written to the MODFLOW zoned layer properties flow (*.lpf) file. In the Edit
MODFLOW Parameters window, you can change the zone number for a lithology by clicking in a cell
and entering a different zone number. If you reorder the zones in this way, zone number conflicts will be
highlighted in red:

Zone numbers must be unique and you will not be able to close the window and save data if there are
conflicts.
If you click on the Sort Zone Numbers button, the zone numbers will be ordered from top to bottom.
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Zone numbers should not be sorted once a model has been exported as the new numbers will not be
reflected in the exported model.
Click OK to update the grid.

MODFLOW Model Display
If you do not have the Hydrogeology extension, MODFLOW models will appear in the project tree as
Restricted. You can change how MODFLOW models are displayed, but you will not be able to make
changes to the models themselves.
In the project tree, MODFLOW models are made up of a grid object ( ), a Simulation Outputs folder
and a hydrological properties table ( ) object. If there is no hydrological properties table, an evaluation
has not yet been set for export. See MODFLOW Evaluations for more information.
For MODFLOW models created in and imported into Leapfrog Works, dragging the model itself into the
scene will display the grid ( ) object. The different parts of the model can also be displayed.
Grid Display Options
Dragging a MODFLOW model into the scene displays its grid object. Here, an imported model has been
evaluated against a geological model and added to the scene:

The viewing options available are the flat colour option, the evaluated geological model and zone data
imported with the model. Other inputs imported with a model will also be available from this list, and
once the model has been evaluated against a geological model or interpolant, you can also display the
model using the grid’s hydrological properties.
Grids are displayed as cells. When a geological model evaluation or lithological zone information is
displayed, you can also display a legend for the grid.
When Show edges ( ) is enabled, the edges of the cells will be displayed.
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The Show inactive blocks ( ) option displays inactive cells in grey:

To display a single layer, tick the One layer box in the shape properties panel, then select the layer to
display.
Head values and MT3D concentrations can also be imported and displayed. See Head Values and MT3D
Concentrations.
Viewing Block Information
When a MODFLOW model is displayed in the scene, you can view information about the individual cells
in the model by clicking on a block. The window that appears shows information about the selected
block, including its centroid and the lithology assigned to the block from the evaluated geological model.
Information from all geological models and interpolants the grid has been evaluated against will be
displayed:

Head Values and MT3D Concentrations
This feature is only available with the Hydrogeology extension. See Flow Models for more
information.
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Leapfrog Works imports the following output file formats:
l
l

Head values files in *.hds, *.hhd and *.hed formats
MT3D concentrations files in *.ucn format

To import head values or MT3D concentration files for a MODFLOW model, right-click on the
Simulation Outputs folder and select the required option. Navigate to select the file, then click Open.
The information will be added to the MODFLOW grid, and you can then select the head values and
MT3D concentrations in the shape list when you display the grid in the scene. If the output is timedependent, a timestep slider will be available from the shape properties panel. Click and drag the slider or
click along the timeline to view the different timesteps available:

Imported head values and MT3D concentrations are stored in the project tree in the Simulation
Outputs folder:

To delete head values or MT3D concentrations, right-click on the object in the project tree and select
Delete.
Once head values have been imported, you can generate a head value mesh. See Generating a Head
Value Mesh.

Generating a Head Value Mesh
This feature is only available with the Hydrogeology extension. See Flow Models for more
information.
Once head values have been imported for a MODFLOW model, you can generate a head value mesh. To
do this, expand the Simulation Outputs folder. Right-click on the head values object and select
Generate Head Value Mesh. The Generate Head Value Mesh window will appear, showing the
layers in the model and the timesteps available. Select the layer of the model you wish to generate a head
value mesh for, then choose the heads. Click OK to create the mesh, which will be saved to the Meshes
folder.

MODFLOW Model Export
This feature is only available with the Hydrogeology extension. See Flow Models for more
information.
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Leapfrog Works has three options for exporting MODFLOW grids:
l
l

l

Export the grid as a MODFLOW file.
Export for Groundwater Vistas. Use this option the first time you export a grid for use in Groundwater
Vistas.
Export a Groundwater Vistas update. Use this option to generate a set of files that can be imported
into Groundwater Vistas as an update.

The Groundwater Vistas options include a zoned layer properties flow (*.lpf) file that includes
information about the zones in the grid.
As a MODFLOW File
To export a grid as a MODFLOW file for use in a package other than Groundwater Vistas, right-click on
the grid in the project tree and select Export to MODFLOW . You will be prompted to choose a File
name and location. Select the options required, then click Save.
For Groundwater Vistas
To export a grid for use in Groundwater Vistas for the first time, right-click on the grid in the project tree
and select Export to MODFLOW for GWV. You will be prompted to choose a File name and location.
Select the options required, then click Save.
If you have previously exported the grid to Groundwater Vistas and have made changes to the grid, use
the Export to GWV Updates option.
As a Groundwater Vistas Update
If you have exported a grid to Groundwater Vistas but then make changes to the Leapfrog Works model,
you can export the changes to the model. The set of files containing the changes can then be imported
to Groundwater Vistas.
To export a Groundwater Vistas update, right-click on the grid in the project tree and select Export
GWV Updates. The Update Groundwater Vistas window will appear listing the files that will be
exported. Enter a Base file name to differentiate the original files from the updates. Click Export. The
files will be saved in the specified directory.

FEFLOW Models
These features are only available as part of the Hydrogeology extension. See Flow Models for more
information.
In Leapfrog Works, creating a 3D FEFLOW model requires:
l
l

A geological model that will be used to assign lithologies to the FEFLOW model’s blocks.
A 2D grid that defines the block size, boundaries and surface features.

Steps for creating a 3D FEFLOW model that can be exported and run outside Leapfrog Works are:
1. Create a geological model.
2. Create and refine a 2D model in Leapfrog Works or import a FEFLOW model.
3. Create the 3D model from the 2D model or another 3D model in the project.
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4. Evaluate the new 3D model against a geological model.
5. Edit the material types.
6. Export the 3D FEFLOW model.
Once the model has been processed outside of Leapfrog Works, a results file can be saved that can be
imported into Leapfrog Works and visualised in the scene.
A 2D grid can be created in or imported into Leapfrog Works. A 3D grid can also be used, in which case
the layer information is not used in creating the 3D grid. Creating the 2D grid in Leapfrog Works
provides the most flexibility, as the block sizes can easily be changed, the boundaries modified and
features added to provide finer resolution where there is more data available.
For information about creating 2D and 3D grids, see Creating a 2D FEFLOW Model and Creating a 3D
FEFLOW Model.
You can also import FEFLOW problem files and result files, visualise them in Leapfrog Works and use
them as the basis for new models. See Importing a FEFLOW Grid.
See FEFLOW Model Display for information on options for displaying FEFLOW models in the scene.
3D grids created in Leapfrog Works can be evaluated against a geological model when they are created.
Grids imported into Leapfrog Works or that were not evaluated when they were created can be
evaluated as described in FEFLOW Evaluations.
Once a model has been defined and evaluated against a geological model, material types can be assigned
and the grid can be exported. See FEFLOW Material Types and FEFLOW Model Export.

FEFLOW Model Display
If you do not have the Hydrogeology extension, FEFLOW models will appear in the project tree as
Restricted. You can change how FEFLOW models are displayed, but you will not be able to make
changes to the models themselves.
In the project tree, 3D FEFLOW models are made up of a grid object representing the finite elements, a
nodes object and a material types table ( ) object. If there is no material types table, an evaluation has
not yet been set for export. See FEFLOW Evaluations for more information.
A 2D FEFLOW grid is made up of a grid object and a nodes object. Here, three types of FEFLOW models
are shown expanded in the project tree:
l
l
l

Feflow 3D Simulation is a 3D model created in Leapfrog Works.
Feflow 2D Simulation is a 2D model created in Leapfrog Works.
Feflow Results is an imported 3D model (DAC file).
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From the information in the project tree, we can see that:
l
l

l

The 3D simulation created in Leapfrog Works ( ) uses the GM geological model to define the layers.
The 2D simulation created in Leapfrog Works ( ) uses the GM geological model as a boundary and
has had collar points added as a feature.
The imported results model ( ) includes a number of simulation outputs.

For each type of FEFLOW model, dragging the model itself into the scene will display the grid ( )
object. The different parts of the model can also be displayed.
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Displaying a 3D Model
Dragging a 3D simulation into the scene displays its grid object, which represents the finite elements.
Here, a 3D model created in Leapfrog Works ( ) has been added to the scene:

For 3D models imported into Leapfrog Works, you can display the model using other information
available for the grid, such as conductivity data. This is available from the view list.
Grids for 3D models are displayed as blocks. You can also display a legend for the grid when a geological
model evaluation is displayed.
When Show edges ( ) is enabled, the edges of the blocks will be displayed.
To display a single layer, tick the One layer box in the shape properties panel, then select the layer to
display.
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You can display the nodes by adding the nodes ( ) object to the scene. When a model with results is
displayed, the simulation outputs can be displayed when the nodes are viewed in the scene. Here, the
nodes for an imported results file have been added to the scene. The heads are displayed for a single
layer:

When the results are time-dependent, a timestep slider will be available from the shape properties panel.
Click and drag the slider or click along the timeline to view the different timesteps available.
Displaying a 2D Model
As with 3D models, dragging a 2D model into the scene displays its grid object. Here, a 2D model
created in Leapfrog Works (( ) has been added to the scene and viewed from above:

Also in the scene is a collar points object that shows collar points that have been added to the grid as a
feature.
2D grids can be viewed as points or as blocks. As with imported 3D grids, an imported 2D grid can also
be displayed using other information available for the grid.
Other viewing options are available for 2D grids created in Leapfrog Works. These are useful in refining a
2D grid and are described in Creating a 2D FEFLOW Model.
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Viewing Block Information
When a FEFLOW model is displayed in the scene, you can view information about the individual blocks in
the model by clicking on a block. The window that appears shows information about the selected block,
including its centroid and the lithology assigned to the block from all evaluated geological models and
interpolants:

Information from all geological models and interpolants the grid has been evaluated against will be
displayed:

Importing a FEFLOW Grid
This feature is only available with the Hydrogeology extension. See Flow Models for more
information.
You can import 2D and 3D FEFLOW grids and use them as the basis for new models. Leapfrog Works
imports two types of FEFLOW files:
l

l

FEFLOW problem files (*.fem) in ASCII format. Importing these files results in a new 2D or 3D model
with a grid and nodes.
FEFLOW results files (*.dac). Importing these files results in a new 3D model with a grid, nodes and
simulation outputs.

To import a FEFLOW grid or results file, right-click on the Flow Models folder and select one of the
FEFLOW > Import options. Leapfrog Works will ask you to specify the file location. Click Open to
import the file.
The new FEFLOW grid will appear in the project tree under the Flow Models folder. To use the
imported grid or results file as the basis for a new FEFLOW model, see Creating a 3D FEFLOW Model.
To associate lithologies with a 3D grid, see FEFLOW Material Types.
See FEFLOW Model Display for information about displaying the FEFLOW grid in the scene window.

Creating a 2D FEFLOW Model
This feature is only available with the Hydrogeology extension. See Flow Models for more
information.
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A 2D FEFLOW model defines the block size, boundaries and surface features for a 3D FEFLOW model.
Although existing 2D grids can be imported into Leapfrog Works and used for creating 3D models,
creating the 2D grid in Leapfrog Works provides the most flexibility, as the block sizes can easily be
changed, the boundaries modified and features added to provide finer resolution where there is more
data available.
It is not necessary to create a geological model before creating a 2D grid. However, you will not be able
to create a 3D grid until a geological model has been created. Therefore, it is a good idea to create the
geological model first, and its dimensions can be used in defining the boundary of the 2D grid.
To create a 2D grid, right-click on the Flow Models folder and select FEFLOW > New 2D Model. The
New 2D FEFLOW Grid window will appear:

All settings can be changed once the grid has been created. It is, therefore, reasonable to accept the
default settings and create the grid, then add it to the scene and begin refining it. Click OK to create the
initial grid.
In the project tree, a 2D FEFLOW grid is made up of a grid object and a nodes object, as described in
FEFLOW Model Display. Here, a newly-created grid with a rectangular boundary appears in the project
tree:

Expand the grid in the project tree and double-click on the grid object ( ) to open the Edit 2D
FEFLOW Grid window. The Features tab will be displayed. When a grid is first created, this window
will be empty, but once features have been added, you can enable them in this tab.
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Click on the Boundary tab to modify the boundary:

Click the Apply button to view the effect of changes made without closing this window.
Boundary Options
When setting the Boundary, you can set a rectangular boundary defined by the From rectangle
settings. You can use the extents of any other object in the project by selecting from the Enclose
Object list, but the grid boundary will always be a rectangle.
To define a non-rectangular boundary, use the From another object options and select from the list of
objects available in the project. This is useful if, for example, you wish to define a grid using the boundary
of a geological model.
The Simplify boundary option reduces the number of points along the boundary. Reducing the
Tolerance value increases the number of points along the boundary. The two settings together let you
define a basic boundary with elements that are roughly uniform in size, set by the value of Element
size. Here, a grid has been created from a geological model with the Simplify boundary option
enabled:
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Disabling the Simplify boundary option results in more detail around the edges of the grid:

Element Size
The Element size setting determines the basic size of the triangles that make up the grid, although the
size will vary according to features applied to the grid and the Feature vertex snapping distance.
The size will also vary if the Simplify boundary option is unticked, in which case the Element size
setting is the maximum size of the triangles.
The Feature vertex snapping distance is automatically set to 1 percent of the Element size. To use
a smaller snapping distance, untick the Auto box and set the value required.
The effects of the Feature vertex snapping distance do not become apparent until features have
been added to the grid.
Adding Features to the Grid
To add features to the grid, right-click on the grid in the project tree and select New Feature. The New
FEFLOW Feature window will appear:

You can add Point, Line and Polygon features, and the Feature Object list will display all suitable
objects available in the project. Ticking the Simplify Feature option will reduce the number of points
used.
Click OK to add the feature, which will appear in the project tree under the FEFLOW grid object:

You can edit the feature by double-clicking on it or by right-clicking and selecting Open. However, the
feature has not yet been applied to the grid. To enable the feature, double-click on the grid to open the
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Edit 2D FEFLOW Grid window. Tick the box to enable the feature, then adjust the number of
Refinement Steps:

More Refinement Steps will produce more detail near the feature.
Click Apply or OK to view the effect the feature and its settings have on the grid.
If you want to modify a feature without having to reprocess the grid, untick it in the Features tab. If you
want to delete a feature, right-click on it in the project tree and select Delete.
The images below show a grid displayed with collar points (in red) to demonstrate the effects of no
features and collars applied with different refinement steps:

No features Collars with 2 refinement steps Collars with 10 refinement steps
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To view all features added to a grid, right-click on the grid and select View Snapped Features. A
Snapped Features object will appear in the shape list that represents all objects used to add features to
the grid:

Here, four snapped objects appear in the scene: the three features listed in the Features tab and the
grid’s boundary.
See Creating a 3D FEFLOW Model for information on using the 2D grid as the basis for a 3D model.

Creating a 3D FEFLOW Model
This feature is only available with the Hydrogeology extension. See Flow Models for more
information.
To create a new 3D FEFLOW model, you must first create or import a 2D FEFLOW grid as described in
Creating a 2D FEFLOW Model and Importing a FEFLOW Grid.
Once you have created or imported a 2D FEFLOW grid, right-click on the Flow Models folder and
select FEFLOW > New 3D Model. The Extrude 3D FEFLOW Grid window will appear:
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The dimensions and resolution of the grid are set by the 2D or 3D grid selected from the FEFLOW Grid
list. See Creating a 2D FEFLOW Model for information on creating and refining a 2D grid that can be
used as the basis for a 3D grid.
The Gridding from setting determines the geological model used for layer guides. Ticking the
Evaluate Gridded Model box will evaluate the new 3D model against the selected geological model
and set it as the evaluation for export. See FEFLOW Evaluations for more information. If you do not wish
to evaluate the geological model on the grid, untick the box. You will still be able to use the layers in the
geological model to control the grid layers.
The FEFLOW grid is initially made up of two layers equally spaced between the topography and the
geological model, with the minimum thickness of each layer determined by the Minimum Thickness
setting. You can add layers to the grid by clicking on the Select Layer Guides button and then
selecting from the layers available in the geological model:

If the grid is required to follow a geological model lithology contact surface, move the layer into the
Selected list and it will be honoured in the gridding process.
Click OK to return to the Extrude 3D FEFLOW Grid window. The selected layers will be displayed:

Click OK to generate the new FEFLOW grid, which will appear in the project tree under the Flow
Models folder.
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Once the model has been created, you can edit it by expanding the model in the project tree and doubleclicking on its grid object. The layer guides selected, the number defined and the Minimum Thickness
can be modified, but the FEFLOW grid on which the model is based and the geological model used for
gridding cannot be changed.
The boundaries of the selected geological model must be larger than the FEFLOW grid used as the
basis for the new model. If this is not the case, you can change the geological model’s extents so that
they enclose the FEFLOW grid.
For further information on working with the new grid, see:
l
l
l
l

FEFLOW Model Display
FEFLOW Evaluations
FEFLOW Material Types
FEFLOW Model Export

FEFLOW Evaluations
This feature is only available with the Hydrogeology extension. See Flow Models for more
information.
When a 3D FEFLOW model is exported, the evaluated geological model is used to assign lithologies to
the blocks in the grid. If the grid has not been evaluated against a geological model, you must do so
before you can edit the material types and before you can export the grid.
To evaluate a FEFLOW grid, expand the model in the project tree. Right-click on the grid object ( ) and
select Evaluations. Although you can evaluate an interpolant or distance function, they cannot be
exported with the grid and are simply used for displaying the grid in Leapfrog Works.
A window will appear listing all objects in the project that can be used for an evaluation. Once you have
selected one or more objects, click OK. You will then be able to select the evaluations from the view list,
as described in Evaluations.
Assigning an Evaluation for Export
For 3D grids created in Leapfrog Works, the evaluation used when creating the grid will automatically be
assigned as the evaluation for export. A material types table ( ) will appear in the project tree as part of
the 3D grid.
If the grid was imported into Leapfrog Works or created without being evaluated against a geological
model, you will need to manually set the evaluation for export. To do this:
l
l

Evaluate the grid against one or more geological models, as described above.
Right-click on the model ( or ) in the project tree and select Set Evaluation for Export. The
Select Evaluation window will appear showing all geological models evaluated on the grid. Select
the required evaluation and click OK.

A material types table will be added to the FEFLOW grid in the project tree. Edit material types by
double-clicking on the table. See FEFLOW Material Types.
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Combined Evaluations
You can combine geological models and set the priority used for evaluation. This is useful when you have
geological models available that describe different parts of the area of interest or if you have a refined
geological model for part of the model. To combine geological models for evaluation, select the required
models in the Select Models To Evaluate window, then click on the Combined Evaluation button.
In this example, there are three geological models selected:
The GM and GM from contacts models describe similar areas, but GM has more detail. The GM larger
model describes a larger area but with less detail. Tick the models to combine them and set their priority.
Click OK to create the combined evaluation, then click OK in the Select Models To Evaluate window.
The combined evaluation will be available from the view list and can be selected as the evaluation for
export.
To delete a combined evaluation, click on the Delete Combined button in the Select Models To
Evaluate window.

FEFLOW Material Types
This feature is only available with the Hydrogeology extension. See Flow Models for more
information.
When a FEFLOW model is first evaluated against a geological model, a material types table ( ) is added
to the FEFLOW grid in the project tree. You can edit material types by double-clicking on the table. You
can also open the table by right-clicking on the grid and selecting Edit Material Types.
If the grid has been imported into Leapfrog Works and has not yet been evaluated against a geological
model, you will be prompted to do so. Expand the model in the project tree, right-click on the grid object
and select Evaluate Geological Model. See FEFLOW Evaluations for more information.
If more than one object has been evaluated on the grid, you can set material types separately for each
evaluation. Select the required evaluation from the Evaluation list:

However, the only material types information that will be exported is that set for the evaluation to be
exported.
In the Edit Material Types window, you can enter the values for material types manually or you can use
the values from an interpolant.
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To enter values manually, click on a cell, then enter the value in the Value field:

Press the Enter key to move down the columns.
To use the values from an interpolant, click the Interpolant button, then select an interpolant from the
list. The interpolant that will be used for the selected value will be displayed in the field:

To use the interpolant for all the values in the selected column, click the All Lithologies button. The
window will be updated to show that the interpolant values will be used for that column:

Click OK to update the grid.
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FEFLOW Model Export
This feature is only available with the Hydrogeology extension. See Flow Models for more
information.
To export a 3D FEFLOW model as an ASCII format FEFLOW file (*.fem), right-click on the grid in the
project tree and select Export To FEFLOW. You will be prompted to choose a File name and location.
Select the options required, then click Save.
2D FEFLOW grids cannot be exported.
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Presentation
Leapfrog Works has a number of tools for displaying and presenting data for use in reports and
presentations.
l
l
l
l

Create and export cross sections, fence sections and serial sections. See Sections.
Create and export contours. See Contour Lines.
Render and save images for use outside of Leapfrog Works. See Rendered Images.
Save scenes that demonstrate different aspects of the model and the model-building process. These
scenes can then be saved as a movie or as a scene file that can be opened in Leapfrog Viewer. See
Saved Scenes.

See Visualising Data for information about the tools available in Leapfrog Works for changing how data
is displayed.

Uploading to View
View is a web-based model sharing platform. You can upload Leapfrog Works data to View, visualise the
data and organise it into slides. You can also share views with collaborators, all in your web browser, with
data saved securely to the cloud. All your collaborators need is a My Seequent ID; a Leapfrog Works
entitlement is not required.
There are two workflows for uploading data from Leapfrog Works to View, uploading the data currently
displayed in the 3D scene and uploading saved scenes. Both techniques are described below, but first it is
important to understand how View handles data objects uploaded from Leapfrog Works.
In this Leapfrog Works scene, we have a number of data objects, including a topography, drilling data, a
geological model and its contact surfaces, plus grade shells from a numeric model. Data is sliced.
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In View, all elements from the Leapfrog Works scene are displayed in the initial view, which is unsliced.
View’s slice tool is similar to the slicer in Leapfrog Works, and you can also rotate, pan and zoom the
view and measure elements.
With the Elements list, you can select which objects to display and how they are displayed:

Once you have set up a view, save it as a slide. In this way, you can organise your data to tell a story and
invite feedback from collaborators.
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If you have permission to edit the view, you can add feedback and annotations and can create new
slides:

To learn more about using View, visit view.seequent.com, where you can explore the View gallery and
see what’s possible:

The rest of this topic describes:
l
l
l

Signing in to View
Uploading to View
Troubleshooting Connectivity Issues

© 2020 Seequent Limited

719 | User Manual

Signing in to View
Signing in to My Seequent via the Seequent ID menu also signs you in to View.
To enable uploading to View, click on the Leapfrog Works menu and then on Settings > User
Interface. Tick the box for Show View upload. The View button ( ) will be displayed in the Scene
View toolbar.

Uploading to View
There are two options for uploading to View:
l
l

Uploading the current 3D view
Uploading saved scenes

When selecting the data you will upload to View, think about the slides you wish to make in View.

Uploading the 3D View
The first option for uploading to View is to upload some or all of the objects in the 3D scene. To do this,
click the View button ( ) in the toolbar:

A list of the objects currently in the scene is displayed, along with information about the upload size for
each object. Objects that are visible in the scene will automatically be selected, whereas any hidden
objects will appear in the list but will not be selected.
If an object in the scene does not appear in the list, it is because the upload of that type of object to
View is not supported at this time.
The maximum number of objects and the maximum amount of data that can be uploaded are displayed
in the window, so if your scene contains large objects or too many objects, you can select which ones
you wish to upload.
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When uploading category data columns to View, there is a limit to how many unique codes can be
uploaded. If your category data is displaying more than 250 unique codes, consider simplifying your
data before uploading to View.
Once you have chosen which objects you want to upload and entered information about the view, click
the Upload button.
Upload progress is shown in the notifications menu:

When the upload is complete, a link to View will be displayed in the notification list:

Notifications persist for the duration of your Leapfrog Works session; all notifications are cleared when
you exit Leapfrog Works.

Uploading Saved Scenes
To upload one of the scenes in the Saved Scenes and Movies folder, right-click on the scene and
select Upload to View. The process is the same as described in Uploading the 3D View above.

Troubleshooting Connectivity Issues
Seequent Start checks to see if your network will support the connection of Seequent web-based
services to your desktop applications. If you are having trouble with your connection to View, see
Checking Connectivity With Seequent Start.
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Sections
There are four types of sections in Leapfrog Works:
l

l

l
l

A typical cross section is a vertical plane with an image or geologic cross section applied to it. In
Leapfrog Works, this type of cross section can be created directly in the scene, from the slicer or
from an imported image.
A fence section deviates. In Leapfrog Works, a fence section can be created from a polyline drawn in
the scene or from any line object in the project.
A serial section is a series of typical cross sections taken at an offset from a single base section.
An alignment serial section uses an imported alignment to create a series of sections along the
alignment.

Evaluating on Sections
Different objects in the project can be evaluated on sections, as described in Evaluations. Such objects
include:
l
l
l
l
l
l
l
l

Geological models
Numeric models
Distance functions
Surfaces
Design lines
GIS lines
Polylines
Combined models

When evaluating objects on sections, you can limit the evaluation to the section extents. To do this,
enable the Clip evaluations to section extents option when selecting what objects you are
evaluating.
Flow models can be evaluated on cross sections but not on serial sections and fence sections.
Objects evaluated on sections can be included when the section is exported.

Exporting Sections
Sections can be exported in the following formats:
l
l
l

DXF Files (11/12 [AC1009]) (*.dxf)
Drawing Files (2013/LT2013) (*.dwg)
Bentley Drawing Files (v8) (*.dgn)

Exporting a section as a DXF file (*.dxf) exports a series of DXF lines created from the intersection of
the evaluation volumes and the section plane. The lines generated from each volume are saved as
separate layers in the file.
For serial sections, the section will be exported in a single file with a collection of DXF lines based on
intersections between the selected evaluation and the section planes.
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To export a section in one of these formats, right-click on the section in the project tree and select
Export. In the window that appears, select the evaluations you wish to export with the section:

The 2D Analysis tab contains two options, Flatten to 2D and Simplify.
When you enable the Flatten to 2D option, the section will be flattened into the X-Y plane, making Z
uniform across the section. You can change the origin, if required. The Flatten to 2D export option is
available for:
l
l
l

Regular cross sections
Cross sections created from images
Child sections of serial and alignment sections

The Simplify option is useful when the file is being exported for use in finite element slope stability
packages. Enabling Simplify evens out the node spacing for model and line evaluations by setting a
minimum allowable distance between nodes. Increasing the Minimum spacing setting reduces the
number of nodes included but can result in loss of detail.
Enter a filename and location, then click Save.

Exporting Section Layouts
Another way to export a section is to create a section layout and then export it as a PDF file (*.pdf),
Scalable Vector Graphics file (*.svg), PNG image (*.png) or GeoTIFF (*.tiff, *.tif). This option is more
flexible than exporting the section as a DXF file as you have more control over the section layout. You
can customise the page layout and include multiple evaluations and annotations. For typical cross
sections and serial sections, you can also display boreholes and planned boreholes. See the Section
Layouts topic for information in using the section editor.
Once you have finished adjusting the section layout, you can export it in one of the following formats:
l
l

PDF Files (*.pdf)
Scalable Vector Graphics Files (*.svg)

© 2020 Seequent Limited

723 | User Manual

l
l

PNG Image Files (*.png)
GeoTIFF Files (*.tiff, *.tif)

Click the Save and Export button ( ) at the top of the window. You will be prompted for a filename
and location.
For serial sections and alignment serial sections, you can batch export multiple section layouts. All
selected sections can be exported as a single PDF or individually in PDF file (*.pdf), Scalable Vector
Graphics file (*.svg), PNG image (*.png) or GeoTIFF (*.tiff, *.tif) formats. When section layouts are
exported individually, all outputs can be combined into a zip archive. To do this, right-click on the Cross
Sections and Contours folder and select Batch Export Layouts.
In the window that appears, selection the layouts you wish to export, then select a format. If you select a
format other than Single PDF, you can combine all outputs into a zip archive. Select where you wish to
save the outputs, then click Export. Progress will be displayed at the top of the Batch Export Section
Layouts window:

Creating Cross Sections
To create a cross section in the scene, add a model to the scene. Next, right-click on the Cross
Sections and Contours folder and select New Cross Section. The New Cross Section window will
appear, together with a section plane and controls in the scene that let you adjust the position of the
section plane:

If the slicer is already in the scene when you select New Cross Section, the position of the slicer will
be used to define the initial orientation of the section. This is an effective way of creating a section
from the slicer: add the model to the scene, draw a slice and then create a cross section.
The front (F) and back (B) of the section plane is indicated in the scene. To swap the front and back,
click the Swap Front button.
Use the handles in the scene to position the section plane. The handles work in the same manner as the
moving plane controls, as described in The Moving Plane.
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Two buttons in the New Cross Section window let you create a cross section that is aligned north-tosouth ( ) or east-to-west ( ):

The other two buttons are active when the slicer is in the scene. Clicking the Set section to slicer
button ( ) creates a cross section from the position of the slicer in the scene. When the Lock section
to slicer button ( ) is enabled, moving the position of the slicer will update the position of the cross
section in the New Cross Section window.
Once the section plane is positioned as required, click OK to create the new cross section, which will
appear in the Cross Sections and Contours folder. Display it by clearing the scene, then adding the
cross section to the scene.
Many objects in a project can be evaluated on cross sections, as described in Evaluations. Such objects
include:
l
l
l
l
l
l
l

Geological models
Interpolants
Distance functions
Surfaces
Design lines
GIS lines
Polylines

Objects evaluated on a cross section or fence section can be included when the section is exported.

Importing Cross Sections
See Importing a Map or Image for more information on importing images into Leapfrog Works.
Leapfrog Works supports the following file formats for creating cross sections:
l
l
l
l
l

PNG files (*.png)
JPEG files (*.jpg, *.jpeg)
TIFF and GeoTIFF files (*.tiff, *.tif)
Windows Bitmap files (*.bmp)
Graphics Interchange Format files (*.gif)

As with other images imported into Leapfrog Works, you can import a single cross section image or
multiple images.
To import a single cross section image, right-click on the Cross Sections and Contours folder and
select New Cross Section From Image. Navigate to the folder that contains the image, select the file
and click Open.
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l

l

If the image contains georeference data, it will be imported into the Cross Sections and Contours
folder.
If the image does not contain georeference data, the New Cross Section From Image window will
be opened so you can add the georeference data. See Manually Georeferencing Images. Once you
have georeferenced the image, click Import. The image will be imported into the Cross Sections
and Contours folder.

There are two ways to import multiple cross section images:
l

l

Right-click on the Cross Sections and Contours folder and select New Cross Section From
Image. Navigate to the folder that contains the files you wish to import. Select the images and click
Open. The images will be imported and added to the Cross Sections and Contours folder.
In the File Explorer, select all the files you wish to import. Drag and drop them into the Cross
Sections and Contours folder in Leapfrog Works.

All images will be imported and added to the Cross Sections and Contours folder. If an image does
not contain georeference data, you will need to open the image and add the information manually, as
described in Manually Georeferencing Images.
Once you have created a cross section, you can edit it or use it to evaluate geological models,
interpolants, distance functions and surfaces. See Evaluations.

Fence Sections
You can draw a polyline or use any existing line object in the project to create a cross section that
deviates. To do this, right-click on the Cross Sections and Contours folder and select New Fence
Section. The New Fence Section window will be displayed:

You can draw the polyline in the scene directly by selecting the New Polyline option. You can also use
any polyline in the project by selecting the Existing Polyline option.
Only GIS lines, polylines imported into Leapfrog Works or polylines created using the straight line
drawing tool can be used to create fence sections.
Click OK to create the fence section. If you chose to create a New Polyline, the drawing controls will
appear in the scene and you can begin drawing, as described in Drawing in the Scene.
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The fence section will appear under the Cross Sections and Contours folder and you can edit it by
double-clicking on it. You can also use it to evaluate different objects in the project, as described in
Evaluations. Such objects include:
l
l
l
l
l
l
l

Geological models
Interpolants
Distance functions
Surfaces
Design lines
GIS lines
Polylines

If you create a section layout for a fence section, you can include multiple evaluations and annotations
on the section layout. See Section Layouts.

Serial Sections
This topic describes the process of creating a serial section, which is a series of cross sections taken at an
offset from a single base section. The topic is divided into:
l
l
l
l
l

Setting the Base Section
Setting the Offset Sections
The Serial Section in the Project Tree
Displaying a Serial Section
Exporting a Serial Section

To create a serial section, add a model to the scene. Next, right-click on the Cross Sections and
Contours folder and select New Serial Section. The New Serial Section window will appear and
planes representing the base section and the offset sections will be added to the scene:

If the slicer is already in the scene when you select New Serial Section, the position of the slicer will
be used to define the initial orientation of the base section.
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Setting the Base Section
The handles in the scene control the position of the base section and work in the same manner as the
moving plane controls (see The Moving Plane).
The front (F) and back (B) of the base section plane are indicated in the scene. To swap the front and
back, click the Swap Front button.
Two buttons in the New Serial Section window let you create a base section that is aligned north-tosouth ( ) or east-to-west ( ). The other two buttons are active when the slicer is in the scene.
Clicking the Set section to slicer button ( ) creates a cross section from the position of the slicer in
the scene. When the Lock section to slicer button ( ) is enabled, moving the position of the slicer
will update the position of the cross section in the New Serial Section window.

Setting the Offset Sections
The number of offset sections is determined by the value of the Spacing setting and the Front and
Back Extents:

You can change the number of offset sections by:
l

l

l

Changing the Spacing setting. The number of offset sections will be recalculated and updated in the
scene.
Changing the Front or Back settings. For example, increasing the Front setting adds an offset
section on the front of the base section, increasing the extents by the value of Spacing.
Changing the object used to define the extents. Select an object from the Enclose Object list. The
base section will be moved to the centre of the selected object.
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The Serial Section in the Project Tree
Click OK to create the section. In the project tree, the serial section includes the individual cross sections:

Many objects in a project can be evaluated on serial sections, as described in Evaluations. Such objects
include:
l
l
l
l
l
l
l

Geological models
Interpolants
Distance functions
Surfaces
Design lines
GIS lines
Polylines

Displaying a Serial Section
When you display a serial section in the scene, you can add the slicer to the scene and use it to move
easily between the sections in the stack. To do this, click on the slicer in the shape list, then select the
base section from the Set to list:

Next, set the Step size to the Spacing setting used to create the section. You can then use the < and >
keys to view each individual cross section.
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Exporting a Serial Section
The options for exporting serial sections differ for the section itself and the offset sections:
l

l

A serial section cannot be used to create a section layout. When exported as a DXF file, the serial
section will be exported in a single file with a collection of DXF lines based on intersections between
the selected evaluation and the section planes.
The offset sections that make up a serial section can be exported in DXF format or as a section
layout. See Exporting Sections and Section Layouts for more information.

Alignment Serial Sections
An alignment serial section can be created using an alignment imported into the Designs folder, a
polyline or a GIS line. When creating an alignment serial section from a polyline, you can use an existing
polyline or draw a new one.
This topic describes the process of creating and working with an alignment serial section. It is divided
into:
l
l
l

Creating an Alignment Serial Section
Displaying an Alignment Serial Section
Exporting an Alignment Serial Section

Creating an Alignment Serial Section
To create an alignment serial section, right-click on the Cross Sections and Contours folder and
select New Alignment Serial Section. The New Alignment Serial Section window will appear.
Select whether you will use an existing line or create a new one.
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Using an Existing Line
If you select an existing line, planes representing the base section and the offset sections will be added to
the scene:

Once you have created an alignment serial section, you can change all settings except the line used.
The Base Section parameters determine the size of the sections and the Offset Section parameters
determine how the sections are distributed along the selected line.
l
l

Swap the start and end points of the selected line by clicking the Swap Start button.
Generate sections along only part of the line by selecting Line Section, then changing the Start
Chainage and End Chainage.

You can set a Start Chainage value that will be assigned to the first point of the line being used for the
alignment.
All changes you make in the New Alignment Serial Section window will be displayed in the scene.
Click OK to create the section.
Using a New Polyline
If you have chosen to create a New Polyline, set the Base Section and the Offset Section
parameters, then click OK. Drawing controls will appear in the scene and you can begin drawing, as
described in Drawing in the Scene.
Once you have finished drawing the polyline, click the Save button ( ). The offset sections will be
generated and will appear in the project tree. Double-click on the section in the project tree to edit its
settings.
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The Alignment Serial Section in the Project Tree
In the project tree, the alignment serial section includes the individual offset sections and the line used to
create it:

Many objects in a project can be evaluated on serial sections, as described in Evaluations. Such objects
include:
l
l
l
l
l
l
l

Geological models
Interpolants
Distance functions
Surfaces
Design lines
GIS lines
Polylines

Displaying an Alignment Serial Section
Add the top-level section to the scene to view all the offset sections. You can also view individual offset
sections.
If a master section layout has been created for an alignment serial section, dragging the master
section layout into the scene displays all sections that use that layout.

Exporting an Alignment Serial Section
Alignment serial sections can be exported in the following formats:
l
l
l

DXF Files (11/12 [AC1009]) (*.dxf)
Drawing Files (2013/LT2013) (*.dwg)
Bentley Drawing Files (v8) (*.dgn)

The DXF format exports a single file with a collection of DXF lines based on intersections between the
selected evaluation and the section planes.
The offset sections that make up an alignment serial section can also be exported as a section layout.
See Section Layouts for more information.
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Section Layouts
With the Section Layout Editor, you can create a section layout for an existing section and then
export the section. You can customise the section layout by:
l
l
l
l

Adding models, surfaces and lines the section has been evaluated against
Adding boreholes and planned boreholes
Changing the page size, orientation and margins
Adding titles, a scale bar, legends, annotations and images, such as a standard form or logo

The appearance of all objects can be customised without changing how objects from the project tree are
displayed in the scene.
Section layouts can be displayed in the scene by dragging a layout into the scene:

Some sections will be too large to display in the scene, which will be indicated in the section layout
editor.
Displaying section layouts in the scene is useful when you are editing a section layout and wish to see the
effect of changes. Detach the section layout tab from the main window and position it adjacent to the
scene window. Periodically save your changes to the section layout to see the effects of those changes
in the scene.
This topic describes how to work with section layouts. It is divided into:
l
l
l
l
l

Setting Up the Section
Creating New Section Layouts
Creating Master Section Layouts (alignment serial sections only)
Copying Section Layouts
Working With the Section Layout Editor
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l
l
l
l
l

Changing Page Properties
Changing the Basic Section Properties
Organising Objects on the Section
Setting Up the Legend
Adding and Organising Annotations

Setting Up the Section
Once you have created a section but before you start creating the section layout, take the following
steps.
1. Check the section’s extents and orientation.
The initial dimensions of the section on the page are determined by the size of the section plane, and its
orientation on the page is determined by the front (F) and back (B) faces of the section plane. Here, the
front and back faces of the section have been swapped, which results in the section displayed on the
page being flipped:

2. Check that the section has been evaluated against objects you wish to display on the page.
To do this, right-click on the section in the project tree and select Evaluations or Evaluate Surface.
3. Add planned boreholes to the project.
Planned boreholes can be displayed on the section, but these must be defined before you start the
process of laying out the section.
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Creating New Section Layouts
To create a new section layout, right-click on an existing section in the project tree and select New
Section Layout. The New Section Layout window will appear, together with the Section Layout
Editor:

The settings in the New Section Layout window determine the basic section layout:
l

l

l

l

The Scale settings determine the scale used to display the section on the page. If you want a specific
page size, select Fit to Page to set a scale that best fits the page width. You will be able to change
the page margins once you have closed the New Section Layout window.
The Page Properties settings determine the page size and orientation. If you wish to use a specific
Scale, select the Orientation required, then click Fit to Section to choose the best page size.
For Evaluations, select from the models, surfaces and lines the section has been evaluated against.
When you select an evaluation, it will be added to the preview.
For Extents, choose whether to use the Section Extents or Evaluation Extents. If you wish to
use the extents from a model evaluation, add only that model to the Models, Surfaces or Lines list,
then select the Evaluation Extents option. Once you have closed this window, you will be able to
add further models, surfaces and lines using the section layout editor.

As you change settings and add objects to the section, the preview in the Section Layout Editor
window will be updated. All settings in the New Section Layout window can be changed once the
layout has been created.
Click OK to close the New Section Layout window. You can then make further changes to the page
layout in the Section Layout Editor. See Working With the Section Layout Editor.

Copying Section Layouts
If you have already created a section layout and wish to reuse it, you can copy it to other sections.
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For alignment serial sections, creating a master section layout is an alternative to duplicating and
managing multiple section layouts. See Creating Master Section Layouts for more information.
Copying a section layout copies the evaluations used in the original section layout, together with the
page size and orientation and the position of the Layout Tree objects on the page. How models,
surfaces and boreholes are copied depends on the section to which the layout is being copied:
l
l

All models and surfaces that can be displayed on the section will be copied.
The boreholes copied to the layout will depend on the type of section the layout is being copied from
and whether or not a filter is set for the layout:
o

o

o

If no distance filter was set for the original layout, all boreholes selected for the original layout will
be copied.
If a distance filter was applied to the original section, the filter will be applied and boreholes
selected that are within that distance of the section to which the layout is being copied.
When the original layout is from an alignment serial section or a fence section, borehole
evaluations will not be copied with the section layout.

To copy a layout, right-click on the layout you wish to copy and select Copy Layout To. In the window
that appears, a summary of the information that will be copied is displayed so you can see what
information will be copied to the selected sections. Move the sections you wish to copy the layout to into
the Selected Sections list, then click OK. A copy of the layout will appear in the project tree under
each section you selected. The layout copies are not linked to the original layout and so will not be
updated when the original is updated.
Copying section layouts to multiple sections can result in numerous section layouts in a project, which
can be difficult to work with. The recommended workflow for creating a section layout that you
intend to make multiple copies of is to first get the layout right on one section before copying it to
other sections.

Creating Master Section Layouts
For alignment serial sections, you can create a master section layout and apply this master layout to all
the child sections of an alignment section. When the master layout is updated, changes will be reflected
wherever it has been applied. To create the master section layout, right-click on the top-level section
and select New Master Section Layout.
The master section layout editor works the same way as the standard layout editor. When you save the
layout, it will be stored as part of the alignment section, separately from the child sections and
evaluations. To copy the master layout to child sections, right-click on it and select Copy Master
Layout To. The master layout will be applied to the selected child sections.
You can edit the child layouts that are linked to the master layout, but doing so will break the link to the
master layout; the child layout will no longer be updated when changes to the master layout are made.
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Working With the Section Layout Editor
In Section Layout Editor, the Layout Tree shows the different layers that can be added to the page.
The different parts of the Layout Tree as they relate to the page preview are shown below:

When you select an object in the layout tree, it will be highlighted by a blue line on the page. In the
example above, the Section object is selected.
Click on an object in the page preview to move or resize it. This will also select the object in the Layout
Tree and you can see what properties can be changed. For example, in the preview, click on the Title to
view its styling options:

Text displayed in the section layout is controlled by a style sheet that can be accessed whenever you are
editing a text object. For example, clicking on Edit Styles for the Title opens the list of Text Styles
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with the Title selected, but also allows you to change the appearance of styles used for other text
objects visible in the preview:

Changing Page Properties
In the Layout Tree, click on Page to change the Page Size, Orientation and Margins:

If you wish to use a specific Scale, select the Orientation required, then click Fit to Section to choose
the best page size.

© 2020 Seequent Limited

Changing the Basic Section Properties | 738

Changing the Basic Section Properties
To change the section layout’s basic properties, click on the Section object in the Layout Tree. In the
Section tab, you can change the scale and units used in the layout and the amount of Vertical
Exaggeration:

For the Scale, you can enter a specific value to use in displaying the section on the page, or, if you want
a specific page size, select Fit to Page to set a scale that best fits the page width.
If you want to change the page size and the margins used, click on the Page object.
To change the size of the section contents (models, boreholes, surfaces and lines) on the page, click on
the Extents tab:

For Extents, choose whether to use the Section Extents or Evaluation Extents.
You may wish to add more space above the section, especially if you will be adding boreholes to the
section and need extra space for the collar labels. To do this, change the Additional sky setting. These
images show the effects of two different Additional sky settings:
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Enable Show end point labels to display the section’s end points as text:

Click Options to change how the end points are displayed relative to the section’s axes. There are two
options that control where the end points are displayed, Points above and Points aligned inside.
The Points above setting determines whether the end points are displayed above or beneath the axes.
Note here the difference between Points above being disabled and enabled:

The Points aligned inside setting determines whether the end points are displayed inside or outside
the section’s axes:

You can also change the spacing between the end point labels and the section axes.
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Edit the text used to display the end points by enabling the Edit box and then changing the text. You
can edit the style used for displaying the labels by clicking Edit Styles to change the style or by
selecting a different style from the dropdown list.

To change how the axes are displayed, click on the either the X-Axis tab or the Y-Axis tab. One of the
options available for the axes is how much information is displayed for the Real World Coordinates on
each axis:

You can also change how Grid Lines are displayed, including the Line style, Line width, Pattern
scale and colour. A Preview is displayed and the grid lines are updated in the section preview.
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By default, the axes are displayed only on the left-hand side and along the bottom of the section. To
display axes along the right-hand side and above the section, tick the Secondary option.
For the Ticks, Leapfrog Works automatically calculates an Initial Value:

If you wish to change this, disable Auto and enter the required value.
If you wish to set an X-axis Start Value other than 0, you must first disable the Real World
Coordinates option:

Edit the style used for displaying the axis labels by clicking Edit Styles to change the style or by
selecting a different style from the dropdown list.

Organising Objects on the Section
The folders below the Section object are used to add and organise models, boreholes, surfaces and
lines and to customise how they are displayed:
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If you selected models, surfaces and lines when you created the section, they will appear in one of these
folders. You can add new objects by right-clicking on a folder and selecting an Add option:

l

l

For the Add Model, Add Surface and Add Line options, you will be able to choose from the
objects that have been evaluated on the section. See Evaluating on Sections for more information.
For the Boreholes folder, there are two options, Add Boreholes and Add Planned Boreholes.
For both options, you can choose from the boreholes and planned boreholes available in the project;
it is not necessary to evaluate these onto the section before you can add them to the layout.

Models, boreholes, surfaces and lines occupy the same space on the section layout, and opacity settings
and an object’s position among the layers can be used changed to emphasise relevant information. To
change the order of objects on the page, right-click on them and select an option:

Models will always be among the lower layers, with lines on top of all the other layers.
You can remove objects from the layout by right-clicking on them and selecting Delete.
To change the opacity of an object, click on it, then adjust the object’s Opacity using the slider:

Adding and Styling Models
The Models folder contains all models that have been added to the section layout. To add another
model, first make sure it has been evaluated on the section, then right-click on the Models folder and
select Add Model. Select from those available and click OK.
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When you display multiple models on the section, you can end up with a large number of objects that
obscure the information you want to emphasise. You can:
l
l
l

l

Use the Opacity setting for each model to expose and emphasise information.
Right-click on the models to move them up or down in the layer hierarchy.
For geological models, numeric models and combined models, expand the model in the Layout Tree
to change how each output volume is displayed. You can also hide some of the output volumes.
For flow models, you can hide categories or filter the values used to display the model

If a geological model with an active fault system is added to the section layout, it will include a Fault
System that contains all the active faults in the model. Click on the Fault System to control whether
or not it is Visible and to set is Opacity:

Click on the individual faults to control how they are displayed:
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Edit the fault’s Description by enabling the Edit box and then changing the text. You can also change
how the fault is displayed, including the Line style, Line width, Pattern scale and colour. You can
also define a marker to display along the line by enabling Add marker and then specifying a Symbol to
use. A Preview is displayed and the fault will be updated in the section preview:

For the volumes in the Output Volumes folder, line, border and swatch properties by clicking on the
volume in the Layout Tree and then changing their properties. Swatches for output volumes can be
displayed using a hatched fill. To do this, click on the volume, enable the Hatch option and click on the
sample to view the available patterns:
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A single line style is used to display a model’s output volumes. There is, however, a Highlight option that
can be enabled to make a volume of interest stand out from the other volumes:

Another way to emphasise a particular volume is to use the surfaces in the model’s Surfaces folder. This
folder contains a single surface for every contact with the section, rather than a single surface for each
contact surface in the model:
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It can result in a large number of surfaces to work with, but does provide you more control over how
these surfaces appear on the section layout. For example, here the outline of the GnD volume can be
shown in different styles (as with the D2 contact) or not at all (as with the Dike contacts):
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You can display a contact surface on a section layout as a surface evaluation, but you can have only one
line style and you don’t have control over what parts of the surface are displayed. For example, you
cannot hide the surface where it is intersected by the dike:

Flow models appear in the Models folder as a single object. They can be displayed using a flat colour or
any of the Colouring options available for the model:
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Click Options to change the colours used to display the model:
l

l

For category evaluations, you can change what categories are visible and the colours used to display
them.
For numeric evaluations, you can filter values and use a different colourmap.

For example, here, a MODFLOW model is displayed using the Colouring from an evaluated geological
model:

The colours used to display categories cannot be changed in the Block Colouring Legend as they are
the colours used by the evaluated model itself. You can, however, hide some categories so they are not
displayed on the section layout.
Here, the MODFLOW model is displayed using the Colouring from an evaluated numeric model:

You can change the Colourmap used to display the model on the section and you can filter the values
displayed.
If a flow model is too big for the section layout, changing the section extents or the section layout
extents will effectively “crop” the flow model and make it small enough to display on the section
layout. There are two ways to do this:
l

Change the section layout extents by clicking on Section in the Layout Tree, then clicking on
the Extents tab. If Extents is set to Evaluation Extents, change it to Section Extents.
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l

Change the size of the section by double-clicking on it in the project tree and then editing its
dimensions in the scene.

Adding Styling Boreholes and Planned Boreholes
The Boreholes folder contains all boreholes and planned boreholes that have been added to the section
layout. Up to three columns of data can be displayed, and numeric data can be displayed as a graph.
To add boreholes to the section, right-click on the Boreholes object and select either Add Boreholes
or Add Planned Boreholes.
For adding boreholes, you will be prompted to select the interval table to display.
For both boreholes and planned boreholes, you can filter the boreholes based on a minimum distance
from the section plane:

This is the minimum distance to any point on each borehole trace.
If you tick the Clip geometry to filter distance option, only parts of the borehole within the filter
distance will be included in the section layout. Select the required boreholes and click OK.
When boreholes and planned boreholes are added to a curved section, a projection is made based on
the locations of neighbouring segments of the section, using the bisectors of the angles between
each segment and its neighbour. These determine the projection point of origin for a given segment
of the section. When boreholes are filtered by the distance to the section plane, the distance is
measured at 90 degrees from the section. Some boreholes may report a distance that is greater than
the specified minimum distance; if this is the case, it is because the evaluation distance is relative to
the projection origin.
On the inside of a tight corner, a single borehole may be projected multiple times onto the section. If
this is the case, the multiple instances of the borehole will appear in the boreholes list and you can
turn individual instances off, if required.
When a fence section is updated, borehole evaluations are updated. If there are multiple instances of a
borehole evaluation, how they appear on the section may change when the section is updated:
l

l

If all instances of a borehole evaluation have been enabled, then all remain enabled when the
section is updated.
If all instances of a borehole evaluation have been disabled, then all will remain disabled when the
section is updated.
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l

If only some instances of a borehole evaluation have been enabled, then all instances will be
enabled when the section is updated.

When a section layout is copied to another section from a fence section, borehole evaluations will not
be copied with the section layout.
You can have the following type of labels at different points along the borehole trace: top labels,
intercept labels, bottom labels and depth markers. To hide or change the appearance of borehole labels,
click on the borehole table, then on the Points and labels tab. Click Options to change how the labels
are displayed. You can rotate labels and have a line connecting the label to the collar:

You can also click on the labels in the layout and move them. Note that the label lines will only appear
once the borehole label has been moved away from the collar.
If you want to return all labels to their default positions, click Reset Dragged Labels in the Points and
Labels > Label Options window.
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How boreholes are displayed is controlled by the Colourings settings in the Lines tab:

Click the Options button to display data (category data) or filter values (numeric data) on the
boreholes:
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Boreholes can be displayed using hatching patterns. In the Display style tab, tick the Hatched option,
then select from the patterns available:

For columns of numeric data, you can display data as a bar graph or line graph. These options are
available in the Display style tab. Here, data is displayed as a bar graph:
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Select a Max length that means that displayed data does not interfere with other boreholes or data
displayed on the section layout. This is especially useful when two graphs are displayed:

If you only want to plot a limited range of data, tick the Axis limit box and set the required range.
Displaying data with the logarithmic scale enabled may enhance differences in the values, and negative
values can be scaled.
The bar and line graph options are not available for the centre of the borehole, although the solid option
can be used.
Adding and Styling Surfaces
The Surfaces folder contains all surfaces that have been added to the section layout. To add another
surface, first make sure it has been evaluated on the section, then right-click on the Surfaces folder and
select Add Surface. Select from those available and click OK.
Click on the surface in the Layout Tree to view styling options:
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Edit the text used to display the surface by enabling the Edit box and then changing the text. You can
change the Line style, Line width, Pattern scale and colour. You can also define a marker to display
along the line by enabling Add marker and then specifying a Symbol to use. A Preview is displayed
and the surface will be updated in the section preview.
You can see below how changes to the Line style, Symbol and Occurrence can be used to indicate
different conditions:

l
l
l

Line style: Long dash
Symbol: ?
Occurrence: 2

l
l
l

Line style: Solid line
Symbol: ?
Occurrence: 3

l
l
l

Line style: Dotted
Symbol: #
Occurrence: 5

Adding and Styling Lines
The Lines folder contains all lines that have been added to the section layout. To add another line, first
make sure it has been evaluated on the section, then right-click on the Lines folder and select Add Line.
Select from those available and click OK.
Click on the line in the Layout Tree to view styling options, including the size, shape and colour of the
pierce point:
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Setting Up the Legend
The Legend Group and the individual legends underneath it control how the legend is displayed on the
page.

Click on the Legend Group object to change the layout of the legend as a whole:

Columns can be laid out vertically or horizontally, and you can also change the swatch size and gradient
and add a Boundary box. For individual legends that have a large number of entries, you may need to
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increase the number of rows. For example, for the combined model, the number of rows has been
increased to accommodate the number of entries in the legend:

When you have multiple models, surfaces, lines and boreholes on the section layout, you can end up with
a large number of entries in the Legend Group. How you hide a legend in the Legend Group depends
on the type of object. Objects displayed on the section layout appear in the Legend Group as follows:
l

l

Each model on the layout has an individual entry. Hide a model in the Legend Group by clicking on
the model’s entry and disabling the Visible option.

Each geological model, numeric model and combined model has a Surfaces folder, which will have
its own entry in the Legend Group when at least one surface in that folder has been set to Show in
legend. The surfaces legend for a model itself can be hidden in the Legend Group by clicking on
the entry and disabling the Visible option:
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l

l
l

Each borehole column that appears on the section has an individual entry. Hide a column in the
Legend Group by clicking on the column’s entry and disabling the Visible option:

Planned boreholes that appear on the section do not appear in the Legend Group.
Surfaces in the Section > Surfaces folder appear in the Legend Group as a single entry. Hide a
surface in the Legend Group by clicking on the surface in the Surfaces folder and disabling
theShow in legend option:
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l

Lines in the Section > Lines folder appear in the Legend Group as a single entry. Hide a line in the
Legend Group by clicking on the line in the Lines folder and disabling theShow in legend option:

The order in which legends appear in the Legend Group is the order in which they appear in the
Layout Tree. To change the order in which the legends appear, right-click on them and select a Move
option.
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The colours, line widths, fills and hatches displayed in the Legend Group are controlled by the objects
themselves. For example, to change how a shell is displayed for the interpolant, click on the output
volume, under the Models object:

Adding and Organising Annotations
Once you have laid out the main Section object and organised the Legend Group, you can add a
number of different types of annotation to the layout, including a title, a title block, location information
and a scale bar, text boxes and imported images.
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Displaying a Title
The Title object formats the title displayed on the page. To move the title, click on it in the layout
preview. The text used for the Title is the name for the section in the project tree, but this can be
changed in the properties panel. Enable the Edit option, then edit the text in the box:

You can display a line around the Title by enabling the Boundary box option. You can customise the
Line style, Line width, Pattern scale and colour of the box. A Preview is displayed and the
boundary is updated in the section preview.
Displaying a Title Block
When the Title Block is visible, a title block based on ISO 7200 is displayed on the layout:
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To display the Title Block on the section, select it in the Layout Tree, then tick the Visible box. In this
panel, you can also change the styles used to display the information in the block.
Displaying a Scale Bar and Location Information
There are a number of different styles available for the Scale Bar, and you can control its Length,
Partitions and Thickness:

You can show the Scale Bar with or without labels, and labels can be shown all along the bar by
disabling the End Points Only option:

The Text options determine whether or not the scale and vertical exaggeration are shown on the scale
bar.
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The Location object controls how location information is displayed:

You can include the Z coordinate, if required and change the number of decimal places used to display
coordinates.
There is a Boundary box option for both the Scale Bar and the Location. You can customise the Line
style, Line width, Pattern scale and colour of the box. A Preview is displayed and the boundary is
updated in the section preview.
Text Boxes
With the Text Boxes object, you can add text boxes and arrows to highlight information and details on
the section:

There is a Show Outline option for the text box, and corners can be square or rounded. You can
customise the Line style, Line width, Pattern scale and colour of the outline. A Preview is displayed
and the text box is updated in the section preview.
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Arrows are connected to text boxes, and so initially only text boxes can be added. Right-click on a text
box to add an arrow to it. When the Automatic anchoring option is enabled for an arrow, the arrow’s
anchor will move when its associated text box is moved:

If this option is disabled, the arrow will move when you move the text box, but you will have to place its
anchor manually.
Images
If you wish to import an image such as a logo or map, right-click on the Images object and select Add
Image. Navigate to the folder that contains the image file and select the file. Click Open to import the
file, which will automatically be added to the section layout:

Move the image by clicking on it in the preview and dragging it. You can resize the image using the
controls in the preview.
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Rendered Images
Leapfrog Works can render high-quality images that you can save on your computer in a format that can
be used in presentations and documents. To do this, click on the Render Image button in the toolbar (
) or click on the Leapfrog Works menu and select Render Image. Leapfrog Works renders an
image from the current scene window, then displays it in the Render Image window:

If you are displaying multiple views in the scene, you can select which ones you want to render from the
Render View list:

Views that are open in tabs are also listed in the Render View list. However, the All (Multi View)
option only renders the split of views displayed in the Scene View tab.
Use the zoom tools to view the rendered image. You can change the image settings by:
l

l

l

Selecting a new image size. To constrain the image’s proportions when changing size, tick the Keep
aspect box.
Changing supersampling options to smooth jagged edges. Select the required option from the list.
The highest sampling option (4x4) will take longer to process than the lowest sampling option or
turning supersampling off.
Viewing the image with or without overlays. See Overlay Settings for more information about further
customising the overlays displayed in the scene.
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Click the Render button to update the image with the changed settings. Once you are satisfied with the
rendered image, click Save. You will be prompted to enter a filename and location.

Background Rendering
You can keep the Render Image tab open while continuing to work in your project, which is useful for
rendering a series of images. To work in this way, dock the Render Image tab adjacent to the scene
window. When you have set up your scene, right-click on the Render Image tab and choose one of the
options:

The Render and Copy Image option will render a new image from the scene and copy it to the
clipboard.
The Render and Save Image option will render a new image and prompt you for a filename and
location.

Saved Scenes
A saved scene is a way of storing the objects in the shape list and their settings. Saved scenes are stored
in the Saved Scenes and Movies folder and can be dragged into the scene, restoring the list of
objects and their settings. A saved scene is, in effect, a bookmark of a specific view of the project data. A
saved scene does not maintain an independent copy of the data in the project, and so if the data
changes, then the appearance of the scene will also change.
When a scene is saved, comments can be entered documenting what is in the scene. Saved scenes
provide a stable point of reference in a project and can explain important features of the project, which is
especially useful for explaining features of a model to others using the project or viewing scene files.
Saved scenes can also be:
l
l

Exported to Leapfrog Viewer. You can export a single scene or a series of scenes.
Used to create a movie. See the Movies topic for information on using a series of saved scenes to
create and export a movie.

The rest of this topic describes:
l
l
l

Saving Scenes
Exporting Scenes
Linking to Scene Files
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Saving Scenes
To save the list of objects currently displayed in the Scene View tab, right-click on the Saved Scenes
and Movies folder and select Save Current Scene. The Save Scene window will be displayed:

Enter a name and description for the scene and click OK. The scene will be saved and added to the
Saved Scenes and Movies folder.
When you save a scene, the properties settings in the shape list are saved for the objects displayed in
the scene. For example, if a lithology table is displayed with the legend in the scene, the legend will be
displayed when the scene is restored. However, saved scenes do not store copies of the objects in the
project tree, and objects deleted from the project tree are no longer available in saved scenes.
To edit a scene, double-click on it. The Edit Saved Scene window will be displayed and you can
update the information.
To display a scene, drag it into the Scene View tab.

Exporting Scenes
Once you have a series of saved scenes, you can use them to create a scene file that can be opened in
Leapfrog Viewer.
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To export a scene, right-click on the Saved Scenes and Movies folder and select Export Scenes.
The Export Scenes window will be displayed. Move the scenes you wish to export to the Selected
scenes list and reorder them, if required.

You can also export an individual scene by right-clicking on the scene and selecting Export.
If you tick the Export hidden shapes box, objects in the shape list that are not visible in the scene
window will be included in the exported scene.
You can also export the data associated with the objects in the scene window, if required. To do so,
select the Export all data that appears when I click option. If viewing the data is not required, or if
you wish to keep sensitive data secure, select the Export shapes only option.
When the Export all data that appears when I click option is selected, all data represented by
shapes in the exported scene will be accessible when the scene is opened in Leapfrog Viewer.
When you have the scenes arranged, click Export. You will be prompted for a filename and location.
Exported scenes cannot be reimported to the project.

Linking to Scene Files
Links to scene files can be included in HTML files using the following format:
<a href="LeapfrogViewer:[path or URL]">link text</a>
Linked scene files will be opened directly in Leapfrog Viewer only from browsers that support custom
URI schemes.
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Movies
Once you have a series of saved scenes (see Saved Scenes), you can use them to create a storyboard
and export a movie.
To create a new movie, right-click on the Saved Scenes and Movies folder and select New Movie. A
tab will open in which you can create a storyboard and edit how each scene and transition is displayed.
You can detach the tab from the main window and create scenes in the main window while working on
scenes in the movie tab. Click the Refresh Scenes button to refresh the scenes in the movie tab when
you have made changes.
Select the saved scenes you wish to add to the movie by clicking on them in the list, then click the Add
To Storyboard button ( ). When subsequent scenes are added, transitions will be added to separate
the scenes:

Change properties for the selected scene or transition, then click the play button ( ) to preview the
settings. To preview the whole movie, click the Select All button then click play.
You can make changes to the included scenes without having to close and reopen the movie window.
Simply update the scenes, then, in the movie editor, click the Refresh Scenes button.
Enter a name and description for the movie and click the Save button ( ). The movie will be saved in
the Saved Scenes and Movies folder.
To export the movie, click the Save and Export button ( ). The Export Movie window will appear:
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If you tick Export frame images, individual frames will be saved as images, together with the movie
file. Click Export. You will be prompted to select a filename and location. Click Save to export the
movie. Leapfrog Works will then save the movie in the specified location, which may take some time.

Contour Lines
You can create contour lines from surfaces in the project and export those contour lines to GIS packages.

Creating Contour Lines
To create contour lines from a surface, right-click on the Cross Sections and Contours folder and
select New Contour Lines From Surface. In the New Contours window, select the surface to
contour from the list. Adjust the Contour Spacing, if required.
If you want to offset the contours by a vector, enter a Contour offset value.
Click OK to generate the contours.
The new contours will appear in the project tree under the Cross Sections and Contours folder.
You can edit the contours by double-clicking on them.

Exporting GIS Contours
To export a contour lines object, right-click on the contour lines in the Cross Sections and Contours
folder and select Export. Select whether or not to export the contours in 2.5D format, then click
Export. You will be prompted for a filename and location.
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